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1

Overview of Creating Oracle Event
Processing Applications

This chapter introduces the tools, technologies, and processes through which you can
build Oracle Event Processing applications, including the programming model, how
applications work, and key concepts and technologies.

This chapter includes the following sections:

= Section 1.1, "Oracle Event Processing Application Programming Model"
= Section 1.2, "How an Oracle Event Processing Application Works"

m  Section 1.3, "Overview of Events, Streams and Relations"

= Section 1.4, "Overview of Application Configuration"

ms  Section 1.5, "Oracle Event Processing APIs"

= Section 1.6, "Packaging an Application"

= Section 1.7, "Oracle Event Processing Application Lifecycle"

1.1 Oracle Event Processing Application Programming Model

This section provides an overview of the concepts, technologies, and tools that are part
of building Oracle Event Processing applications.

An Oracle Event Processing application receives and processes data streaming from an
event source. That data might be coming from one of a wide variety of places,
including a monitoring device, a financial services company, or a motor vehicle. Using
the data, the application might identify and respond to patterns, look for extraordinary
events and alert other applications, or do some other work that requires immediate
action based on quickly changing data.

When developing an Oracle Event Processing application, you assemble a network of
components that each have a role in processing the data. This event processing
network is essentially linear, with events passing through it from one end to the other.
Along the way, components execute queries in a language specifically designed for
streaming data, execute logic in Java, and create connections with other external
components.

Section 1.1.1, "Key Concepts Underlying Oracle Event Processing Applications"
Section 1.1.2, "Component Roles in an Event Processing Network"

Section 1.1.3, "Tools and Supporting Technologies for Developing Applications"

Overview of Creating Oracle Event Processing Applications 1-1
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1.1.1 Key Concepts Underlying Oracle Event Processing Applications

Applications you build with Oracle Event Processing are based on concepts and
technologies that are a mix of the familiar and (if you're new to event-based
applications) unfamiliar. The following list briefly describes the key concepts and
technologies that underlie how event processing networks work.

= Applications leverage the database programming model. Some of the
programming model in Oracle Event Processing applications is conceptually an
extension of what you find in database programming. Events are similar to
database rows in that they are tuples against which you can execute queries (with
a language that is an extension of SQL). In other words, if you know relational
databases, much of this will seem familiar.

For a closer look at the similarity between database programming and Oracle
Event Processing applications, see Section 1.3, "Overview of Events, Streams and
Relations".

= Stages represent discrete functional roles. The staged structure of an event
processing network (EPN) provides a means for you to execute different kinds of
logic against events flowing through the network. This includes query logic with
Oracle Continuous Query Language (Oracle CQL) as well as logic in Java. It also
provides a way to capture multiple processing paths with a network that branches
into multiple downstream directions based on discoveries your code makes.

For a list of roles stages play in an EPN, see Section 1.1.2, "Component Roles in an
Event Processing Network". For a closer look at the pieces of an EPN, see
Section 1.2, "How an Oracle Event Processing Application Works".

= Stages transmit events through an EPN by acting as event sinks and event
sources. The stages in an EPN are able to receive events (as event sinks) and/or
send events (as event sources). This includes stage components that come with
Oracle Event Processing as well as components you build, such as your own
adapters and beans.

For more about implementing your own event sinks and sources, see Chapter 16,
"Handling Events with Java"

s Events are handled either as streams or relations. The concept of a stream, unique
to streaming event-based applications, captures the fact that events arrive at your
application sequentially by timestamp. Contrast this with rows in a database,
where the table rows have no inherent relationship to one another aside from
schema. However, many queries of events in stream result in a relation, in which
events could be related in a way other than their relative sequence in time (similar
to database query results).

For more on streams and relations, see Section 1.3, "Overview of Events, Streams
and Relations".

1.1.2 Component Roles in an Event Processing Network

The core of Oracle Event Processing applications you build is an event processing
network (EPN). You build an EPN by connecting components (also known as stages)
that each have a role in processing events that pass through the network. When
developing an Oracle Event Processing application, you identify which kinds of
components will be needed. As you add components to the EPN, you configure each
as well as their connections with one another. As you use the IDE to build the EPN,
you arrange and connect components in a roughly linear shape in which events will
enter from the left end, move through the EPN and exit or terminate at the right end.
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For a high-level overview of an EPN using an application example, including fuller
descriptions of the technologies involved, see Section 1.2, "How an Oracle Event
Processing Application Works".

The EPN components you use provide ways to:

= Exchange event data with external sources. Through adapters and other stages,
you can connect external components to the EPN of your application to add ways
for data, including event data, to pass into or out of the EPN.

These external components include those in the following list (you can also build
your own).

s Relational databases. You can access a database table from within Oracle CQL
code, querying the database as you would with SQL.

s Caches. By adding a cache stage to an EPN, you can exchange data with the
cache.

= Java Message Service (JMS). With the JMS adapter, you can exchange
messages with a JMS destination without writing the Java code typically
needed for it.

s HTTP publish-subscribe server. The HTTP pub-sub adapter simplifies
exchanging messages with an HTTP publish-subscribe server.

= Model event data so that it can be handled by application code. You implement
or define event types that model event data so that application code can work with
it. For more information, see Chapter 9, "Defining and Using Event Types".

= Query and filter events. The Oracle Continuous Query Language (Oracle CQL) is
an extension of the SQL language through which you can query events as you
would data in a database. Oracle CQL includes features specifically intended for
querying streaming data. You add Oracle CQL code to an event processing
network by adding a processor. For more information, see Chapter 17, "Querying
an Event Stream with Oracle CQL".

= Execute Java logic to handle events. To an EPN you can add Java classes that
receive and send events just as other EPN stages do. Logic in these classes can
retrieve values from events, create new events, and more. For more information,
see Chapter 16, "Handling Events with Java".

For IDE reference information on creating event processing networks, see Section 7.4,
"Using the EPN Editor".

1.1.3 Tools and Supporting Technologies for Developing Applications

Included with Oracle Event Processing is a set of tools and supporting technologies
you can use to develop applications. These include tools for building and debugging
applications, testing applications in a lightweight way, accessing underlying
functionality with Java, and designing Oracle CQL queries.

The following lists some of these tools and technologies:

s The Oracle Event Processing IDE for Eclipse provides features specifically
designed to make developing Oracle Event Processing easier, including an EPN
Editor for graphically designing an event processing network. For more
information, see Chapter 4, "Overview of the Oracle Event Processing IDE for
Eclipse".

For a step-by-step introduction to using the IDE to build a simple application, see
Chapter 8, "Walkthrough: Assembling a Simple Application”.
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= By using the load generator with the csvgen adapter, you can more easily debug
an application in the early stages of development. The load generator is a tool that
reads data from a comma-separated text file and feeds the data to your EPN as
event data. For more information, see Chapter 21, "Testing Applications With the
Load Generator and csvgen Adapter".

s The Oracle Event Processing Java API includes classes for work such as
implementing stages in the event processing network, extending included
functionality, managing the server, and so on. For more information, see
Section 1.5, "Oracle Event Processing APIs".

s Oracle Event Processing Visualizer is a web-based user interface through which
you can design Oracle CQL queries and configure Oracle Event Processing
applications on the server. For more information, see "Overview of Using Oracle
Event Processing Visualizer" in the Oracle Fusion Middleware Visualizer User’s Guide
for Oracle Event Processing

= You connect and configure components through standard XML configuration
files. Much of the work of writing these files is done for you when you use the
IDE to assemble the event processing network. Yet there are many settings you
might need to make by editing the files directly. For more on configuration files,
see Section 1.4, "Overview of Application Configuration".

= You can improve scalability and promote high availability by using certain
application design patterns, server resources, and configuration conventions. For
more information, see Chapter 25, "Developing Scalable Applications" and
Chapter 24, "Developing Applications for High Availability".

1.2 How an Oracle Event Processing Application Works

As with many enterprise-scale applications, an Oracle Event Processing application is
full of "connected-to" relationships. For example, an adapter might be connected to a
processor, which might be connected to an event bean, which might be connected to a
external data source, and so on. The connections aren't necessarily in that order, but
you get the idea.

Events arrive from an outside source, then move through the application's event
processing network (EPN). Along the way they might be filtered, queried, and
otherwise processed as needed by EPN components that you put in place.

For example, take a look at a simple TradeReport application you can build using the

topics described in Chapter 8, "Walkthrough: Assembling a Simple Application".

Gl EPM: TradeReport 2
Filter ¥ Bundle: TradeReport ‘ AL AL [100% - | = -

AdapterQutputChannel = ProcessorOutputChannel

StockTradeCSVAdapter GetHighVelumeProcessor ListenerBean

Overview | Event Types

The following sections describe the role of each component in the application.

1-4 Developer's Guide for Oracle Event Processing



How an Oracle Event Processing Application Works

Event Information is Received in Its Raw Form

In the TradeReport example, the event data source is simply a text file with rows of
comma-separated values. To try things out, you can use such a file in combination
with the load generator included with Oracle Event Processing.

An event data source is outside the application, yet connected though an adapter that
knows how to retrieve its data. The event source could be something physically near
(such as another application in the organization) or it could be quite far away (perhaps
a temperature sensor in a server room in another city).

For information on event data and creating event types, see Chapter 9, "Defining and
Using Event Types".

For step-by-step content on capturing event data in the TradeReport application, see
Section 8.3, "Create an Event Type to Carry Event Data".

Adapters Connect External Components to the EPN

In the TradeReport example, the event data source is connected to the event processing
network through an adapter that knows how to receive event data sent from the CSV
file. The adapter converts the incoming data into instances of an event type that the
EPN can work with.

You can use an adapter to either receive incoming or send outgoing data. Adapters
provided with Oracle Event Processing give you access to CSV files and also to
systems such as the Java Message Service or an HTTP Publish-Subscribe server. You
can also develop your own adapters for integrating systems that aren't supported by
default.

When configuring an input adapter, you specify how the event data should be bound
to an instance of an event type that you've defined in the EPN.

For more information, see the following;:

Chapter 11, "Integrating the Java Message Service"

Chapter 12, "Integrating an HTTP Publish-Subscribe Server"

Chapter 13, "Integrating a Cache"

Chapter 15, "Integrating an External Component Using a Custom Adapter”
Chapter 21, "Testing Applications With the Load Generator and csvgen Adapter"

For step-by-step content on adding a csvgen adapter to receive CSV content in the
TradeReport application, see Section 8.4, "Add an Input Adapter to Receive Event
Data".

Event Types Provide Useful Structure for Event Data

In the TradeReport application, the input adapter converts the incoming event data
from a set of comma-separated values into property values of an event type instance
that's defined as a Java class.

An event type provides a predictable structure for event data that other code in your
application can use. Examples of that code include an Oracle CQL query that filters the
events to discover those to act on, Java code in a bean that creates new kinds of events
based on what your application received, and code to retrieve values and merge them
with values from another data source.

Event types define properties that provide access to event data. Adapters receive
incoming events from different event sources, such as the Java Messaging System
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(JMS) or financial market data feeds. You must define an Oracle Event Processing
event type for these events before code is able to work with them.

You specify event types when you're configuring the EPN. With the structure of the
raw event data in hand, you can define an event type that best suits your application's
needs. The general best practice for defining an event type is to write a JavaBean class
whose properties map to the event data that your application will use. You can also
define event types as simple tuples and Java Map instances.

For more information, see Chapter 9, "Defining and Using Event Types"

For step-by-step content on defining an event type for the TradeReport application, see
Section 8.3, "Create an Event Type to Carry Event Data".

Channels Transfer Events from Stage to Stage

In the TradeReport application, the input adapter transmits events to an Oracle CQL
processor by sending the events through a channel.

Channels connect stages in an event processing network. Between most components
you will add a channel that listens for events coming from one stage and sends those
events to another stage.

For more information on adding channels, see Chapter 10, "Connecting EPN Stages
Using Channels".

For step-by-step content on adding a channel to the TradeReport application, see
Section 8.5, "Add a Channel to Convey Events".

Processors Contain Query Code to Examine Events

The TradeReport application includes a processor that contains a simple Oracle
Continuous Query Language (Oracle CQL) query to filter the stream of received
events down to only those that meet certain criteria. As events flow through the
processor, the Oracle CQL code executes, acting as a filter to determine which events
get passed to the next stage.

The logic of the application relies on the specific qualities of events flowing through it.
In this application, a processor stage is a place to discover those qualities by using
Oracle CQL code to look for occurrences of particular data or trends.

Because it is a great deal like the SQL language used to query more static, relational
data sources, the Oracle CQL language is a powerful tool to discover information
about data represented by events. For example, Oracle CQL contains a wide
assortment of functions ranging from simple count () and sum () functions to
sophisticated statistics functions.

Oracle CQL is like SQL, but also includes functionality intended specifically for
writing queries that account for a characteristic typically not as important when
querying static databases: the passage of time. Through these time-related features,
you can, for example, write code that defines specific windows, such as from the
present to the preceding 5 milliseconds. Your queries can execute to isolate this
window as events pass through.

You can also use the code in Oracle CQL processor to collect and combine data from a
variety of sources, including a cache and a relational database. Using a cache, for
example, gives you a place to put frequently-retrieved data where performance will be
faster.

The Oracle CQL engine is also extensible with cartridges that make additional
functionality available to your Oracle CQL code.
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For more information on Oracle CQL, see Chapter 17, "Querying an Event Stream with
Oracle CQL".

For step-by-step information on defining an Oracle CQL query in the TradeReport
application, see Section 8.8, "Add an Oracle CQL Processor to Filter Events".

Beans Provide a Place for Java Logic

Once the TradeReport application has processed events with Oracle CQL, it passes the
resulting events to an event bean that receives the events and prints to the console data
contained in each event type instance.

In an EPN, a bean provides a place for you to execute Java code over events that are
passing through. A bean can receive and sent events. For example, a bean might
receive events of one type, then retrieve their data to perform some calculation or
lookup using the data. The bean could then create new events from the newly
generated data before passing the new events along to another stage.

You can write and configure beans as either Spring beans or event beans. Spring beans
are managed by the Spring framework, and are a good choice if you want to integrate
your bean to an existing Spring deployment. Event beans, on the other hand, use
Oracle Event Processing conventions for configuring beans so that they're managed by
the Oracle Event Processing server. With an event bean, for example, you get the
support of Oracle Event Processing server features such as monitoring and event
recording and playback (useful for debugging an application).

For more information on writing and using Java classes that handle events, see
Chapter 16, "Handling Events with Java".

For step-by-step content on adding an event bean to the TradeReport application, see
Section 8.6, "Create a Listener to Receive and Report Events".

Configuration Files Define an EPN and Its Components

The EPN presence of and connections between TradeReport application stages is
configured in an EPN assembly XML file. There is also a component configuration file
which, though it isn’t used in this case, could define runtime configuration for the
components.

The EPN assembly file is what you are writing as you assemble an event processing
network using the IDE (the EPN editor is essentially a user interface for designing
EPN assembly files). What's in the EPN assembly file declares the stages and
determines how they interact, including which direction events flow when moving
from one stage to another. The EPN assembly file also sets default values for
component settings, or values that you won't need to change at runtime.

With a component configuration file, on the other hand, you can specify configuration
data that an administrator can later change while the application is running. The
component configuration file is where Oracle CQL code is typically written (as
configuration for a processor component).

For more information on configuration files, see Section 1.4, "Overview of Application
Configuration".

Design and Configuration Conventions Scalability and High Availability

While the simple TradeReport application doesn't demonstrate them, there are design
patterns that you can use to ensure that your application remains available and scales
well.

When ensuring that your application remains highly available, you integrate
application design patterns, server resources, and configuration conventions so that
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your deployed application continues to fulfill its role even in the event of software or
hardware failures.

A scalable Oracle Event Processing application incorporates design patterns with
implementation and configuration conventions to ensure that the application functions
well as the event load increases.

For more information, see the following:
Chapter 24, "Developing Applications for High Availability"
Chapter 25, "Developing Scalable Applications"

1.3 Overview of Events, Streams and Relations

An Oracle Event Processing application handles events that arrive in a stream as raw
event data, are converted to event type instances inside the application, and move
from one application stage to another in an event processing network. Along the way,
the events might be filtered with Oracle CQL queries, handled by Java code, stored in
a cache, forwarded to other applications, and so on.

But what is an event? With the emphasis on the streaming aspect of event data, it can
be easy to forget how much events are like rows in a database. In application terms, an
event is a tuple, or set of values. Like a relational database row, an event has a schema
in which each value has specific constraints, such as a particular data type. An event’s
schema defines its set of properties (where values will go) and their types.

Where events are unlike database rows is in the importance of time. In a stream of
events, when an event arrives, including which event arrives before or after another
event, can make all the difference. As a result, your application needs to be able to
account for time and sequence.

For example, in an application that processes stock trades, event tuples made up of
stock symbol, price, last price, percentage change, and volume would likely arrive one
after the other in the order in which each trade was executed. Your application’s logic
might look for trades of one stock that occurred immediately after trades of another.

In other words, in an event processing application the sequence in which events occur
in a stream is as important as the data types and values of each event property. As a
result, conventions of the Oracle Event Processing programming model reflect the
importance of time and sequence. Your code should be able to discover which events
are related to one another based on certain criteria (such as a shared stock symbol). But
it also needs to be able to discover sequence patterns (such as trades within fifteen
seconds of one another). And it should be able to discover these things with very low
latency as the events arrive at your application.

To account for both the sequential and relational aspects of event data, Oracle Event
Processing uses the concepts of streams and relations.

= A stream is a potentially infinite sequence of events. Like rows in a database, the
events are tuples, yet each has its own timestamp. In a stream, the events must be
ordered by time, one after the other, so that timestamps do not decrease from one
event to the next (although there might be events in a stream that have the same
timestamp).

» In a relation, sequence might be unimportant (as with the results of a database
query). Instead, events in a relation are typically related because they met certain
criteria. For example, events in a relation might be the result of a query executed
against a stream of stock trades, where the query was looking for trade volumes
above a particular level.
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Consider that stream of stock trade events. The events are arriving in sequence, each
with its own timestamp (perhaps the time when the trade occurred). To isolate the
share price for trades that occurred within 5 seconds of one another, you query the
stream (received from StockTradeChannel) with the following Oracle CQL code:

select price from StockTradeChannel [range 5 seconds]

Because it uses a window -- [range 5 seconds] -- to isolate the events, this query’s
output is a relation. Though the events returned from the query have timestamps, they
are unordered in the relation. Because the incoming events are in a stream, the query
will execute continuously against every 5 seconds” worth of events as they pass into
the query processor. As new events come along, those meeting the query terms are
inserted into the relation, while those leaving (pushed out, actually) are deleted from
the relation.

Why does this matter? A stream’s integrity as a stream is important. Technically, a
stream is a continuously moving -- well, streaming -- and ordered set of tuples. In a
stream, every event can be said to be "inserted,” having been put into the stream by its
source, one after the other. When you get a subset of the stream with a query, you no
longer have something that is ordered. And once you have the subset in hand, you
might want to further isolate events by executing Oracle CQL code that queries the
relations that result from queries of streams.

For this reason, examples in the Oracle CQL reference show the output of a query as
events that are, as a result of the query and at that particular place in time, either
inserted or deleted.

Before passing a relation along to the next stage in the EPN, you can convert it back
into a stream by using an operator such as IStream.

For more information, see:
= Section 10.1.2, "Channels Representing Streams and Relations"

»  "Streams and Relations" in the Oracle Fusion Middleware CQL Language Reference for
Oracle Event Processing

1.4 Overview of Application Configuration

You configure Oracle Event Processing applications through XML files that are based
on standard schemas. When you install Oracle Event Processing, XSD files for these
schemas are included in the directory MIDDLEWARE HOME\ocep_11.1\xsd.

As you assemble an event processing network (EPN), even if you are using the IDE,
you are creating an EPN assembly XML file. An entry for a stage in this file adds that
stage to the EPN and defines its connections with other stages. For more on this file,
see Section 1.4.1, "Overview of EPN Assembly Files".

Each component in your event processing network (adapter, processor, channel, or
event bean) can have associated configuration XML. By providing this configuration,
you provide a way for the component’s configuration to be edited at runtime. (Only
processors are required to have a configuration file.) Configuration XML for
components can be grouped into a single component configuration file or divided
among multiple files, depending on the needs of your development process. For more
on component configuration files, see Section 1.4.2, "Overview of Component
Configuration Files".

Other aspects of an Oracle Event Processing application might require their own
configuration files. These include caching provided by Oracle Coherence. For
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information about other configuration, see documentation sections related to those
technologies.

1.4.1 Overview of EPN Assembly Files

When you are assembling an event processing network (EPN) using the IDE, you are
defining the EPN in an assembly file. The EPN assembly file is an XML file whose
shape is based on the Spring framework XML configuration file. The EPN assembly
file schema extends the Spring configuration schema.

The spring-wlevs-v11l_1_1_6.xsd schema file describes the structure of EPN
assembly files. When you install Oracle Event Processing, XSD files such as this one
are included in the directory MIDDLEWARE_HOME\ocep_11.1\xsd..

The structure of EPN assembly files is as follows. There is a top-level root element
named beans that contains a sequence of sub-elements. Each individual sub-element
contains the configuration data for an Oracle Event Processing component. For
example:

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xsi:schemalocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-v1l1l_1_1_6.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="HelloWorldEvent">
<wlevs:class>com.bea.wlevs.event.example.helloworld.HelloWorldEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutputChannel"
event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean"/>
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

</beans>

For some Oracle Event Processing features, you specify some configuration in the EPN
assembly file and some in the component configuration file.

For more information, see:
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= Section 5.3, "Creating EPN Assembly Files"
s Section 1.4.2, "Overview of Component Configuration Files"

= Appendix B.1, "EPN Assembly Schema spring-wlevs-v11_1_1_6.xsd"

1.4.1.1 Nesting Stages in an EPN Assembly File

When you define a child stage within a parent stage in an EPN, the child stage is said
to be nested. Only the parent stage can specify the child stage as a listener.

Example 1-1 shows the EPN assembly source in which HelloWorldBean is nested
within the helloworldOutputChannel. Only the parent helloworldOutputChannel
may specify the nested bean as a listener.

Example 1-1 EPN Assembly File With Nested Bean

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >

<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutput" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

Alternatively, you can define this EPN so that all nodes are nested as Example 1-2
shows. The helloworldAdapter, the outermost parent stage, is the only stage
accessible to other stages in the EPN.

Example 1-2 EPN Assembly File With all Nodes Nested

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message"
value="HelloWorld - the current time is:"/>
<wlevs:listener>
<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener>
<wlevs:processor id="helloworldProcessor">
<wlevs:listener>
<wlevs:channel id="helloworldOutputChannel"
event-type="HelloWorldEvent">
<wlevs:listener>
<bean
class="com.bea.wlevs.example.helloworld.HelloW
orldBean"/>
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:processor>
</wlevs:listener>
</wlevs:channel>

Overview of Creating Oracle Event Processing Applications 1-11



Overview of Application Configuration

</wlevs:listener>
</wlevs:adapter>

For more information, see Section 7.2.9, "Nested Stages".

1.4.1.2 Referencing Foreign Stages in an EPN Assembly File

You can refer to a stage that is in another Oracle Event Processing application. A stage
from another application is considered a foreign stage. You do this by id attribute when
you define both the source and target stage in the same application.

Note: You can’t connect a processor stage to a channel that is a
foreign stage.

To refer to a stage you define in a different application, you use the following syntax:

FOREIGN-APPLICATION-NAME: FOREIGN-STAGE-ID

Where FOREIGN-APPLICATION-NAME is the name of the application in which you
defined the foreign stage and FOREIGN-STAGE-IDis the id attribute of the foreign stage.

Example 1-3 shows how the reference in applicationl to the foreign stage
HelloWorldBeanSource that you define in application application2.

Example 1-3 Application 1 Referencing Foreign Stage in Application 2
<wlevs:stream id="helloworldInstream" >
<wlevs:listener ref="helloworldProcessor"/>

<wlevs:source ref="application2:HelloWorldBeanSource"/>
</wlevs:stream>

Example 1-4 Foreign Stage in Application 2
<wlevs:event-bean id="HelloWorldBeanSource"

class="com.bea.wlevs.example.helloworld.HelloWorldBeanSource"
advertise="true"/>

The following stages cannot be foreign stages:
s Cache

When creating Oracle Event Processing applications with foreign stages, you must
consider foreign stage dependencies when assembling, deploying, and redeploying
your application. For more information, see Section 23.2.3, "Assembling Applications
With Foreign Stages".

1.4.2 Overview of Component Configuration Files

Each component in your event processing network (adapter, processor, channel, or
event bean) can have an associated configuration file, although only processors are
required to have a configuration file. The caching system also uses a configuration file,
regardless of whether it is a stage in the event processing network. Component
configuration files in Oracle Event Processing are XML documents whose structure is
defined using standard XML Schema. You create a single file that contains
configuration for all components in your application, or you can create separate files
for each component; the choice depends on which is easier for you to manage.
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The wlevs_application_config.xsd schema file describes the structure of component
configuration files. When you install Oracle Event Processing, XSD files such as this
one are included in the directory MIDDLEWARE_HOME\ocep_11.1\xsd..

This XSD schema imports the following schemas:

s wlevs_base_config.xsd: Defines common elements that are shared between
application configuration files and the server configuration file

m wlevs_eventstore_config.xsd: Defines event store-specific elements.
s wlevs_diagnostic_config.xsd: Defines diagnostic elements.

The structure of application configuration files is as follows. There is a top-level root
element named config that contains a sequence of sub-elements. Each individual
sub-element contains the configuration data for an Oracle Event Processing
component (processor, channel, or adapter). For example:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>helloworldProcessor</name>
<rules>
<query id="helloworldRule">
<! [CDATA[ select * from helloworldInputChannel [Now] ]]>
</query>
</rules>
</processor>
<channel>
<name>helloworldInputChannel</name>
<max-size>10000</max-size>
<max-threads>2</max-threads>
</channel>
<channel>
<name>helloworldOutputChannel</name>
<max-size>10000</max-size>
<max-threads>2</max-threads>
</channel>
</nl:config>

For more information, see:

= Section 1.4.2.1, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

= Section 5.4, "Creating Component Configuration Files"

= Appendix B.2, "Component Configuration Schema wlevs_application_config.xsd"

1.4.2.1 Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class

Using the ConfigurationPropertyPlaceholderConfigurer class, you can reference
existing configuration file properties, in both component configuration and server
configuration files, using a symbolic placeholder. This allows you to define a value in
one place and refer to that one definition rather than hard-coding the same value in
many places.

To use this feature, insert a ConfigurationPropertyPlaceholderConfigurer bean in
the application context configuration file of your application bundle as Example 1-5
shows.

Overview of Creating Oracle Event Processing Applications 1-13



Overview of Application Configuration

Example 1-5 Adding a ConfigurationPropertyPlaceholderConfigurer

<bean class="com.bea.wlevs.spring.support.ConfigurationPropertyPlaceholderConfigurer"/>

For complete details, see the
com.bea.wlevs.spring.support.ConfigurationPropertyPlaceholderConfigurer
class in the Oracle Fusion Middleware Java API Reference for Oracle Event Processing.

For more information on accessing property files, see Section 5.7.3, "How to Add a
Property File to an Oracle Event Processing Project".

1.4.3 Configuring Oracle Event Processing Resource Access

Because Oracle Event Processing applications are low latency high-performance
event-driven applications, they run on a lightweight container and are developed
using a POJO-based programming model. In POJO (Plain Old Java Object)
programming, business logic is implemented in the form of POJOs, and then injected
with the services they need. This is popularly called dependency injection. The injected
services can range from those provided by Oracle Event Processing services, such as
configuration management, to those provided by another Oracle product such as
Oracle Kodo, to those provided by a third party.

By using Oracle Event Processing and standard Java annotations and deployment
XML, you can configure the Oracle Event Processing Spring container to inject
resources (such as data sources or persistence managers, and so on) into your Oracle
Event Processing application components.

The Spring container typically injects resources during component initialization.
However, it can also inject and re-inject resources at runtime and supports the use of
JNDI lookups at runtime.

Oracle Event Processing supports the following types of resource access:
ms  Section 1.4.3.1, "Static Resource Injection"

= Section 1.4.3.2, "Dynamic Resource Injection”

= Section 1.4.3.3, "Dynamic Resource Lookup Using JNDI"

See Section 1.4.3.4, "Understanding Resource Name Resolution" for information on
resource name resolution.

See Appendix I, "Oracle Event Processing Metadata Annotation Reference" for
complete details of all Oracle Event Processing annotations.

In the following sections, consider the example resource that Example 1-6 shows. This
is a data source resource named StockDS that you specify in the Oracle Event
Processing server config.xml file.

Example 1-6 Sample Resource: Data Source StockDS

<config ...>
<data-source>
<name>StockDs</name>

<driver-params>
<url>jdbc:derby:</url>

<driver-params>
</data-source>

</config>
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1.4.3.1 Static Resource Injection

Static resource injection refers to the injection of resources during the initialization
phase of the component lifecycle. Once injected, resources are fixed, or static, while the
component is active or running.

You can configure static resource injection using;:
m Section 1.4.3.1.1, "Static Resource Names"

= Section 1.4.3.1.2, "Dynamic Resource Names"

1.4.3.1.1 Static Resource Names When you configure static resource injection using
static resource names, the resource name you use in the @Resource annotation or
Oracle Event Processing assembly XML file must exactly match the name of the
resource as you defined it. The resource name is static in the sense that you cannot
change it without recompiling.

To configure static resource injection using static resource names at design time, you
use the standard javax.annotation.Resource annotation as Example 1-7 shows.

To override design time configuration at deploy time, you use Oracle Event Processing
assembly file XML as Example 1-8 shows.

In Example 1-7 and Example 1-8, the resource name StockDs exactly matches the
name of the data source in the Oracle Event Processing server config.xml file as
Example 1-6 shows.

Example 1-7 Static Resource Injection Using Static Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource (name="StockDs")

public void setDataSource (DataSource dataSource) {
this.dataSource = dataSource;

}

Example 1-8 Static Resource Injection Using Static Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource" name="StockDs"/>
</wlevs:event-bean>

If the name of the EventBean set method matches the name of the resource, then the
@Resource annotation name attribute is not needed as Example 1-9 shows. Similarly, in
this case, the wlevs:resource element name attribute is not needed as Example 1-10.

Example 1-9 Static Resource Injection Using Static Resource Names: Annotations
import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource ()

public void setStockDs (DataSource dataSource) {

this.dataSource = dataSource;
}
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Example 1-10 Static Resource Injection Using Static Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource"/>
</wlevs:event-bean>

1.4.3.1.2 Dynamic Resource Names A dynamic resource name is one that is specified as
part of the dynamic or external configuration of an application. Using a dynamic
resource name, the deployer or administrator can change the resource name without
requiring that the application developer modify the application code or the Spring
application context.

To add a dynamic resource name to a component, such as an adapter or POJO, you
must first specify custom configuration for your component that contains the resource
name as Example 1-11 shows.

Example 1-11 Custom Component Configuration

<simple-bean>
<name>SimpleBean</name>
<trade-datasource>StockDs</trade-datasource>
</simple-bean>

To configure static resource injection using dynamic resource names at design time,
you use the standard javax.annotation.Resource annotation as Example 1-12 shows.

To override design time configuration at deploy time, you use Oracle Event Processing
assembly file XML as Example 1-13 shows.

Example 1-12 Static Resource Injection Using Dynamic Resource Names: Annotations

import javax.annotation.Resource;
public class SimpleBean implements EventBean {

@Resource (name="trade-datasource")
public void setDataSource (DataSource dataSource) {
this.dataSource = dataSource;

Example 1-13 Static Resource Injection Using Dynamic Resource Names: XML

< wlevs:event-bean id="simpleBean" class="...SimpleBean"/>
<wlevs:resource property="dataSource" name="trade-datasource"/>
</wlevs:event-bean>

1.4.3.2 Dynamic Resource Injection

Dynamic resource injection refers to the injection of resources dynamically while the
component is active in response to a dynamic configuration change using Spring
container method injection.

To configure dynamic resource injection at design time, you use the standard
javax.annotation.Resource annotation as Example 1-14 shows.

Example 1-14 Dynamic Resource Injection: Annotations

import javax.annotations.Resource;

public class SimpleBean implements EventBean {
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@Resource ("trade-datasource")
public abstract DataSource getDataSource ();

}

The component calls the getDataSource method at runtime whenever it needs to
retrieve a new instance of the resource that the resource name trade-datasource
refers to.

Typically, the component calls the getDataSource method during the @Prepare or
@Activate methods when dynamic configuration changes are handled. For more
information see:

= Section 1.2, "com.bea.wlevs.configuration.Activate"
= Section 1.3, "com.bea.wlevs.configuration.Prepare"

Another strategy is to always call the getDataSource prior to using the data source.
That is, the application code does not store a reference to the data source as a field in
the component.

1.4.3.3 Dynamic Resource Lookup Using JNDI

Oracle Event Processing supports the use of JNDI to look up resources dynamically as
Example 1-15.

Example 1-15 Dynamic Resource Lookup Using JNDI

import javax.naming.InitialContext;
public class SimpleBean implements EventBean {
public abstract void getDataSource () throws Exception {
InitialContext initialContext= new InitialContext ();
return initialContext.lookup ("StockDs”);

}

In Example 1-15, the JNDI name StockDs must exactly match the name of the data
source in the Oracle Event Processing server config.xnl file as Example 1-6 shows.

Note: You must disable security when starting the Oracle Event
Processing server in order to use JNDI. Oracle does not recommend
the use of JNDI for this reason.

For more information, see "Configuring Security for Oracle Event
Processing" in the Oracle Fusion Middleware Administrator’s Guide for
Oracle Event Processing.

1.4.3.4 Understanding Resource Name Resolution

Oracle Event Processing server resolves resource names by examining the naming
scopes that Table 1-1 lists.

Table 1-1 Resource Name Resolution

Naming Scope | Contents Resolution Behavior

Component The property names of the component’s custom configuration | Mapping

Application The names of the configuration elements in the application Matching
configuration files
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Table 1-1 (Cont.) Resource Name Resolution

Naming Scope | Contents Resolution Behavior

Server The names of the configuration elements in the server Matching

configuration file

JNDI The names registered in the server's JNDI registry Matching

Each naming scope contains a set of unique names. The name resolution behavior is
specific to a naming scope. Some naming scopes resolve names by simple matching.
Other scopes resolve names by mapping the name used to do the lookup into a new
name. Once a name is mapped, lookup proceeds recursively beginning with the
current scope.

1.5 Oracle Event Processing APIs

Oracle Event Processing provides a variety of Java APIs that you use in your adapter
or event bean implementation.

This section describes the APIs in the com.bea.wlevs.ede.api package that you will
most typically use in your adapters and event beans.

AdapterFactory—Adapter factories must implement this interface.
For more information, see Section 15.6, "Creating a Custom Adapter Factory"

Component life cycle interfaces—If you want some control over the life cycle of
the component you are programming, then your component should implement
one or more of the following interfaces.

For more information about the life cycle, see Section 1.7, "Oracle Event Processing
Application Lifecycle".

- InitializingBean—Use if you require custom initialization after Oracle Event
Processing has set all the properties of the component. Implement the
afterPropertiesSet method.

- ActivatableBean—Use if you want to run some code after all dynamic
configuration has been set and the event processing network has been
activated. Implement the afterConfigurationActive method.

- RunnableBean—Use if you want the component to be run in a thread.

The Spring framework implements similar bean life cycle interfaces; however,
the equivalent Spring interfaces do not allow you to manipulate beans that
were created by factories, while the Oracle Event Processing interfaces do.

- SuspendableBean—Use if you want to suspend resources or stop processing
events when the event processing network is suspended. Implement the
suspend method.

- ResumableBean—Use if you want to perform some task, such as acquire or
configure resources, before the component resumes work.

- DisposableBean—Use if you want to release resources when the application is
undeployed. Implement the destroy method in your component code.

See also Appendix I, "Oracle Event Processing Metadata Annotation Reference" for
additional lifecycle annotations.

Event type instantiation interfaces—Use these interfaces for greater control over
how event types are instantiated for use in an EPN.
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For more information about event types, see Chapter 1, "Overview of Creating
Oracle Event Processing Applications".

- EventBuilder—Use to control event type instantiation, such as to ensure that
the properties of a configured event are correctly bound to the properties of an
event type class, such as one you have implemented as a JavaBean.

For more information, see Section 9.3.1.5, "Controlling Event Type
Instantiation with an Event Type Builder Class".

- EventBuilder.Factory—Factory for creating EventBuilders.

s Event source and sink interfaces—Use these to enable a class to receive and send
events as part of the event processing network.

For more information on event sources and sinks, see Section 16.2, "Handling
Events with Sources and Sinks" and

- StreamSinkand BatchStreamSink—Components that want to receive events as
an Oracle Event Processing stream must implement this interface. An Oracle
Event Processing stream has the following characteristics:

Append-only, that is, events are always appended to the end of the stream.
Unbounded and generally need a window to be defined before it can be processed.
Events have non-decreasing time-stamps.

For more implementation information, see Section 16.2.1, "Implementing an
Event Sink".

- StreamSource, StreamSender and BatchStreamSender—Components that
send events modeling an Oracle Event Processing stream, such as adapters,
must implement StreamSource. The interface has a setEventSender method
for setting the StreamSender or BatchStreamSender, which actually send the
event to the next component in the network.

For more implementation information, see Section 16.2.2, "Implementing an
Event Source".

- RelationSink and BatchRelationSink—Components that want to receive
events modeling an Oracle Event Processing relation must implement one of
these interfaces. An Oracle Event Processing relation has the following
characteristics:

Supports events that insert, delete, and update its content.
Is always known at an instant time.
Events have non-decreasing time-stamps.

For more implementation information, see Section 16.2.1, "Implementing an
Event Sink".

— RelationSource, RelationSender, and BatchRelationSender—Components
that send events modeling an Oracle Event Processing relation, such as
adapters, must implement this interface. The interface has a setEventSender
method for setting the RelationSender or BatchRelationSender, which
actually send the event to the next component in the network.

For more implementation information, see Section 16.2.2, "Implementing an
Event Source".

For more information, see:

»s  For the full reference documentation for all classes and interfaces, see Oracle Fusion
Middleware Java API Reference for Oracle Event Processing.
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»  For sample Java code that uses these APIs, see:
— Chapter 9, "Defining and Using Event Types"
— Chapter 15, "Integrating an External Component Using a Custom Adapter"
— Chapter 16, "Handling Events with Java"
— Chapter 2, "Oracle Event Processing Samples"

= Section 1.4.3, "Configuring Oracle Event Processing Resource Access" for
information on using Oracle Event Processing annotations and deployment XML
to configure resource injection.

1.6 Packaging an Application

After an application is assembled, it must be packaged so that it can be deployed into
Oracle Event Processing. This is a simple process. The deployment unit of an
application is a plain JAR file, which must contain, at a minimum, the following
artifacts:

»  The compiled application Java code of the business logic POJO.

= Component configuration files. Each processor is required to have a configuration
file, although adapters and streams do not need to have a configuration file if the
default configuration is adequate and you do not plan to monitor these
components.

= The EPN assembly file.
m A MANIFEST.MF file with some additional OSGi entries.

After you assemble the artifacts into a JAR file, you deploy this bundle to Oracle Event
Processing so it can immediately start receiving incoming data.

For more information, see Chapter 23, "Assembling and Deploying Oracle Event
Processing Applications".

1.7 Oracle Event Processing Application Lifecycle

Figure 1-1 shows a state diagram for the Oracle Event Processing application lifecycle.
In this diagram, the state names (STARTING, INITIALIZING, RUNNING, SUSPENDING,
SUSPENDED, and FAILED) correspond to the ApplicationRuntimeMBean method
getState return values. These states are specific to Oracle Event Processing; they are
not OSGi bundle states.
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Figure 1-1 Oracle Event Processing Application Lifecycle State Diagram
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Note: For information on Oracle Event Processing server lifecycle,
see "Oracle Event Processing Server Lifecycle" in the Oracle Fusion
Middleware Administrator’s Guide for Oracle Event Processing.

This section describes the lifecycle of an application deployed to the Oracle Event
Processing server and the sequence of com.bea.wlevs.ede.api API callbacks.

This information explains how Oracle Event Processing manages an application's
lifecycle so that you can better use the lifecycle APIs in your application.

For a description of these lifecycle APIs (such as RunnableBean and SuspendableBean),
see:

ms  Section 1.5, "Oracle Event Processing APIs"
= Appendix I, "Oracle Event Processing Metadata Annotation Reference"
»  Oracle Fusion Middleware Java API Reference for Oracle Event Processing

The lifecycle description is broken down into actions that a user performs, including
those described in the following sections.

Installing an application or starting the server with application already deployed
Oracle Event Processing performs the following actions:

1. Oracle Event Processing installs the application as an OSGI bundle. OSGI resolves
the imports and exports, and publishes the service.

2. Oracle Event Processing creates beans (for both standard Spring beans and those
that correspond to the Oracle Event Processing tags in the EPN assembly file). For
each bean, Oracle Event Processing:

- Sets the properties on the Spring beans. The <wlevs:instance-property>
values are set on adapters and event-beans.

— Injects appropriate dependencies into services specified by @Service or
@ServiceReference annotations.
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- Injects appropriate dependencies into static configuration properties.
— Calls the InitializingBean.afterPropertiesSet method.

- Calls configuration callbacks (éPrepare,@Activate) on Spring beans as well as
factory-created stages.

For more information, see Section 1.4.3, "Configuring Oracle Event Processing
Resource Access".

3. Application state is now INITIALIZING.
4. Oracle Event Processing registers the MBeans.

5. Oracle Event Processing calls the ActivatableBean.afterConfigurationActive
method on all ActivatableBeans.

6. Oracle Event Processing calls the ResumableBean.beforeResume method on all
ResumableBeans.

7. For each bean that implements RunnableBean, Oracle Event Processing starts it
running in a thread.

8. Application state is now RUNNING.

Suspending the application
Oracle Event Processing performs the following actions:

1. Oracle Event Processing calls the SuspendableBean. suspend method on all
SuspendableBeans.

2. Application state is now SUSPENDED.

Resuming the application
Oracle Event Processing performs the following actions:

1. Oracle Event Processing calls the ResumableBean.beforeResume method on all
ResumableBeans

2. For each bean that implements RunnableBean, Oracle Event Processing starts it
running in a thread.

3. Application state is now RUNNING.

Uninstalling application
Oracle Event Processing performs the following actions:

1. Oracle Event Processing calls the SuspendableBean. suspend method on all
SuspendableBeans.

2. Oracle Event Processing unregisters MBeans.

3. Oracle Event Processing calls the DisposableBean.dispose method on all
DisposableBeans.

4. Oracle Event Processing uninstalls application bundle from OSGI.

Updating the application
This is equivalent to first uninstalling an application and then installing it again.

See those user actions in this list.
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Calling methods of stream and relation sources and sinks

You may not call a method on a stream or relation source or sink from a lifecycle
callback because components may not be ready to receive events until after these
phases of the application lifecycle complete.

For example, you may not call StreamSender method sendInsertEvent from a
lifecycle callback such as such as afterConfigurationActive or beforeResume.

You can call a method on a stream or relation source or sink from the run method of
beans that implement RunnableBean.

For more information, see the description of installing an application. Also see
Section 16.2, "Handling Events with Sources and Sinks".

Overview of Creating Oracle Event Processing Applications 1-23



Oracle Event Processing Application Lifecycle

1-24 Developer's Guide for Oracle Event Processing



2

Oracle Event Processing Samples

This chapter introduces sample code provided with Oracle Event Processing,
describing how to set up and use code ranging from simple "Hello World" to
applications of Oracle Continuous Query Language (Oracle CQL), as well as for
spatial and industry-focused scenarios.

This chapter includes the following sections:

Section 2.1, "Overview of the Samples Provided in the Distribution Kit"
Section 2.2, "Installing the Default ocep_domain and Samples"

Section 2.3, "Using Oracle Event Processing Visualizer With the Samples"
Section 2.4, "Increasing the Performance of the Samples"

Section 2.5, "HelloWorld Example"

Section 2.6, "Oracle Continuous Query Language (Oracle CQL) Example"
Section 2.7, "Oracle Spatial Example"

Section 2.8, "Foreign Exchange (FX) Example"

Section 2.9, "Signal Generation Example"

Section 2.10, "Event Record and Playback Example"

2.1 Overview of the Samples Provided in the Distribution Kit

Oracle Event Processing includes the following samples:

HelloWorld: a basic skeleton of a typical Oracle Event Processing application.

Oracle Continuous Query Language (CQL): an example that shows how to use the
Oracle Event Processing Visualizer Query Wizard to construct various Oracle CQL
queries to process event streams.

Oracle Spatial: an example that shows how to use Oracle Spatial with Oracle CQL
queries to process a stream of Global Positioning System (GPS) events to track the
GPS location of buses and generate alerts when a bus arrives at its pre-determined
bus stop positions.

Foreign Exchange (FX): a complete example that includes multiple components.
Signal Generation: an example that simulates market trading and trend detection.

Event record and playback: an example that shows how to configure event record
and playback using a persistent event store.

These samples are provided in two forms, as follows:
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Section 2.1.1, "Ready-to-Run Samples"

Section 2.1.2, "Sample Source"

The samples use Ant as their development tool; for details about Ant and installing it
on your computer, see http: //ant.apache.org/.

2.1.1 Ready-to-Run Samples

Out-of-the-box sample domains pre-configured to deploy an assembled application;
each sample has its own domain for simplicity. Each domain is a standalone server
domain; the server files are located in the defaultserver subdirectory of the domain
directory. To deploy the application you simply start the default server in the domain.

The sample HelloWorld domain is located in \MIDDLEWARE_HOME\ocep_
11.1\samples\domains\helloworld_domain, where MIDDLEWARE_ HOME refers to the
Middleware directory you specified when you installed Oracle Event Processing,
such as d:\Oracle\Middleware.

See Section 2.5.1, "Running the HelloWorld Example from the helloworld Domain"
for details.

The sample CQL domain is located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\cqgl_domain.

See Section 2.6.1, "Running the CQL Example" for details.

The sample Oracle Spatial domain is located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\spatial_domain.

See Section 2.7.1, "Running the Oracle Spatial Example" for details.

The sample Foreign Exchange domain is located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\£fx_domain.

See Section 2.8.1, "Running the Foreign Exchange Example" for details.

The sample Signal Generation domain is located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\signalgeneration_domain.

See Section 2.9.1, "Running the Signal Generation Example" for details.

The sample Record and Playback domain is located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\recplay_domain.

See Section 2.10.1, "Running the Event Record /Playback Example" for details.

2.1.2 Sample Source

The Java and configuration XML source for each sample is provided in a separate
source directory that describes a sample development environment.

2-2

The HelloWorld source directory is located in MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\helloworld, where MIDDLEWARE_HOME refers
to the Middleware directory you specified when you installed Oracle Event
Processing, such as d: \Oracle\Middleware.

See Section 2.5.4, "Implementation of the HelloWorld Example" for details.

The CQL source directory is located in MIDDLEWARE_HOME\ocep_
11.1\\samples\source\applications\cql.

See Section 2.6.4, "Implementation of the CQL Example" for details.
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s The Oracle Spatial source directory is located in MIDDLEWARE_HOME\ocep_
11.1\\samples\source\applications\spatial.

See Section 2.7.4, "Implementation of the Oracle Spatial Example" for details.

s The Foreign Exchange source directory is located in MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\fx.

See Section 2.8.4, "Implementation of the FX Example" for details.

= The Signal Generation source directory is located in MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\signalgeneration.

See Section 2.9.4, "Implementation of the Signal Generation Example" for details.

s The Record and Playback source directory is located in MIDDLEWARE_HOME\ocep_
11.1\\samples\source\applications\recplay.

See Section 2.10.4, "Implementation of the Record and Playback Example" for
details.

2.2 Installing the Default ocep_domain and Samples

To install all Oracle Event Processing components including the default ocep_domain
domain (with default passwords) and the samples, you must chose the Custom option
to also install the samples. The Typical option does not include the default ocep_
domain and samples.

If you previously installed Oracle Event Processing using the Typical option, and you
now want to also install the samples, re-run the Oracle Event Processing installation
process and specify the same Oracle Event Processing home directory; a later step in
the installation process allows you to then install just the samples.

2.3 Using Oracle Event Processing Visualizer With the Samples

The Oracle Event Processing Visualizer is a Web 2.0 application that consumes data
from Oracle Event Processing, displays it in a useful and intuitive way to system
administrators and operators, and, for specified tasks, accepts data that is then passed
back to Oracle Event Processing so as to change it configuration.

Visualizer is itself an Oracle Event Processing application and is automatically
deployed in each server instance. To use it with the samples, be sure you have started
the server (instructions provided for each sample below) and then invoke the
following URL in your browser:

http://host:9002/wlevs
where host refers to the name of the computer hosting Oracle Event Processing;; if it is
the same as the computer on which the browser is running you can use localhost.

Security is disabled for the HelloWorld application, so you can click Logon at the login
screen without entering a username and password. For the FX and signal generation
samples, however, security is enabled, so use the following to logon:

User Id: wlevs
Password: wlevs

For more information about Oracle Event Processing Visualizer, see Oracle Fusion
Middleware Visualizer User's Guide for Oracle Event Processing.
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2.4 Increasing the Performance of the Samples

To increase the throughput and latency when running the samples, and Oracle Event
Processing applications in general, Oracle recommends the following:

s Use the JRockit JDK included in Oracle JRockit Real Time and enable the
deterministic garbage collector by passing the -dgc parameter to the command
that starts the Oracle Event Processing instance for the appropriate domain:

prompt> startwlevs.cmd -dgc

By default the deterministic garbage collector is disabled for the samples.

For more information on Oracle JRockit Real Time, see
http://www.oracle.com/technology/products/jrockit/jrrt/index.
html.

= When running Oracle Event Processing on a computer with a larger amount of
memory, you should set the load generator and server heap sizes appropriately for
the size of the computer. On computers with sufficient memory, Oracle
recommend a heap size of 1 GB for the server and between 512MB - 1GB for the
load generator.

2.5 HelloWorld Example

The first example that shows how to create an Oracle Event Processing application is
the ubiquitous HelloWorld.

Figure 2-1 shows the HelloWorld example Event Processing Network (EPN). The EPN
contains the components that make up the application and how they fit together.

Figure 2—-1 The HelloWorld Example Event Processing Network
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The example includes the following components:

= helloworldAdapter—Component that generates Hello World messages every
second. In a real-world scenario, this component would typically read a stream of
data from a source, such as a data feed from a financial institution, and convert it
into a stream of events that the event processor can understand. The HelloWorld
application also includes a HelloWorldAdapterFactory that creates instances of
HelloWorldAdapter.

= helloworldInputChannel—Component that streams the events generated by the
adapter (in this case Hello World messages) to the event processor.

=  helloworldProcessor—Component that simply forwards the messages from the
helloworldAdapter component to the POJO that contains the business logic. In a
real-world scenario, this component would typically execute additional and
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possibly much more processing of the events from the stream, such as selecting a
subset of events based on a property value, grouping events, and so on using
Oracle CQL.

helloworldOutputChannel—Component that streams the events processed by the
event processor to the POJO that contains the user-defined business logic.

helloworldBean—POJO component that simply prints out a message every time it
receives a batch of messages from the processor via the output channel. In a
real-world scenario, this component would contain the business logic of the
application, such as running reports on the set of events from the processor,
sending appropriate emails or alerts, and so on.

2.5.1 Running the HelloWorld Example from the helloworld Domain

The HelloWorld application is pre-deployed to the helloworld domain. To run the
application, you simply start an instance of Oracle Event Processing server.

To run the HelloWorld example from the helloworld domain:

1.

Open a command window and change to the default server directory of the
helloworld domain directory, located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\helloworld_domain\defaultserver, where MIDDLEWARE_
HOME refers to the Middleware home directory you specified when you installed
Oracle Event Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\domains\helloworld_
domain\defaultserver

Ensure the environment is set correctly in the server startup script.

For more information, see Chapter 3, "Getting Started with Developing Oracle
Event Processing Applications"

Start Oracle Event Processing by executing the appropriate script with the correct
command line arguments:

a. On Windows:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.cmd -dgc

* If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.cmd

b. On UNIX:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.sh -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.sh

After server status messages scroll by, you should see the following message
printed to the output about every second:
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Message: HelloWorld - the current time is: 3:56:57 PM

This message indicates that the HelloWorld example is running correctly.

2.5.2 Building and Deploying the HelloWorld Example from the Source Directory

The HelloWorld sample source directory contains the Java source, along with other
required resources such as configuration XML files, that make up the HelloWorld
application. The build.xml Ant file contains targets to build and deploy the
application to the helloworld domain.

For more information, see Section 2.5.3, "Description of the Ant Targets to Build Hello
World".

To build and deploy the HelloWorld example from the source directory:

1.

If the helloworld Oracle Event Processing instance is not already running, follow
the procedure in Section 2.5.1, "Running the HelloWorld Example from the
helloworld Domain" to start the server.

You must have a running server to successfully deploy the rebuilt application.

Open a new command window and change to the HelloWorld source directory,
located in MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\helloworld where MIDDLEWARE_HOME is the
Middleware home directory you specified when you installed Oracle Event
Processing.

For example:

prompt> cd d:\Oracle\Middleware\ocep_
11.1\samples\source\applications\helloworld

Set your development environment as described in Section 3.2, "Setting Your
Development Environment."

Execute the all Ant target to compile and create the application JAR file:

prompt> ant all

Execute the deploy Ant target to deploy the application JAR file to Oracle Event
Processing;:

prompt> ant -Daction=update deploy

Caution: This target overwrites the existing helloworld application
JAR file in the domain directory.

You should see the following message printed to the output about every second:

Message: HelloWorld - the current time is: 3:56:57 PM

This message indicates that the HelloWorld example has been redeployed and is
running correctly.

2.5.3 Description of the Ant Targets to Build Hello World

The build.xmnl file, located in the top level of the HelloWorld source directory,
contains the following targets to build and deploy the application:
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s clean—This target removes the dist and output working directories under the
current directory.

s all—This target cleans, compiles, and JARs up the application into a file called
com.bea.wlevs.example.helloworld 11.1.1.4_0.jar, and places the generated
JAR file into a dist directory below the current directory.

s deploy—This target deploys the JAR file to Oracle Event Processing using the
Deployer utility.

For more information, see "Deployer Command-Line Reference" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing.

2.5.4 Implementation of the HelloWorld Example

The implementation of the HelloWorld example generally follows Section 3.1,
"Creating an Oracle Event Processing Application".

Refer to that section for a task-oriented procedure that describes the typical
development process.

The HelloWorld example, because it is relatively simple, does not use all the
components and configuration files described in the general procedure for creating an
Oracle Event Processing application.

All the example files are located relative to the MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\helloworld directory, where MIDDLEWARE_HOME
refers to the Middleware directory you specified when you installed Oracle Event
Processing c:\Oracle\Middleware. Oracle recommends that you use this example
directory setup in your own environment, although it is obviously not required.

The files used by the HelloWorld example include:

= An EPN assembly file that describes each component in the application and how
all the components are connected together. The EPN assembly file extends the
standard Spring context file. The file also registers the event types used in the
application. You are required to include this XML file in your Oracle Event
Processing application.

In the example, the file is called
com.bea.wlevs.example.helloworld-context.xml and is located in the
META-INF/spring directory.

= Java source file for the helloworldAdapter component.

In the example, the file is called HelloWorldAdapter. java and is located in the
src/com/bea/wlevs/adapter/example/helloworld directory.

For a detailed description of this file and how to program the adapter Java files in
general, see Chapter 15, "Integrating an External Component Using a Custom
Adapter".

= Java source file that describes the HelloWorldEvent event type.

In the example, the file is called HelloWorldEvent. java and is located in the
src/com/bea/wlevs/event/example/helloworld directory.

For a detailed description of this file, as well as general information about
programming event types, see Chapter 9, "Defining and Using Event Types".

= An XML file that configures the helloworldProcessor and
helloworldOutputChannel components. An important part of this file is the set of
EPL rules that select the set of events that the HelloWorld application processes.
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You are required to include a processor configuration file in your Oracle Event
Processing application, although the adapter and channel configuration is
optional.

In the example, the file is called config.xml and is located in the META-INF/wlevs
directory.

= AJava file that implements the helloworldBean component of the application, a
POJO that contains the business logic.

In the example, the file is called HelloWorldBean. java and is located in the
src/com/bea/wlevs/example/helloworld directory.

For a detailed description of this file, as well as general information about
programming event sinks, see Chapter 16, "Handling Events with Java".

= A MANIFEST.MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Event Processing.

In the example, the MANIFEST . MF file is located in the META-INF directory.

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Event Processing, see Section 23.1,
"Overview of Application Assembly and Deployment".

The HelloWorld example uses a build.xml Ant file to compile, assemble, and deploy

the OSGi bundle; see Section 2.5.2, "Building and Deploying the HelloWorld Example
from the Source Directory" for a description of this build.xml file if you also use Ant

in your development environment.

2.6 Oracle Continuous Query Language (Oracle CQL) Example

The Oracle CQL example shows how to use the Oracle Event Processing Visualizer
Query Wizard to construct various types of Oracle CQL queries.

Figure 2-2 shows the CQL example Event Processing Network (EPN). The EPN
contains the components that make up the application and how they fit together.

Figure 2-2 The CQL Example Event Processing Network
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The application contains three separate event paths in its EPN:

Missing events: this event path consists of an adapter orderCvVsAdapter connected
to a channel orderChannel. The orderChannel is connected to processor
orderProcessor which is connected to channel alertChannel which is connected
to adapter alertOutput.

This event path is used to detect missing events in a customer order workflow.

For more information on how to construct the query that the cqlProc processor
executes, see Section 2.6.4.1, "Creating the Missing Event Query".

Moving average: this event path consists of channel stockChannel connected to
processor stockProcessor which is connected to channel movingAvgChannel
which is connected to adapter movingOutput.

This event path is used to compute a moving average on stock whose volume is
greater than 1000.

For more information on how to construct the query that the cqlProc processor
executes, see Section 2.6.4.2, "Creating the Moving Average Query".

Cache: this event path consists of adapter adapter connected to channel S1
connected to Oracle CQL processor cacheProcessor connected to channel 52
connected to bean Bean. There is a cache stockCache also connected to the Oracle
CQL processor cacheProcessor. There is also a bean Loader.

This event path is used to access information from a cache in an Oracle CQL query.

Note: For more information about the various components in the
EPN, see the other samples in this book.

2.6.1 Running the CQL Example

For optimal demonstration purposes, Oracle recommends that you run this example
on a powerful computer, such as one with multiple CPUs or a 3 GHz dual-core Intel,
with a minimum of 2 GB of RAM.

The CQL application is pre-deployed to the cql_domain domain. To run the
application, you simply start an instance of Oracle Event Processing server.

To run the CQL example:

1.

Open a command window and change to the default server directory of the CQL
domain directory, located in MIDDLEWARE_HOME\ocep_11.1\samples\domains\cql_
domain\defaultserver, where MIDDLEWARE HOME refers to the Middleware
directory you specified when you installed Oracle Event Processing, such as
d:\Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\domains\cqgl_
domain\defaultserver

Set your development environment, as described in Chapter 3.2, "Setting Your
Development Environment"

Start Oracle Event Processing by executing the appropriate script with the correct
command line arguments:

a. On Windows:
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*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.cmd -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.cmd

b. On UNIX:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.sh -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.sh

The CQL application is now ready to receive data from the data feeds.

4. To simulate the data feed for the missing event query, open a new command
window and set your environment as described in Chapter 3, "Getting Started
with Developing Oracle Event Processing Applications”

5. Change to the MIDDLEWARE_HOME\ocep_11.1\utils\load-generator directory,
where MIDDLEWARE_HOME refers to the Middleware directory you specified when
you installed Oracle Event Processing, such as d: \Oracle\Middleware.

6. Run the load generator using the orderData.prop properties file:
a. On Windows:

prompt> runloadgen.cmd orderData.prop

b. On UNIX:
prompt> runloadgen.sh orderData.prop
7. To simulate the data feed for the moving average query, open a new command

window and set your environment as described in Chapter 3, "Getting Started
with Developing Oracle Event Processing Applications"

8. Change to the MIDDLEWARE_HOME\ocep_11.1\utils\load-generator directory,
where MIDDLEWARE_HOME refers to the Middleware directory you specified
when you installed Oracle Event Processing, such as d: \Oracle\Middleware.

9. Run the load generator using the stockData.prop properties file:
a. On Windows:

prompt> runloadgen.cmd stockData.prop

b. On UNIX:

prompt> runloadgen.sh stockData.prop

10. To simulate the data feed for the cache query, you only need to run the example.

The load data is generated by Adaptor. java and the cache data is generated by
Loader.java. You can verify that data is flowing through by turning on statistics
in the Oracle Event Processing Visualizer Query Plan.
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2.6.2 Building and Deploying the CQL Example

The CQL sample source directory contains the Java source, along with other required
resources such as configuration XML files, that make up the CQL application. The
build.xml Ant file contains targets to build and deploy the application to the cql_
domain domain, as described in Section 2.5.3, "Description of the Ant Targets to Build
Hello World."

To build and deploy the CQL example from the source directory:

1.

If the CQL Oracle Event Processing instance is not already running, follow the
procedure in Section 2.6.1, "Running the CQL Example" to start the server.

You must have a running server to successfully deploy the rebuilt application.

Open a new command window and change to the CQL source directory, located in
MIDDLEWARE_HOME\ocep_11.1\samples\source\applications\cql, where
MIDDLEWARE_HOME refers to the Middleware directory you specified when
you installed Oracle Event Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\source\applications\cql

Set your development environment, as described in Section 3.2, "Setting Your
Development Environment"

Execute the a1l Ant target to compile and create the application JAR file:

prompt> ant all

Execute the deploy Ant target to deploy the application JAR file to Oracle Event
Processing;:

prompt> ant -Dusername=wlevs -Dpassword=wlevs -Daction=update deploy

Caution: This target overwrites the existing CQL application JAR file
in the domain directory.

If the load generators required by the CQL application are not running, start them
as described in Section 2.6.1, "Running the CQL Example."

2.6.3 Description of the Ant Targets to Build the CQL Example

The build.xmnl file, located in the top-level directory of the CQL source, contains the
following targets to build and deploy the application:

clean—This target removes the dist and output working directories under the
current directory.

all—This target cleans, compiles, and jars up the application into a file called
com.bea.wlevs.example.cql_11.1.1.4_0.jar, and places the generated JAR file
into a dist directory below the current directory.

deploy—This target deploys the JAR file to Oracle Event Processing using the
Deployer utility.

For more information, see "Deployer Command-Line Reference" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing.
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2.6.4 Implementation of the CQL Example

This section describes how to create the queries that the CQL example uses, including;:
»  Section 2.6.4.1, "Creating the Missing Event Query"
= Section 2.6.4.2, "Creating the Moving Average Query"

2.6.4.1 Creating the Missing Event Query

This section describes how to use the Oracle Event Processing Visualizer Query
Wizard to create the Oracle CQL pattern matching query that the cqlProc processor
executes to detect missing events.

Consider a customer order workflow in which you have customer order workflow
events flowing into the Oracle Event Processing system.

In a valid scenario, you see events in the order that Table 2-1 lists:

Table 2-1 Valid Order Workflow

Event Type Description

C Customer order
A Approval

S Shipment

However, it is an error if an order is shipped without an approval event as Table 2-2
lists:

Table 2-2 Invalid Order Workflow

Event Type Description
C Customer order
S Shipment

You will create and test a query that detects the missing approval event and generates
an alert event:

»  "To create the missing event query:" on page 2-12

= "To test the missing event query:" on page 2-35

To create the missing event query:

1. If the CQL Oracle Event Processing instance is not already running, follow the
procedure in Section 2.6.1, "Running the CQL Example" to start the server.

You must have a running server to use the Oracle Event Processing Visualizer.
2. Invoke the following URL in your browser:

http://host:port/wlevs

where host refers to the name of the computer on which Oracle Event Processing is
running and port refers to the Jetty NetlO port configured for the server (default
value 9002).

The Logon screen appears as Figure 2-3 shows.
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Figure 2-3 Oracle Event Processing Visualizer Logon Screen
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3. Inthe Logon screen, enter the User Id wlevs and Password wlevs, and click Log
In.

The Oracle Event Processing Visualizer dashboard appears as Figure 2—4 shows.
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Figure 2-4 Oracle Event Processing Visualizer Dashboard
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For more information about the Oracle Event Processing Visualizer user interface,
see "Understanding the Oracle Event Processing Visualizer User Interface” in the
Oracle Fusion Middleware Visualizer User’s Guide for Oracle Event Processing.

4. In the right-hand pane, expand WLEventServerDomain > NonClusteredServer >

Applications.

5. Select the cql node.

The CQL application screen appears as Figure 2-5 shows.
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Figure 2-5 CQL Application Screen: General Tab
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6. Select the Event Processing Network tab.

The Event Processing Network screen appears as Figure 2—-6 shows.
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Figure 2-6 CQL Application: Event Processing Network Tab
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7. Double-click the orderProcessor Oracle CQL processor icon.

The Oracle CQL processor screen appears as Figure 2-7 shows.
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Figure 2-7 Oracle CQL Processor: General Tab
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8. Select the Query Wizard tab.

The Query Wizard screen appears as Figure 2-8 shows
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Figure 2-8 Oracle CQL Processor: Query Wizard Tab
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You can use the Oracle CQL Query Wizard to construct an Oracle CQL query from
a template or from individual Oracle CQL constructs.

In this procedure, you are going to create an Oracle CQL query from a template.

For more information, see "Creating a Rule in an Oracle CQL Processor Using the
Query Wizard" in the Oracle Fusion Middleware Visualizer User’s Guide for Oracle
Event Processing.

9. Click the Templates tab.
The Templates tab appears as Figure 2-9 shows.
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Figure 2-9 Template Tab
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10. Click and drag the Pattern Match Template from the Templates palette and drop it
anywhere in the Query Wizard canvas as shown in Figure 2-9.

11. Double-click the SSource icon.

The SSource configuration screen appears as Figure 2-10 shows.
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Figure 2-10 SSource Configuration Dialog
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14.
15.

The source of your query will be the orderChannel stream.
Configure the SSource as follows:

= Select Stream as the Type.

= Select orderChannel from the Select a source pull-down menu.
Click Save.

Click Save Query.

Double-click the Pattern icon.

The Pattern configuration screen appears as Figure 2-11 shows.
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Figure 2-11 Pattern Configuration Dialog: Pattern Tab
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Using the Pattern tab, you will define the pattern expression that matches when
missed events occur. The expression is made in terms of named conditions that
you will specify on the Define tab in a later step.

16. Enter the following expression in the Pattern Expression field:
CustOrder NoApproval*? Shipment
This pattern uses the Oracle CQL pattern quantifiers that Table 2-3 lists. Use the
pattern quantifiers to specify the allowed range of pattern matches. The
one-character pattern quantifiers are maximal or "greedy"; they will attempt to

match the biggest quantity first. The two-character pattern quantifiers are minimal
or "reluctant"; they will attempt to match the smallest quantity first.

Table 2-3 MATCH_RECOGNIZE Pattern Quantifiers

Maximal | Minimal | Description

* *? 0 or more times
+ +? 1 or more times.
? ?? 0 or 1 time.

For more information, see:

s "PATTERN Condition" in the Oracle Fusion Middleware CQL Language Reference
for Oracle Event Processing

s  "MATCH_RECOGNIZE Condition" in the Oracle Fusion Middleware CQL
Language Reference for Oracle Event Processing
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17. Select orderid from the Partition By pull-down menu and click the Plus Sign
button to add this property to the PARTITION BY clause.

This ensures that Oracle Event Processing evaluates the missing event query on
each order.

18. Enter Orders in the Alias field.

This assigns an alias (Orders) for the pattern to simplify its use later in the query.
19. Click the Define tab.

The Define tab appears as Figure 2-12 shows.

Figure 2-12 Pattern Configuration Dialog: Define Tab
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You will now define each of the conditions named in the pattern clause as
Table 2—4 lists:

Table 2-4 Condition Definitions

Condition Name Definition

CustOrder orderChannel .eventType = 'C’
NoApproval NOT (orderChannel .eventType = 'A’)
Shipment orderChannel .eventType = 'C’

20. Enter CustOrder in the Object Name field.

21. Click the Expression Builder button and configure the Expression Builder as
follows (see Figure 2-13):

= In the Variables list, double-click eventType.
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= In the Operands list, double-click =.

= After the = operand, enter the value 'C"’.

Figure 2-13 Expression Builder: CustOrder
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22, Click Save.
23. Click the Plus Sign button.

The condition definition is added to the Object List as Figure 2-14 shows.
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Figure 2-14 Pattern Configuration Dialog: Define Tab With CustOrder Condition
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24. Enter NoApproval in the Object Name field.

25. Click the Expression Builder button and configure the Expression Builder as
follows (see Figure 2-15):

= In the Variables list, double-click eventType.
= In the Operands list, double-click =.

= After the = operand, enter the value 'a’.

= Place parenthesis around the expression.

= Place the insertion bar at the beginning of the expression, outside the open
parenthesis.

= In the Operands list, double-click NOT.
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Figure 2-15 Expression Builder: NoApproval
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26.
27.

28.
29.

Click Save.

Click the Plus Sign button.

The condition definition is added to the Object List.
Enter Shipment in the Object Name field.

Click the Expression Builder button and configure the Expression Builder as
follows (see Figure 2-16):

= In the Variables list, double-click eventType.
= In the Operands list, double-click =.

= After the = operand, enter the value 'S’.
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Figure 2-16 Expression Builder: Shipment
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30. Click Save.
31. Click the Plus Sign button.
The Define tab appears as Figure 2-17 shows.
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Figure 2-17 Pattern Configuration Dialog: Define Tab Complete
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32. Click the Measure tab.
The Measure tab appears as Figure 2-18 shows.
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Figure 2-18 Measure Tab

o= Pattern Match [ID :2 ] x

[ Pattern I[Define H Subset " Measure |

Ohject Mame A5

Step 4 - Create measure ohjects

heasure List (click to select) b

Froperties (07

Generated Pattern Match Statement

a A

SELECT * FROM orderChannel MATCH_RECOGHNIZE { PARTITION BY arderid PATTERN{ CustOrder
MoApproval® Shipment) DEFINE CustOrder AS arderChannel eveniType = 'C', MoApproval AS
MoT{orderChannel eventType = 'A% | Shipment AS arderChannel eventType = "85 AS Orders

@ Help | o Validate | | E Save | | @ Cancel

33.
34.

Use the Measure tab to define expressions in a MATCH_RECOGNIZE condition and to
bind stream elements that match conditions in the DEFINE clause to arguments that
you can include in the select statement of a query.

Use the Measure tab to specify the following:
m CustOrder.orderid AS orderid

m CustOrder.amount AS amount

For more information, see:

= "MEASURES Clause" in the Oracle Fusion Middleware CQL Language Reference
for Oracle Event Processing

s  "MATCH_RECOGNIZE Condition" in the Oracle Fusion Middleware CQL
Language Reference for Oracle Event Processing

Enter orderid in the Object Name field.

Click the Expression Builder button and configure the Expression Builder as
follows (see Figure 2-19):

s In the Variables list, double-click CustOrder.orderid.
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Figure 2-19 Expression Builder: orderid

g Bﬁem ﬁatcﬂ i HB :E | =
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1

CustOrder.amount  javalang. Lo ® |

CustOrderts jawva.lang.String I

CustOrderewentType  java.lang

1

G  CustOrderorderid  java.lang.Str

Shipment.amount  java.lang.L
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Shipment.ewentType javalang ™ = bt

Function Description

@ Help | E Save | | @Cancel |

35.
36.
37.
38.

Click Save.
Click the Plus Sign button.
Enter amount in the Object Name field.

Click the Expression Builder button and configure the Expression Builder as
follows (see Figure 2-20):

s In the Variables list, double-click CustOrder.amount.
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Figure 2-20 Expression Builder: amount

Expression Builder

CustOrder.armount
Variables Functions Operands
v | | Select a function type v + lisy
Properties (12) | Functians - =
E» CustOrderamount java.lang.Lo ™ | - -
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=
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Function Description

—

39. Click Save.
40. Click the Plus Sign button.

| B save || @ cancel |

The Measure tab appears as Figure 2-21 shows.
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Figure 2-21 Measure Tab: Complete

e emn i

Measure

Step 4 - Create measure ohjects

Object Narme A E8 +
heasure List (click to select) b
Froperies (23

orderid  CustOrderorderid

amount CustOrder.amount

Generated Pattern Match Statement

SELECT * FROM orderChannel MATCH_RECOGHIZE { PARTITION BY orderid MEASURES
CustOrder.orderid AS orderid, CustOrder amount AS amount PATTERMN{ CustOrder MoApproval®?
Shipment) DEFINE CustOrder AS orderChannel eventType = 'C' NoApproval AS
MOT(orderChannel eventType = 'A%, Shipment AS orderChannel eventType = '579 AS Orders

@ Help o Validate | | E Save | | @Cancel |

41. Click Save.
42. Double-click the Select icon.

The Select configuration screen appears as Figure 2-22 shows.

Oracle Event Processing Samples 2-31



Oracle Continuous Query Language (Oracle CQL) Example

Figure 2-22 Select Configuration Dialog: Project Tab

\@ Select[ID:3] x

|P|oiect || Group || Candition || Order |

Step 1- Project

|:| Distinct Results Target Event Type  Select or Input Event Type I;I
Source Propetties (select frorm here) Source Propetties ~
| Select a source Tl Select List (0]
Froperies {00
Froject Expression ¥ +
i s
Generated CQL Statement
SELECT * FROM orderChannel MATCH_RECOGNIZE { PARTITICN BY arderid MEASURES CustOrder. orderid AS
orderid, CustOrder.amount AS amount PATTERM{ CustOrder MoAppraval®™? Shipment) DEFINE CustOrder AS
arderChannel eventType = 'C' MoApproval AS MOT(orderChannel eventType = A%, Shipment AS
arderChannel eventType = '8% AS Orders
() Help | g Yalidate | | H save | | ) cancel |

43. Configure the Project tab as follows:
= Select AlertEvent from the Select or Input Event Type pull-down menu.
= Select Orders from the Select a source pull-down menu.

44. Double-click orderid in the Properties list and select orderid from the Select or
Input Alias pull-down menu.

45. Click the Plus Sign button to add the property to the Generated CQL Statement.

46. Double-click amount in the Properties list and select amount from the Select or
Input Alias pull-down menu.

47. Click the Plus Sign button to add the property to the Generated CQL Statement.

48. Click in the Project Expression field and enter the value "Error - Missing
Approval" and select alertType from the Select or Input Alias pull-down menu.

49. Click the Plus Sign button to add the property to the Generated CQL Statement.
The Project tab appears as Figure 2-23 shows.
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Figure 2-23 Select Configuration Dialog: Project Tab Complete

W

Step 1- Project

[ Distinct Results

Target Event Tvpe  AlertBEvent

i
Source Propetties (select frorm here) Source Propetties M
Orders v | Select List(3)
Froperies (2) Orders.orderid
Orders.amount
orderid  CustOrderorderid
"Errar - Missing Ewant"
amount CustOrder.amount

Froject Expression

AR

Generated CQL Statement

SELECT Qrders.orderid AS orderid Orders amount AS amoaount,"Errar - Missing Event' AS alerdType FROM arderChannel
MATCH_RECOGHIZE { PARTITION BY arderid MEASURES CustOrder.orderid AS orderid, CustOrder amount AS
amount PATTERM{ CustOrder MoApproval™ Shipment) DEFIME CustOrder AS arderChannel eventTwpe = 'C
MoApproval AS NOT(orderChannel eventType = 'A%, Shipment AS orderChannel eveniType = '57 AS Orders

@ Help

| ¢ Yalidate | | B save | | @-Cancel |

50. Click Save.
51. Click Save Query.
52. Double-click the Output icon.

The Output configuration screen appears as Figure 2-24 shows.
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Figure 2-24 Output Configuration Dialog

7] output [ID: 41

Type  («) Guery
Query Name  Tracking
Enable (a) true () false
O Wiew
Yiew Mame

Wiew Schema

Froject List

Froperies (3

1 Orders.orderid:orderid

2 Orderz.amaunt:amount

2 "Ermor- Missing Ewent':aledType

Generated CQAL Statement

SELECT Orders. orderid AS arderid Orders. amount AS amaount "Errar - Missing Event' AS alertType
FROM orderChannel MATCH_RECOGNIZE ( PARTITION BY orderid MEASURES
CustOrder.orderid AS orderid, CustOrder.amount AS armount PATTERMN{ CustOrder MoApproval®?
Shipment) DEFINE CustOrder AS orderChannel eventType = 'C' NoApproval AS
MOT(orderChannel eventType = 'A%, Shipment AS orderChannel eventType = '579 AS Orders

| (@ Help | | [iE Inject Rule | | & Replace Rule | | f Validate | | B save | | @ cancel |

53.

Configure the Output as follows:
= Select Query.
= Enter Tracking as the Query Name.

54, Click Inject Rule.

The Inject Rule Confirmation dialog appears as Figure 2-25 shows.

Figure 2-25 Inject Rule Confirmation Dialog

m

55.

56.
57.

58.

Click OK.

The Query Wizard adds the rule to the cqlProc processor.
Click Save.

Click on the CQL Rules tab.

The CQL Rules tab appears as Figure 2-26 shows.

Click on the Query radio button.

Confirm that your Tracking query is present.
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Figure 2-26 CQL Rules Tab With Tracking Query

r
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To test the missing event query:

1.

To simulate the data feed for the missing event query, open a new command
window and set your environment as described in Chapter 3, "Getting Started
with Developing Oracle Event Processing Applications"

Change to the MIDDLEWARE_HOME\ocep_11.1\utils\load-generator directory,
where MIDDLEWARE_HOME refers to the Middleware directory created when
you installed Oracle Event Processing, such as d: \Oracle\Middleware.

Run the load generator using the orderData.prop properties file:
a. On Windows:

prompt> runloadgen.cmd orderData.prop

b. On UNIX:

prompt> runloadgen.sh orderData.prop

In the Oracle Event Processing Visualizer, click the ViewStream button in the top
pane.

The Stream Visualizer screen appears as Figure 2-27 shows.
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Figure 2-27 Stream Visualizer: Showing Missing Events
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As missing events are detected, the Oracle Event Processing updates the Received
Messages area showing the AlertEvents generated.

2.6.4.2 Creating the Moving Average Query

This section describes how to use the Oracle Event Processing Visualizer Query
Wizard to create the Oracle CQL moving average query that the stockProc processor
executes.

You do this in two steps:

First, you create a view (the Oracle CQL equivalent of a subquery) that serves as

the source of the moving average query.

See "To create a view source for the moving average query:" on page 2-37.

Second, you create the moving average query using the source view.

See "To create the moving average query using the view source:" on page 2-51.

Finally, you test the moving average query.
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See "To test the moving average query:" on page 2-70.

To create a view source for the moving average query:

1. If the CQL Oracle Event Processing instance is not already running, follow the
procedure in Section 2.6.1, "Running the CQL Example" to start the server.

You must have a running server to use the Oracle Event Processing Visualizer.
2. Invoke the following URL in your browser:

http://host:port/wlevs

where host refers to the name of the computer on which Oracle Event Processing is
running and port refers to the Jetty NetIO port configured for the server (default
value 9002).

The Logon screen appears as Figure 2-28 shows.

Figure 2-28 Oracle Event Processing Visualizer Logon Screen

) Oracle Complex Event Processing Visualizer - Mozilla Firefox

File Edit View History Bookmarks Tools  Help

' c A O I: |j Ehttp:,l’,l’localhost:QDDZIwIevs,l’

|j Oracle Complex Event Processing...ﬂ -

CORACLE CEP Yisualizer

Welcome

UserId |

Password

Log In

£5 CHNEr TAME S My B2 e MAarks af F20r Bapecive mwiess

I Dione I

3. Inthe Logon screen, enter the User Id wlevs and Password wlevs, and click Log
In.

The Oracle Event Processing Visualizer dashboard appears as Figure 2-29 shows.
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Figure 2-29 Oracle Event Processing Visualizer Dashboard
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For more information about the Oracle Event Processing Visualizer user interface,
see "Understanding the Oracle Event Processing Visualizer User Interface” in the
Oracle Fusion Middleware Visualizer User’s Guide for Oracle Event Processing.

4. In the right-hand pane, expand WLEventServerDomain > NonClusteredServer >

Applications.

5. Select the cql node.

The CQL application screen appears as Figure 2-30 shows.
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Figure 2-30 CQL Application Screen: General Tab
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6. Select the Event Processing Network tab.

The Event Processing Network screen appears as Figure 2-31 shows.

Figure 2-31 CQL Application: Event Processing Network Tab
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7. Double-click the stockProcessor Oracle CQL processor icon.

The Oracle CQL processor screen appears as Figure 2-32 shows.
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Figure 2-32 Oracle CQL Processor: General Tab

& Processor: stockProcessor - cql@NonClusteredServer (= =l [ [ =)

Processor Properties
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8. Select the Query Wizard tab.
The Query Wizard screen appears as Figure 2-33 shows.

Figure 2-33 Oracle CQL Processor: Query Wizard Tab
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You can use the Oracle CQL Query Wizard to construct an Oracle CQL query from
a template or from individual Oracle CQL constructs.
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In this procedure, you are going to create an Oracle CQL view and query from
individual Oracle CQL constructs.

For more information, see "Creating a Rule in an Oracle CQL Processor Using the
Query Wizard" in the Oracle Fusion Middleware Visualizer User’s Guide for Oracle
Event Processing.

9. Click and drag an SSource icon (Stream Source) from the CQL Constructs palette
and drop it anywhere in the Query Wizard canvas as Figure 2-34 shows.

Figure 2-34 Query Wizard: SSource
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10. Double-click the SSource icon.
The SSource configuration screen appears.

The source of your view will be the stockChannel stream. You want to select stock
events from this stream where the volume is greater than 1000. This will be the
source for your moving average query.

11. Configure the SSource as follows (as shown in Figure 2-35):
= Select Stream as the Type.
The source of your view is the stockChannel stream.
= Select stockChannel from the Select a source pull-down menu.

s Enter the alias StockVolGt1000 in the AS field.
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Figure 2-35 SSource Configuration Dialog

S —
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12. Click Save.
13. Click Save Query.
14. When prompted, enter StockVolGt1000 in the Query Id field.
15. Click Save.
Next, you will add an Oracle CQL filter.

16. Click and drag a Filter icon from the CQL Constructs palette and drop it anywhere
in the Query Wizard canvas as Figure 2-36 shows.
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Figure 2-36 Query Wizard: Filter
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17. Click on the SSource icon and drag to the Window icon to connect the Oracle CQL
constructs as Figure 2-37 shows.

Figure 2-37 Connecting the SSource and Filter Icons

m 135 oree 2Filter

18. Double-click the Filter icon.

The Filter configuration screen appears as Figure 2-38 shows.
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Figure 2-38 Filter Configuration Dialog
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19. Click the Expression Builder button.
The Expression Builder dialog appears.
20. Configure the Expression Builder as follows (as shown in Figure 2-39):

= Select StockVolGt100 from the Select an Event Type pull-down menu to
define the variables you can use in this expression.

= Double-click the volume variable to add it to the Expression Builder field.
= Double-click > in the Operands list to add it to the Expression Builder field.
= Enter the value 1000 after the > operand.
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Figure 2-39 Filter Expression Builder
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21. Click Save.
22. Click Add Filter.

The Query Wizard adds the expression to the Generated CQL Statement as
Figure 2-40 shows.
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Figure 2—40 Filter Configuration Dialog: After Adding the Filter
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23. Click Save.
24. Click Save Query.
Next you want to add a select statement.

25. Click and drag a Select icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as Figure 2—41 shows.
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Figure 2-41 Query Wizard: Select
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26. Click on the Filter icon and drag to the Select icon to connect the Oracle CQL
constructs.

27. Double-click the Select icon.

The Select configuration screen appears.

You want to select price, symbol, and volume from your StockVolGt1000 stream.
28. Configure the Select as follows:

= Select StockVolGt1000 from the Select a source pull-down menu.

»  Select the price property and click the Plus Sign button.

The Query Wizard adds the property to Generated CQL Statement
= Repeat for the symbol and volume properties.

The Select configuration dialog appears as Figure 2-42 shows.
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Figure 2-42 Select Configuration Dialog: Properties Selected
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29. Click Save.
30. Click Save Query.

Finally, you will add an Output.
31. Click and drag an Output icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as Figure 2—43 shows.
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Figure 2-43 Query Wizard: Output
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32. Click on the Select icon and drag to the Output icon to connect the Oracle CQL
constructs.

33. Double-click the Output icon.
The Output configuration screen appears.
34. Configure the Output as follows (as shown in Figure 2—44):
= Select View.
s Configure View Name as StockvolGt1000.
= Delete the contents of the View Schema field.

You can let the Oracle Event Processing server define the view schema for you.
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Figure 2-44 Output Configuration Dialog
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35. Click Inject Rule.

The Inject Rule Confirmation dialog appears as Figure 2—45 shows.

Figure 2—45 Inject Rule Confirmation Dialog

36. Click OK.

The Query Wizard adds the rule to the cglProc processor.
37. Click Save.
38. Click on the CQL Rules tab.

The CQL Rules tab appears as Figure 2-46 shows.
39. Click on the View radio button.

Confirm that your StockVolGt1000 view is present.
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Figure 2-46 CQL Rules Tab With View StockVolGt1000
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To create the moving average query using the view source:

1. If the CQL Oracle Event Processing instance is not already running, follow the
procedure in Section 2.6.1, "Running the CQL Example" to start the server.

You must have a running server to use the Oracle Event Processing Visualizer.
2. Invoke the following URL in your browser:

http://host:port/wlevs

where host refers to the name of the computer on which Oracle Event Processing is
running and port refers to the Jetty NetlO port configured for the server (default
value 9002).

The Logon screen appears as Figure 2-47 shows.
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Figure 2—47 Oracle Event Processing Visualizer Logon Screen
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3. In the Logon screen, enter the User Id wlevs and Password wlevs, and click Log
In.

The Oracle Event Processing Visualizer dashboard appears as Figure 2-48 shows.
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Figure 2-48 Oracle Event Processing Visualizer Dashboard
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For more information about the Oracle Event Processing Visualizer user interface,
see "Understanding the Oracle Event Processing Visualizer User Interface” in the
Oracle Fusion Middleware Visualizer User’s Guide for Oracle Event Processing.

4. In the left-hand pane, expand WLEventServerDomain > NonClusteredServer >
Applications.

5. Select the cql node.

The CQL application screen appears as Figure 2—49 shows.
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Figure 2-49 CQL Application Screen: General Tab
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6. Select the Event Processing Network tab.
The Event Processing Network screen appears as Figure 2-50 shows.

Figure 2-50 CQL Application: Event Processing Network Tab
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7. Double-click the stockProcessor Oracle CQL processor icon.

The Oracle CQL processor screen appears as Figure 2-51 shows.
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Figure 2-51 Oracle CQL Processor: General Tab
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8. Select the Query Wizard tab.

The Query Wizard screen appears as Figure 2-52 shows. If you have been recently
creating or editing queries for this processor, you might see those queries on the
Query Wizard canvas. Otherwise, the canvas will be blank.

Figure 2-52 Oracle CQL Processor: Query Wizard Tab
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You can use the Oracle CQL Query Wizard to construct an Oracle CQL query from
a template or from individual Oracle CQL constructs.

In this procedure, you are going to create an Oracle CQL view and query from
individual Oracle CQL constructs.
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For more information, see "Creating a Rule in an Oracle CQL Processor Using the
Query Wizard" in the Oracle Fusion Middleware Visualizer User’s Guide for Oracle
Event Processing.

9. Click and drag an SSource icon (Stream Source) from the CQL Constructs palette
and drop it anywhere in the Query Wizard canvas as Figure 2-53 shows.

Figure 2-53 Query Wizard: SSource for Moving Average Query
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10. Double-click the SSource icon.
The SSource configuration screen appears.

11. Configure the SSource dialog as follows (as shown in Figure 2-54):
= Select View as the Type.

= Select the StockVolGt1000 view from the Select a source pull-down menu.

2-56 Developer's Guide for Oracle Event Processing



Oracle Continuous Query Language (Oracle CQL) Example

Figure 2-54 SSource Configuration Dialog: Moving Average Query
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12. Click Save.
13. Click Save Query.

14. Click and drag a Window icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as Figure 2-55 shows.
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Figure 2-55 Query Wizard: Window for Moving Average Query
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2-58 Developer's Gu

Click on the SSource icon and drag to the Window icon to connect the Oracle CQL
constructs.

Double-click the Window icon.

The SSource configuration screen appears.

You want to create a sliding window over the last 2 events, partitioned by symbol.
Configure the Window dialog as follows (as shown in Figure 2-56):

= Select symbol in the Source Property List to add it to the Partition List.

= Select Partition as the Type.

»  Select Row Based and enter 2 in the Row Based field.

Click Add Window.

The Query Wizard adds the sliding window to the Generated CQL Statement as
Figure 2-56 shows.

ide for Oracle Event Processing
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Figure 2-56 Window Configuration Dialog: After Adding Window
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20. Click Save Query.
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21. Click and drag a Select icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as Figure 2-57 shows.
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Figure 2-57 Query Wizard: Select for Moving Average Query
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26.

Click on the Window icon and drag to the Select icon to connect the Oracle CQL
constructs.

Double-click the Select icon.
The Select configuration screen appears.
Select StockVolGt1000 from the Select a source pull-down menu.

This is the source of moving average query: the view you created earlier (see "To
create a view source for the moving average query:" on page 2-37).

Select MovingAvgEvent from the Target Event Type pull-down menu.

This is the output event your moving average query will produced. You will map
properties from the source events to this output event.

In the Source Properties list, select symbol.

The selected source property is added to the Project Expression as Figure 2-58
shows.

2-60 Developer's Guide for Oracle Event Processing




Oracle Continuous Query Language (Oracle CQL) Example

Figure 2-58 Select Configuration Dialog: Source Property symbol Selected
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In this case, you just want to map the source property symbol to output event

property symbol as is.

27. Click on the pull-down menu next to the AS field and select symbol.

28. Click the Plus Sign button.

The source property is added to the project expression of the Generated CQL

Statement as Figure 2-59 shows.
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Figure 2-59 Select Configuration Dialog: Source Property symbol Mapped to Output
Event Property
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29. In the Source Properties list, select price.
The selected source property is added to the Project Expression as Figure 2-60
shows.
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Figure 2-60 Select Configuration Dialog: Source Property price Selected
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In this case, you want to process the source property price before you map it to
the output event.

30. Click the Expression Builder button.
The Expression Builder dialog appears.
31. Select Aggregate Function from the Select a function type pull-down menu.

A list of the aggregate functions that Oracle CQL provides is displayed. You are
going to use the AVG function.

32. Select the StockVolGt1000.price in the Expression Builder field.
33. Double-click the AVG function.

The AvVG () function is wrapped around your selection in the Expression Builder
field as Figure 2-61 shows.
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Figure 2-61 Expression Builder: Applying the AVG Function
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34. Click Save.

The expression is added to the Project Expression field as Figure 2-62 shows.

2-64 Developer's Guide for Oracle Event Processing



Oracle Continuous Query Language (Oracle CQL) Example

Figure 2-62 Select Configuration Dialog: With Expression
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35. Click on the pull-down menu next to the AS field and select movingAvgPrice.

36. Click the plus Sign button.

The source property is added to the project expression of the Generated CQL
Statement as Figure 2-63 shows.

Oracle Event Processing Samples 2-65



Oracle Continuous Query Language (Oracle CQL) Example

Figure 2-63 Select Configuration Dialog: Source Property price Mapped to Output Event
Property
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37. Click Validate.

A validation error dialog is shown as Figure 2-64 shows.

Figure 2-64 Validation Error: GROUP BY

Because you are partitioning, you must specify a GROUP BY clause.
38. Select the Group tab.

The Group tab appears.
39. Configure the Group tab as follows (as shown in Figure 2-65):
n  Select StockVolGt1000 from the Select a source pull-down menu.
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= Select symbol from the Properties list.
s Click the Plus Sign button.
The symbol property is added to GROUP BY clause as Figure 2-65 shows.

Figure 2-65 Group Tab: With symbol Grouping Property
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40. Click Save.
41. Click Save Query.
Next, you want to connect the query to an output.

42. Click and drag an Output icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as Figure 2—-66 shows.
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Figure 2-66 Query Wizard: Output
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43. Click on the Select icon and drag to the Output icon to connect the Oracle CQL
constructs.

44. Double-click the Output icon.
The Output configuration screen appears.

45. Configure the Output as follows (as shown in Figure 2-67):
= Select Query.
= Enter MovingAverage as the Query Name.
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Figure 2-67 Output Configuration Dialog
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46. Click Inject Rule.

The Inject Rule Confirmation dialog appears as Figure 2-68 shows.

Figure 2-68 Inject Rule Confirmation Dialog

P ———

Rule has been s Iy added.

47. Click OK.
The Query Wizard adds the rule to the cglProc processor.
48. Click Save.
49. Click on the CQL Rules tab.
The CQL Rules tab appears as Figure 2-69 shows.
50. Click on the Query radio button.

Confirm that your MovingAverage query is present.
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Figure 2-69 CQL Rules Tab With View MovingAverage
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To test the moving average query:

1. To simulate the data feed for the moving average query, open a new command
window and set your environment as described in Section 3.2, "Setting Your
Development Environment."

2. Change to the MIDDLEWARE_HOME\ocep_11.1\utils\load-generator directory,
where MIDDLEWARE_HOME refers to the Middleware directory you specified when
you installed Oracle Event Processing, such as d:\Oracle\Middleware.

3. Run the load generator using the stockData.prop properties file:
a. On Windows:

prompt> runloadgen.cmd stockData.prop

b. On UNIX:

prompt> runloadgen.sh stockData.prop

4. In the Oracle Event Processing Visualizer, click the ViewStream button in the top
pane.

The Stream Visualizer screen appears as Figure 2-70 shows.
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Figure 2-70 Stream Visualizer: Showing Moving Average Query Output
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6. Enter /stockmoving in the Initialize client field.

7. Click Subscribe.

As the moving average query outputs events, the Oracle Event Processing updates
the Received Messages area showing the events generated.

2.7 Oracle Spatial Example

This example shows how to use Oracle Spatial with Oracle CQL queries to process a
stream of Global Positioning System (GPS) events to track the GPS location of buses
and generate alerts when a bus arrives at its pre-determined bus stop positions.

Figure 2-71 shows Oracle Spatial example Event Processing Network (EPN). The EPN
contains the components that make up the application and how they fit together.
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Figure 2-71 Oracle Spatial Example Event Processing Network
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The example includes the following components:

BusPositionGen—Component that simulates an input stream of bus position GPS
events. It uses the Oracle Event Processing loadgen utility and csvgen adapter
provider to read in comma separated values (CSV) and deliver them to the EPN as
BusPos events.

BusStopAdapter—Custom adapter component that generates bus stop positions
based on MIDDLEWARE HOME\ocep_11.1\samples\domains\spatial_
domain\defaultserver\applications\spatial_sample\bus_stops.csv, where
MIDDLEWARE_HOME refers to the Middleware directory you specified when you
installed Oracle Event Processing, such as d: \Oracle\Middleware.

BusPosStream—Component that transmits BusPos events to the Processor as a
stream.

BusStopRelation—Component that transmits BusPos events to the Processor as a
relation.

Processor—Component that executes Oracle CQL queries on the incoming
BusPos events.

BusStopChannel, BusPosChannel, and BusStopArrivalChannel—Components that
each specify a different selector to transmit the results of a different query from the
Processor component to the appropriate outbound adapter or output bean.

BusStopPub, BusPosPub, and BusStopArrival Pub—Components that publish the
results of the Processor component’s queries.

BusStopArrivalOutputBean—POJO event bean component that logs a message for
each insert, delete, and update event to help visualize the relation offered by the
BusStopArrivalChannel.

Note: For more information about data cartridges, see:

= "Introduction to Data Cartridges" in the Oracle Fusion Middleware
CQL Language Reference for Oracle Event Processing

= "Oracle Spatial" in the Oracle Fusion Middleware CQL Language
Reference for Oracle Event Processing

2.7.1 Running the Oracle Spatial Example

The Oracle Spatial application is pre-deployed to the spatial_domain domain. To run
the application, you simply start an instance of Oracle Event Processing server.
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To run the Oracle Spatial example from the spatial_domain domain:

1.

Open a command window and change to the default server directory of the Oracle
Spatial example domain directory, located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\spatial_domain\defaultserver, where MIDDLEWARE_HOME
refers to the Middleware directory you specified when you installed Oracle Event
Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle iddleware\ocep_11.1\samples\domains\spatial
domain\defaultserver

Ensure the environment is set correctly in the server startup script.

For more information, see Chapter 3, "Getting Started with Developing Oracle
Event Processing Applications"

Start Oracle Event Processing by executing the appropriate script with the correct
command line arguments:

a. On Windows:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.cmd -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.cmd

b. On UNIX:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.sh -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.sh

Wait for the console log to show:

<Mar 4, 2010 2:13:15 PM EST> <Notice> <Spring> <BEA-2047000> <The application
context for "spatial_sample" was started successfully>
<Mar 4, 2010 2:13:15 PM EST> <Notice> <Server> <BEA-2046000> <Server STARTED>

This message indicates that the Oracle Spatial example is running correctly.

On the same host as the Oracle Spatial example is running, launch a browser and
navigate to http:/ /localhost:9002 /bus/main.html.

Note: You cannot run this example on one host and browse to it from
another host. This is a limitation of the Google API Key that the
example uses and is not a limitation of Oracle Event Processing.

The Oracle Spatial example Web page appears as Figure 2-72 shows.
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Figure 2-72 Oracle Spatial Web Page
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Click the Bus Top Arrivals tab to view bus stop arrivals as Figure 2-73 shows.
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Figure 2-73 Oracle Spatial Web Page: Bus Stop Arrivals Tab
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5. Execute the Oracle Event Processing load generator to generate sample data:

a. On Windows:

*  Open a command prompt and navigate to MIDDLEWARE_HOME/ocep_
11.1/utils/load-generator
* runloadgen.cmd bus_positions.prop
b. On UNIX:
*  Open a terminal window and navigate to MIDDLEWARE_HOME/ocep_
11.1/utils/load-generator
¥

runloadgen.sh bus_positions.prop

6. Observe the bus movements and alerts in the browser as Figure 2-74 shows.

Oracle Event Processing Samples 2-75



Oracle Spatial Example

Figure 2-74 Oracle Spatial Web Page: Bus Tracking
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2.7.2 Building and Deploying the Oracle Spatial Example

The

Oracle Spatial sample source directory contains the Java source, along with other

required resources such as configuration XML files, that make up the Oracle Spatial
application. The build.xml Ant file contains targets to build and deploy the
application to the spatial_domain domain.

For more information, see Section 2.5.3, "Description of the Ant Targets to Build Hello
World".

To build and deploy the Oracle Spatial example from the source directory:

1.

If the spatial_domain Oracle Event Processing instance is not already running,
follow the procedure in Section 2.7.1, "Running the Oracle Spatial Example" to

start the server.
You must have a running server to successfully deploy the rebuilt application.

Open a new command window and change to the Oracle Spatial source directory,
located in MIDDLEWARE_HOME\ocep_11.1\samples\source\applications\spatial
where MIDDLEWARE_HOME is the Middleware directory you specified when you
installed Oracle Event Processing.

For example:

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\source\applications\spatial

Set your development environment as described in Section 3.2, "Setting Your
Development Environment."
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4. Execute the all Ant target to compile and create the application JAR file:

prompt> ant all

5. Execute the deploy Ant target to deploy the application JAR file to Oracle Event
Processing;:

prompt> ant -Daction=update deploy

Caution: This target overwrites the existing Oracle Spatial
application JAR file in the domain directory.

2.7.3 Description of the Ant Targets to Build the Oracle Spatial Example

The build.xmnl file, located in the top level of the Oracle Spatial source directory,
contains the following targets to build and deploy the application:

= clean—This target removes the dist and output working directories under the
current directory.

s all—This target cleans, compiles, and JARs up the application into a file called
com.bea.wlevs.example.helloworld 11.1.1.4_0.jar, and places the generated
JAR file into a dist directory below the current directory.

s deploy—This target deploys the JAR file to Oracle Event Processing using the
Deployer utility.

For more information, see "Deployer Command-Line Reference" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing.

2.7.4 Implementation of the Oracle Spatial Example

The implementation of the Oracle Spatial example generally follows "Creating Oracle
Event Processing Applications: Typical Steps" in the Oracle Fusion Middleware
Developer’s Guide for Oracle Event Processing for Eclipse.

Refer to that section for a task-oriented procedure that describes the typical
development process.

All the files of the Oracle Spatial example are located relative to the MIDDLEWARE_
HOME\ocep_11.1\samples\source\applications\spatial directory, where
MIDDLEWARE_HOME refers to the Middleware directory you specified when you installed
Oracle Event Processing, such as c: \Oracle\Middleware. Oracle recommends that you
use this example directory setup in your own environment, although it is obviously
not required.

The files used by the Oracle Spatial example include:

= An EPN assembly file that describes each component in the application and how
all the components are connected together. You are required to include this XML
file in your Oracle Event Processing application.

In the example, the file is called context.xml and is located in the
META-INF/spring directory.

= A component configuration file that configures the various components on the
EPN including the processor component of the application:

In the example, this file is called config.xml and is located in the META-INF/wlevs
directory.
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= Java files that implement:

— BusStopAdapter: Custom adapter component that generates bus stop
positions based on MIDDLEWARE_HOME\ocep_11.1\samples\domains\spatial_
domain\defaultserver\applications\spatial_sample\bus_stops.csv,
where MIDDLEWARE_HOME refers to the Middleware directory you specified
when you installed Oracle Event Processing, such as d: \Oracle\Middleware.

- OutputBean: POJO event bean component that logs a message for each insert,
delete, and update event to help visualize the relation offered by the
BusStopArrivalChannel

— OrdsHelper: Helper class that provides method getOrds to return the
ordinates from a JGeometry as a List of Double values.

These Java files are located in the
source\applications\spatial\src\com\oracle\cep\sample\spatial directory.

For additional information about the Oracle Event Processing APIs referenced in
this POJO, see Oracle Fusion Middleware Java API Reference for Oracle Event
Processing.

s A MANIFEST.MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Event Processing.

In the example, the MANIFEST . MF file is located in the META-INF directory.

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Event Processing, see Section 23.1,
"Overview of Application Assembly and Deployment".

The Oracle Spatial example uses a build.xml Ant file to compile, assemble, and
deploy the OSGi bundle; see Section 2.7.2, "Building and Deploying the Oracle
Spatial Example" for a description of this build.xml file if you also use Ant in your
development environment.

2.8 Foreign Exchange (FX) Example

The foreign exchange example, called FX for simplicity, is a more complex example
than the HelloWorld example because it includes multiple processors that handle
information from multiple data feeds. In the example, the data feeds are simulated
using the Oracle Event Processing load generator utility.

Figure 2-75 shows the FX example Event Processing Network (EPN). The EPN
contains the components that make up the application and how they fit together.
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Figure 2-75 FX Example Event Processing Network
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In this scenario, three data feeds, simulated using the load generator, send a constant
pair of values from different parts of the world; the value pairs consist of a currency
pair, such as USDEUR for US dollar - European euro, and an exchange rate between
the two currencies. The fxMarketAmer, fxMarketAsia, and fxMarketEuro adapters
receive the data from the feeds, convert them into events, and pass them to the
corresponding FilterAmer, FilterAsia, and FilterEuro processors. Each processor
performs an initial stale check to ensure that no event is more than 1 second old and
then a boundary check to ensure that the exchange rate between the two currencies is
within a current boundary. The processor also only selects a specific currency pair
from a particular channel; for example, the server selects USDEUR from the simulated
American data feed, but rejects all other pairs, such as USDAUD (Australian dollar).

After the data from each data feed provider passes this initial preparation phase, a
different processor, called FindCrossRate, joins all events across all providers,
calculates the mid-point between the maximum and minimum rate, and then applies a
trader-specified spread. Finally, the processor forwards the rate to the POJO that
contains the business code; in this example, the POJO simply publishes the rate to
clients.

The Oracle Event Processing monitor is configured to watch if the event latency in the
last step exceeds some threshold, such as no updated rates in a 30 second time-span,
and if there is too much variance between two consecutive rates for the same currency
pair. Finally, the last rate of each currency pair is forwarded to the Oracle Event
Processing http pub-sub server.

2.8.1 Running the Foreign Exchange Example

For optimal demonstration purposes, Oracle recommends that you run this example
on a powerful computer, such as one with multiple CPUs or a 3 GHz dual-core Intel,
with a minimum of 2 GB of RAM.

The Foreign Exchange (FX) application is pre-deployed to the £x_domain domain. To
run the application, you simply start an instance of Oracle Event Processing server.

To run the foreign exchange example:

1. Open a command window and change to the default server directory of the FX
domain directory, located in MIDDLEWARE_HOME\ocep_11.1\samples\domains\£fx_
domain\defaultserver, where MIDDLEWARE HOME refers to the Middleware
directory you specified when you installed Oracle Event Processing, such as
d:\Oracle\Middleware.
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prompt> cd d:\Oracle iddleware\ocep_11.1\samples\domains\fx_
domain\defaultserver

2. Set your development environment, as described in Section 3.2, "Setting Your
Development Environment."

3. Start Oracle Event Processing by executing the appropriate script with the correct
command line arguments:

a. On Windows:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.cmd -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.cmd

b. On UNIX:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.sh -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.sh

The FX application is now ready to receive data from the data feeds.

4. To simulate an American data feed, open a new command window and set your
environment as described in Section 3, "Getting Started with Developing Oracle
Event Processing Applications."

5. Change to the MIDDLEWARE_HOME\ocep_11.1\utils\load-generator directory,
where MIDDLEWARE_HOME refers to the Middleware directory you specified when
you installed Oracle Event Processing, such as d: \Oracle\Middleware.

6. Run the load generator using the fxAmer.prop properties file:
a. On Windows:

prompt> runloadgen.cmd fxAmer.prop

b. On UNIX:

prompt> runloadgen.sh fxAmer.prop

7. Repeat steps 4 - 6 to simulate an Asian data feed, using the fxAsia.prop properties
file:

a. On Windows:

prompt> runloadgen.cmd fxAsia.prop

b. On UNIX:

prompt> runloadgen.sh fxAsia.prop
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8. Repeat steps 4 - 6 to simulate an European data feed, using the fxEuro.prop

properties file:
a. On Windows:

prompt> runloadgen.cmd fxEuro.prop

b. On UNIX:

prompt> runloadgen.sh fxEuro.prop

After the server status messages scroll by in the command window from which
you started the server, and the three load generators start, you should see
messages similar to the following being printed to the server command window
(the message will likely be on one line):

OutputBean:onEvent () +
<TupleValue>
<EventType>SpreaderOuputEvent</EventType>
<ObjectName>FindCrossRatesRule</ObjectName>
<Timestamp>1843704855846</Timestamp>
<TupleKind>null</TupleKind>
<DoubleAttribute>
<Value>90.08350000074516</Value>
</DoubleAttribute>
<CharAttribute>
<Value>USD</Value>
<Length>3</Length>
</CharAttribute>
<CharAttribute>
<Value>JPY</Value>
<Length>3</Length>
</CharAttribute>
<IsTotalOrderGuarantee>false</IsTotalOrderGuarantee>
</TuplevValue>

These messages indicate that the Foreign Exchange example is running correctly.
The output shows the cross rates of US dollars to Japanese yen and US dollars to
UK pounds sterling.

2.8.2 Building and Deploying the Foreign Exchange Example from the Source Directory

The Foreign Exchange (FX) sample source directory contains the Java source, along
with other required resources such as configuration XML files, that make up the FX
application. The build.xml Ant file contains targets to build and deploy the
application to the fx_domain domain, as described in Section 2.5.3, "Description of the
Ant Targets to Build Hello World."

To build and deploy the foreign exchange example from the source directory:

1.

If the FX Oracle Event Processing instance is not already running, follow the
procedure in Section 2.8.1, "Running the Foreign Exchange Example" to start the
server.

You must have a running server to successfully deploy the rebuilt application.

Open a new command window and change to the FX source directory, located in
MIDDLEWARE _HOME\ocep_11.1\samples\source\applications\fx, where
MIDDLEWARE_HOME refers to the Middleware directory you specified when you
installed Oracle Event Processing installation directory, such as
d:\Oracle\Middleware.
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prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\source\applications\fx
Set your development environment, as described in Section 3.2, "Setting Your
Development Environment."

Execute the all Ant target to compile and create the application JAR file:

prompt> ant all

Execute the deploy Ant target to deploy the application JAR file to Oracle Event
Processing;:

prompt> ant -Dusername=wlevs -Dpassword=wlevs -Daction=update deploy

Caution: This target overwrites the existing FX application JAR file
in the domain directory.

If the load generators required by the FX application are not running, start them as
described in Section 2.8.1, "Running the Foreign Exchange Example."

After server status messages scroll by, you should see the following message
printed to the output:

{crossRate=USDJPY, internalPrice=119.09934499999781}, {crossRate=USDGBP,
internalPrice=0.5031949999999915}, {crossRate=USDJPY,
internalPrice=117.73945624999783}

This message indicates that the FX example has been redeployed and is running
correctly.

2.8.3 Description of the Ant Targets to Build FX

The build.xnl file, located in the top-level directory of the FX source, contains the
following targets to build and deploy the application:

clean—This target removes the dist and output working directories under the
current directory.

all—This target cleans, compiles, and jars up the application into a file called
com.bea.wlevs.example.fx_11.1.1.4_0.7jar, and places the generated JAR file
into a dist directory below the current directory.

deploy—This target deploys the JAR file to Oracle Event Processing using the
Deployer utility.

For more information, see "Deployer Command-Line Reference" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing.

2.8.4 Implementation of the FX Example

The implementation of the foreign exchange (FX) example generally follows "Creating
Oracle Event Processing Applications: Typical Steps" in the Oracle Fusion Middleware
Developer’s Guide for Oracle Event Processing for Eclipse.

Refer to that section for a task-oriented procedure that describes the typical
development process.

All the files of the FX example are located relative to the MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\fx directory, where MIDDLEWARE_HOME is the
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Middleware home directory you specified when you installed Oracle Event Processing
c:\Oracle\Middleware. Oracle recommends that you use this example directory setup
in your own environment, although it is obviously not required.

The files used by the FX example include:

= An EPN assembly file that describes each component in the application and how
all the components are connected together. You are required to include this XML
file in your Oracle Event Processing application.

In the example, the file is called com.oracle.cep.sample. fx.context.xml and is
located in the META-INF/spring directory.

s Two XML files that configure the processor components of the application:

The first XML file configures the filterAmer, filterAsia, filterEuro, and
FindCrossRates processors, all in a single file. This XML file includes the Oracle
CQL rules that select particular currency pairs from particular simulated market
feeds and joins together all the events that were selected by the pre-processors,
calculates an internal price for the particular currency pair, and then calculates the
cross rate. In the example, this file is called spreader.xml and is located in the
META-INF/wlevs directory.

The second XML file configures the summarizeResults processor and includes the
Oracle CQL rule that summarizes the results of the FindCrossRates processor. In
the example, this file is called SummarizeResults.xml and is located in the
META-INF/wlevs directory.

= An XML file that configures the PublishSummaryResults http pub-sub adapter. In
the example, this file is called PubSubAdapterConfiguration.xml and is located in
the META-INF/wlevs directory.

= A Java file that implements the OutputBean component of the application, a POJO
that contains the business logic. This POJO prints out to the screen the events that
it receives, programmed in the onEvent method. The POJO also registers into the
event type repository the ForeignExchangeEvent event type.

In the example, the file is called OutputBean. java and is located in the
src/com/oracle/cep/sample/fx directory.

For additional information about the Oracle Event Processing APIs referenced in
this POJO, see Oracle Fusion Middleware Java API Reference for Oracle Event
Processing.

s A MANIFEST.MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Event Processing.

In the example, the MANIFEST . MF file is located in the META-INF directory.

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Event Processing, see Section 23.1,
"Overview of Application Assembly and Deployment".

The FX example uses a build.xml Ant file to compile, assemble, and deploy the
OSGi bundle; see Section 2.8.2, "Building and Deploying the Foreign Exchange
Example from the Source Directory” for a description of this build.xml file if you
also use Ant in your development environment.

2.9 Signal Generation Example

The signal generation sample application receives simulated market data and verifies
if the price of a security has fluctuated more than two percent. The application also
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detects the pattern occurring by keeping track of successive stock prices for a
particular symbol; if more than three successive prices are larger than the one before it,
this is considered a pattern.

Figure 2-76 shows the signal generation example Event Processing Network (EPN).
The EPN contains the components that make up the application and how they fit
together.

Figure 2-76 The Signal Generation Example Event Processing Network
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The application simulates a market data feed using the Oracle Event Processing load
generator utility; in this example, the load generator generates up to 10,000 messages
per second. The example includes an HTML dashboard which displays the matched
events along with the latencies; events consist of a stock symbol, a timestamp, and the
price.

The example demonstrates very low latencies, with minimum latency jitter under high
throughputs. Once the application starts running, the processor matches an average of
800 messages per second. If the application is run on the minimum configured system,
the example shows very low average latencies (30-300 microsecond, on average) with
minimal latency spikes (low milliseconds).

The example computes and displays latency values based on the difference between a
timestamp generated on the load generator and timestamp on Oracle Event
Processing. Computing valid latencies requires very tight clock synchronization, such
as 1 millisecond, between the computer running the load generator and the computer
running Oracle Event Processing. For this reason, Oracle recommends running both
the load generator and Oracle Event Processing on a single multi-CPU computer
where they will share a common clock.

The example also shows how to use the Oracle Event Processing event caching feature.
In particular the single processor in the EPN sends events to both an event bean and a
cache.

The example also demonstrates how to use Oracle CQL queries.

2.9.1 Running the Signal Generation Example

For optimal demonstration purposes, Oracle recommends that you run this example
on a powerful computer, such as one with multiple CPUs or a 3 GHz dual-core Intel,
with a minimum of 2 GB of RAM.
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The signalgeneration_domain domain contains a single application: the signal
generation sample application. To run the signal generation application, you simply
start an instance of Oracle Event Processing in that domain.

To run the signal generation example:

1.

Open a command window and change to the default server directory of the
signalgeneration_domain domain directory, located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\signalgeneration_domain\defaultserver, where
MIDDLEWARE_HOME refers to the Middleware home directory you specified when
you installed Oracle Event Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\domains\signalgeneration_
domain\defaultserver

Set your development environment, as described in Section 3.2, "Setting Your
Development Environment."

Start Oracle Event Processing by executing the appropriate script with the correct
command line arguments:

a. On Windows:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.cmd -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.cmd

b. On UNIX:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.sh -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.sh

Wait until you see console messages like this:

<Apr 24, 2009 11:40:37 AM EDT> <Notice> <Server> <BEA-2046000> <Server STARTED>
Throughput (msg per second): 0. Average latency (microseconds): 0
Throughput (msg per second): 0. Average latency (microseconds): 0
Throughput (msg per second): 0. Average latency (microseconds): 0
Throughput (msg per second): 0. Average latency (microseconds): 0

The signal generation application is now ready to receive data from the data feeds.

Next, to simulate a data feed, you use a load generator programmed specifically
for the example.

Open a new command window.

Change to the MIDDLEWARE_HOME\ocep_
11.1\samples\domains\signalgeneration_domain\defaultserver\utils
directory, where MIDDLEWARE_HOME refers to the Middleware home directory you
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specified when you installed Oracle Event Processing, such as
d:Oracle\Middleware.

7. Run the startDataFeed command:
a. On Windows:

prompt> startDataFeed.cmd

b. On UNIX:

prompt> startDataFeed.sh

8. Invoke the example dashboard by starting a browser and opening the following
HTML page:

http://host:9002/signalgeneration/dashboard.html

Replace host with the name of the computer on which Oracle Event Processing is
running; if it is the same computer as your browser, you can use localhost.
9. In the browser, click Start on the HTML page.

You should start seeing the events that match the Oracle CQL rules configured for
this example as Figure 2-77 shows.

Figure 2-77 Signal Generation Dashboard
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2.9.2 Building and Deploying the Signal Generation Example from the Source Directory

The signal generation sample source directory contains the Java source, along with
other required resources, such as configuration XML files, EPN assembly file, and
DOJO client JavaScript libraries, that make up the signal generation application. The
build.xml Ant file contains targets to build and deploy the application to the
signalgeneration_domain domain, as described in Section 2.9.3, "Description of the
Ant Targets to Build Signal Generation."

To build and deploy the signal generation example from the source directory:

1. If the signal generation Oracle Event Processing instance is not already running,
follow the procedure in Section 2.9.1, "Running the Signal Generation Example" to
start the server. You must have a running server to successfully deploy the rebuilt
application.

2. Open a new command window and change to the signal generation source
directory, located in MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\signalgeneration, where MIDDLEWARE_ HOME
refers to the Middleware home directory you specified when you installed Oracle
Event Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_
11.1\samples\source\applications\signalgeneration

3. Set your development environment, as described in Section 3.2, "Setting Your
Development Environment."

4. Execute the all Ant target to compile and create the application JAR file:
prompt> ant all

5. Execute the deploy Ant target to deploy the application JAR file to the

MIDDLEWARE_HOME\ocep_11.1\samples\domains\signalgeneration_
domain\defaultserver\applications\signalgeneration directory:

prompt> ant deploy

Caution: This target overwrites the existing signal generation
application JAR file in the domain directory.

6. If the load generator required by the signal generation application is not running,
start it as described in Section 2.9.1, "Running the Signal Generation Example."

7. Invoke the example dashboard as described in Section 2.9.1, "Running the Signal
Generation Example."

2.9.3 Description of the Ant Targets to Build Signal Generation

The build.xml file, located in the top-level directory of the signal generation example
source, contains the following targets to build and deploy the application:

= clean—This target removes the dist and output working directories under the
current directory.

s all—This target cleans, compiles, and jars up the application into a file called
com.bea.wlevs.example.signalgen_ 11.1.1.4_0.jar, and places the generated
JAR file into a dist directory below the current directory.
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deploy—This target deploys the JAR file to Oracle Event Processing using the
Deployer utility.

For more information, see "Deployer Command-Line Reference" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing.

2.9.4 Implementation of the Signal Generation Example

The implementation of the signal generation example generally follows "Creating
Oracle Event Processing Applications: Typical Steps" in the Oracle Fusion Middleware
Developer’s Guide for Oracle Event Processing for Eclipse.

Refer to that section for a task-oriented procedure that describes the typical
development process.

All the files of the signal generation are located relative to the MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\signalgeneration directory, where
MIDDLEWARE_HOME refers to the Middleware home directory you specified when you
installed Oracle Event Processing, such as c: \Oracle\Middleware. Oracle recommends
that you use this example directory setup in your own environment, although it is
obviously not required.

The files used by the signal generation example include:

A EPN assembly file that describes each component in the application and how all
the components are connected together.

In the example, the file is called epn_assembly.xml and is located in the
META-INF/spring directory.

An XML file that configures the processor component of the application; this file is
called config.xml and is located in the META-INF/wlevs directory

The config.xml file configures the processorl Oracle CQL processor, in particular
the Oracle CQL rules that verify whether the price of a security has fluctuated
more than two percent and whether a trend has occurred in its price.

A Java file that implements the SignalgenOutputBean component of the
application, a POJO that contains the business logic. This POJO is an HttpServlet
and an EventSink. Its onEvent method consumes PercentTick and TrendTick
event instances, computes latency, and displays dashboard information.

In the example, the file is called SignalgenOutputBean. java and is located in the
src/oracle/cep/example/signalgen directory.

For general information about programming event sinks, see Section 16.2,
"Handling Events with Sources and Sinks".

A MANIFEST.MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Event Processing.

In the example, the MANIFEST . MF file is located in the META-INF directory

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Event Processing, see Section 23.1,
"Overview of Application Assembly and Deployment".

A dashboard.html file in the main example directory; this HTML file is the
example dashboard that displays events and latencies of the running signal
generation application. The HTML file uses Dojo JavaScript libraries from
http://dojotoolkit.org/,located in the dojo directory.
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For additional information about the Oracle Event Processing APIs referenced in
ForeignExchangeBuilderFactory, see Oracle Fusion Middleware Java API Reference for
Oracle Event Processing.

The signal generation example uses a build.xml Ant file to compile, assemble, and
deploy the OSGi bundle; see Section 2.9.2, "Building and Deploying the Signal
Generation Example from the Source Directory” for a description of this build.xml file
if you also use Ant in your development environment.

2.10 Event Record and Playback Example

The record and playback example shows how to configure a component to record
events to an event store and then configure another component in the network to
playback events from the store. The example uses the Oracle Event
Processing-provided default Berkeley database to store the events. The example also
shows how to configure a publishing HTTP pub-sub adapter as a node in the event
processing network.

Figure 2-78 shows the event record and playback example Event Processing Network
(EPN). The EPN contains the components that make up the application and how they
fit together.

Figure 2-78 The Event Record and Playback Example Event Processing Network

eventatream

simpleEventSource recplayEventSink playbackHttpPublisher
Legend
Acdapter Channel Ewert
Bean

The application contains four components in its event processing network:

= simpleEventSource: an adapter that generates simple events for purposes of the
example. This component has been configured to record events, as shown in the
graphic.

The configuration source for this adapter is:

<adapter>
<name>simpleEventSource</name>
<record-parameters>

</record-parameters>
</adapter>

= eventStream: a channel that connects the simpleEventSource adapter and
recplayEventSink event bean. This component has been configured to playback
events.

The configuration source for this channel is:

<channel>
<name>eventStream</name>
<playback-parameters>
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</playback-parameters>
</channel>
recplayEventSink: an event bean that acts as a sink for the events generated by
the adapter.

playbackHttpPublisher: a publishing HTTP pub-sub adapter that listens to the
recplayEventSink event bean and publishes to a channel called
/playbackchannel of the Oracle Event Processing HTTP Pub-Sub server.

2.10.1 Running the Event Record/Playback Example

The recplay_domain domain contains a single application: the record and playback
sample application. To run this application, you first start an instance of Oracle Event
Processing in the domain, as described in the following procedure.

The procedure then shows you how to use Oracle Event Processing Visualizer to start
the recording and playback of events at the simpleEventSource and eventStream
components, respectively. Finally, the procedure shows you how to use Oracle Event
Processing Visualizer to view the stream of events being published to a channel by the
playbackHttpPublisher adapter.

To run the event record/playback example:

1.

Open a command window and change to the default server directory of the
recplay_domain domain directory, located in MIDDLEWARE_HOME\ocep_
11.1\samples\domains\recplay_ domain\defaultserver, where MIDDLEWARE_HOME
refers to the Middleware directory you specified when you installed Oracle Event
Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\domains\recplay_
domain\defaultserver

Set your development environment, as described in Section 3.2, "Setting Your
Development Environment."

Start Oracle Event Processing by executing the appropriate script with the correct
command line arguments:

a. On Windows:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.cmd -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.cmd

b. On UNIX:

*  If you are using the JRockit JDK included in Oracle JRockit Real Time,
enable the deterministic garbage collector by passing the -dgc parameter
to the command:

prompt> startwlevs.sh -dgc

*  If you are not using the JRockit JDK included in Oracle JRockit Real Time:

prompt> startwlevs.sh
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After server status messages scroll by, you should see the following message
printed to the output:

SimpleEvent created at: 14:33:40.441
This message indicates that the Oracle Event Processing server started correctly
and that the simpleEventSource component is creating events.
4. Invoke the following URL in your browser:
http://host:port/wlevs
where host refers to the name of the computer on which Oracle Event Processing is

running and port refers to the Jetty NetIO port configured for the server (default
value 9002).

The Logon screen appears as Figure 2-79 shows.

Figure 2-79 Oracle Event Processing Visualizer Logon Screen

) Oracle Complex Event Processing Visualizer - Mozilla Firefox

File Edit Wiew History Bookmarks Tools  Help

= e A I: |j éhttp:,l’,l’localhost:QDDZIwIevs,l’

|j Dracle Complex Event Processing...ﬂ -

CORACLE CEP Yisualizer

Welcome

User Id |

Pasgword

Log In

I Dione

5. In the Logon screen, enter the User Id wlevs and Password wlevs, and click Log
In.

The Oracle Event Processing Visualizer dashboard appears as Figure 2-80 shows.
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Figure 2-80 Oracle Event Processing Visualizer Dashboard
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For more information about the Oracle Event Processing Visualizer user interface,
see "Understanding the Oracle Event Processing Visualizer User Interface” in the
Oracle Fusion Middleware Visualizer User’s Guide for Oracle Event Processing.

6. In the left pane, select WLEventServerDomain > NonClusteredServer >
Applications > recplay > Stages > simpleEventSource.

7. In the right pane, select the Record tab as shown in Figure 2-81.
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Figure 2-81 Event Record Tab
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The DataSet Name field contains the value of the record-parameters child
element dataset-name element from the simpleEventSource adapter application
configuration file MIDDLEWARE_HOME\ocep_11.1\samples\domains\recplay_
domain\defaultserver\applications\recplay\config.xml as Example 2-1

shows.

Example 2-1 recplay Application Configuration File config.xml: adapter Element

<adapter>
<name>simpleEventSource</name>
<record-parameters>
<dataset-name>recplay_sample</dataset-name>
<event-type-list>
<event-type>SimpleEvent</event-type>
</event-type-list>
<batch-size>1l</batch-size>
<batch-time-out>10</batch-time-out>
</record-parameters>
</adapter>

8. At the bottom of the Record tab, click Start.

An Alert dialog appears as shown in Figure 2-82.
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Figure 2-82 Start Recording Alert Dialog
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I
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9. Click OK.
The Current Status field reads Recording....

As soon as you click OK, events start to flow out of the simpleEventSource
component and are stored in the configured database.

You can further configure when events are recorded using the Start Recording and
Stop Recording fields.

10. In the left pane, select eventStream.

11. In the right pane, select the Playback tab as shown in Figure 2-83.

Figure 2-83 Event Playback Tab
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12. At the bottom of the tab, click Start.
An Alert dialog appears as shown in Figure 2-84.
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Figure 2-84 Start Playback Alert Dialog
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Click OK.
The Current Status field reads Playing....

As soon as you click OK, events that had been recorded by the
simpleEventSource component are now played back to the simpleStream
component.

You should see the following messages being printed to the command window
from which you started Oracle Event Processing server to indicate that both
original events and playback events are streaming through the EPN:

SimpleEvent created at: 14:33:11.501
Played back: Original time=14:15:23.141 Playback time=14:33:11.657

You can further configure the playback parameters, such as the recorded time
period for which you want playback events and the speed that they are played
back, by updating the appropriate field and clicking Change Parameters. You
must restart the playback after changing any playback parameters.

To view the events that the playbackHttpPublisher adapter is publishing to a
channel, follow these steps:

a. In the top pane, select Viewstream.

The Viewstream window appears as shown in Figure 2-85.
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Figure 2-85 Stream Visualizer

Home Security  f] Dashboard 2 Wiew Stream () Logout [E3) Full Screen Preference ® Help
Stream Visualizer ===
CEP SemerMame  ponClusteredServer Pubsub SenerName  pupsub

Pub/Sub Server URL  hittp:ir1 41.144.178.24:9002/pubsub B [l Disconnect

Publish | Subscribe

| Channel Name
() | fewsmaonitar
(| fevsalert
()| fevsdomainchanoe
(=) | Iplaybackehannel
Qutput messages from subscription @ﬂ Refrezh
| iplayb.[x%] |

[

MereationTime™" 111716, 706" "plavhackTime""11:19:29. 143"}
MereationTire™" 11171 7.002" "plavhackTime""11:19:20 440"}
MereationTime™"11:17:17.3158" "plavhackTime""11:19:28. 752"}
MereationTime™" 11171761 2" "plavhackTime""11:19:30 045"}
MereationTirne™"11:17:17.909" "plavhackTime""11:19:30 346"}
MereationTime™"11:17:18.221" "plavhackTime""11:19:30 639"}
MereationTime™"11:17:18.518" "plavhackTime""11:19:30 956"}
MereationTire™"11:17:18.815" "plavhackTimea""11:19:31 252"}
MereationTime™"11:17:19.11 2" "plavhackTime""11:19:31 545"}
MereationTime™"11:17:19. 424" "plavhackTime""11:19:31 862"}
MereationTire™" 1117197 21" "plavhackTime""11:19:32 159"}
ereationTime™"11:17:20001 8" "playhackTime""11:19:32 456"} —

[

| & Subscrike | | TR Clean Text |

b. In the right pane, click Initialize Client.
c. In the Subscribe Channel text box, enter /playbackchannel.
d. Click Subscribe.

The Received Messages text box displays the played back event details. The
played back events show the time at which the event was created and the time at
which it was played back.

2.10.2 Building and Deploying the Event Record/Playback Example from the Source
Directory

The record and playback sample source directory contains the Java source, along with
other required resources, such as configuration XML file and EPN assembly file that
make up the application. The build.xml Ant file contains targets to build and deploy
the application to the signalgeneration_domain domain, as described in Section 2.10.3,
"Description of the Ant Targets to Build the Record and Playback Example."
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To build and deploy the event record/playback example from the source
directory:

1.

If the record /playback Oracle Event Processing instance is not already running,
follow the procedure in Section 2.10.1, "Running the Event Record /Playback
Example" to start the server. You must have a running server to successfully
deploy the rebuilt application.

Open a new command window and change to the record/playback source
directory, located in MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\recplay, where MIDDLEWARE_HOME refers to
the Middleware home directory you specified when you installed Oracle Event
Processing, such as d: \Oracle\Middleware.

prompt> cd d:\Oracle\Middleware\ocep_11.1\samples\source\applications\recplay
Set your development environment, as described in Section 3.2, "Setting Your
Development Environment."

Execute the all Ant target to compile and create the application JAR file:

prompt> ant all

Execute the deploy Ant target to deploy the application JAR file to the

MIDDLEWARE_HOME\ocep_11.1\samples\domains\recplay_
domain\defaultserver\applications\recplay directory:

prompt> ant -Dusername=wlevs -Dpassword=wlevs -Daction=update deploy

Caution: This target overwrites the existing event record /playback
application JAR file in the domain directory.

After an application redeploy message, you should see the following message
printed to the output about every second:

SimpleEvent created at: 14:33:40.441
This message indicates that the record and playback example has been redeployed
and is running correctly.

Follow the instructions in Section 2.10.1, "Running the Event Record /Playback
Example," starting at step 4, to invoke Oracle Event Processing Visualizer and start
recording and playing back events.

2.10.3 Description of the Ant Targets to Build the Record and Playback Example

The build.xmnl file, located in the top-level directory of the record/playback source,
contains the following targets to build and deploy the application:

clean—This target removes the dist and output working directories under the
current directory.

all—This target cleans, compiles, and jars up the application into a file called
com.bea.wlevs.example.recplay_11.1.1.4_0.jar, and places the generated JAR
file into a dist directory below the current directory.

deploy—This target deploys the JAR file to Oracle Event Processing using the
Deployer utility.

Oracle Event Processing Samples 2-97



Event Record and Playback Example

For more information, see "Deployer Command-Line Reference" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing.

2.10.4 Implementation of the Record and Playback Example

The implementation of the signal generation example generally follows "Creating
Oracle Event Processing Applications: Typical Steps" in the Oracle Fusion Middleware
Developer’s Guide for Oracle Event Processing for Eclipse.

Refer to that section for a task-oriented procedure that describes the typical
development process.

All the files of the example are located relative to the MIDDLEWARE_HOME\ocep_
11.1\samples\source\applications\recplay directory, where MIDDLEWARE_HOME
refers to the Middleware home directory you specified when you installed Oracle
Event Processing, such as c:\Oracle\Middleware. Oracle recommends that you use
this example directory setup in your own environment, although it is obviously not
required.

The files used by the record and playback example include:

= An EPN assembly file that describes each component in the application and how
all the components are connected together as shown in Figure 2-78.

In the example, the file is called com.bea.wlevs.example.recplay-context .xml
and is located in the META-INF/spring directory.

= Java source file for the simpleEventSource adapter.

In the example, the file is called SimpleEventSource.java and is located in the
src/com/bea/wlevs/adapter/example/recplay directory.

For a detailed description of how to program the adapter Java files in general, see
Section 15.1, "Overview of Custom Adapters".

= Java source file that describes the PlayedBackEvent and SimpleEvent event types.
The SimpleEvent event type is the one originally generated by the adapter, but the
PlayedBackEvent event type is used for the events that are played back after
having been recorded. The PlayedBackEvents look almost exactly the same as
SimpleEvent except they have an extra field, the time the event was recorded.

In the example, the two events are called SimpleEvent.java and
PlayedBackEvent.java and are located in the
src/com/bea/wlevs/event/example/recplay directory.

For a detailed description of this file, as well as general information about
programming event types, see Section 9.1, "Overview of Oracle Event Processing
Event Types".

= AJava file that implements the recplayEventSink event bean of the application,
which is an event sink that receives both realtime events from the
simpleEventSource adapter as well as playback events.

In the example, the file is called RecplayEventSink. java and is located in the
src/com/bea/wlevs/example/recplay directory.

For more information about event sources and sinks, see Section 16.2, "Handling
Events with Sources and Sinks".

= An XML file that configures the simpleEventSource adapter and eventStream
channel components. The adapter includes a <record-parameters> element that
specifies that the component will record events to the event store; similarly, the
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channel includes a <playback-parameters> element that specifies that it receives
playback events.

In the example, the file is called config.xml and is located in the META-INF/wlevs
directory.

s A MANIFEST.MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Event Processing.

In the example, the MANIFEST . MF file is located in the META-INF directory

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Event Processing, see Section 23.1,
"Overview of Application Assembly and Deployment".

The record/playback example uses a build.xml Ant file to compile, assemble, and
deploy the OSGi bundle; see Section 2.10.2, "Building and Deploying the Event
Record /Playback Example from the Source Directory" for a description of this
build.xml file if you also use Ant in your development environment.
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3

Getting Started with Developing Oracle

Event Processing Applications

This chapter provides suggestions for getting started in building Oracle Event
Processing applications, including suggested start-to-finish steps, setting up a
development environment, and tools for development and testing.

This chapter includes the following sections:

Section 3.1, "Creating an Oracle Event Processing Application”
Section 3.2, "Setting Your Development Environment"

Section 3.3, "Using an IDE to Develop Applications"

Section 3.4, "Testing Applications"

3.1 Creating an Oracle Event Processing Application

The following procedure shows the suggested start-to-finish steps to create an Oracle
Event Processing application. Although it is not required to program and configure the
various components in the order shown, the procedure shows a typical and logical
flow recommended by Oracle.

It is assumed in the procedure that you are using an IDE, although it is not required
and the one you use is your choice. For one targeted to Oracle Event Processing
developers, see Chapter 4, "Overview of the Oracle Event Processing IDE for Eclipse"

To create an Oracle Event Processing application:

1.

Set up your environment as described in Section 3.2, "Setting Your Development
Environment."

Create an Oracle Event Processing project using the Oracle Event Processing IDE
for Eclipse.

For more information, see Chapter 5, "Oracle Event Processing IDE for Eclipse
Projects".

Design your event processing network (EPN).

Using the Oracle Event Processing IDE for Eclipse and the EPN editor, add the full
list of components that make up the application and how they are connected to
each other, as well as registering the event types used in your application.

This step combines both designing of your application, in particular determining
the components that you need to configure and code, as well as creating the actual
XML file that specifies all the components (the EPN assembly file) and the XML
file that specifies component configuration (the component configuration file). You
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will likely be constantly updating these XML files as you implement your
application, but Oracle recommends you start with this step so you have a
high-level view of your application.

For more information, see:

s Chapter 7, "Oracle Event Processing IDE for Eclipse and the Event Processing
Network"

= Section 5.3, "Creating EPN Assembly Files."
= Section 5.4, "Creating Component Configuration Files."

4. Determine the event types that your application is going to use, and, if creating
your own JavaBean, program the Java file.

See Chapter 9, "Defining and Using Event Types"

5. Program, and optionally configure, the adapters or event beans that act as
inbound, intermediate, or outbound components of your event processing
network. You can create your own adapters or event beans, or use the adapters
provided by Oracle Event Processing. For details, see:

= Section 1.5, "Oracle Event Processing APIs"

= Section 1.4.3, "Configuring Oracle Event Processing Resource Access"

s Chapter 11, "Integrating the Java Message Service"

s Chapter 12, "Integrating an HTTP Publish-Subscribe Server"

s Chapter 15, "Integrating an External Component Using a Custom Adapter"
s Chapter 16, "Handling Events with Java"

6. Configure the processors by creating their component configuration XML files; the
most important part of this step is designing and declaring the initial rules that are
associated with each processor.

See:
s Chapter 17, "Querying an Event Stream with Oracle CQL"
s Chapter 19, "Querying an Event Stream with Oracle EPL"

7. Design the rules that the processors are going to use to select events from their
upstream channels and output events to their downstream channels.

See:
»  Oracle Fusion Middleware CQL Language Reference for Oracle Event Processing
»  Oracle Fusion Middleware EPL Language Reference for Oracle Event Processing

Note: Oracle CQL replaces Event Processing Language (EPL) in
Oracle Event Processing 11g Release 1 (11.1.1). Oracle Event
Processing supports EPL for backwards compatibility.

8. Optionally configure the channels that stream data between adapters, processors,
and the business logic POJO by creating their configuration XML files.

See Chapter 10, "Connecting EPN Stages Using Channels."
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9. Optionally configure the caching system to publish or consume events to and from
a cache to increase the availability of the events and increase the performance of
your applications.

See Chapter 13, "Integrating a Cache."

10. Optionally, use the Oracle Event Processing server log subsystem to write log
messages from your application to the Oracle Event Processing server log:

import org.apache.commons.logging.Log;
import org.apache.commons.logging.LogFactory;

Log LOG=LogFactory.getLog ("LogName") ;

LOG.debug ("Some debug information");

Using the Oracle Event Processing Visualizer, you can deploy your application,
configure the log level for your application, and view the Oracle Event Processing
server console.

For more information, see:

s "Configuring Logging and Debugging for Oracle Event Processing” in the
Oracle Fusion Middleware Administrator’s Guide for Oracle Event Processing

= Section 23.4, "Managing Log Message Catalogs"

= "How to Configure Component Logging" in the Oracle Fusion Middleware
Visualizer User’s Guide for Oracle Event Processing

= "How to View Console Output” in the Oracle Fusion Middleware Visualizer
User’s Guide for Oracle Event Processing

3.2 Setting Your Development Environment

You must set your development environment before you can start Oracle Event
Processing instances and run the samples. In particular, you must set the PATH and
JAVA_HOME environment variables so that you are using the correct version of the
JRockit JDK.

There are two ways in which JRockit might have been installed on your computer:

= As part of the Oracle JRockit Real Time installation. This version of the JRockit
JDK includes the deterministic garbage collector.

= As part of the Oracle Event Processing 11g Release 1 (11.1.1) installation. This
version of the JRockit JDK does not include the deterministic garbage collector, and
is provided for testing purposes only.

Although not required, Oracle recommends that you run Oracle Event Processing
using the JRockit JDK version included in Oracle JRockit Real Time for best results;
however, the following procedures describe how to set your environment for either
case.

For more information about JRockit, see Section 2.4, "Increasing the Performance of the
Samples".

This section describes:
= Section 3.2.1, "How to Set Your Development Environment on Windows"

= Section 3.2.2, "How to Set Your Development Environment on UNIX"
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3.2.1 How to Set Your Development Environment on Windows

This procedure describes how to set your development environment on Windows.

To make it easier to reset your development environment after logging out of a
session, you can create a command file, such as setEnv.cmd, that contains the set
commands this section describes.

You can also set the required environment variables permanently on your Windows
computer by invoking the Control Panel > System window, clicking the Advanced

tab, and then clicking the Environment Variables button. You can set the environment
variables for the current user or for the entire system.

To set your development environment on Windows:

1.

Update your PATH environment variable to include the bin directory of the JRockit
JDK. Also, be sure that your PATH environment variable includes the bin directory
of your Ant installation:

a. If using the JRockit JDK installed with Oracle JRockit Real Time:

If you installed Oracle JRockit Real Time in the d: \jrockit directory and Ant
is installed in the d: \ant directory, set your PATH environment variable as
shown:

prompt> set PATH=d:\jrockit\[JRRT_HOME]\bin;d:\ant\bin;$PATH%

where JRRT_HOME is the JRockit Real Time directory.
b. If using the JRockit JDK installed with Oracle Event Processing;:

If you installed Oracle Event Processing in the d: \Oracle\Middleware
directory and Ant is installed in the d: \ant directory, set your PATH
environment variable as shown:

prompt> set PATH=d:\Oracle\Middleware\jrockit_160_20\bin;d:\ant\bin;%$PATH%
Ensure that the JAVA_HOME variable in the setDomainEnv.cmd script points to the
correct JRockit JDK. If it does not, edit the script.

The setDomainEnv.cmd script is located in the defaultserver subdirectory of the
main domain directory; the defaultserver subdirectory contains the files for the
standalone server of each domain. For example, the HelloWorld domain is located
in MIDDLEWARE_HOME\ocep_11.1\samples\domains\helloworld_domain, where
MIDDLEWARE_HOME refers to the Middleware home directory you specified when
you installed Oracle Event Processing, such as d: \Oracle\Middleware.

a. If using the JRockit JDK installed with Oracle JRockit Real Time:
The set command should be as follows:

set JAVA_HOME=d:\jrockit\[JRRT_HOME]

where JRRT_HOME is the JRockit Real Time directory.
b. If using the JRockit JDK installed with Oracle Event Processing:
The set command should be as follows:

set JAVA_HOME=d:\Oracle\Middleware\jrockit_160_20

Set the JAVA_HOME variable in your own development environment to point to the
JRockit JDK.

a. If using the JRockit JDK installed with Oracle JRockit Real Time:
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The set command should be as follows:

prompt> set JAVA_HOME=d:\jrockit\ [JRRT_HOME]

where JRRT_HOME is the JRockit Real Time directory.
b. If using the JRockit JDK installed with Oracle Event Processing;:
The set command should be as follows:

prompt> set JAVA_HOME=d:\Oracle\Middleware\jrockit_160_20

3.2.2 How to Set Your Development Environment on UNIX

This procedure describes how to set your development environment on UNIX.

To make it easier to reset your development environment after logging out of a
session, you can create a command file, such as setEnv. sh, that contains the set
commands this section describes.

To set your development environment on UNIX:

1.

Update your PATH environment variable to include the bin directory of the JRockit
JDK. Also, be sure that your PATH environment variable includes the bin directory
of your Ant installation.

a. If using the JRockit JDK installed with Oracle JRockit Real Time:

If you installed Oracle JRockit Real Time in the /jrockit directory and Ant is
installed in the /ant directory, set your PATH environment variable as follows:

prompt> PATH=/jrockit/j [JRRT_HOME] /bin:/ant/bin:$PATH

where JRRT_HOME is the JRockit Real Time directory.
b. If using the JRockit JDK installed with Oracle Event Processing;:

If you installed Oracle Event Processing in the /Oracle/Middleware directory
and Ant is installed in the /ant directory, set your PATH environment variable
as shown:

prompt> PATH=/Oracle/Middleware/jrockit_160_20/bin:/ant/bin:$PATH
Ensure that the JAVA_HOME variable in the setDomainEnv. sh script points to the
correct JRockit JDK. If it does not, edit the script.

The setDomainEnv.sh script is located in the defaultserver subdirectory of the
main domain directory; the defaultserver subdirectory contains the files for the
standalone server of each domain. For example, the HelloWorld domain is located
in MIDDLEWARE_HOME/ocep_11.1/samples/domains/helloworld_domain, where
MIDDLEWARE_HOME refers to the Middleware home directory you specified when
you installed Oracle Event Processing, such as /0Oracle/Middleware.

a. If using the JRockit JDK installed with Oracle JRockit Real Time:
The JAVA_HOME variable should be set as follows:

JAVA_HOME=/jrockit/[JRRT_HOME]

where JRRT_HOME is the JRockit Real Time directory.
b. If using the JRockit JDK installed with Oracle Event Processing;:

The JAVA_HOME variable should be set as follows:
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JAVA_HOME=/Oracle/Middleware/jrockit_160_20
3. Set the JAVA_HOME variable in your development environment to point to the
JRockit JDK.
a. If using the JRockit JDK installed with Oracle JRockit Real Time:
The JAVA_HOME variable should be set as follows:

prompt> JAVA_HOME=/jrockit/[JRRT_HOME]

where JRRT_HOME is the JRockit Real Time directory.
b. If using the JRockit JDK installed with Oracle Event Processing;:
The JAVA_HOME variable should be set as follows:

prompt> JAVA_HOME=/Oracle/Middleware/jrockit_160_20

3.3 Using an IDE to Develop Applications

Oracle Event Processing includes a pluging that enhances the Eclipse IDE with
features specifically designed to ease the work of building Oracle Event Processing
applications. For more information about the IDE, see Section 4, "Overview of the
Oracle Event Processing IDE for Eclipse".

3.4 Testing Applications

You can test Oracle Event Processing applications you build by using the included
csvadapter and load generator.

The load generator is a command-line tool the reads a comma-separated values (CSV)
file and feeds the results to the csvadapter. The csvadapter, in turn, is designed to
receive values from the load generator, then bind those values to an event type that
you specify.

Using these tools is a relatively simple way to try out code in development before you
are ready for the application to receive data from the actual event data source.

For more information about testing with these tools, see Section 21, "Testing
Applications With the Load Generator and csvgen Adapter".
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Oracle Event Processing IDE for Eclipse

Part II contains the following chapters:

Chapter 4, "Overview of the Oracle Event Processing IDE for Eclipse"
Chapter 5, "Oracle Event Processing IDE for Eclipse Projects"

Chapter 6, "Oracle Event Processing IDE for Eclipse and Oracle Event Processing
Servers"

Chapter 7, "Oracle Event Processing IDE for Eclipse and the Event Processing
Network"






4

Overview of the Oracle Event Processing IDE

for Eclipse

This chapter introduces the Oracle Event Processing IDE features available for Eclipse,
providing information on how to install and configure the features.

This chapter includes the following sections:

Section 4.1, "Overview of Oracle Event Processing IDE for Eclipse"
Section 4.2, "Installing the Latest Oracle Event Processing IDE for Eclipse”

Section 4.3, "Installing the Oracle Event Processing IDE for Eclipse Distributed
With Oracle Event Processing”

Section 4.4, "Configuring Eclipse"

4.1 Overview of Oracle Event Processing IDE for Eclipse

Oracle Event Processing IDE for Eclipse is a set of plugins for the Eclipse IDE designed
to help develop, deploy, and debug applications for Oracle Event Processing.

This section describes:

Section 4.1.1, "Features"
Section 4.1.2, "JDK Requirements"

Section 4.1.3, "Default Oracle Event Processing Domain ocep_domain and
Development"

For more information about Oracle Event Processing IDE for Eclipse, see
http://www.oracle.com/technology/products/event-driven-architect
ure/cep-ide/11/.

4.1.1 Features

The key features of the Oracle Event Processing IDE for Eclipse are as follows:

Project creation wizards and templates to quickly get started building event driven
applications.

Advanced editors for source files including Java and XML files common to Oracle
Event Processing applications.

Integrated server management to seamlessly start, stop, and deploy to Oracle
Event Processing server instances all from within the IDE.

Integrated debugging.
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= Event Processing Network (EPN) visual design views for orienting and navigating
in event processing applications and visually creating and editing EPN
components.

s Oracle Event Processing application source file validation including Oracle
Continuous Query Language (Oracle CQL) syntax highlighting and component
configuration and assembly files.

= Ability to build and export deployable Oracle Event Processing applications.

s Integrated support for the Oracle Event Processing Visualizer so you can use the
Oracle Event Processing Visualizer from within the IDE.

4.1.2 JDK Requirements

In 11g Release 1 (11.1.1), Oracle Event Processing IDE for Eclipse requires JDK 6.0. For
more information, see:

= Section 3.2, "Setting Your Development Environment."

= Section 4.4, "Configuring Eclipse"

4.1.3 Default Oracle Event Processing Domain ocep_domain and Development

When you choose a Typical Oracle Event Processing server install, the installation
does not include the default ocep_domain domain (with default passwords) and the
product samples.

If you want to install the default ocep_domain and samples (recommended), choose
the Custom Oracle Event Processing server install option.

The Typical install is appropriate for a production environment while the Custom
install is appropriate for a development environment.

Oracle recommends that you install the default ocep_domain and samples for use
with the Oracle Event Processing IDE for Eclipse during development.

If you choose a Typical Oracle Event Processing server install, you can use the
Configuration Wizard to create an Oracle Event Processing server domain.

For more information, see:

s "Installation Overview" in the Oracle Fusion Middleware Getting Started Guide for
Oracle Event Processing

s "Creating an Oracle Event Processing Standalone-Server Domain" in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing

= "Creating an Oracle Event Processing Multi-Server Domain Using Oracle Event
Processing Native Clustering" in the Oracle Fusion Middleware Administrator’s Guide
for Oracle Event Processing

4.2 Installing the Latest Oracle Event Processing IDE for Eclipse

New versions of the IDE will be made available via the Oracle Technology Network
Web site. Oracle recommends that you install the IDE from this Eclipse update site.

To install the latest Oracle Event Processing IDE for Eclipse:

1. Obtain the required versions of Eclipse (3.7.2) and WTP (2.0). Be sure to install the
Eclipse IDE for Java EE developers. We recommend you take the entire Indigo
installation available at the following Web sites:
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Windows:
http://www.eclipse.org/downloads/download.php?file=/technolog
v/epp/downloads/release/indigo/R/eclipse-jee-indigo-win32.zip

Linux:
http://www.eclipse.org/downloads/download.php?file=/technolog
v/epp/downloads/release/indigo/SR2/eclipse-jee-indigo-SR2-1in
ux-gtk.tar.gz

2. Open your Eclipse IDE and select the menu item Help > Install New Software.
The Install dialog appears as Figure 4-1 shows.

Figure 4—-1 Install Dialog

¥ Install
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Select a site or enter the location of a site.

work with: | SIS B e ]

Find more software by working with the 'Available Software Sites' preferences.,

Mame ‘ersion
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Details
Show only the latest versions of available software [JHide items that are already installed
Group items by category ‘Wwhat is already installed?

[ Contact all update sites during install to find required software

@

3. Click Add.
The Add Site dialog appears as Figure 4-2 shows.

Figure 4-2 Add Site Dialog

F Add Repository.

Mame: || |[ Local... ]

Location: |http:,|’,|’ |[ Archive... ]

® o« Cow]

4. Configure this dialog as Table 4-1 describes.
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Table 4-1 New Update Site Dialog Attributes
Attribute | Description
Name The name for this remote update site. For example: Oracle Event Processing
Tools Update.
URL The URL to the remote update site. Valid value:
http://download.oracle.com/technology/software/cep-ide/11/
5. Click OK.
6. In the Install dialog, from the Work with pull down menu, select the Oracle

Event Processing Tools Update site you just created.

It make take a few moments for Eclipse to contact the remote update site. During
this time, the "There is no site selected" entry reads "Pending".

When Eclipse has made contact with the remote update site, the Oracle Event
Processing Tools entry appears in the list of update sites as Figure 4-3 shows.

Check the check box next to the Oracle Event Processing Tools entry as Figure 4-3
shows.

Figure 4-3 Install Dialog - Site Selected
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Mame
000 cracle CEP Tools

Details

[Hide items that are already installed
What is already installed?

Show only the latest versions of available software
Group items by category

[ Contact all update sites during install to find required software

®

8. Click Next.
The Install Details dialog appears as Figure 4-4 shows.
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Figure 4-4 Install Dialog - Install Details
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9. Click Next.
The Review Licenses dialog appears.

10. Click Finish.

11. When prompted restart, Eclipse. If you skip this, unreliable behavior can occur.

12. To confirm the installation, select Help > About Eclipse.

The About Eclipse dialog appears as Figure 4-5 shows.

Figure 4-5 About Eclipse
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® Installation Details

13. Click Oracle.
The About Eclipse Features dialog appears as Figure 4-6 shows.
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Figure 4-6 About Eclipse Features Dialog

¥ About Eclipse Features |:
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14. Click Plug-In Details.
The Feature Plug-ins dialog appears as Figure 4-7 shows.

Figure 4-7 Feature Plug-ins Dialog
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15. Confirm that the plug-ins that Table 4-2 lists are shown.
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Table 4-2 Oracle Event Processing IDE for Eclipse Plug-Ins

Provider | Plug-in Name Plug-in Id

Oracle Oracle Event Processing Tools com.bea.wlevs.eclipse.tools.core
Core

Oracle Oracle Event Processing Tools com.bea.wlevs.eclipse.tools.doc
Documentation

Oracle Oracle Event Processing Tools Ul | com.bea.wlevs.eclipse.tools.ui

16. After installing Oracle Event Processing IDE for Eclipse, consider the following
topics:
= Section 4.1.3, "Default Oracle Event Processing Domain ocep_domain and

Development"

= Section 4.4, "Configuring Eclipse"

4.3 Installing the Oracle Event Processing IDE for Eclipse Distributed
With Oracle Event Processing

A version of the Oracle Event Processing IDE for Eclipse is shipped with the Oracle
Event Processing product, although this version might be older than the one on the
Oracle Technology Network site.

To install the Oracle Event Processing IDE for Eclipse distributed with Oracle

Event Processing:

1. Obtain the required versions of Eclipse (3.7.2) and WTP (2.0). Be sure to install the
Eclipse IDE for Java EE developers. We recommend you take the entire Indigo
installation available at the following Web sites:

Windows:
http://www.eclipse.org/downloads/download.php?file=/technolog
y/epp/downloads/release/indigo/R/eclipse-jee-indigo-win32.zip

Linux:
http://www.eclipse.org/downloads/download.php?file=/technolog
yv/epp/downloads/release/indigo/SR2/eclipse-jee-indigo-SR2-1in
ux-gtk.tar.gz

2. Open your Eclipse IDE and select the menu item Help > Install New Software.
The Install dialog appears as Figure 4-1 shows.
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Figure 4-8 Install Dialog
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3. Click Add.
The Add Site dialog appears as Figure 4-2 shows.

Figure 4-9 Add Site Dialog
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4. Click Archive.
The Select Local Site Archive dialog appears as Figure 4-10 shows.
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Figure 4-10 Select Local Site Archive Dialog
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5. Navigate to the MIDDLEWARE_HOME/ocep_l1l.1/eclipse-update-site
directory and select the cep-tools-11.1.0.DATE-BUILD. zip file.

Where MIDDLEWARE_HOME refers to the directory into which you installed Oracle
Event Processing, such as c: \Oracle\Middleware, and DATE is the build date
and BUILDis the build number.

6. Click Open.

7. Complete the Update Manager, selecting to install the Oracle Event Processing

tools.

8. When prompted restart, Eclipse. If you skip this, unreliable behavior can occur.

9. To confirm the installation, select Help > About Eclipse.

The About Eclipse dialog appears as Figure 4-5 shows.

Figure 4-11 About Eclipse
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10. Click Oracle.

The About Eclipse Features dialog appears as Figure 4-6 shows.
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Figure 4-12 About Eclipse Features Dialog
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11. Click Plug-In Details.

The Feature Plug-ins dialog appears as Figure 4-7 shows.

Figure 4-13 Feature Plug-ins Dialog
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12. Confirm that the plug-ins that Table 4-2 lists are shown.
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Table 4-3 Oracle Event Processing IDE for Eclipse Plug-Ins

Provider | Plug-in Name Plug-in Id

Oracle Oracle Event Processing Tools com.bea.wlevs.eclipse.tools.core
Core

Oracle Oracle Event Processing Tools com.bea.wlevs.eclipse.tools.doc
Documentation

Oracle Oracle Event Processing Tools Ul | com.bea.wlevs.eclipse.tools.ui

13. After installing Oracle Event Processing IDE for Eclipse, consider the following
topics:

= Section 4.1.3, "Default Oracle Event Processing Domain ocep_domain and
Development"

= Section 4.4, "Configuring Eclipse"

4.4 Configuring Eclipse

This section describes how to configure Eclipse to work with Oracle Event Processing.

To configure Eclipse:
1. Exit out of Eclipse if it is running.

2. Install a Java 6 JRE on your computer.

For example, you might have installed the JRE included with a Java Development
Kit to the following location:

C:\Java\jre6

3. Using the editor of your choice, open your eclipse.ini file located in your
Eclipse install directory, for example, C:\eclipse\ as Example 4-1 shows.

Example 4-1 Default eclipse.ini File

-showsplash
org.eclipse.platform
--launcher.XXMaxPermSize
256M

Note: When making changes to the eclipse.ini file, add
arguments one argument per line, as
http://wiki.eclipse.org/Eclipse.ini describes.

For more information about configuring Eclipse, see
http://wiki.eclipse.org/FAQ How_do_I_run_Eclipse.

4. Add the following lines to the eclipse.ini file as Example 4-2 shows.

Example 4-2 Memory Resources

-showsplash
org.eclipse.platform
--launcher.XXMaxPermSize
256M
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-vmargs
-Xmx512m
-XX:MaxPermSize=256M

5. Add the following to the eclipse. ini file as Example 4-3 shows.

Example 4-3 Virtual Machine Path
—-vm

PATH-TO-JRE-6. 0-JAVAW

Where PATH-TO-JRE-6. 0-JAVAW s the fully qualified path to your Java 6.0 JRE
javaw executable. For example:

-vm
C:\Java\jre6\bin\javaw.exe

Note: Do not put both the -vm and the path on the same line. Each
must be on a separate line as Example 4-3 shows.

Save and close the eclipse.ini file.
Start Eclipse.
Select Help > About Eclipse and click Installation Details.

© ®» N o

Click the Configuration tab.

The Configuration Details tab appears as shown in Figure 4-14.

4-12 Developer's Guide for Oracle Event Processing



Configuring Eclipse

Figure 4-14 Configuration Details for Java 6
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10. Confirm that the eclipse.vm property points to the Java 6.0 JRE you configured
in the eclipse. ini file.
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Oracle Event Processing IDE for Eclipse
Projects

This chapter describes how to use the Oracle Event Processing IDE for Eclipse to create
projects with which to develop event processing networks (EPNs), including EPN
assembly files and component configuration files.

This chapter includes the following sections:

ms  Section 5.1, "Oracle Event Processing Project Overview"
m  Section 5.2, "Creating Oracle Event Processing Projects"
= Section 5.3, "Creating EPN Assembly Files"

= Section 5.4, "Creating Component Configuration Files"

= Section 5.5, "Exporting Oracle Event Processing Projects"
= Section 5.6, "Upgrading Projects"

= Section 5.7, "Managing Libraries and Other Non-Class Files in Oracle Event
Processing Projects"

= Section 5.8, "Configuring Oracle Event Processing IDE for Eclipse Preferences”

5.1 Oracle Event Processing Project Overview
An Oracle Event Processing application includes the following artifacts:
= Java source files
= XML configuration files
= OSGi bundle Manifest file

Figure 5-1 shows the Explorer after creating a project.
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Figure 5-1 Oracle Event Processing Project Structure
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Table 5-1 summarizes the important files in an Oracle Event Processing project

including their use and location.

Table 5-1

Oracle Event Processing Project Artifacts

File Type Location

Description

Java source files Any Java source folder.

Default: src.

Events, adapters, and listeners are implemented in an
Oracle Event Processing application with Java files. All
Java files must be in a source folder in order to be
compiled.

For more information, see Chapter 1, "Overview of
Creating Oracle Event Processing Applications".

EPN assembly file | META-INF/spring

These are the main files used to wire-up an EPN and to
define event types. This is a Spring context file, and is
where adapters, channels, processors, and listeners are
connected.

For more information, see Chapter 1.4.1, "Overview of EPN
Assembly Files".

Processor
configuration file

META-INF/wlevs

The processor configuration file is where the Oracle Event
Processing processor is defined. In this file you'll find
processor rules (defined in the Continuous Query
Language - CQL or the Event Processing Language--EPL)
and other component configuration settings.

For more information, see:

= Chapter 17, "Querying an Event Stream with Oracle
CQL"

= Chapter 19, "Querying an Event Stream with Oracle
EPL"

MANIFEST.MF file | META-INF

The manifest file contains metadata about your application
including its name, version, and dependencies, among
others.

For more information, see Chapter 23, "Assembling and
Deploying Oracle Event Processing Applications".

5.2 Creating Oracle Event Processing Projects

Development of an Oracle Event Processing application begins by creating a project to

hold all source code and related files.
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Projects correspond 1-to-1 with Oracle Event Processing applications and are the unit
of work that is associated with and deployed to a server instance. In concrete terms,
the output of a built project is a single OSGi bundle (JAR) containing the Oracle Event
Processing application.

5.2.1 How to Create an Oracle Event Processing Project

By default new projects are set to use Java 6.0. This section describes how to create an
Oracle Event Processing project using Java 6. For information on configuring an Oracle
Event Processing project to use Java 6, see Section 4.4, "Configuring Eclipse".

Note: By default, the Overview view of the Eclipse manifest editor
provides a link to launch the OSGi framework for testing the plugin.
When you've created an Oracle Event Processing project using an
application template, launching the framework is not supported.

To create an Oracle Event Processing project:
1. Open the EPN Editor (see Section 7.1, "Opening the EPN Editor")

2. Select File > New Project.
The New Project - Select a Wizard dialog appears as shown in Figure 5-2.

Figure 5-2 New Project - Select a Wizard Dialog

8] New Project (=] [

Select a wizard —

Wizards:
type filter text

> [ Eclipse Modeling Framework -
. (= BB
> = Java
[~ Java EE
s [ JavaScript
: (= JAXB
> (= IPA
(== Oracle Event Processing
@ Oracle Event Processing Application Project

[

m

: (= Plug-in Development
> = Web
> = Examples L

o
'\?) < Back Finish

3. Expand Oracle Event Processing and select Oracle Event Processing Application
Project.

4. Click Next.

The New Oracle Event Processing Application Project wizard appears as shown in
Figure 5-3.
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Figure 5-3 New Oracle Event Processing Application Project Wizard: Create an Oracle
Event Processing Application

E.] New Oracle Event Processing Application Project [ C1 i:hl

Create an Oracle Event Processing Application.

Create an Oracle Event Processing Application Project. \y

Project name:  MyCEPProj

Use default location

Location: Checlipse_workspaces\oep_projects\MyCEPProj Browse...

Target Runtime

Oracle Event Processing v11.1 '] l New... I
'C?j' [ < Back ” MNext = [\L Finish

5. Configure the Create an Oracle Event Processing Application dialog as shown in
Table 5-2.

Table 5-2 Create an Oracle Event Processing Application Dialog

Attribute Description

Project name The name of your Oracle Event Processing project. This name
will be used as the default name of your application when it is
deployed to the Oracle Event Processing server.

Location The directory in which your project is stored.

By default your project is located inside the Eclipse workspace
directory.

To keep your workspace and source code control directories
separate, clear Use default location and click Browse to place
the project in a directory outside of your workspace.

Target Runtime The Oracle Event Processing server you will deploy your project
to.

6. Click Next.

The Oracle Event Processing Application Content dialog appears as shown in
Figure 5-4.
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Figure 5-4 New Oracle Event Processing Application Project Wizard: Oracle Event
Processing Application Content

E.] New Oracle Event Processing Application Project [ C1 i&]
Oracle Event Pr ing Application Content
Enter the data required to create application. \y

Bundle Properties
Bundle ID: ity CEPProf]

Bundle Version:  1.0.0

Bundle Name: My CEPProj

Bundle Provider:
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7. Optionally, configure the Oracle Event Processing Application Content dialog as
shown in Table 5-3.

Table 5-3 Oracle Event Processing Application Content Dialog

Attribute Description

Bundle ID The unique ID that distinguishes this application’s OSGi bundle from those
deployed to the target runtime.

Bundle Version  The version of this instance of this OSGi bundle.
Bundle Name The name of this application’s OSGi bundle.

Bundle Provider The name of the provider for this application’s OSGi bundle (optional).

8. Click Next.
The Template dialog appears as shown in Figure 5-5.
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Figure 5-5 New Oracle Event Processing Application Project Wizard: Template Dialog

10.

11.

E.] New Oracle Event Processing Application Project l = iz-]

New Oracle Event Processing Application Project
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Processing Application

[¥] Create an Oracle Event Processing Application using an application template

Templates:
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Optionally, select an Oracle Event Processing application template to pre-populate
your project with the content that the template specifies.

Click Finish.

The Oracle Event Processing IDE for Eclipse creates the Oracle Event Processing
project.

Optionally, create additional EPN assembly files and component configuration
files.

By default, Oracle Event Processing IDE for Eclipse creates one EPN assembly file
and one component configuration file for your project. Optionally, you may
choose to define and configure Oracle Event Processing objects in multiple EPN
assembly and component configuration files to improve management, concurrent
development, and re-use.

For more information, see:
= Section 5.3, "Creating EPN Assembly Files"

= Section 5.4, "Creating Component Configuration Files"

5.3 Creating EPN Assembly Files

You use the Event Processing Network (EPN) assembly file to declare the components
that make up your Oracle Event Processing application and how they are connected to
each other. You also use the file to register event types of your application, as well as
the Java classes that implement the adapter and POJO components of your
application.

For an example of an EPN assembly file, see the Section 2.8, "Foreign Exchange (FX)
Example". For additional information about Spring and OSGi, see Appendix A,
"Additional Information about Spring and OSGi."
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5.3.1 How to Create a New EPN Assembly File Using Oracle Event Processing IDE for

Eclipse

The most efficient and least error-prone way to create and edit the EPN file is using the
New File Wizard in the Oracle Event Processing IDE for Eclipse.

For more information, see:

Section 7.2, "EPN Editor Overview"

Section 5.7, "Managing Libraries and Other Non-Class Files in Oracle Event

Processing Projects"

To create a new EPN assembly file using Oracle Event Processing IDE for
Eclipse:

1.

Create an Oracle Event Processing project.

See Section 5.2, "Creating Oracle Event Processing Projects".

By default, Oracle Event Processing IDE for Eclipse creates one EPN assembly file
for your project. Optionally, you may choose to define Oracle Event Processing
objects in multiple EPN assembly files to improve management, concurrent

development, and re-use.

To optionally create additional EPN assembly files:

a. Select File > New > Other.

The New dialog appears as Figure 5-6 shows.

Figure 5-6 New Dialog

& New [E=EET)

Select a wizard e

Wizards:

type filter text

> [ Java Emitter Templates -
> [ JavaScript
» = JAXE
> = JPA
4 [~ Oracle Event Processing
i Oracle Event Processing Application Configuration File
Q Oracle Event Processing Application Project

m

:ﬁ’ Oracle Event Processing Assembly File
> [ Plug-in Development
> [ Remote System Explorer
- == Server
> [= 5QL Development -

I

b. Expand Oracle Event Processing and select Oracle Event Processing

Assembly File.
c. Click Next.

The New OEP Assembly File dialog appears as Figure 5-7 shows.
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Figure 5-7 New OEP Assembly File Dialog

1) New OEP Assembly File (=B ez

New OEP Assembly File

Create a new OEP assembly file.
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Sy CEPProj/META-INF/spring

124 MyCEPProj
(= .settings
(= build
(= META-INF

= spring
= wlevs
(= src

File name: = com.oracle.oep.example.myfontest.xml

'@:l < Back Mext = | Finish N | Cancel |

d. Configure the New OEP Assembly File dialog as shown in Table 5-4.

Table 5-4 New OEP Assembly File Dialog

Attribute Description

Enter or select the parent Enter the fully qualified path to the folder in which Oracle Event
folder Processing IDE for Eclipse will create the EPN assembly file or
use the file system navigation controls to select the folder.

File name Enter the name of the new EPN assembly file.

e. Click Finish.
3. Open the EPN editor.
See Section 7.1, "Opening the EPN Editor".

4. If you created multiple EPN assembly files, you can select the EPN assembly file
you want to work on using the EPN Editor Filter pull-down menu.

This lets you focus on just the subset of the EPN that the selected EPN assembly
file represents.

To see the union of all components in all EPN assembly files, select Full EPN from
the EPN Editor Filter pull-down menu.

For more information, see Section 7.2.2, "Filtering".
5. Create and connect nodes on the EPN.

See Section 7.4, "Using the EPN Editor".

5.4 Creating Component Configuration Files

You use a component configuration file to configure the components that make up
your Oracle Event Processing application.
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For an example of a component configuration file, see the Section 2.8, "Foreign
Exchange (FX) Example".

5.4.1 How to Create a New Component Configuration File Using Oracle Event
Processing IDE for Eclipse

The most efficient and least error-prone way to create and edit a component
configuration file is using the New File Wizard in the Oracle Event Processing IDE for
Eclipse.

For more information, see:
s Section 7.2, "EPN Editor Overview"

= Section 5.7, "Managing Libraries and Other Non-Class Files in Oracle Event
Processing Projects"

To create a new component configuration file using Oracle Event Processing IDE
for Eclipse:

1. Create an Oracle Event Processing project.
See Section 5.2, "Creating Oracle Event Processing Projects".

By default, Oracle Event Processing IDE for Eclipse creates one component
configuration file for your project. Optionally, you may choose to configure Oracle
Event Processing objects in multiple component configuration files to improve
management, concurrent development, and re-use.

2. To optionally create component configuration files:
= Select File > New > Other.

The New dialog appears as Figure 5-8 shows.

Figure 5-8 New Dialog
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= Expand Oracle Event Processing and select Oracle Event Processing
Application Configuration File.

Oracle Event Processing IDE for Eclipse Projects 5-9



Exporting Oracle Event Processing Projects

s Click Next.

The New OEP Application Configuration File dialog appears as Figure 5-9
shows.

Figure 5-9 New OEP Application Configuration File Dialog
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= Configure the New OEP Assembly File dialog as shown in Table 5—4.

Table 5-5 New OEP Configuration File Dialog

Attribute Description

Enter or select the parent Enter the fully qualified path to the folder in which Oracle Event

folder Processing IDE for Eclipse will create the component
configuration file or use the file system navigation controls to
select the folder.

File name Enter the name of the new component configuration file.

»  Click Finish.
3. Open the EPN editor.

See Section 7.1, "Opening the EPN Editor".
4. Create and connect nodes on the EPN.

See Section 7.4, "Using the EPN Editor".

5.5 Exporting Oracle Event Processing Projects

Exporting an Oracle Event Processing project builds the project into an OSGi bundle
that can be deployed to a production Oracle Event Processing server.
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5.5.1 How to Export an Oracle Event Processing Project

This section describes how to export an Oracle Event Processing project into an OSGi
bundle.

To export an Oracle Event Processing project:
1. Start the Oracle Event Processing IDE for Eclipse and open your Oracle Event
Processing project.

2. The Oracle Event Processing IDE for Eclipse compiles and adds Java resources to
the exported JAR automatically. If your project contains other resources (such as a
manifest file or images), configure your project to export them:

a. Locate the build.properties file in the Project Explorer and double-click
this file to edit it.

The build.properties file opens as shown in Figure 5-10.

Figure 5-10 Oracle Event Processing Project build.properties File

5k EPM: Helloworld |od *build, properties 23 =0
@ Build Configuration @

[ custom Ewild

Runtime Information
Define the libraries, specify the order in which they should be built, and list the source Folders that should be compiled into each
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&[] e settings
] (= META-INF

~ 7 [¥] .classpath »
7 1% .project

4] = buid #-[] (= settings
~[][mb build. properties -] = META-INF
[ 48] build.xml -] buid
|Z| bundle.properties [ |mb build. properties
[ dist [ 58] build. el
[ DB images |:| = bundle.properties
\ £, example-resource jpg &= dist
e % - +-[] = images w
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Build | build. properties

b. In the Binary Build area, check the resources you want exported with your
application.

3. Select File > Export.
The Export dialog appears.

4. Expand the Oracle Event Processing option and select Oracle Event Processing
Applications.

5. Click Next.

The Oracle Event Processing Applications Export: Select Project dialog appears as
shown in Figure 5-11.
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Figure 5-11 Oracle Event Processing Applications Export: Select Project Dialog

@ Oracle Event Processing Applications [ S X"
Oracle Event Processing Applications
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6. Configure the Oracle Event Processing Applications Export: Select Project dialog
as shown in Table 5-6.

Table 5-6 Oracle Event Processing Application Content Dialog

Attribute Description

Available Projects The list of Oracle Event Processing projects available for export.
Check the project or projects you want to export.

Each project will be exported to a JAR file with the name given
in the Output File column. The name of the bundle that will be
exported conforms to the OSGi bundle naming conventions,
using the bundle ID and the bundle version in the JAR name.

Directory The directory in which Oracle Event Processing project JAR files
are exported.

Click Browse to choose this directory.

Overwrite existing files Check this option to overwrite existing JAR files with the same
without warning name in the selected directory.

7. Click Finish.

Your project, its Java resources, and any binary resources you selected are
exported to the project JAR file.

8. Deploy the JAR file to your Oracle Event Processing server.

a. If your JARis an application, see Section 6.3.6, "How to Deploy an Application
to an Oracle Event Processing Server".

b. If your JAR is an application library, see Section 23.1.3, "Application Libraries"
9. Deploy other dependent resources, if any, to your Oracle Event Processing server.

For example:
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s Other OSGi bundles your application depends on.

Deploy these bundles on the Oracle Event Processing server using the Oracle
Event Processing Visualizer or command line deployment tools.

= Any entries in config.xml for datasources that are referenced from within
the application.

Add these entries to the target server's config.xml file.

5.6 Upgrading Projects

When upgrading Oracle Event Processing from one version to another, it may be
necessary to make changes to your existing Oracle Event Processing projects.

This section describes:
= Section 5.6.1, "How to Upgrade Projects from Oracle Event Processing 2.1 to 10.3"

= Section 5.6.2, "How to Upgrade Projects from Oracle Event Processing 10.3 to 11g
Release 1 (11.1.1)"

For more information, see:
= Section 4.4, "Configuring Eclipse"
»  Oracle Fusion Middleware Getting Started Guide for Oracle Event Processing

5.6.1 How to Upgrade Projects from Oracle Event Processing 2.1 to 10.3

While project structure has stayed the same since 2.1, the data stored in Oracle Event
Processing Projects has changed significantly. It is therefore necessary to take steps to
upgrade 2.1 projects manually before continuing their development in 10.3.

The following outlines the steps necessary to upgrade 2.1 projects to 10.3

To upgrade projects from Oracle Event Processing 2.1 to 10.3:

1. Open your Oracle Event Processing 2.1 project in Oracle Event Processing IDE for
Eclipse.

2. Select File > Switch Workspace > Other.
The Workspace Launcher dialog appears.

Note: Do not choose to copy settings from the current workspace.

3. Click Browse and select a new workspace directory.
Eclipse exits and restarts using the new workspace.
4. Select File > Import.
The Import Dialog appears.
5. Expand the General option and select Existing Projects into Workspace.
6. Click Next.
The Import Projects dialog appears.

7. Use the Import Projects dialog to import your 2.1 projects into the new workspace.
Optionally, choose to copy the project files into your new workspace.
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8. For each project, change the project facet version as follows:
a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 5-12.

Figure 5-12 Project Properties Dialog: Project Facets
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b. Select the Project Facets option.

The Project Facet properties are displayed as Figure 5-12 shows.
c. Click Modify Project.

The Modify Faceted Project dialog appears shown in Figure 5-13.
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Figure 5-13 Modify Faceted Project
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d. For the Oracle Event Processing facet, select 10.3 from the Version pull-down

menu.
e. Click Finish.
f. Click OK.

g. Repeat for the next project.
9. Create a new Oracle Event Processing server runtime:
a. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 5-14.
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Figure 5-14 Preferences Dialog
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b. Expand the Server option and select Installed Runtimes.

¢. Add anew 10.3 Oracle Event Processing server runtime as Section 6.2.3, "How
to Create an Oracle Event Processing Server Runtime" describes.

d. Click OK.

10. For each project, specify the new 10.3 Oracle Event Processing server runtime you
created:

a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 5-15.
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Figure 5-15 Project Properties Dialog: Targeted Runtimes
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b. Select the Targeted Runtimes option.

The Targeted Runtimes properties are displayed as Figure 5-15 shows.

c. Check the new Oracle Event Processing 10.3 targeted runtime you created.

d. Click OK.

e. Repeat for the next project.

11. For each project update the project builders:

a. Right-click the project and select Open EPN Editor.

b. If the EPN diagram opens without error, proceed to step 12.

c. If the EPN diagram opens with the error shown in Figure 5-16, click the
Configure Builder button.

Oracle Event Processing IDE for Eclipse Projects 5-17



Upgrading Projects

Figure 5-16 Builder Error

| hella.context. xml ) EPN: hella 23 =8
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The EPN cannot be displaved because the Oracle CEP build is configured in an invalid order,
Click. the button below to reconfigure the builder in the correct order,

Configure Builder

Overview | Event Types

The EPN diagram is displayed.
d. Repeat for the next project.
12. Validate build inclusions:

If your application bundle is using bundle localization and has substitution
variables in its MANIFEST . MF file such as:

Bundle-Name: $project.name
Then your project root directory’s build.properties file element

bin.include must contain a reference to your bundle.properties file such
as:

bin.includes = META-INF/,\
bundle.properties, \

13. Perform source changes, if necessary.
For more information, see:

s "Upgrading a WebLogic Event Server 2.0 Application to Run on Oracle Event
Processing 10.3" in the Oracle Fusion Middleware Getting Started Guide for Oracle
Event Processing

»  Oracle Event Processing Release Notes for 10.3
(http://download.oracle.com/docs/cd/E13157_
01/wlevs/docs30/notes/notes.html)

After performing these steps, you should do a clean build of your project.

5.6.2 How to Upgrade Projects from Oracle Event Processing 10.3 to 11g Release 1
(11.1.1)

While project structure has stayed the same since 10.3, the data stored in Oracle Event
Processing Projects has changed significantly. It is therefore necessary to take steps to

upgrade 10.3 projects manually before continuing their development in 11g Release 1

(11.1.7).
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The following outlines the steps necessary to upgrade 10.3 projects to 11g Release 1
(11.1.1)

To upgrade projects from Oracle Event Processing 10.3 to 11g Release 1 (11.1.1)

1. Open your Oracle Event Processing 10.3 project in Oracle Event Processing IDE for
Eclipse.

2. Select File > Switch Workspace > Other.
The Workspace Launcher dialog appears.

3. Click Browse and select a new workspace directory.

Note: Do not choose to copy settings from the current workspace.

Eclipse exits and restarts using the new workspace.
4. Select File > Import.

The Import Dialog appears.
5. Expand the General option and select Existing Projects into Workspace.
6. Click Next.

The Import Projects dialog appears as shown in Figure 5-17.

Figure 5-17 Import Projects Dialog
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7. Use the Import Projects dialog to import your 10.3 projects into the new
workspace. Optionally, choose to copy the project files into your new workspace.

8. For each project, change the project facet version as follows:

a. Right-click your project and select Properties.
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The Project Properties dialog appears as shown in Figure 5-12.

Figure 5-18 Project Properties Dialog: Project Facets
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b. Select the Project Facets option.

The Project Facet properties are displayed as Figure 5-12 shows.
c. Click Modify Project.

The Modify Faceted Project dialog appears shown in Figure 5-13.
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Figure 5-19 Modify Faceted Project
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d. For the Java facet, select 6.0 from the Version pull-down menu.

e. For the Oracle Event Processing facet, select 11.1 from the Version pull-down

menu.
f. Click Finish.
g. Click OK.

h. Repeat for the next project.
9. Create a new Oracle Event Processing server runtime:
a. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 5-14.
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Figure 5-20 Preferences Dialog
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b. Expand the Server option and select Installed Runtimes.

c. Add anew 11.0 Oracle Event Processing server runtime as Section 6.2.3, "How
to Create an Oracle Event Processing Server Runtime" describes.

d. Click OK.

10. For each project, specify the new 11.0 Oracle Event Processing server runtime you
created:

a. Right-click your project and select Properties.

The Project Properties dialog appears as shown in Figure 5-15.
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Figure 5-21 Project Properties Dialog: Targeted Runtimes
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b. Select the Targeted Runtimes option.

The Targeted Runtimes properties are displayed as Figure 5-15 shows.

c. Check the new Oracle Event Processing 11.0 targeted runtime you created.

d. Click OK.

e. Repeat for the next project.

11. For each project update the project builders:

a. Right-click the project and select Open EPN Editor.

b. If the EPN diagram opens without error, proceed to step 12.

c. If the EPN diagram opens with the error shown in Figure 5-16, click the
Configure Builder button.
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Figure 5-22 Builder Error

| hella.context. xml ) EPN: hella 23

Filter: = Full EPM G| 100%

The EPN cannot be displaved because the Oracle CEP build is configured in an invalid order,

Click. the button below to reconfigure the builder in the correct order,

Configure Builder

Overview | Event Types

The EPN diagram is displayed.
d. Repeat for the next project.
12. Select Window > Preferences.

The Preferences dialog appears as shown in Figure 5-23.
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Figure 5-23 Preferences Dialog
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13. Select the Validation option.

14. Ensure that the following validation options are checked:
s CQL Validator
= EPN Validator
= XML Validator

15. Clear all other options.

16. Click OK.

17. Validate build inclusions:

If your application bundle is using bundle localization and has substitution
variables in its MANIFEST . MF file such as:

Bundle-Name: $project.name

Then your project root directory’s build.properties file element
bin.include must contain a reference to your bundle.properties file such
as:

bin.includes = META-INF/,\
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bundle.properties, \

18. Perform source changes, if necessary.

For more information, see:

s "Upgrading an Oracle Event Processing 10.3 Application to Run on Oracle
Event Processing Release 11gR1 (11.1.1)" in the Oracle Fusion Middleware
Getting Started Guide for Oracle Event Processing

5.7 Managing Libraries and Other Non-Class Files in Oracle Event
Processing Projects

Many projects require the use of non-class files such as libraries or property files that
were obtained from a source other than the project itself, whether that be third party
libraries, internal libraries created in other projects, or otherwise.

You can add the following non-class files to an Oracle Event Processing project, each
with its own packaging and deployment characteristics:

Standard JAR Files: Adding a standard JAR file to a project makes for the easiest
management of the library. The library is packaged directly with the project by the
Oracle Event Processing IDE for Eclipse and you can check the library into a
source code control system as part of the project.

For more information, see:

= Section 5.7.1, "How to Add a Standard JAR File to an Oracle Event Processing
Project"

= Section 5.7.2, "How to Add an OSGi Bundle to an Oracle Event Processing
Project"

s Section 5.7.3, "How to Add a Property File to an Oracle Event Processing
Project"

s Section 5.7.4, "How to Export a Package"
= Section 5.7.5, "How to Import a Package"
= Section 23.2.2.2.2, "Accessing Third-Party JAR Files Using -Xbootclasspath"

OSGi Bundles: If your library is already packaged as an OSGi bundle and you
would like to deploy it to the server once (allowing multiple applications to
reference it), you can use the OSGi bundle library option. Note that this leaves
some parts of deployment to the user since the OSGi bundle is not automatically
packaged with the application. It can also make working in team environments a
little more difficult because each developer must have the bundle in the DOMATN_
DIR/servername/modules directory of their machine, rather than have it
source controlled with the rest of the project.

The main advantage of the OSGi bundle library option is that you can use the
Oracle Event Processing server application library to manage OSGi bundle
libraries to ensure that they are deployed before any applications that depend on
them.

For more information, see:

s Section 5.7.2, "How to Add an OSGi Bundle to an Oracle Event Processing
Project"

»  Section 23.1.3, "Application Libraries"
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»  Property Files: Adding a Java property file to a project allows you to manage
properties efficiently. You can add a Java property file to an Oracle Event
Processing project so that the property file is deployed with your application and
is available at runtime.

For more information, see:

s Section 5.7.3, "How to Add a Property File to an Oracle Event Processing
Project"”

»  Section 1.4.2.1, "Accessing Component and Server Configuration Using the
ConfigurationPropertyPlaceholderConfigurer Class"

5.7.1 How to Add a Standard JAR File to an Oracle Event Processing Project

If the library you need to use is a standard JAR file, you can add it to your Oracle
Event Processing project. Alternatively, you can add a library as an OSGi bundle (see
Section 5.7.2, "How to Add an OSGi Bundle to an Oracle Event Processing Project").

When you add a standard JAR file to an Oracle Event Processing project, you can
optionally expose some or all of its packages to other bundles that will depend on this
bundle.

To add a standard JAR file to an Oracle Event Processing project:

1. Create a folder in your Oracle Event Processing IDE for Eclipse project to put the
JAR file in.

Oracle recommends that you create a folder to put them in such as 1ib.
To create a new folder, right-click your project folder and select New > Folder.

2. Outside of the Oracle Event Processing IDE for Eclipse, copy your JAR file into the
lib folder.

3. Inside the Oracle Event Processing IDE for Eclipse, right-click the 1ib folder and
select Refresh.

The JAR file appears in the 1ib folder as Figure 5-24 shows.

Figure 5-24 Oracle Event Processing IDE for Eclipse lib Directory
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[ build

== dist
(== META-INF

(2= spring

B2 wlews

|=| MANIFEST.MF

|m8 build, properties

E bundle. properties

startDataFeed. crd

4. Expand the META-INF directory and right-click the MANIFEST . MF file and select
Open With > Plug-in Manifest Editor.
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The Manifest Editor opens as Figure 5-25 shows.

Figure 5-25 Manifest Editor: Build Tab
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} Extra Classpath Entries

COverview Dependencies | Runtime | Build | MAMIFEST.MF | build. properties

5. Click the Build tab.

6. Add your JAR file to the binary build under the project root as follows:
s In the Binary Build area, expand the 1ib directory.
»  Check the box next to your library as Figure 5-25 shows.
»  Press hit CTRL-SHIFT-S to save all files.

This edits the build.properties file in your project, and tells the Oracle
Event Processing IDE for Eclipse to add the JAR file to your bundle when you
build the bundle JAR.

7. In the Manifest Editor, click the Runtime tab.

The Runtime tab appears as Figure 5-26 shows.

5-28 Developer's Guide for Oracle Event Processing



Managing Libraries and Other Non-Class Files in Oracle Event Processing Projects

Figure 5-26 Manifest Editor - Runtime Tab
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Overview Dependencies | Runtime | Build | MANIFEST.MF | build, properties

8. Add the JAR file to your project's classpath as follows:
s In the Manifest Editor, click the Add button.

The JAR Selection dialog appears as shown in Figure 5-27.

Figure 5-27 JAR Selection Dialog
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(= dist
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= Select the JAR you want to add to the bundle.

In this example, expand the lib directory and select the javax.jws_2.0.jar
file.

s Click OK.
This adds the selected JAR to the Classpath list as Figure 5-28 shows.

Figure 5-28 Manifest Editor Runtime tab After Adding a JAR to the Classpath
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Exported Packages Classpath
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Tewm

Remove

p

Total: 0

Owerview Dependencies | Runtime | Build | MAMIFEST.MF | build. properties

»  Press hit CTRL-SHIFT-S to save all files.
This edits the MANIFEST . MF file, putting the JAR on your project classpath.

To confirm this, in the Manifest Editor, click the MANIFEST.MF tab and note
that the JAR is now listed under the Bundle-Classpath property as
Figure 5-29 shows.
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Figure 5-29 Manifest Editor MANIFEST.MF Tab
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Note also that the JAR now appears as a library at the root of the project as
Figure 5-30 shows.

Figure 5-30 Package Explorer
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9. Optionally, if your bundle needs to export packages from this JAR to other
bundles that will depend on this bundle, then you can export these packages as
Section 5.7.4, "How to Export a Package" describes.
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5.7.2 How to Add an OSGi Bundle to an Oracle Event Processing Project

If the library you need to use is an OSGi bundle, you can add it to your Oracle Event
Processing project. Alternatively, you can add a library as a standard JAR file (see
Section 5.7.1, "How to Add a Standard JAR File to an Oracle Event Processing
Project").

To add an OSGi bundle to an Oracle Event Processing project, you add the bundle to
that bundle's dependencies definition.

Note: This process only makes the referenced bundle available to
your project at build time. It does not package the bundle directly
with your application when it is deployed or exported. Instead, this
bundle must be deployed to the Oracle Event Processing server
manually. For more information, see Section 23.1.3, "Application
Libraries".

To add an OSGi bundle to an Oracle Event Processing project:

1. Place the OSGi bundle in the DOMAIN DIR/servername/modules directory,
where DOMAIN_ DIR refers to the domain directory such as /oracle_cep/user_
projects/domains/mydomain and servername refers to the server instance,
such as myserver. For example:

c:\oracle_cep\user_projects\domains\mydomain\myserver\modules

2. Start the Oracle Event Processing IDE for Eclipse.
3. Right-click the project and select Refresh Targeted Runtime.

4. Right-click the META-INF/MANIFEST . MF file and select Open With > Plug-in
Manifest Editor.

The Manifest Editor opens as Figure 5-31 shows.

Figure 5-31 Manifest Editor: Dependencies Tab
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5.
6.

Click the Dependencies tab.
In the Required Plug-ins area, click Add.

The Plug-in Selection dialog appears as shown in Figure 5-32.

Figure 5-32 Plug-in Selection Dialog
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Select the bundle you added to the DOMAIN_DIR/servername/modules
directory of your Oracle Event Processing server installation directory in step 1
and click OK.

The selected bundle appears in the Require-Bundle section of the MANIFEST . MF
file.

5.7.3 How to Add a Property File to an Oracle Event Processing Project

You can add a Java property file to an Oracle Event Processing project so that the
property file is deployed with your application and is available at runtime.

To add a property file to an Oracle Event Processing project:
1.

Create a folder in your Oracle Event Processing IDE for Eclipse project to put the
property files in.

Oracle recommends that you create a folder to put them in such as properties.
To create a new folder, tight-click your project folder and select New > Folder.

Outside of the Oracle Event Processing IDE for Eclipse, copy your property file
into the properties folder.

Inside the Oracle Event Processing IDE for Eclipse, right-click the properties
folder and select Refresh.

The property file appears in the properties folder.

Expand the META-INF directory and right-click the MANIFEST . MF file and select
Open With > Plug-in Manifest Editor.

The Manifest Editor opens as Figure 5-33 shows.
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Figure 5-33 Manifest Editor: Build Tab
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5. Click the Build tab.

6. Add your property file to the binary build under the project root as follows:
s In the Binary Build area, expand the properties directory.
s Check the box next to your property file as Figure 5-33 shows.
s Press hit CTRL-SHIFT-S to save all files.

This edits the build.properties file in your project, and tells the Oracle
Event Processing IDE for Eclipse to add the property file to your bundle when
you build the bundle JAR.

7. You can access the properties file in Java code as Example 5-1 shows:

Example 5-1 Accessing a Properties File

public void onInsertEvent (Object event) {
if (event instanceof HelloWorldEvent) {

HelloWorldEvent helloWorldEvent = (HelloWorldEvent) event;

InputStream resourceAsStream = getClass () .getClassLoader () .getResourceAsStream (
"properties/test.properties"

)i

Properties props = new Properties();

try {
props.load (resourceAsStream) ;

} catch (IOException e) {
e.printStackTrace() ;

}

System.out.println("Message: " + props.get ("test-key"));

// Throw com.bea.wlevs.ede.api.EventRejectedException to have exceptions propagated
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// up to senders. Other errors will be logged and dropped.

5.7.4 How to Export a Package

Optionally, if your bundle needs to export a package from a JAR to other bundles that
will depend on this bundle, then you can export this package. By doing so, you update
the Package-Export MANIFEST entry to create an OSGi exporter for the package.

To export a package:

1. Inside the Oracle Event Processing IDE for Eclipse, expand the META-INF
directory as Figure 5-34 shows.

Figure 5-34 Oracle Event Processing IDE for Eclipse lib Directory
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2. Right-click the MANIFEST . MF file and select Open With > Plug-in Manifest
Editor.

The Manifest Editor opens as Figure 5-35 shows.
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Figure 5-35 Manifest Editor: Runtime tab
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3. Click the Runtime tab.

The Runtime tab appears as Figure 5-35 shows.

4. In the Exported Packages area, click the Add button.

The Package Selection dialog appears as Figure 5-36 shows.

Figure 5-36 Package Selection Dialog
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5. Select the package you want to export.
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To find a package in the list by name, type the name into the text field.

In this example, select the javax. jws . soap package.

6. Click OK.

The selected package is added to the Exported Packages area as Figure 5-37

shows.

Figure 5-37 Manifest Editor Runtime tab After Exporting a Package
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7. Press CTRL-SHIFT-S to save all files.

5.7.5 How to Import a Package

Optionally, if your bundle needs to import a package from a JAR, then you can import
this package. By doing so, you update the Package-Import MANIFEST entry to

create an OSGi importer for the package.

To import a package:

1. Inside the Oracle Event Processing IDE for Eclipse, expand the META-INF

directory as Figure 5-38 shows.
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5-38

Figure 5-38 Oracle Event Processing IDE for Eclipse lib Directory
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2. Right-click the MANIFEST . MF file and select Open With > Plug-in Manifest

Editor.

The Manifest Editor opens as Figure 5-39 shows.

Figure 5-39 Manifest Editor: Dependencies tab
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The Dependencies tab appears as Figure 5-39 shows.

4. In the Imported Packages area, click the Add button.

The Package Selection dialog appears as Figure 5-40 shows.
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Figure 5-40 Package Selection Dialog
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5. Select the package you want to import.

To find a package in the list by name, type the name into the text field.

In this example, select the javax. jws . soap package.

6. Click OK.

The selected package is added to the Import Packages area as Figure 5-41 shows.

Figure 541 Manifest Editor Dependencies tab After Importing a Package
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5.8 Configuring Oracle Event Processing IDE for Eclipse Preferences

You can configure various preferences to customize Oracle Event Processing IDE for
Eclipse to suit your needs, including:

= Section 5.8.1, "How to Configure Application Library Path Preferences"

= Section 5.8.2, "How to Configure Problem Severity Preferences"

5.8.1 How to Configure Application Library Path Preferences

You can define the path to an Oracle Event Processing server domain directory that
contains application libraries that extend the Oracle Event Processing runtime.

For more information, see Section 23.3.1, "How to Define the Application Library
Directory Using Oracle Event Processing IDE for Eclipse".

5.8.2 How to Configure Problem Severity Preferences

You can assign a severity to the various problems that Oracle Event Processing IDE for
Eclipse can detect in your Oracle Event Processing project and application.

You can configure these preferences for each project individually or you can configure

these preferences the same for all the projects in a given workspace.

To configure problem severity preferences:
1. Open the EPN Editor (see Section 7.1, "Opening the EPN Editor")

2. Select Window > Preferences.
The Preferences dialog appears.
3. Select Oracle Event Processing Problem Severities.

The Oracle Event Processing Problem Severities dialog appears as Figure 542
shows.
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Figure 5-42 Oracle Event Processing Problem Severities Dialog: Workspace
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4. Select a severity for each type of problem. You can select one of:

= Error: treat the problem as an error.

= Warning: treat the problem as a warning.

= Ignore:ignore the problem.

Table 5-7 describes each of the problem areas you can configure.
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Table 5-7 Oracle Event Processing Problem Severities

Category

Problem

Description

Cache Configuration

Unresolved cache loaders or
resolved loaders with incorrect
interface declarations.

Ensure that the assembly file contains a bean element that identifies
the cache loader class for each wlevs:cache-loader element and
ensure that the cache loader class implements the appropriate
interfaces.

For more information, see:

= Section 13.5.5.1, "Loading Cache Data from a Read-Only Data
Source"

Unresolved cache stores or
resolved stores with incorrect
interface declarations.

Ensure that the assembly file contains a bean element that identifies
the cache store class for each wlevs: cache-store element and
ensure that the cache store class implements the appropriate
interfaces.

For more information, see:

= Section 13.5.5.2, "Exchanging Data with a Read-Write Data
Source."

Event Processing

Configuration objects without

EPN configuration elements are linked to assembly definitions by

Network a matching assembly definition | name and ID, respectively. Validate that a configuration element has
a name that exactly matches an assembly element by ID within the
same application.

Configuration objects with Configuration elements in Oracle Event Processing configuration

duplicate name declarations. files are identified by a name. Validate that no two configuration
elements in an application have the same name.

Unresolved event listeners or An event processing network is built by defining how elements in

resolved listeners with the network pull or push to events to other elements in the

incorrect interface declarations | application. Validate that the target of an event push, a listener
declaration on an EPN assembly element, implements the interfaces
required to receive pushed events.

Unresolved event sources or An event processing network is built by defining how elements in

resolved sources with incorrect | the network pull or push to events to other elements in the

interface declarations application. Validate that the source of an event pull, a source
declaration on an EPN assembly element, implements the interfaces
required to provide pulled events.

Unresolved query selectors Given a channel with an upstream Oracle CQL processor that

configured for channels. defines more than one rule, ensure that the channel component
configuration file selector element contains only rule names of
the rules defined in the upstream Oracle CQL processor.

For more information, see Section D.87, "selector".

References to foreign stages Ensure that references to foreign stages can be resolved.

(sta%es Sefmed in external For more information, see Section 1.4.1.2, "Referencing Foreign

applications). Stages in an EPN Assembly File".

Channels not associated with Given a channel that does not have an upstream Oracle CQL

Oracle CQL processors missing | processor, ensure that the assembly file wlevs: channel element is

"event-type" declaration. configured with an event-type attribute.

For more information, see Chapter 10, "Connecting EPN Stages
Using Channels".

Deprecated EPN elements Oracle Event Processing provides backwards compatibility with
applications built for previous versions. Validate an application's use
of deprecated XML elements.

Event Type Repository | Event property type values that | Event types may be defined using dynamic Spring Beans through
are not predefined types or do | the properties element. The property values are limited to a
not resolve to a known class. fixed set of supported types. Validate that the property type is one

of these allowed types.
For more information, see Chapter 9, "Defining and Using Event
Types".

Query Validation Problems found validating Validate that the Oracle CQL statement in a processor configuration

CQL Statements

is correct given the current application. Verify property names, event
types, syntax, and other assembly-to-Oracle CQL references.
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Table 5-7 (Cont.) Oracle Event Processing Problem Severities

Category

Problem

Description

Problems preventing the
validation of CQL statements

Some fundamental application errors will keep a Oracle CQL
statement from being validated. For example, a processor
configuration must have a matching processor assembly definition
before any Oracle CQL requirements can be met. Verify that the
minimum requirements are met to validate a processor's Oracle CQL
statements.

CQL statements affected
directly or indirectly by
missing binding parameters.

Parameterized queries.

CQL statements in
disconnected processors (no

upstream channels in the EPN).

Ensure that all Oracle CQL processors are connected to an upstream
stage on the EPN. Without an upstream stage, the Oracle CQL
processor’s rules have no event stream to operate on.

Click Apply.
Click OK.
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Oracle Event Processing IDE for Eclipse and
Oracle Event Processing Servers

This chapter describes how to use the Oracle Event Processing IDE for Eclipse to create
and manage Oracle Event Processing servers to develop and debug event-driven
applications.

This chapter includes the following sections:

= Section 6.1, "Oracle Event Processing Server Overview"
m  Section 6.2, "Creating Oracle Event Processing Servers"

= Section 6.3, "Managing Oracle Event Processing Servers"

= Section 6.4, "Debugging an Oracle Event Processing Application Running on an
Oracle Event Processing Server"

6.1 Oracle Event Processing Server Overview

The Oracle Event Processing IDE for Eclipse provides features that allow you to set up
and manage Oracle Event Processing servers that are used during development. These
tools help you to:

= Configure instances of Oracle Event Processing servers
= Attach to external Oracle Event Processing server instances

= Manage Oracle Event Processing server lifecycle with start, stop, and debug
commands

= Associate applications with and deploy applications to Oracle Event Processing
servers during development

Table 6-1 maps Eclipse terminology used by the Oracle Event Processing IDE for
Eclipse to Oracle Event Processing server terminology.

Table 6—1 Eclipse and Oracle Event Processing Server Concepts

Oracle Event

Eclipse IDE Processing Server

Concept Concept Description

Runtime Oracle Event The Oracle Event Processing IDE for Eclipse has the concept of a
Processing server runtime. The runtime defines the location where the Oracle
installation Event Processing IDE for Eclipse can find the installation of a

particular Oracle Event Processing server. This information is
used to find JAR files and OSGi bundles to add to the project
classpath and to further define Servers and Server Instances.

Note that a Runtime is not itself a runnable artifact.
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Table 6-1 (Cont.) Eclipse and Oracle Event Processing Server Concepts

Eclipse IDE Processing Server
Concept Concept Description

Oracle Event

Server and Domain The Oracle Event Processing IDE for Eclipse uses the term
Server Instance Server to describe an actual runnable Oracle Event Processing

server instance. You can think of it as something that has start
scripts, for example. In Oracle Event Processing server
terminology, this equates to a Domain. When you set up a
server, you specify the domain that this instance will run.

For more information on domains, see:

N For more information, see "Administering Oracle Event
Processing Standalone-Server Domains" in the Oracle Fusion
Middleware Administrator’s Guide for Oracle Event Processing.

N For more information, see "Administering Oracle Event
Processing Standalone-Server Domains" in the Oracle Fusion
Middleware Administrator’s Guide for Oracle Event Processing.

Publish Deploy The Oracle Event Processing IDE for Eclipse typically uses the

term Publish to describe physically deploying an application to a
server.

Project Application or A project in the Oracle Event Processing IDE for Eclipse becomes

Deployment a single Oracle Event Processing application packaged as an
OSGi bundle. It is deployed to a server and shows in the Oracle
Event Processing server’s deployments . xml file.

Server definitions are the central concept in controlling an Oracle Event Processing
server from the Oracle Event Processing IDE for Eclipse. It is from the server definition
that you start and stop the server. After associating a project with the server, you can
publish (deploy) the application to and unpublish (undeploy) the application from the
server, all without having to leave the Oracle Event Processing IDE for Eclipse. For
more information, see Section 6.2, "Creating Oracle Event Processing Servers".

You can communicate with a running Oracle Event Processing server using Oracle
Event Processing IDE for Eclipse in the following ways:

Start a server from within Oracle Event Processing IDE for Eclipse.

In this case, the Oracle Event Processing server console is sent directly to the
console view in Oracle Event Processing IDE for Eclipse. All of the Oracle Event
Processing server features (such as start, stop, publish, unpublish, debug, and
launching the Oracle Event Processing Visualizer) are available. The Oracle Event
Processing server process itself is managed from within Oracle Event Processing
IDE for Eclipse. In other words, stopping the Oracle Event Processing server from
the Oracle Event Processing IDE for Eclipse will terminate the actual Oracle Event
Processing server process. Console messages from the Oracle Event Processing
server are sent to the Oracle Event Processing IDE for Eclipse Console view.

For more information, see:

- Section 6.3.1, "How to Start a Local Oracle Event Processing Server"
- Section 6.3.2, "How to Stop a Local Oracle Event Processing Server"
Attach to a running Oracle Event Processing server.

In this case, the user starts the Oracle Event Processing server from the command
line, then clicks the Start button for that server in Oracle Event Processing IDE for
Eclipse. A dialog is shown asking whether or not to attach and, if the user clicks
Yes, Oracle Event Processing IDE for Eclipse enters attached mode. All of the
Oracle Event Processing server features except debug are available. However, the
Oracle Event Processing server process is not managed by the Oracle Event
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Processing IDE for Eclipse. Clicking the Stop button simply disconnects from the
attached Oracle Event Processing server; it does not terminate the actual Oracle
Event Processing server process. Console messages from the Oracle Event
Processing server are sent to the Oracle Event Processing server console (standard
output to the terminal window in which it is running). Oracle Event Processing
IDE for Eclipse only shows limited Oracle Event Processing IDE for Eclipse
operation messages in the console view.

For more information, see:

- Section 6.3.3, "How to Attach to an Existing Local Oracle Event Processing
Server Instance"

- Section 6.3.5, "How to Detach From an Existing Oracle Event Processing Server
Instance"

6.2 Creating Oracle Event Processing Servers

Creating a server allows you to start and stop the server instance from within the
Oracle Event Processing IDE for Eclipse, as well as automatically deploy your
applications to that server.

You can create a local or remote Oracle Event Processing server:

Local server: a local Oracle Event Processing server is one in which both the server
and server runtime are on the same host

Remote server: a remote Oracle Event Processing server is one in which the server
and server runtime are on different hosts. The server is on a remote host and the
server runtime is on the local host (the host on which you are executing the Oracle
Event Processing IDE for Eclipse).

This section describes:

Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

Section 6.2.2, "How to Create a Remote Oracle Event Processing Server and Server
Runtime"

Section 6.2.3, "How to Create an Oracle Event Processing Server Runtime"

6.2.1 How to Create a Local Oracle Event Processing Server and Server Runtime

This section describes how to create both a local server and server runtime. After
creating the initial server and server runtime, you can create additional server
runtimes.

A local Oracle Event Processing server is one in which both the server and server
runtime are on the same host. Alternatively, you can create a remote server and server
runtime.
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Note: If the server you're creating in Eclipse is one you created from
a domain with the Configuration Wizard, be sure to run the server
from the command line before adding the server to your Eclipse
project. Doing so will ensure that all server artifacts are created. Also,
when specifying domain configuration information in the Eclipse
New Server wizard, be sure to click the Advanced tab to specify the
user name and password used when creating the domain.

For more information on running a server from the command line, see
"Starting and Stopping an Oracle Event Processing Server in a
Standalone-Server Domain" in Oracle Fusion Middleware
Administrator’s Guide for Oracle Event Processing.

For more information, see:
= Section 6.2.3, "How to Create an Oracle Event Processing Server Runtime"

= Section 6.2.2, "How to Create a Remote Oracle Event Processing Server and Server
Runtime"

To create a local Oracle Event Processing server and server runtime:
1. Select Window > Show View > Servers.

The Servers view appears as shown in Figure 6-1.

Figure 6—1 Oracle Event Processing IDE for Eclipse Server View

[Z! Markers | = Properties | 4k Servers 52 . 8 Data Source Explorer| [ Snippets =Rk
P P pp

New v | B Server
Properties Alt+Enter

2. Right-click in the Servers view pane and select New > Server.
3. Consider whether or not server runtimes have been created:

a. If this is the first time you have created an Oracle Event Processing server,
there will be no installed server runtimes. Proceed to step 4.

b. If this is not the first time you have created an Oracle Event Processing server,
there will be one or more installed server runtimes. Proceed to step 5.

4. If this is the first time you have created an Oracle Event Processing server, there
will be no installed server runtimes:

In this case, the New Server: Define New Server dialog appears as Figure 6-2
shows.
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Figure 6—2 New Server: Define New Server Dialog (No Installed Runtimes)
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Configure the new server as follows:

a. Configure the dialog as shown in Table 6-2.

Table 6—2 New Server: Define New Server Dialog (No Installed Runtimes) Attributes

Attribute Description

Server’s host name The host name of the computer on which you installed Oracle
Event Processing server.

For development, this will typically be localhost.
Select the server type The type of Oracle Event Processing server.

In this example, choose Oracle Event Processing v1l
Server name The name of this Oracle Event Processing server.

Default: Oracle Event Processing v11l.l1 at HOSTNAME

Where HOSTNAME is the value you entered in the Server’s host
name field.

b. Click Next.

The New Server: New Oracle Event Processing v11 Runtime dialog appears as
shown in Figure Figure 6-3.
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Figure 6-3 New Server: New Oracle Event Processing v11.1 Runtime Dialog
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c. Configure the dialog as shown in Table 6-3.

Table 6-3 New Server: New Oracle Event Processing v11 Runtime Dialog Attributes

Attribute Description

Oracle Middleware Home
Directory

The fully qualified path to the Oracle Event Processing server
installation directory. This is the same as the "Middleware
Home" that was selected when installing the server.

When selecting this directory, select the directory that contains
the Oracle Event Processing installation rather than the Oracle
Event Processing directory itself. For example, choose:

C:\OracleCEP

But do not choose:

C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle Event Processing installation directory.

For more information, see "Oracle Fusion Middleware Directory
Structure and Concepts" in the Oracle Fusion Middleware Getting
Started Guide for Oracle Event Processing.

JRE The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose a Java 6 JRE.

NOTE: The Oracle Event Processing server JRE is ultimately set
by the JAVA_HOME setting in setDomainEnv.cmd or
setDomainEnv. sh script in the server domain directory.
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d. Proceed to step 6.

5. If this is not the first time you have created an Oracle Event Processing server,
there will be one or more installed server runtimes.

In this case, the New Server: Define New Server dialog appears as Figure 64
shows.

Figure 6—-4 New Server: Define New Server (Installed Runtimes) Dialog
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Configure the dialog as shown in Table 6-4.

Table 6-4 New Server: Define New Server (Installed Runtimes) Dialog Attributes

Attribute Description

Server’s host name The host name of the computer on which you installed Oracle
Event Processing server.

For development, this will typically be localhost.
Select the server type The type of Oracle Event Processing server.

In this example, choose Oracle Event Processing v11l.
Server runtime Select the server runtime from the pull-down menu.

To create or edit server runtimes, click Installed Runtimes. For
more information, see Section 6.2.3, "How to Create an Oracle
Event Processing Server Runtime".

6. Click Next.

The New Server: New Oracle Event Processing v11.1 Server dialog appears as
Figure 6-5 shows.
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Figure 6-5 New Server: New Oracle Event Processing v11.1 Server
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A local server executes on this machine. In addition to deploying and undeploying
applications, you can also start, stop, and debug the local server process.

A remote server executes on a machine on a network accessible by this machine. Instead of
controlling the server process, you can only attach to an already running remote server. Java
debugging is not available for remote servers.

@ Local Server
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Select Local Server.

8. Click Next.

The New Server: New Oracle Event Processing v11 Server dialog appears as
Figure 6-6 shows.
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Figure 6—6 New Server: New Oracle Event Processing v11 Server Dialog for a Local

Server
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9. Click Advanced and configure the dialog as shown in Table 6-5.

Table 6-5 New Server: New Oracle Event Processing v11 Server Dialog Attributes for a

Local Server

Attribute

Description

Domain Directory

Start Script

Stop Script

The fully qualified path to the directory that contains the domain for
this server.

Click Browse to choose the directory.

Default: MIDDLEWARE _HOME\user_projects\domains\ocep_
domain\defaultserver.

The script that Oracle Event Processing IDE for Eclipse uses to start
the Oracle Event Processing server.

Default on UNIX: MIDDLEWARE_HOME/user_
projects/domains/ocep_
domain/defaultserver/startwlevs.sh

Default on Windows: MIDDLEWARE_HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.cmd

The script that Oracle Event Processing IDE for Eclipse uses to stop the
Oracle Event Processing server.

Default on UNIX: MIDDLEWARE_HOME/user_
projects/domains/ocep_
domain/defaultserver/stopwlevs.sh

Default on Windows: MIDDLEWARE_HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.cmd
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Table 6-5 (Cont.) New Server: New Oracle Event Processing v11 Server Dialog
Attributes for a Local Server

Attribute Description

Debug Port The Oracle Event Processing server port that Oracle Event Processing
IDE for Eclipse connects to when debugging the Oracle Event
Processing server.

Default: 8453.

User Name The user name Oracle Event Processing IDE for Eclipse uses when
logging into the Oracle Event Processing server.

Default: wlevs.

User Password The user password Oracle Event Processing IDE for Eclipse uses when
logging into the Oracle Event Processing server.

Default: wlevs.

Automatic Publishing By default, when you change an application, you must manually
publish the changes to the Oracle Event Processing server.

Select Use Workspace Default to configure Oracle Event Processing
IDE for Eclipse to automatically publish changes to the Oracle Event
Processing server.

Default: Disabled.

10. Click Finish.

11. If you configured Automatic Publishing to Use Workspace Default, select
Windows > Preferences.

12. Select the Server option.
13. Configure your automatic publishing options:

= Automatically publish to local servers: enable or disable this option, as
required.

Default: enabled.

— Publishing interval: configure the frequency at which the Oracle Event
Processing IDE for Eclipse publishes changes to the server (in seconds).

Default: 60 seconds.

= Automatically publish to remote servers: enable or disable this option, as
required.

Default: enabled.

— Publishing interval: configure the frequency at which the Oracle Event
Processing IDE for Eclipse publishes changes to the server (in seconds).

Default: 60 seconds.
14. Click OK.

6.2.2 How to Create a Remote Oracle Event Processing Server and Server Runtime

This section describes how to create both a remote server and server runtime. After
creating the initial server and server runtime, you can create additional server
runtimes.

A remote Oracle Event Processing server is one in which the server and server runtime
are on different hosts. The server is on a remote host and the server runtime is on the
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local host (the host on which you are executing the Oracle Event Processing IDE for
Eclipse).

Alternatively, you can create a local server and server runtime.
For more information, see:
= Section 6.2.3, "How to Create an Oracle Event Processing Server Runtime"

»  Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

To create a remote Oracle Event Processing server and server runtime:
1. Select Window > Show View > Servers.

The Servers view appears as shown in Figure 6-1.

Figure 6—7 Oracle Event Processing IDE for Eclipse Server View
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2. Right-click in the Servers view pane and select New > Server.
3. Consider whether or not server runtimes have been created:

a. If this is the first time you have created an Oracle Event Processing server,
there will be no installed server runtimes. Proceed to step 4.

b. If this is not the first time you have created an Oracle Event Processing server,
there will be one or more installed server runtimes. Proceed to step 5.

4. If this is the first time you have created an Oracle Event Processing server, there
will be no installed server runtimes:

In this case, the New Server: Define New Server dialog appears as Figure 6-2
shows.
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Figure 6-8 New Server: Define New Server Dialog (No Installed Runtimes)
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Configure the new server as follows:

a. Configure the dialog as shown in Table 6-2.

Table 66 New Server: Define New Server Dialog (No Installed Runtimes) Attributes

Attribute Description

Server’s host name The host name of the computer on which you installed Oracle
Event Processing server.

For development, this will typically be localhost.
Select the server type The type of Oracle Event Processing server.

In this example, choose Oracle Event Processing vll
Server name The name of this Oracle Event Processing server.

Default: Oracle Event Processing v11l.1 at HOSTNAME

Where HOSTNAME is the value you entered in the Server’s host
name field.

b. Click Next.

The New Server: New Oracle Event Processing v11 Runtime dialog appears as
shown in Figure Figure 6-3.
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Figure 6-9 New Server: New Oracle Event Processing v11.1 Runtime Dialog
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c. Configure the dialog as shown in Table 6-3.

Table 6-7 New Server: New Oracle Event Processing v11 Runtime Dialog Attributes

Attribute

Description

Oracle Middleware Home

Directory

JRE

The fully qualified path to the Oracle Event Processing server
installation directory. This is the same as the "Middleware
Home" that was selected when installing the server.

When selecting this directory, select the directory that contains
the Oracle Event Processing installation rather than the Oracle
Event Processing directory itself. For example, choose:

C:\OracleCEP

But do not choose:

C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle Event Processing installation directory.

For more information, see "Oracle Fusion Middleware Directory
Structure and Concepts" in the Oracle Fusion Middleware Getting
Started Guide for Oracle Event Processing.

The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose a Java 6 JRE.

NOTE: The Oracle Event Processing server JRE is ultimately set
by the JAVA_HOME setting in setDomainEnv.cmd or
setDomainEnv. sh script in the server domain directory.
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d. Proceed to step 6.

5. If this is not the first time you have created an Oracle Event Processing server,
there will be one or more installed server runtimes.

In this case, the New Server: Define New Server dialog appears as Figure 64
shows.

Figure 6-10 New Server: Define New Server (Installed Runtimes) Dialog
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Supports controlling Oracle Event Processing Servers. Allows starting/stopping the serve
and deploying applications.

Server's host name: * localhost
SErver name: Oracle Event Processing v11.1 at localhost
Server runtime environment: IOracIe Event Processing vil.1 >

Configure the new server as follows:

Table 6-8 New Server: Define New Server (Installed Runtimes) Dialog Attributes

Attribute Description

Server’s host name The host name of the computer on which you installed Oracle
Event Processing server.

For development, this will typically be localhost.
Select the server type The type of Oracle Event Processing server.

In this example, choose Oracle Event Processing v11.

Server runtime Select the server runtime from the pull-down menu.

To create or edit server runtimes, click Installed Runtimes. For
more information, see Section 6.2.3, "How to Create an Oracle
Event Processing Server Runtime".

6. Click Next.

The New Server: New Oracle Event Processing v11.1 Server dialog appears as
Figure 6-5 shows.
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Figure 6—-11 New Server: New Oracle Event Processing v11.1 Server

@ MNew Server l =] ﬁ]

Mew Oracle Event Processing v11.1 Server

Define a new Oracle Event Processing vl1.1 server \% |

A local server executes on this machine. In addition to deploying and undeploying
applications, you can also start, stop, and debug the local server process.

A remote server executes on a machine on a network accessible by this machine. Instead of

controlling the server process, you can only attach to an already running remote server. Java
debugging is not available for remote servers.

@ Local Server
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Select Remote Server.

Click Next.

The New Server: New Oracle Event Processing v11 Server dialog appears dialog
appears as Figure 6-12 shows.
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Figure 6—12 New Server: New Oracle Event Processing v11 Server Dialog for a Remote

Server
E.] New Server l El &]
New Oracle Event Processing v11.1 Server
Define a new Oracle Event Processing v11.1 server \y
Remote Server IP Address:  10.159.108.215
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9. Configure the dialog as shown in Table 6-9.

Table 6-9 New Server: Oracle Event Processing v11 Server Dialog Attributes for a Local
Server

Attribute Description

Remote Server IP Address The IP address of the remote Oracle Event Processing server.
Default: IP address of localhost.

Remote Server Port The port you specified in the remote Oracle Event Processing
server DOMAIN DIR/config/config.xml file that describes

your Oracle Event Processing domain, where DOMATIN_DIR
refers to your domain directory.

The port number is the value of the Port child element of the
Netio element:

<Netio>
<Name>NetIO</Name>
<Port>9002</Port>
</Netio>

Default: 9002

User Name The user name that the Oracle Event Processing IDE for Eclipse
uses to log into the remote server.

Default: wlevs

User Password The password that the Oracle Event Processing IDE for Eclipse
uses to log into the remote server.

Default: wlevs
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10. Click Finish.

6.2.3 How to Create an Oracle Event Processing Server Runtime

Before you can create a server, you must configure the Oracle Event Processing IDE for
Eclipse with the location of your Oracle Event Processing server installation by
creating a server runtime using the runtime wizard. You can access the runtime wizard
from several places including the new server wizard, the new project wizard, and the
workspace preferences dialog.

You only need to create a runtime explicitly if you have not yet created an Oracle
Event Processing server.

For more information, see:

»  Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

= Section 6.2.2, "How to Create a Remote Oracle Event Processing Server and Server

Runtime"

To create an Oracle Event Processing server runtime:
1. Select Windows > Preferences.

The Preferences dialog appears as Figure 6-13 shows.

Figure 6—-13 Preferences - Server - Installed Runtimes

p
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Oracle Event Processing =
> Plug-in Development
> Remote Systems
> Run/Debug
a Server
Audio
Launching
Profilers
Runtime Environme
> Team
Terminal

> Usage Data Collector
Validation -
4 m b

@ B

2. Expand the Server option and select Runtime Environments.
3. Click Add.

The New Server Runtime Environment dialog appears as shown in Figure 6-14.
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Figure 6—-14 New Server Runtime Environment Dialog
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4. Configure the dialog as shown in Table 6-10.

Table 6-10 New Server Runtime Dialog Attributes

Attribute Description
Select the type of runtime The type of Oracle Event Processing server.
environment

In this example, choose Oracle Event Processing v11.1.

Create a new local server Optionally, check this to create a new local server if you have not
yet created a server. For more information, see Section 6.2.1,
"How to Create a Local Oracle Event Processing Server and

Server Runtime".

5. Click Next.

The New Server Runtime Environment dialog appears as shown in Figure 6-15.
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Figure 6-15 New Server Runtime Environment: New Oracle Event Processing v11.1
Runtime Dialog
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6. Configure the dialog as shown in Table 6-11.

Table 6-11

New Server Runtime Dialog Attributes

Attribute

Description

Oracle Middleware Home

Directory

JRE

The fully qualified path to the Oracle Event Processing server
installation directory. This is the same as the "Middleware
Home" that was selected when installing the server.

When selecting this directory, select the directory that contains
the Oracle Event Processing installation rather than the Oracle
Event Processing directory itself. For example, choose:

C:\OracleCEP

But do not choose:
C:\OracleCEP\ocep_11.1

The runtime wizard will use the installation to find the
appropriate Oracle Event Processing installation directory.

For more information, see "Oracle Fusion Middleware Directory
Structure and Concepts" in the Oracle Fusion Middleware Getting
Started Guide for Oracle Event Processing.

The type of JRE to use.

Select the type of JRE to use from the pull-down menu or click
the Installed JRE preferences link to create a new JRE.

Be sure to choose either JRockit Real Time or the JRockit JDK
installed with your Oracle Event Processing installation.

7.

Click Finish.
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6.3 Managing Oracle Event Processing Servers

Using the Oracle Event Processing IDE for Eclipse and the Oracle Event Processing
Visualizer accessible from the Oracle Event Processing IDE for Eclipse, you can
manage many aspects of your Oracle Event Processing server during development.

This section describes the following Oracle Event Processing server management tasks
you can perform from the Oracle Event Processing IDE for Eclipse:

= Section 6.3.1, "How to Start a Local Oracle Event Processing Server"
= Section 6.3.2, "How to Stop a Local Oracle Event Processing Server"

= Section 6.3.3, "How to Attach to an Existing Local Oracle Event Processing Server
Instance”

= Section 6.3.4, "How to Attach to an Existing Remote Oracle Event Processing
Server Instance"

= Section 6.3.5, "How to Detach From an Existing Oracle Event Processing Server
Instance”

= Section 6.3.6, "How to Deploy an Application to an Oracle Event Processing
Server"

= Section 6.3.7, "How to Configure Connection and Control Settings for Oracle Event
Processing Server"

= Section 6.3.8, "How to Configure Domain (Runtime) Settings for Oracle Event
Processing Server"

= Section 6.3.9, "How to Start the Oracle Event Processing Visualizer from Oracle
Event Processing IDE for Eclipse”

6.3.1 How to Start a Local Oracle Event Processing Server

After you create a local server, you can start the Oracle Event Processing server from
the Oracle Event Processing IDE for Eclipse.

You can also start the local Oracle Event Processing server in debug mode.

Alternatively, you can start the local Oracle Event Processing server from the
command line and attach to it using Oracle Event Processing IDE for Eclipse.

For more information, see:

»  Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

= Section 6.4.1, "How to Debug an Oracle Event Processing Application Running on
an Oracle Event Processing Server"

= Section 6.3.3, "How to Attach to an Existing Local Oracle Event Processing Server

Instance"

To start a local Oracle Event Processing server:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 6-16.
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Figure 6-16 Starting an Oracle Event Processing Server
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2. Start the server by choosing one of the following;:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

After starting the server you will see log messages from the server in the Console
view.

6.3.2 How to Stop a Local Oracle Event Processing Server

After you start a local Oracle Event Processing server from the Oracle Event
Processing IDE for Eclipse, you can stop the Oracle Event Processing server from the
Oracle Event Processing IDE for Eclipse.

Note that stopping the Oracle Event Processing while Oracle Event Processing
Visualizer is running might produce console messages indicating that a service proxy
has been destroyed. This is generally an informational message only.

For more information, see Section 6.3.1, "How to Start a Local Oracle Event Processing
Server".

To stop a local Oracle Event Processing server:
1. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 6-17.

Figure 6-17 Stopping an Oracle Event Processing Server
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2. Stop the server by choosing one of the following:
a. Click the Stop the Server icon in the Servers view tool bar.

b. Right-click a server in the Servers view and select Stop.
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6.3.3 How to Attach to an Existing Local Oracle Event Processing Server Instance

After you create a local server, you can start the local Oracle Event Processing server
from the command line and attach Oracle Event Processing IDE for Eclipse to this
existing, already running local Oracle Event Processing server instance.

Alternatively, you can start the local Oracle Event Processing server directly from
within Oracle Event Processing IDE for Eclipse.

For more information, see:

m  Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

= Section 6.3.1, "How to Start a Local Oracle Event Processing Server"

To attach to an existing local Oracle Event Processing server instance:
1. Start the Oracle Event Processing server from the command line.

For more information, see "Starting and Stopping Oracle Event Processing Servers'
in the Oracle Fusion Middleware Administrator’s Guide for Oracle Event Processing.

2. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 6-16.

Figure 6—18 Attaching to an Existing Local Oracle Event Processing Server Instance
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3. Attach to the already running local server by choosing one of the following:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.
The Attach to Running OEP Server dialog appears.

4. Click Yes.

After attaching to the server you will not see log messages from the server in the
Console view.

You can view the server console using the Oracle Event Processing Visualizer. For
more information, see "How to View Console Output" in the Oracle Fusion
Middleware Visualizer User's Guide for Oracle Event Processing.

6.3.4 How to Attach to an Existing Remote Oracle Event Processing Server Instance

After you create a remote server, you can start the remote Oracle Event Processing
server from the command line and attach Oracle Event Processing IDE for Eclipse to
this existing, already running remote Oracle Event Processing server instance.
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For more information, see Section 6.2.2, "How to Create a Remote Oracle Event
Processing Server and Server Runtime".

To attach to an existing remote Oracle Event Processing server instance:

1.

Start the remote Oracle Event Processing server from the command line.

For more information, see "Starting and Stopping Oracle Event Processing Servers"
in the Oracle Fusion Middleware Administrator’s Guide for Oracle Event Processing.

Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 6-16.

Figure 6—19 Attaching to an Existing Remote Oracle Event Processing Server Instance
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Attach to the already running remote server by choosing one of the following:
a. Click the Start the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Start.

After attaching to the remote server, Oracle Event Processing IDE for Eclipse
writes one status message to the Console view, reading;:

[3/23/10 12:32 PM] Attached to remote OEP server at address 10.11.12.13 and
port 9002
You will not see log messages from the remote server in the Console view.

You can view the server console using the Oracle Event Processing Visualizer. For
more information, see "How to View Console Output" in the Oracle Fusion
Middleware Visualizer User's Guide for Oracle Event Processing.

6.3.5 How to Detach From an Existing Oracle Event Processing Server Instance

After you attach to an existing, running Oracle Event Processing server instance, you
can detach from the Oracle Event Processing server and leave it running.

For more information, see:

Section 6.3.3, "How to Attach to an Existing Local Oracle Event Processing Server
Instance"

Section 6.3.4, "How to Attach to an Existing Remote Oracle Event Processing
Server Instance”

To detach from an existing Oracle Event Processing server instance:

1.

Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 6-17.
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Figure 6-20 Stopping an Oracle Event Processing Server
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2. Detach from the server by choosing one of the following;:
a. Click the Stop the Server icon in the Servers view tool bar.
b. Right-click a server in the Servers view and select Stop.

Oracle Event Processing IDE for Eclipse detaches from the Oracle Event
Processing server instance. The Oracle Event Processing server instance continues
to run.

If you detach from a remote Oracle Event Processing server, Oracle Event
Processing IDE for Eclipse writes a log message to the Console view reading:

[3/23/10 12:47 PM] Server communication stopped

6.3.6 How to Deploy an Application to an Oracle Event Processing Server

A project in the Oracle Event Processing IDE for Eclipse is built as an Oracle Event
Processing application, then deployed to the server. To deploy an application, a server
must first be defined. To then deploy an application, simply add it to the server. The
application will be deployed immediately if the server is already started, or when the
server is next started if the server is stopped.

For more information, see:

»  Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

= Section 6.2.2, "How to Create a Remote Oracle Event Processing Server and Server
Runtime"

To deploy an application to an Oracle Event Processing server:

1. Create an Oracle Event Processing project (see Section 5.2, "Creating Oracle Event
Processing Projects").

2. Create a server (see Section 6.2.1, "How to Create a Local Oracle Event Processing
Server and Server Runtime").

3. Select Window > Show Views > Servers.

The Servers view opens as shown in Figure 6-21.
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Figure 6-21 Adding a Project to an Oracle Event Processing Server
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4. Right-click the server and select Add and Remove.

The Add and Remove dialog appears as shown in Figure 6-22.

Figure 6-22 Add and Remove Dialog
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5. Configure the dialog as Table 6-12 shows.

Table 6—-12 Add and Remove Dialog Attributes

Attribute Description

Available Select one or more projects from this list and click Add or Add
All to move them into the Configured list.
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Table 6-12 (Cont.) Add and Remove Dialog Attributes

Attribute Description

Configured Select one or more projects from this list and click Remove or
Remove All to move them into the Available list.

If server is started, publish ~ Check this option to immediately publish projects that you
changes immediately. modify. Applicable only if the server is already running.

6. Click Finish.

Once an application is added, it will show as a child of the server in the Servers
view as shown in Figure 6-23.

Figure 6-23 Server View After Adding a Project
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7. To deploy (publish) the application to the Oracle Event Processing server,
right-click the added application and select Force Publish.

a. If the Oracle Event Processing server is part of a standalone-server, domain the
application is deployed.

b. If the Oracle Event Processing server is part of a multi-server domain, the
Select Cluster Deployment Group Name dialog appears as Figure 6-24 shows.

Figure 6—24 Select Cluster Deployment Group Name Dialog
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Select the cluster deployment group you want to deploy the application to and
click OK.

For more information on clustering, see "Introduction to Multi-Server
Domains" in the Oracle Fusion Middleware Administrator’s Guide for Oracle Event
Processing.
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Once an application is deployed (published), it will show as a child of the server in
the Servers view as shown in Figure 6-25.

Figure 6-25 Server View After Deploying (Publishing) a Project
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6.3.7 How to Configure Connection and Control Settings for Oracle Event Processing

Server

After you create a server, you can use the Server Overview editor to configure all the
important server connection and control settings that Oracle Event Processing IDE for
Eclipse uses to communicate with the Oracle Event Processing server.

For more information, see:

= Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

= Section 6.3.8, "How to Configure Domain (Runtime) Settings for Oracle Event
Processing Server"

To configure connection and control settings for Oracle Event Processing
server:

1. Select Window > Show Views > Servers.
2. Double-click a server in the Servers view.

The Server Overview editor opens as shown in Figure 6-26.
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Figure 6-26 Server Overview Editor
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3. Configure the Server Overview editor as shown in Table 6-13.

Table 6-13 Server Overview Editor Attributes

Attribute

Description

Server Name

Host Name

Runtime Environment

Domain Directory’

The name of this server. Only used within the Oracle Event
Processing IDE for Eclipse as a useful identifier.

For more information, see Section 6.2.1, "How to Create a Local
Oracle Event Processing Server and Server Runtime".

The name of the host on which this server is installed.

For more information, see Section 6.2.1, "How to Create a Local
Oracle Event Processing Server and Server Runtime".

The current installed runtime selected for this server.

Select a new runtime from the pull down menu or click the Edit
link to modify the configuration of the selected runtime.

For more information, see Section 6.2.1, "How to Create a Local
Oracle Event Processing Server and Server Runtime".

The fully qualified path to the directory that contains the
domain for this server.

Click Browse to choose the directory.

Default: MIDDLEWARE_HOME\user_
projects\domains\ocep_domain\defaultserver.
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Table 6-13 (Cont.) Server Overview Editor Attributes

Attribute

Description

Start Scrip’c1

Stop Script!

Debug Port!

Remote Server IP Address®

Remote Server Port?

User Name?

User Password?

The script that Oracle Event Processing IDE for Eclipse uses to
start the Oracle Event Processing server.

Click Browse to choose the start script.

Default on UNIX: MIDDLEWARE_HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.sh

Default on Windows: MIDDLEWARE_HOME\user_
projects\domains\ocep_
domain\defaultserver\stopwlevs.cmd

The script that Oracle Event Processing IDE for Eclipse uses to
stop the Oracle Event Processing server.

Click Browse to choose the stop script.

Default on UNIX: MIDDLEWARE_HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.sh

Default on Windows: MIDDLEWARE_HOME\user_
projects\domains\ocep_
domain\defaultserver\startwlevs.cmd

The Oracle Event Processing server port that Oracle Event
Processing IDE for Eclipse connects to when debugging the
Oracle Event Processing server.

Default: 8453.

The IP address of the remote Oracle Event Processing server.
Default: IP address of localhost.

The port you specified in the remote Oracle Event Processing
server DOMAIN_DIR/config/config.xml file that describes

your Oracle Event Processing domain, where DOMAIN_DIR
refers to your domain directory.

The port number is the value of the Port child element of the
Netio element:

<Netio>
<Name>NetIO</Name>
<Port>9002</Port>
</Netio>

Default: 9002

The user name that the Oracle Event Processing IDE for Eclipse
uses to log into the remote server.

Default: wlevs

The password that the Oracle Event Processing IDE for Eclipse
uses to log into the remote server.

Default: wlevs
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Table 6-13 (Cont.) Server Overview Editor Attributes

Attribute Description

Publishing By default, when you change an application, you must manually
publish the changes to the Oracle Event Processing server.

Select Never publish automatically to disable automatic
publishing.

Select Override default settings to override the default
automatic publishing interval. Enter a new publishing interval
(in seconds).

Default: Never publish automatically.
Timeouts Enter a positive, integer number of seconds in the Start (in

seconds) field to specify the time in which the Oracle Event
Processing server must start.

Default: 150 seconds.

Enter a positive, integer number of seconds in the Stop (in
seconds) field to specify the time in which the Oracle Event
Processing server must start.

Default: 60 seconds.

' Click Local Server to modify. Applies to both a local server and the runtime of a remote server.
2 Click Remote Server to modify. Applies only to a remote server.

4. Select File > Save.

5. Close the Server Overview editor.

6.3.8 How to Configure Domain (Runtime) Settings for Oracle Event Processing Server

After you create a server, you can use the Oracle Event Processing IDE for Eclipse to
configure Oracle Event Processing server domain (runtime) settings in the Oracle
Event Processing server config.xml file.

Recall that a local Oracle Event Processing server is one in which both the server and
server runtime are on the same host and a remote Oracle Event Processing server is
one in which the server and server runtime are on different hosts: the server is on a
remote host and the server runtime is on the local host (the host on which you are
executing the Oracle Event Processing IDE for Eclipse).

For both local and remote Oracle Event Processing servers, when you configure
domain (runtime) settings, you are modifying only the Oracle Event Processing server
config.xml on the local host.

You can also use the Oracle Event Processing IDE for Eclipse to configure all the
important server connection and control settings that Oracle Event Processing IDE for
Eclipse uses to communicate with the Oracle Event Processing server.

Any changes you make to the Oracle Event Processing server config.xml file for a
running Oracle Event Processing server are not read by the Oracle Event Processing
server until you restart it.

If you make changes to the Oracle Event Processing server config.xml file for a
running Oracle Event Processing server using the Oracle Event Processing Visualizer,
the changes apply to the running Oracle Event Processing server as soon as you save
them. The Oracle Event Processing Visualizer updates the Oracle Event Processing
server config.xml file and overwrites the current filesystem version of that file with
the current, in-memory version.
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If you make changes to the Oracle Event Processing server config.xml file by
manually editing this file, and you then make further changes using the Oracle Event
Processing Visualizer, your manual edits will be overwritten by the Oracle Event
Processing Visualizer.

To avoid this, when you manually edit the Oracle Event Processing server
config.xml file, always stop and start the Oracle Event Processing server to read
those changes into the runtime configuration and then use the Oracle Event Processing
Visualizer to make further changes.

For more information, see:

= Section 6.2.1, "How to Create a Local Oracle Event Processing Server and Server
Runtime"

= Section 6.2.2, "How to Create a Remote Oracle Event Processing Server and Server
Runtime"

= Section 6.3.7, "How to Configure Connection and Control Settings for Oracle Event
Processing Server"

= Section 6.3.9, "How to Start the Oracle Event Processing Visualizer from Oracle
Event Processing IDE for Eclipse”

s "Understanding Oracle Event Processing Server Configuration” in the Oracle
Fusion Middleware Administrator’s Guide for Oracle Event Processing

To configure domain (runtime) settings for Oracle Event Processing server:
1. Select Window > Show Views > Servers.

2. Right-click a server in the Servers view and select Open Domain Configuration
File as shown in Figure 6-27.

Figure 6-27 Editing the Domain Configuration File

4k Servers £ 0 B = O
Server State Status
. Cracls CEP v11 §. Started How -

Cpen

3 Delete
Rename

?;?» Debug

D Restart

Stop
FIE Publish

Clean...

fizr Add and Remave Projects...
Monitoring 4

Open CEP Visualizer

Open Domain Configuration File

Properties

The Oracle Event Processing server domain configuration file config.xml opens
as shown in Figure 6-28.
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Figure 6-28 Oracle Event Processing Domain Configuration File config.xml

| config.xml 3 |

<?xml wersion="1.0" encoding="UTF-5"2:> .
<!-—ZFample XML file generated by XML3py w2007 spZ (http://www.altova.com) —-
<nl:config xsi:schemalocation="htcp://wuw.bea.com/ns/wlevs/config/server wl
<domains
<natiz>wlevs30_domain</ nawe:
</ domain:

<netiox
<namerNetI0</ name
<port>900Z</ports
</netiox

<netiox
<name>ss1Net Io</ names
<ssl-config-hean-namersslConfig</ssl-config-hean-name:>
<port>9003</ports

</netiox

<Work-manager:>
<name>JettyWorkManager </ name >
<min-threads-constraint>5</min-threads-constraints v
< >
Design | Source

3. Edit the domain configuration file as required.
4. Select File > Save.

5. Close the domain configuration file.

6.3.9 How to Start the Oracle Event Processing Visualizer from Oracle Event
Processing IDE for Eclipse

After you create a server, you can start the Oracle Event Processing Visualizer from the
Oracle Event Processing IDE for Eclipse.

The Oracle Event Processing Visualizer is the administration console for a running
Oracle Event Processing server. For more information, see the Oracle Fusion
Middleware Visualizer User's Guide for Oracle Event Processing.

For more information, see Section 6.2.1, "How to Create a Local Oracle Event
Processing Server and Server Runtime".

Note: If you use the Oracle Event Processing Visualizer to make
changes to the Oracle Event Processing server config.xml (for
example, editing a data source), you may overwrite config.xml file
changes made manually. For more information, see Section 6.3.8,
"How to Configure Domain (Runtime) Settings for Oracle Event
Processing Server".

To start the Oracle Event Processing Visualizer from Oracle Event Processing

IDE for Eclipse:

1. Start the server (see Section 6.3.1, "How to Start a Local Oracle Event Processing
Server").

Note that if you stop the server while Oracle Event Processing Visualizer is
running, you might see informational messages about the service proxy. These are
typically not errors.
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2. Right-click the running server in the Servers view and select Open Oracle Event
Processing Visualizer as shown in Figure 6-29.

Figure 6—29 Opening the Oracle Event Processing Visualizer
4 Servers B0 #IF= 0L f2 =08
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, I
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Open CEl

Open Domain Configuration File

Properties

The Oracle Event Processing Visualizer opens as shown in Figure 6-30.
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Figure 6-30 Oracle Event Processing Visualizer
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3. Use the Oracle Event Processing Visualizer as the Oracle Fusion Middleware
Visualizer User’s Guide for Oracle Event Processing describes.

6.4 Debugging an Oracle Event Processing Application Running on an
Oracle Event Processing Server

Because Oracle Event Processing applications are Java applications, standard Java
debugging tools including those provided in Eclipse can be used with these
applications.

This section describes:

= Section 6.4.1, "How to Debug an Oracle Event Processing Application Running on
an Oracle Event Processing Server"

You can also use the load generator and csvgen adapter to simulate data feeds for
testing. For more information, see Chapter 21, "Testing Applications With the Load
Generator and csvgen Adapter".
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6.4.1 How to Debug an Oracle Event Processing Application Running on an Oracle
Event Processing Server

This section describes how to debug an Oracle Event Processing application running
on an Oracle Event Processing server.

To debug an Oracle Event Processing application running on an Oracle Event
Processing server:

1. Set a breakpoint in the Java code you wish to debug.

In this case, set the breakpoint by right-clicking in the gutter of the editor and
selecting Toggle Breakpoint as Figure 6-31 shows.

Figure 6-31 Setting a Breakpoint

@g EPM: Hello -@ Hello HelloWorldBean.java &2 =8

BSuppressWarnings {({ "unchecked” })
public void onEvent (List newEvents) throws EventRejectedException {

Ffoar (fhiect eiwent + pnewEvents) {
© Toggle Ereakpoint ceof HelloWorldEvent) |
Toggle Enablement ent helloWorldEvent = (HelloWorldEwvent) ewvent;
intln("Message: " + helloWorldEvent.getMessage()):
Add Bookmark. .. \
Add Task...

v Show Quick Diff ChrH-Shift+C
Show Line Numbers
Folding 3

2. Select Window > Show Views > Servers.

3. Start the server in debug mode by choosing one of the following as shown in
Figure 6-32:

a. Click the Start the Server in debug mode icon in the Servers view tool bar.

b. Right-click a server in the Servers view and select Debug.

Figure 6-32 Starting the Oracle Event Processing Server in Debug Mode
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4. The server will start, and when it gets to your breakpoint the thread will stop.

If the Oracle Event Processing IDE for Eclipse does not automatically switch to the
Debug perspective, switch to that perspective by selecting Window > Open
Perspective > Other and selecting the Debug option from the list of perspective.

5. Debug your application using the Debug perspective.
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Note: In some cases you may get a dialog box warning that it could
not install a breakpoint because of missing line number information.
This dialog comes from the core Eclipse debugger and is normally a
harmless issue with Oracle Event Processing Service Engine
applications. Simply check the Don't Tell Me Again checkbox and
continue debugging.

6. When you are finished you can stop the server as usual (see Section 6.3.2, "How to
Stop a Local Oracle Event Processing Server").
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7

Oracle Event Processing IDE for Eclipse and
the Event Processing Network

This chapter describes how to use the Oracle Event Processing IDE for Eclipse to
develop event processing networks (EPNs), where application components are wired
together. The EPN Editor provides a graphical view of the EPN and offers
visualization and navigation features to help you build Oracle Event Processing
applications.

This chapter includes the following sections:
= Section 7.1, "Opening the EPN Editor"

m  Section 7.2, "EPN Editor Overview"

= Section 7.3, "Navigating the EPN Editor"
= Section 7.4, "Using the EPN Editor"

7.1 Opening the EPN Editor

You can open the EPN Editor from either the project folder or a context or
configuration file of an Oracle Event Processing application.

7.1.1 How to Open the EPN Editor from a Project Folder

You can open the EPN Editor from the Eclipse project folder of an Oracle Event
Processing application. Alternatively, you can open the EPN Editor from a context or
configuration file (see Section 7.1.2, "How to Open the EPN Editor from a Context or
Configuration File").

To open the EPN Editor from a project:
1. Launch the Oracle Event Processing IDE for Eclipse.

2. Open your Oracle Event Processing project in the Project Explorer.

3. Right-click the project folder and select Open EPN Editor as Figure 7-1 shows.
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Figure 7-1 Opening the EPN Editor from a Project
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The EPN Editor opens in a tab named EPN: PROJECT-NAME, where
PROJECT-NAME is the name of your Oracle Event Processing project, as Figure 7-2
shows.
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Figure 7-2 EPN Editor
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7.1.2 How to Open the EPN Editor from a Context or Configuration File

You can open the EPN Editor from a Spring context file or an Oracle Event Processing
server configuration file in an Oracle Event Processing application. Alternatively, you
can open the EPN Editor from a context or configuration file (see Section 7.1.1, "How
to Open the EPN Editor from a Project Folder")

To open the EPN Editor from a context or configuration file:
1. Launch the Oracle Event Processing IDE for Eclipse.

2. Open your Oracle Event Processing project in the Project Explorer.

3. Right-click a context or configuration file and select Open in EPN Editor as
Figure 7-3 shows.
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Figure 7-3 Opening the EPN Editor from a Context or Configuration File
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The EPN Editor opens in a tab named EPN: PROJECT-NAME, where
PROJECT-NAME is the name of your Oracle Event Processing project, as Figure 7—4
shows.
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Figure 7-4 EPN Editor
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7.2 EPN Editor Overview

This section describes the main controls you use to manage the EPN view and how the
EPN Editor displays Oracle Event Processing application information, including:

s Section 7.2.1, "Flow Representation"

= Section 7.2.2, "Filtering"

= Section 7.2.3, "Zooming"

= Section7.2.4, "Layout"

= Section 7.2.5, "Showing and Hiding Unconnected Beans"
= Section 7.2.6, "Printing and Exporting to an Image"

= Section 7.2.7, "Configuration Badging"

m  Section 7.2.8, "Link Specification Location Indicator"

= Section 7.2.9, "Nested Stages"

»  Section 7.2.10, "Event Type Repository Editor"

7.2.1 Flow Representation

The primary display in the editor is of the flow inside the application as Figure 7-5
shows.
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Figure 7-5 EPN Flow Representation
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The EPN is composed of nodes connected by links and streams. Nodes are of various
types including adapter, processor, database table, bean, and cache. For more
information on the graphic notation the EPN Editor uses on nodes, links, and streams,
see:

= Section 7.2.7, "Configuration Badging"

= Section 7.2.8, "Link Specification Location Indicator"

7.2.2 Filtering

Although you often specify your EPN in a single assembly file, you may specify an
EPN across multiple assembly files.

By default the EPN Editor shows the EPN for a single Oracle Event Processing
application bundle with the information combined from all files.

To see the network for a single assembly file simply select that file from the Filter
pull-down menu as Figure 7-6 shows.

Figure 7-6 Filtering the EPN by Assembly File
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When editing an EPN, the assembly file shown in the EPN Editor filter is the assembly
file to which new nodes will be added. If the EPN Editor filter is set to Full EPN then
the first assembly file in the filter list will be the file to which new nodes will be added.
Existing nodes will be edited in or deleted from the assembly file in which they are
defined.

If the assembly file the EPN Editor edits is open in an Eclipse source editor, then the
edits will be made to the editor for that open file. In this case, you will need to save
changes to the open editor before the changes appear in the file on disk.
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If the assembly file the EPN Editor edits is not open in an Eclipse source editor, then
the edits are immediately applied to the file on disk.

For more information, see Section 5.3, "Creating EPN Assembly Files".

7.2.3 Zooming

You can change the zoom level of the EPN Editor by entering a percent value into the
zoom field or selecting a value from the zoom field pull-down menu as Figure 7-7
shows. To fit the EPN into the current EPN Editor window, select Fit to Window.

Figure 7-7 Zoom Level
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7.24 Layout

You can optimize and simplify the EPN layout by clicking Layout EPN as Figure 7-8
shows.

Figure 7-8 Optimize Layout
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7.2.5 Showing and Hiding Unconnected Beans

You can also filter out <bean> elements with no references in the EPN. Clicking
Show/Hide Unconnected Beans will toggle the visibility of such beans as Figure 7-9
shows. For more information, see Section 7.4.3, "Laying Out Nodes".
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Figure 7-9 Show/Hide Unconnected Beans
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7.2.6 Printing and Exporting to an Image

You can export the EPN Editor view to an image file by clicking Export to Image as
Figure 7-10 shows. You can export the image asa .bmp, .gif, . jpg, or .png file.

Figure 7-10 Exporting the EPN as an Image File
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You can print the EPN Editor view by clicking Print as Figure 7-11 shows.

Figure 7-11 Printing the EPN
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7.2.7 Configuration Badging

Nodes that have configuration information in one of the configuration files in the
META-INF/wlevs directories are badged with an indicator on the bottom right as
Figure 7-12 shows.
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Figure 7-12 Configuration Badging

outStream
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Nodes with this badge will also have the Go To Configuration Source context menu
item.

7.2.8 Link Specification Location Indicator
When working with streams, you can specify a link in the assembly file as a:
= source element in the downstream node.
= listener element in the upstream node
A circle on the line indicates where a particular link is specified in the assembly file.

Figure 7-13 shows an example in which the link is specified as a source element on the
downstream node outStream so the circle is next to the out Stream node.
Figure 7-14 shows the corresponding assembly file.

Figure 7-13 Link Source

filkered3traam
filkerFanoutProcessor

Figure 7-14 Link Source Assembly File

<wlevs:processor 1d="hREA3 bRk S o]
</wlevs:processor>

<wleva:channel id="filtereditream”
event-type="FilteredPriceEvent ">
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<wlevs:source ref="filterFanoutProcessor™ />
</wlevs:channels
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Figure 7-15 shows an example in which the link is specified as a listener element in the
upstream node algoTradingProcessor so the circle is next to the
algoTradingProcessor node. Figure 7-16 shows the corresponding assembly file.

Figure 7-15 Link Listener
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Figure 7-16 Link Listener Assembly File

<wlewvs:processor  id="|38
<wlevs:listener ref="CrossRatel3tream"/>
</wlevs:processors

=" provider="ogl'Ts

<wlewvs:channel id="CrossBEateStream” event-type="SpreaderCuputEvent” advertise="true:
<wlevs:listensr ref="swmwarizeResults™/ >
<wlevsz:listeners
<hean class="cow.oracle.cep.sample.fx.0utputBean” autowvire="bylame™/ >
<fwlevs: listeners
</wlevs:channels>

7.2.9 Nested Stages

When you define a child node within a parent node, the child node is said to be
nested. Only the parent node can specify the child node as a listener. You can drag
references from a nested element, but not to them. For more information, see
Section 7.4.2, "Connecting Nodes".

Consider the EPN that Figure 7-17 shows. Example 7-1 shows the EPN assembly
source for this EPN. Note that the HelloWorldBean is nested within the
helloworldOutputChannel. As a result, it appears within a box in the EPN
diagram. Only the parent helloworldOutputChannel may specify the nested bean
as a listener.

Figure 7-17 EPN With Nested Bean

hellowerldInputChannel = helloworldOutputChannel
helloworldadapter hellowarldProcessor HelloWorldBean

Example 7-1 Assembly Source for EPN With Nested Bean

<wlevs:adapter id="helloworldAdapter"
class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >

<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
</wlevs:adapter>

<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener ref="helloworldProcessor"/>
<wlevs:source ref="helloworldAdapter"/>

</wlevs:channel>

<wlevs:processor id="helloworldProcessor" />

<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent" advertise="true">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean" />
</wlevs:listener>
<wlevs:source ref="helloworldProcessor"/>
</wlevs:channel>

Alternatively, you can define this EPN so that all nodes are nested as Figure 7-18
shows. Example 7-2 shows the EPN assembly source for this EPN. Note that all the
nodes are nested and as a result, all nodes appear within a box in the EPN diagram.
The helloworldAdapter is the outermost parent node and does not appear within a
box in the EPN diagram.
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Figure 7-18 EPN With all Nodes Nested
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helloworldadapter helloworldProcessor HelloWorldBean

Example 7-2 Assembly Source for EPN With all Nodes Nested

<wlevs:adapter id="helloworldAdapter" class="com.bea.wlevs.adapter.example.helloworld.HelloWorldAdapter" >
<wlevs:instance-property name="message" value="HelloWorld - the current time is:"/>
<wlevs:listener>
<wlevs:channel id="helloworldInputChannel" event-type="HelloWorldEvent" >
<wlevs:listener>
<wlevs:processor id="helloworldProcessor">
<wlevs:listener>
<wlevs:channel id="helloworldOutputChannel" event-type="HelloWorldEvent">
<wlevs:listener>
<bean class="com.bea.wlevs.example.helloworld.HelloWorldBean"/>
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:processor>
</wlevs:listener>
</wlevs:channel>
</wlevs:listener>
</wlevs:adapter>

7.2.10 Event Type Repository Editor

You can create and edit JavaBean and tuple event types using the event type repository
editor.

To open the event type repository editor, click on the Event Types tab in the EPN
editor as Figure 7-19 shows.

Figure 7-19 Event Type Repository Editor

?‘3 HEPN; CEPFx &4 X| spreader,xml || *com,oracle.cep.sample.fx.context.xml Iﬂ MarketEvent. java om

Event Type Definitions = ) Event Type Details

= B4 com.orade.cep.sample.Fx.context, xml Typs name: | StockTick
"

':;X—" CrossRateEvent
':_X—" SpreaderCuputEvent
:5,-‘ CrossrateSummaryEvent

(%) Properties defined declaratively
() Properties defined in Java bean

Mame Type ‘char' Length

lastPrice doublz
symbal char

Crverview Event Types

For more information, see:
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s Section 9.3.1.1, "How to Create an Oracle Event Processing Event Type as a
JavaBean Using the Event Type Repository Editor"

= Section 9.3.2.2, "How to Create an Oracle Event Processing Event Type as a Tuple
Using the Event Type Repository Editor"

For information on the other types of events you can create, see Section 9.1, "Overview
of Oracle Event Processing Event Types".

7.3 Navigating the EPN Editor

Because the EPN Editor has a view of the whole project it is a natural place from which
to navigate to the various artifacts that make up an Oracle Event Processing
application. Oracle Event Processing IDE for Eclipse offers the following features to
help navigate the EPN Editor:

= Section 7.3.1, "Moving the Canvas"

= Section 7.3.2, "Shortcuts to Component Configuration and EPN Assembly Files"
= Section 7.3.3, "Hyperlinking"

s Section 7.3.4, "Context Menus"

= Section 7.3.5, "Browsing Oracle Event Processing Types"

7.3.1 Moving the Canvas

To move the EPN canvas without using the horizontal and vertical scroll bars, you can
use any of the following options:

= Position the cursor on the canvas, hold down the middle mouse button, and drag.
=  Hold down the space bar and click and drag the canvas.

s In the Overview view, click in the highlight box and drag.

7.3.2 Shortcuts to Component Configuration and EPN Assembly Files

If a node has a configuration object associated with it, then double-clicking that node
will open the component configuration file where that node's behavior is defined.

Otherwise, double-clicking that node will open the EPN assembly file (the Spring
context file) where that node is defined.

A configuration badge will be shown on nodes with associated configuration objects
as shown in Figure 7-20.

Figure 7-20 Node with Configuration Badge

an
exampleProcessamithConfig

For more information, see:
= Section 7.2.7, "Configuration Badging"
= Section 7.3.3, "Hyperlinking"
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7.3.3 Hyperlinking

When editing a component configuration file, EPN assembly file, or Oracle CQL
statement, hold down the Ctrl key to turn on hyperlinking. Using hyperlinking, you
can easily move between assembly and configuration files and follow reference IDs to
jump to bean implementation classes.

This section describes:

s Section 7.3.3.1, "Hyperlinking in Component Configuration and EPN Assembly
Files"

= Section 7.3.3.2, "Hyperlinking in Oracle CQL Statements"

7.3.3.1 Hyperlinking in Component Configuration and EPN Assembly Files

Figure 7-21 shows a component configuration file with the cursor over the value of a
processor element name child element while holding down the Ctrl key. The name
value has an underline to indicate it is a hyperlink. Click this link to jump to the
corresponding element in the EPN assembly file as Figure 7-22 shows.

Figure 7-21 Component Configuration File: Hyperlinking to EPN Assembly File

@gEPN: COLTest |X] citipoc,context,xml \X| com.oracle.cep.sample.Fx.contesxt, xml |X| citipocoml E2 )

1K?xml wersion="1.0" encoding="UTF—8"?>l .
Z<nliconfig xsiischemalocation="http://wyw.bea.com/ns/wvlevs/config/ applicati
Gumlna:inl="http://www. bea. con/ns/wlevs/config/application”

dxmlns:xsi="hrop: S/ vww. wi . org/ 2001/ EML3chema-instance ™

S<processor:>

& <name>filterFanoutProcgssor</ name:>

7 <rulesx i

=) <guery id="Yr3iZector™:><![CDATL]

9 select cusip, bid, srcld, bidQty, ask, askQty, seq from priceltream whe
10 11><fquerys

11 </ruless>

12 </processors>
13
l4<processors

15 <name>bbaProcessor</ name:

16 “rules:

17 <wiew id="laatEvents" schema="cusip bid sreld bidoty ask askQty seqts

18 select cusip, bid, srcld, bidQty, ask, askOty, seq

19 from filtered3tream[ srcld, cusip 1]

z0 11=<fviews

z1 <wiew id="hidask" schema="cusip bhid ask"><![CDATL[

22 zelect cusip, max(bid), min{ask)

Z3 from lastEvents

24 group by cusip v
< ¥

Design | Source
Similarly, hovering over the wlevs : processor element id child element value

filterFanoutProcessor while holding down the Ctrl key allows you to hyperlink
back to the component configuration file.
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Figure 7-22 EPN Assembly File: Hyperlinking to Component Configuration File

Fﬁq’g EPM: CQLTesk |X| citipoc.context.ml £2 |X| com.oracle.cep.sample.fx. context, xml |X| citipoc,xml = m
a1 </wlevs:adapters> »
gz
83 <wlevs:channel id="priceStream” event-type="PriceEvent™:
a4 <wlevs:listener ref="filterFanoutProcessor™ />
85 <wlevs:source ref="Priceldapter™ />

</wlevs:channel>
<!-— By default, CQL iz used for OZEP 11.0 --=

<wlevs:processor id="filcerFanoutProcessor™ >
I

</wlevs:processors

<wlevs:channel id="filtered3tream™
event-type="FilteredPriceEwventc":
<wlevs:listener ref="bbaProcessor" />
<wlevs:listener ref="analyticsProcessor™ />
<wlevarsource ref="filterFanoutProcessor™ />
</wlevs:channel>

100 <!-— Explicitly specify provider CQOL -->

101 “wlevs:processor id="hhaProcessor™ provider="ocgl™:

10z <wleva:listener ref="bidliskBEAStream" />

103 </wlevs:processors

104 v

Design | Source

7.3.3.2 Hyperlinking in Oracle CQL Statements

Figure 7-23 shows a component configuration file with the cursor over an event
attribute while holding down the Ctrl key. The fromRate attribute has an underline
to indicate it is a hyperlink. Click this link to jump to the corresponding event
definition in the EPN assembly file as Figure 7-24 shows.

Note: Hyperlinking in Oracle SQL statements is designed for simple
use cases and may not work as expected in more complex
implementations.

Figure 7-23 Oracle CQL Statement: Event Schema

I3k EPM; CEPFx |X| spreader.xml 3 i m|
<guery id="EuroFilterdrossRates"s< ! [CLOLTL[select * from EurToGhpl a
<frulesz
</processors>

<processor:
<name>FindCrossRates</ name:
<rulesx
<guery id="FindfrossREatesEule"s<!|[CDATL[
select [(a.price * b.price) + 0.05) as internalPrice,

a.fromPate as crossRatel,
b.tDRag jas crossRatez

from FxQuoteltream [ 1] a= a, FxQuoteltream [ 1] a= b
where

HOT (a.price IS HULL)
and

HOT (b.price IS HULL)

1] =</ querys

<frules>

</processors>
</nliconfigs

< >
Design | Source

7-14 Developer's Guide for Oracle Event Processing



Navigating the EPN Editor

Figure 7-24 Corresponding Event Definition in EPN Assembly File

E‘%EPN: CEPFx X| spreader,xml |%| com.oracle.cep.sample.Fx.context.xml £2 > m

<wlevs:property name="symbol" type=Tchar" /> ~
</wlevs:properties>
</wlevs:event—type:
wwlevs:event-type type-name="CrossRateEvent™s
“wlewvs:propertises:
<wlevs:property name="price™ type="Tdouble"™ />
<WleVS:property nsme= " q="" type="char"™ />
<wlevs:property name="toRate" type=Tchkar" />
</wlevs:propertiess
</wlevs:event—types
“wlewvs:event-type type-name="SpreaderluputEvent ™
<wleva:properties type="iuple™
<wlevs:property name="internglPrice™ type="double™ /»
<WlEVS:property name="crosskatel™ type="char"™ />
<wlevs:property name="crossEatelf" type="ckar" />
</wlevs:propertiess
</wlevsievent—types
<wlewvs:event-type type-name="CrossrateSummarvEvent s

<wlevs:properties>
<wlevs:property name="arveragelnternalPrice”™ type="doukle™ />
<wlevs:property name="crossRatePair™ type="char" />
<wlevs:property name="totelCount" type="Tint" />

Design | Source

Similarly, you can Ctrl-click the FxQuoteStream channel in the Oracle CQL
statement that Figure 7-23 shows to jump to the channel’s definition. This is applicable
wherever references to external objects are present in a Oracle CQL statement.

7.3.4 Context Menus

Each node on the EPN Editor has a group of context menu items that provide
convenient access to various node-specific functions. Right-click the node to display its
context menu.

Depending on the node type, you can use the EPN Editor context menu to select from
the following options:

Go to Configuration Source: opens the corresponding component configuration
file and positions the cursor in the appropriate element. You can use hyperlinking
to quickly move from this file to the corresponding EPN assembly file. For more
information, see Section 7.3.3, "Hyperlinking".

Go to Assembly Source: opens the corresponding EPN assembly file and
positions the cursor in the appropriate element. You can use hyperlinking to
quickly move from this file to the corresponding component configuration file. For
more information, see Section 7.3.3, "Hyperlinking"

Go to Java Source: opens the corresponding Java source file for this component.

Delete: deletes the component from both the EPN assembly file and component
configuration file (if applicable).

Rename: allows you to change the name of the component. The name is updated
in both the EPN assembly file and component configuration file (if applicable).

Help: displays context sensitive help for the component.

Note that these navigation options will become disabled when a corresponding source
artifact cannot be found. For example, if an adapter does not have a corresponding
entry in a configuration XML file, its Go to Configuration Source menu item will be
greyed out.
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7.3.5 Browsing Oracle Event Processing Types

A typical Oracle Event Processing project contains many instances of Oracle Event
Processing types such as adapters, channels, processors, event beans. In a large,
complex Oracle Event Processing project, it can be a challenge to locate a particular
instance. The Oracle Event Processing IDE for Eclipse provides an Oracle Event
Processing type browser that you can use to quickly locate instances of any Oracle
Event Processing type.

7.3.5.1 How to Browse Oracle Event Processing Types

You
Ctrl

can open the Oracle Event Processing type browser using the keyboard short cut
-Alt-T.

To browse Oracle Event Processing types:

1.

Open an Oracle Event Processing project.

In the following procedure, consider the Oracle Event Processing project that
Figure 7-25 shows. This is based on the Oracle Event Processing foreign exchange
example. For more information on this example, see Section 2.8, "Foreign
Exchange (FX) Example".

Figure 7-25 Example Oracle Event Processing EPN

1} Java EE - CEPFx - Eclipse

File Edit Mavigate Search Project Run  Window Help
- P30 Q- A E T S R Ne=10 A" .
fe=ts
L5 Project Explorer &2 - <.===(> @ 0O E EPM: CEPFx i3 = m]ifld S
B 22 CEPFx Fiter: =/ Bu... | ezt oar (100w = | H B e 7
[ src v
N csvTestData Y | = B »
J- 83 com.oracke.cep,sample. —_ R
tl m MarketEvent. java
£ m OutputBean.java % { )
(¥, JRE System Lib JavaSE-1.6
&.t ystem Lbrary [ava ] FilteramerStream
B OCEP Classpath FxMarketamer
(= build
== META-INF R —
=z spring
|X| com.oracle.cep.sample.Fx.context, xml ) FilterAsiaStreamn
gy FxMarketisia
=2 wlevs
|X] PubSubadapterConfiguration.ml
|| spreader.xml % { ’
1X] SummarizeResuits. xml FilkarF1 wnShraanm b
A MANIFEST MF £ 2
lavd build, properties COwerview | Event Types
@ bundle.properties o
startDataFeed. cmd [l markers [ =] Properties | 47 Servers 23 88 Data Source Explorer | B2 Snippets )
% 0 e o
@ Oracle CEP w11.1 at lacalhost [Stopped]
i om

2.
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Type the keyboard short cut Ctrl-Alt-T.

The Oracle Event Processing type browser appears as Figure 7-26 shows.
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Figure 7-26 Oracle Event Processing Type Browser

5] Open CEP Type

Select an item o open (7 = any character, * = any string): -

| Filter* |

Makching items:

lkerAmer
ilber AmerStream

ilber Asiastrean

ilkerEuro
O FilberEuroStream

‘::, Filterfsia - C:/edipse-galilea-projects/ CEPFx/META-INF /spring) com. oracle. cep. sample. Fx. context. xml

@j [ O H Cancel ]

3. Configure the Oracle Event Processing Type dialog as shown in Table 7-1.

Table 7-1 Oracle Event Processing Type Dialog

Attribute Description

Select an item to open Specify a filter to match the names of the items you wan to find.

Use the ? wildcard for any single character and the * wildcard
for any string of two or more characters.

Matching items The list of Oracle Event Processing type instances whose name
matches the filter you specified.

By default, the status line below the Matching items list shows the fully qualified
path to the selected item in the Select an item to open list. To toggle status line
display, click on the pull-down menu in the right hand corner and select Show
Status Line.

4. Select a type in the Matching Items list and click OK.

The type is opened in the source file in which it is defined. For example, selecting
FilterAsia from the Matching Items list and clicking OK opens the
com.oracle.cep.sample. fx.content.xml EPN assembly file in which this
processor is defined as Figure 7-27 shows.
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Figure 7-27 Opening the FilterAsia EPN Assembly File

4F Java EE - CEPEX/META-INF/spring/com.oracle.cep.sample. fx.context.xml - Eclipse

File Edit Mavigate Search Project Run  Design  wWindow Help
O B0 -6 M I0iIRIBYEE £ (92 Javae |
: : A=
[[\:,Project Explorer &3 = g:p | @EPN:CEPFX |X| com.oracle.cep.sample.Fx.context.xml 23 = 0| e
= =2 CEPFx in & real application —-—» R 1
B sre <wlevs:channel id="Fil ter}ls?_lastre?m 5 -[€] beans w &
=3 com.oracle.cep.sample.fx <wlevs:listener ref="Filterdsia"/ > [&] wlev
m MarketEvent.java </wlevs:channels> 0. #eoor
[1] outputBean.java <wlevs:processor id= " provic |°E| wlev
B, JRE System Library [1avasE-1.6] <wlevs: listener ref="FxQuoteStrean' [—
Y o
B, OCEP Classpath </wlevs:processors [&] wiev
(= build [&] wilev
5= META-INF <wlevs:adapter id="fazMarketZuro™ provic [E] wlev
(== spring <wlevs:instance-property name="port [
|| com,oracle,cep,sample.fx,context.xml <wlevs:listenser ref="FilterFuroStre [&] wlev
= wilevs . </wlevs:adapters [E] wiev
%] PubSubAdapterConfiguration. xml (8] wiev
%] spreader.xml < !-— This processor is simply here to £ U weor
@ 1X] SummarizeResults, xml to make it appear more realistic. It wow [€] wiev
g MANIFEST MF < > - Ta] e
@: build. properties Design | Source < >
bundle.properties " ' 3 g :
startDataFeed. cmd & Markers | = Properties 4 Servers 23 m Data Sourc | f=1 Snippets & Progress =
o & 0| B
E‘g iOracle CEP v11,1 at localhost [Stopped] §
< ?
iy Ditems selected

To navigate to the corresponding component configuration file as Figure 7-28
shows, Ctrl-click the FilterAsia id attribute value.

Figure 7-28 Opening the FilterAsia Component Configuration File

va EE - CEPFX/META-INFAwlevs/spreader.xml - Eclipse

File Edit Source Mavigate Search Project Run Window Help
G-HE i %-0 -G (B 6 2o - (@i HAN B | ¢9 JvaE |
-5 o

[[\:,Project Explorer &3 g:p @ i |X| com.oracle,cep.sampl \X| spreader.xml &3 21 k]
= bd CEPF:x <guery id="AmerFilterCrossRates
-1 sre </ruless>
=3 com.oracle.cep.sample. </processor> =-[&] nicarfig xr
m MarketEvent.java <processors [&] process:
m CukputBean.java <narme - / name> 2-[&] process:
B, JRE System Library [JavasE-1.6] <rules:> [&] nam
B, OCEP Classpath <view id="EurTolpy" schema="1zs & rule:
(= build select lastPrice, svmbol from F [&] process
== META-INF 11=</views [ process
== spring <view id="EurTofpyPre" schema="'
|| com,oracle,cep,sample.fx,context.xml select avg(lastPrice)] as price,
== wlevs from EurTodpy
%] PubSubadapterConfiguration.xml where lastPrice < 200.0 and las
%] spreader.xml 11 »</views
] SummarizeResults, xml <guery id="AsiagFilterCrossRates™
I MANIFEST MF 3 >
@ build. properties Design | Source < >

bundle.properties

startDataFeed.cmd [2_‘ Markers | =1 Properties 4L Servers 52 m Data Sourc | = Snippets @J Progress e

£ L
F‘g Cracle CEP vw11.1 at localhaost [Stopped]

:¢ nl:configiprocessoriname/#text ‘Writable Smart Insert 15: 25

For more information on hyperlinking, see Section 7.3.3, "Hyperlinking".
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7.4 Using the EPN Editor

The EPN Editor allows you to create and edit an application's EPN using actions on
the editor surface. Most actions in the EPN Editor result in edits to an assembly file in
that application. You can use a single EPN assembly file or multiple EPN assembly
files (for more information, see Section 7.2.2, "Filtering").

The following sections describe EPN Editor editing tasks, including;:
= Section 7.4.1, "Creating Nodes"

= Section 7.4.2, "Connecting Nodes"

= Section 7.4.3, "Laying Out Nodes"

= Section 7.4.4, "Renaming Nodes"

= Section 7.4.5, "Deleting Nodes"

For more information, see:

= Section 5.1, "Oracle Event Processing Project Overview"
s Section 7.2, "EPN Editor Overview"

= Section 7.1, "Opening the EPN Editor"

= Section 7.3, "Navigating the EPN Editor"

7.4.1 Creating Nodes

When adding new nodes to an EPN using the EPN editor, a new node will appear at
the location of the mouse click that was used to show the EPN Editor context menu.
You can create any of the nodes that Table 7-2 lists.

Table 7-2 EPN Editor Icons

Node Description

Yo Adapter: a node that interfaces an event data source with the EPN or interfaces
“ the EPN with an event data sink.

For more information, see:

m  Section 7.4.1.2, "How to Create an Adapter Node"

»  Chapter 11, "Integrating the Java Message Service"

s Chapter 12, "Integrating an HTTP Publish-Subscribe Server"

»  Chapter 15, "Integrating an External Component Using a Custom Adapter"

»  Chapter 21, "Testing Applications With the Load Generator and csvgen
Adapter"

GRS Channel: a node that conveys events between an event data source and an event
data sink.

For more information, see:
s Section 7.4.1.1, "How to Create a Basic Node"

s Chapter 10, "Connecting EPN Stages Using Channels"

P Processor: a node that executes Oracle CQL or EPL rules on the event data
- offered to it by one or more channels.

For more information, see:

s Section 7.4.1.3, "How to Create a Processor Node"

s Chapter 17, "Querying an Event Stream with Oracle CQL"
»  Chapter 19, "Querying an Event Stream with Oracle EPL"
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Table 7-2 (Cont.) EPN Editor Icons

Node Description
'S Event Bean: a node similar to a standard Spring bean except that it can be
@ managed by the Oracle Event Processing management framework and can

actively use the capabilities of the Oracle Event Processing server container.
For more information, see:
s Section 7.4.1.1, "How to Create a Basic Node"

s Chapter 16, "Handling Events with Java"

. Spring Bean: a Plain Old Java Object (POJO) node that consumes events. A
& Spring bean is managed by the Spring framework.

For more information, see:
s Section 7.4.1.1, "How to Create a Basic Node"

= Chapter 16, "Handling Events with Java"

Cache: a node that provides a temporary storage area for events, created
exclusively to improve the overall performance of your Oracle Event Processing
application.

For more information, see:
s Section 7.4.1.1, "How to Create a Basic Node"

»  Chapter 13, "Integrating a Cache"

Table: a node that connects a relational database table to the EPN as an event

(=
T a data source.

For more information, see:

s Section 7.4.1.1, "How to Create a Basic Node"

o

= Section 17.3, "Configuring an Oracle CQL Processor Table Source”

The user may not reposition the nodes on the EPN Editor. To refresh the layout of the
nodes on the EPN Editor, click the Layout EPN button on the EPN Editor toolbar. For
more information, see Section 7.4.3, "Laying Out Nodes".

When a child node is nested within a parent node, its icon appears within a box. For
more information, see Section 7.2.9, "Nested Stages".

7.4.1.1 How to Create a Basic Node
Basic nodes include beans, caches, channels, event beans, and tables.

For information on how to create other nodes, see Section 7.4.1, "Creating Nodes".

To create a basic node:
1. Open the EPN Editor (see Section 7.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 7-29 shows.
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Figure 7-29 Creating a Basic Node

@QEPN: SimpleProject &3 =0
Fiter: = Full EPM a% &1 100% = |.*.;1 =
adapterl BeanClass
Bean...
Help

Cache...

Event Bean... E!

Processar...
Table. ..

Crverview | Event Types

3. Select the type of node you want to create.

The EPN Editor edits the source file indicated in the EPN Editor filter and the EPN
Editor displays the new EPN node. For most nodes, a default ID is chosen and the
new node is immediately opened for rename as Figure 7-30 shows.

Figure 7-30 New Basic Node

@gEPN: SimpleProject &3 =8
Filker: v[}gullEPN &b AT 100% b |;';;J =
adapterl BeanClass

Crverview | Event Types

To rename the node, see Section 7.4.4, "Renaming Nodes".

To reposition the node and update the EPN Editor layout, see Section 7.4.3,
"Laying Out Nodes".

4. Optionally, configure additional node options.
See:
s Chapter 10, "Connecting EPN Stages Using Channels"
= Section 17.3, "Configuring an Oracle CQL Processor Table Source"
»  Chapter 13, "Integrating a Cache"
»  Chapter 15, "Integrating an External Component Using a Custom Adapter”
s Chapter 16, "Handling Events with Java"

s Chapter 21, "Testing Applications With the Load Generator and csvgen
Adapter"
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7.4.1.2 How to Create an Adapter Node

This section describes how to create an adapter using the EPN Editor, including:
= JMS adapters (in-bound or out-bound)
=  HTTP publish-subscribe server adapters (publishing or subscribing)

For information on how to create other nodes, see Section 7.4.1, "Creating Nodes".

To create an adapter node:
1. Open the EPN Editor (see Section 7.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 7-31 shows.

Figure 7-31 Creating an Adapter Node

@ EPM: SimpleProject &3 =8
Filter: = Full EPM AT AL | 100% = | ==
adapterl BeanClass

B T
Bean...

elp Cache...
Channel...
Event Bean...
Processar, ..
Table...

Crverview | Event Types

3. Select node type Adapter.
The New Adapter wizard appears as shown in Figure 7-32.

Figure 7-32 New Adapter Wizard

12 New Adapter EI@

Basic Adapter Information
Specify an ID, provider, and configuration lacation for the new adaptar, %

Adapter ID: | adapker |

Type:

(&) Provider:

Configuration location:

() Create a new File:

| adapter.xml |

(%) Use an existing configuration File:

|c0nfig.xml - |

@
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4. Configure the New Adapter Wizard - Page 1 as shown in Table 7-3.

Table 7-3 New Adapter Wizard - Page 1

Attribute

Description

Adapter ID

Provider

Class

Create a new file

Use an existing configuration file

Specifies the ID of the adapter EPN element and the name
of the associated adapter configuration element.

Select the adapter provider type from the pull-down menu
for an adapter already defined in the Oracle Event
Processing component configuration schema.

Select one of:
= jms-inbound: JMS in-bound adapter.
= jms-outbound: JMS out-bound adapter.

= httppub: HTTP publish-subscribe adapter for
publishing.

= httpsub: HTTP publish-subscribe adapter for
subscribing.

Specify the fully qualified Java class name of a custom
adapter.

NOTE: If you are using a custom adapter factory, you must
add the wlevs: factory element manually. For more
information, see Chapter 15, "Integrating an External
Component Using a Custom Adapter".

Creates the adapter component configuration in a new file.

The new file is created in the application's
META-INF/wlevs directory with the same name as the
adapter ID.

Creates the adapter component configuration in an existing
configuration file.

The new adapter configuration element is appended to the
configurations in the selected file.

5. Proceed depending on how you configured the adapter implementation:

a. If you selected Class, Proceed to step 8.

b. If you selected Provider, proceed to step 6.

6. Click Next.

The provider-specific New Adapter Wizard page appears.

7. Configure the provider-specific New Adapter Wizard page as the following

figures show:

»  Figure 7-33, "New Adapter Wizard - jms-inbound"

See Section 11.6.1, "JMS Inbound Adapter Component Configuration".

»  Figure 7-34, "New Adapter Wizard - jms-outbound"

See Section 11.6.2, "JMS Outbound Adapter Component Configuration".

»  Figure 7-35, "New Adapter Wizard - httppub"”
See Section 12.5.1, "HTTP Pub-Sub Adapter for Publishing Component

Configuration".

»  Figure 7-36, "New Adapter Wizard - httpsub"
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See Section 12.5.2, "HTTP Pub-Sub Adapter for Subscribing Component
Configuration”.

Figure 7-33 New Adapter Wizard - jms-inbound

T New Adapter @

Adapter Configuration "
Enter configuration values For this adapter,
Properties: Property Description:
Zonneckion Event Type
Event Type: |

Event type whose property
names match inbound JM3 Map
Message property names.

JNDI Provider URL:* |

JNDI Factory: | weblogic.jndi, WLInitialContextFactary Specify this property only if
wou want Oracle CEP ta
Connection JNDI Marne: | weblogic.jms. ConnectionFactary automatically perform the

conversion between JM35
messages and events, If you
have created your own custom
converter bean, then do not
specify this property,

() Destination JNDI Mame:* |

() Destination Mame:™* |

Security
User:

() Passwaord:

() Encrypted Password:

Connection User:

O Connection Password:

() Connection Encrypted Password:

Advanced

‘Wark Manager:

Message Selectar: |

Concurrent Consumers:

Session Acknowledgrnent Mode: | AUTO_ACKNOWLEDGE v

Session Transacted: O

* Required property

@
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Figure 7-34 New Adapter Wizard - jms-outbound

LF New A dapter @

Adapter Configuration

Enter configuration values For this adapter.

R

Propetties: Property Descripkion:
Conneckion Event Type
Event Type: |

Event type whose property

INDI Pravider URL:* |

names match inbound JMS Map
Message property names,

JMDI Factary:

| weblogic. jndi. WLInitialConkextFactory

Specify this property only if

wou wank Oracle CEP to

Connection JMDI Mame:

| weblogic. jms. ConnectionFactory

corversion betwesn JM3

() Destination JNDI Mame:* |

messages and events, If you

() Destination Marme:* |

have created your own custom

|
|
|
| automnatically perform the
|
| converter bean, then do not

Security

specify this property,

User;

() Password:

() Encrypted Password:

Conneckion User;

O Connection Password:

() Connection Encrypted Password:

Advanced
Session Transacted: [ |

Delivery Mode: | persistent

®@

* Required property

Cancel

Figure 7-35 New Adapter Wizard - httppub

L New A dapter E

Adapter Configuration

Enter configuration values For this adapter,

Properties:

RS

Property Description:

Zonneckion

Channel:*

|
() Server URL:* |
|
|

Event Type:

Security

User: |

() Password: |

() Encrypred Password: |

* Required property

Cancel
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Figure 7-36 New Adapter Wizard - httpsub

LF New A dapter

Adapter Configuration

Enter configuration values For this adapter.

Propetties: Propetty Description:
Conneckion Server URL
ok

Sy U | | | The Server URL is used when

Channeli* | | publishing or subscribing to a remote
channel, i.e. a channel hosted by &

Event Type: | | remate Pub-Sub server, The Server
URL identifies the remote Pub-Sub

Securit server, For example, a value such

¥ as 'htp:ffmyhost, com: 2002 pubsub’

Lser: | | could be used ko identify the
Pub-5ub server running on hosk

() Passward: | | ravhost.com at pork 9002,

() Encrypred Passwoard: | |

* Required property

@

8. Click Finish.
9. Use the new adapter node on the EPN.

The EPN Editor creates the adapter configuration in the file you specified in the
New Adapter wizard, edits the source file indicated in the EPN Editor filter, and
displays the new EPN node as Figure 7-37 shows.

Figure 7-37 New Adapter Node

[El EpM: SimpleProject 52 =0
Filter: = Bundle: SimpleProject | oAb A 100% =3 | H o=

' 7=

e, — p—

hellowarldOutputChannel

helloworidInputChannel =
hellowarldadapter helloworldProcessor

)

adapter

<
Crverview | Event Types

|

To rename the node, see Section 7.4.4, "Renaming Nodes".

To reposition the node and update the EPN Editor layout, see Section 7.4.3,
"Laying Out Nodes".
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10. Optionally, configure additional node options.
For more information, see:
s Chapter 11, "Integrating the Java Message Service"
s Chapter 12, "Integrating an HTTP Publish-Subscribe Server"

7.4.1.3 How to Create a Processor Node

This section describes how to create a processor node using the EPN Editor. For
information on creating other node types, see Section 7.4.1.1, "How to Create a Basic
Node".

When deploying an Oracle Event Processing application with a wlevs:processor
node, other nodes in an EPN may reference that processor only if a processor
configuration exists for that processor. Processor configurations are defined in Oracle
Event Processing application configuration files. See Section 1.4.2, "Overview of
Component Configuration Files" for more information about Oracle Event Processing
configuration files.

To create a processor node:
1. Open the EPN Editor (see Section 7.1, "Opening the EPN Editor").

2. Right-click on an empty portion of the EPN Editor surface and select New from
the context menu as Figure 7-38 shows.

Figure 7-38 Creating a Processor Node

5l EpM: SimpleProject 52 =0
Filter: = Full EPN a0 A% 100% 3| A =
8 '
%
adapteri Beanlass
Bean...
Help

Cache...
Channel...
Event Bean...

Table... k

Crverview | Event Types

3. Select node type Processor.

The New Processor dialog appears as shown in Figure 7-39.
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Figure 7-39 New Processor Dialog

& New Processor,

Processor ID:

Configuration location:

() Create a new file:
processor,xml

() Use an existing configuration file:

Specify an ID and configuration location for the new processor,

X
"”_

Ok H Caneel ]

4,

Configure the New Processor dialog as shown in Table 7—4.

Table 7-4 New Processor Dialog

Attribute

Description

Processor ID

Create a new file

Use an existing configuration file

Specifies the ID of the processor EPN element and the name
of the associated processor configuration element

Creates the processor configuration in a new file.

The new file is created in the application's
META-INF/wlevs directory with the same name as the
processor ID.

Creates the processor configuration in an existing
configuration file.

The new processor configuration element is appended to
the configurations in the selected file.

Click OK.

The EPN Editor creates the processor configuration in the file you specified in the
New Processor dialog, edits the source file indicated in the EPN Editor filter, and
displays the new EPN node as Figure 7-40 shows.

Figure 7-40 New Processor Node

[l Epn: SimpleProject 57

Filker: V%ull EPN
BeanClass

adapterl

i

0

=

processar

Crverview | Event Types

To rename the node, see Section 7.4.4, "Renaming Nodes".
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To reposition the node and update the EPN Editor layout, see Section 7.4.3,
"Laying Out Nodes".

Note: In Oracle Event Processing, you must use a channel to connect
a push event source to an Oracle CQL processor and to connect an
Oracle CQL processor to an event sink. For more information, see
Section 10.1.2, "Channels Representing Streams and Relations".

6. Optionally, configure additional processor options.
See:
s Chapter 17, "Querying an Event Stream with Oracle CQL"
= Chapter 19, "Querying an Event Stream with Oracle EPL"

7.4.2 Connecting Nodes

The nodes in the EPN represent the flow of events through an Event Processing
Network of an Oracle Event Processing application. When a node may forward events
to another node in the EPN, the EPN Editor allows you to connect that node visually
by dragging a line from the source node to the destination node.

7.4.2.1 How to Connect Nodes
This section describes how to connect nodes in the EPN Editor.

To connect nodes:
1. Open the EPN Editor (see Section 7.1, "Opening the EPN Editor").

2. Select the source of events and drag to the target of the event flow.

= If a connection is allowed, a plug icon is shown at the target end as
Figure 7—41 shows.

Figure 7-41 Connecting Nodes: Connection Allowed

Fq‘lg EPM: SimpleProject &3 =8

Fiter: ¥ Secondfssembly.context.xml &b AT 100% = | &= =

Edapter

»  If the connection is not allowed, a forbidden icon is shown at the target end as
Figure 7—42 shows.

Crverview | Event Types
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Figure 7-42 Connecting Nodes: Connection Forbidden

@gEPN: SimpleProject &3 ¥| Secondassembly. contesxt, xml =08

Filter: = Secondassembly, context,xml &b AT 100% - = =

o B

adapter

y

. %@O
[Missing 10,

Crverview | Event Types

Not all nodes may be a target of event flow. For example, connection is
forbidden if:

— A node does not define a valid identifier.
- A node is nested (for more information, see Section 7.2.9, "Nested Stages").
3. Release the mouse button to complete the connection.

When the connection is made, the EPN Editor updates the EPN assembly file. For
example:

= When you connect an adapter to a channel or a channel to a processor or event
bean, the EPN Editor adds a wlevs:1listener element to the source node
with a reference to the target node by ID.

= When you connect a table to a processor, the EPN Editor adds a
wlevs:table-source element to the target processor node that references
the source table.

For example, suppose you connect the adapter to the channel, and the channel to
the processor shown in Figure 7—43.

Figure 7-43 Valid Connections

channel
adapter pracessar

Figure 7-44 shows the EPN assembly file before connection.

Figure 7-44 EPN Assembly File: Before Connection

<wlevs:adapter id="adapter" provider="httppuh™:
</ wlevs:adapters>

<wlevz:channel id="channel™:
</wlevs:channel>

<wlewvs:processor id="processor™:
</wlevs:processor:

Figure 745 shows the EPN assembly file after connection.
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Figure 7-45 EPN Assembly File: After Connection

<wlevs:adapter id="adapter" provider="httppuk™:
<wlevs:listener ref="channel"™ />
</ wlevs:adapters

<wlevs:channel id="channel™:
<wlevs:listener ref="processor" />
</ wlevs:channels

<wlevs:processor id="processor™:
</wWlEvs:processor>

7.4.3 Laying Out Nodes

Certain EPN Editor actions will use the location of the action as the location of the
rendered result. For example, when adding new nodes to an EPN using the EPN
editor, a new node will appear at the location of the mouse click that was used to show
the EPN Editor context menu. The user may not reposition the nodes on the EPN
Editor. To refresh the layout of the nodes on the EPN Editor, click the Layout EPN
button on the EPN Editor toolbar as Figure 7-46 shows.

Figure 7-46 Laying Out Nodes

[El EpM: SimpleProject 52 =0
Filter: = Secondfssembly,contesxt.xml
Fred

processar

@ eventBean

adapker

skream

Crverview | Event Types

For more information, see Section 7.2.4, "Layout".

7.4.4 Renaming Nodes

Most node types support a rename operation that will change all references to the
node across both assembly and configuration XML files. You can select Rename from
the node’s context menu as Figure 7-47 shows.

Figure 7-47 Renaming Nodes

P Goto Assembly Source ‘

7.4.5 Deleting Nodes

You may delete most nodes and connections visible on the EPN Editor using the
node’s context menu or the Delete key:
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= Using the keyboard, select the object you want to delete and then click the Delete
key.

= Using the context menu, right-click on the object to show the context menu, then
select Delete as Figure 7-48 shows.

Figure 7-48 Deleting Nodes

[l EPM: SimpleProject 52 =0

Fiter: = Secondssernbly,conkext.ml Ab AT 100%. = |;‘.;J =

stream . =
processor

adapter

Go ko Assembly Source

Rename...

Crverview | Event Types

When deleting a node, the incoming and outgoing connections are also deleted. For
example, Figure 7-49 shows the EPN and Figure 7-51 shows the assembly file before
deleting the channel node named stream.

Figure 7-49 EPN Before Deleting a Channel Node

(5l EPM: SimpleProject 52 =0

Fiter: = SecondAssernbly,conkext.ml AT AT 100% = |;‘.7:] =

; stream =
% processor
adapter &

eventhean

Crverview | Event Types

Figure 7-50 Assembly File Before Deleting a Channel Node

<wlevs:adapter id="adapter"” provider="httppub™:>
<wlevs:listener ref="channel"™ />
</wlevs:adapters>

<wlevs:channel id="channel':
<wlewvs:listener ref="processor"™ />

</wlevs:channels

<wlevs:processor id="processor™:
</wlevs:processors>

Figure 7-51 shows the EPN and Figure 7-52 shows the assembly file after deleting this
channel node.
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Figure 7-51 EPN After Deleting a Channel Node
@g EPM: SimpleProject 3 |¥| *Secondassembly. context, xml =0

Filter: = Seconddssernbly, conbext.xml &% At [ 100% = |;‘.;J =

A

@ processor
adapter &

eventBean

Crverview | Event Types

Figure 7-52 Assembly File After Deleting a Channel Node

<wlewvs:adapter id="adapter”™ provider="httppub™:

</wlevs:iadapters

<wlews:processor id="processor™:
</ wWlevs:processors

Note: If a bean or other anonymous element is deleted, then the
object containing that object is deleted too. For example, given a
bean within a wlevs: listener element, then deleting the bean
will delete the 1istener element too.
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Chapter 11, "Integrating the Java Message Service"
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8

Walkthrough: Assembling a Simple
Application

This chapter introduces how to build Oracle Event Processing applications through a
walkthrough in which you build a simple application. Along the way, it provides an
overview of key concepts

This chapter includes the following sections:

= Section 8.1, "Introduction to the Simple Application Walkthrough"
= Section 8.2, "Create the Workspace and Project"

m  Section 8.3, "Create an Event Type to Carry Event Data"

= Section 8.4, "Add an Input Adapter to Receive Event Data"

= Section 8.5, "Add a Channel to Convey Events"

= Section 8.6, "Create a Listener to Receive and Report Events"

= Section 8.7, "Set Up the Load Generator and Test"

m  Section 8.8, "Add an Oracle CQL Processor to Filter Events"

= Section 8.9, "Summary: Simple Application Walkthrough"

8.1 Introduction to the Simple Application Walkthrough

This walkthrough introduces the basics of building Oracle Event Processing
applications using the Eclipse IDE. It is intended as a survey of key Oracle Event
Processing concepts, a starting place from which you can investigate more about each.

The application you build in this walkthrough models a simple stock trade alert
system. The application receives example data about stock trades, examines the data
for certain characteristics, then prints some of the data to the console. The following
illustration shows the application’s finished EPN diagram:

L EPM: TradeReport 52

Filter ¥ Bundle: TradeReport &b AT [100% > | A=

P —m —m 2

AdapterQutputChannel i = ProcessorOutputChannel i
StockTradeCSVAdapter GetHighVelumeProcessor ListenerBean

Overview | Event Types
This introduction includes the following sections:
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= Section 8.1.1, "Key Concepts in this Walkthrough"
s Section 8.1.2, "Before You Get Started"

This walkthrough starts with Section 8.2, "Create the Workspace and Project".

8.1.1 Key Concepts in this Walkthrough

This walkthrough introduces the following concepts that are typically part of Oracle
Event Processing applications you build:

s IDE features designed to make building Oracle Event Processing applications
easier, including a project type, a graphical editor for designing event processing
networks, and validation support for project-specific configuration files

= Building an application as an event processing network (EPN), the core design
construct for modeling the behavior of an application that receives streaming data
and operates on that data as it flows through the application.

= Designing event types that model events, normalizing event data for use with
code inside the application.

= Using adapters to manage interactions with external components, including
sources of streaming data.

= Implementing a Java class that can receive or send events within an event
processing network.

s Using Oracle Continuous Query Language (Oracle CQL) to filter events based on
specific properties within them.

8.1.2 Before You Get Started

You should have installed Oracle Event Processing and the Eclipse IDE. In addition,
you should have updated the Eclipse IDE with the plugin included with Oracle Event
Processing.

Although it introduces features specific to Oracle Event Processing, this walkthrough
assumes that you are somewhat familiar with basic Java programming.

For more information, see the following topics:

s "Installation Overview" in the Oracle Fusion Middleware Getting Started Guide for
Oracle Event Processing

= Section 4.1, "Overview of Oracle Event Processing IDE for Eclipse"

8.2 Create the Workspace and Project

In this first step, you'll use the IDE to create the workspace and project in which to
develop your application. To make it easier to develop Oracle Event Processing
applications, the IDE provides the Oracle Event Processing application project type.
This project type includes the artifacts and dependencies that typical Oracle Event
Processing applications need, making it easier to get into writing application-specific
code.

You should already have configured your IDE preferences to know the location of the
JRockit JRE, which is the best practice choice on which to run the Oracle Event
Processing server.
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Create the Walkthrough Workspace and TradeReport Project

1.
2.
3.

Start the Eclipse IDE.
When prompted to select a workspace, create a workspace called walkthroughs.
From the File menu, choose New > Project to begin creating a new project.

In the New Project dialog, expand Oracle Event Processing, click Oracle Event
Processing Application Project, then click Next.

E_.] Mew Project l G |G|

Select a wizard —>

Wizards:
type filter text

= CVs -
» [= Eclipse Modeling Framewark
- [= EIB
. [= Java
= Java EE
> [= JavaScript
- (= JAXB
. = IPA
(= Oracle Event Processing

m

1Y

Q Oracle Event Processing Application Project
> = Plug-in Development
. = Web -

)
[==]

J

In the New Oracle Event Processing Application Project dialog, in the Project
name box, enter TradeReport.

Leave the Use default location check box selected to have the new project created
in the location of the workspace you created.

Under Target Runtime, if no runtime is displayed in the dropdown, do the
following:

1. Click the New button.

2. Inthe New Server Runtime Environment dialog, expand Oracle, then select
Oracle Event Processing v11.1 and click Next.

3. Click Next.

4. Under New Oracle Event Processing v11.1 Runtime, next to the Oracle
Middleware Home Directory box, click Browse.

5. In the Browse for Folder dialog, locate the Middleware home directory, then
click OK.

By default, the Middleware home directory will be located at ORACLE _
HOME/Middleware.

6. In the JRE dropdown, select a JRockit JRE.

The Oracle Event Processing server is optimized for use with the JRockit JRE.
If a JRockit JRE isn't available among those listed, use the following steps to
locate the JRE that is included with Oracle Event Processing.
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Click the Installed JRE preferences link.

In the Preferences dialog, next to the Installed JREs list, click the Add button.

In the Add JRE dialog, under Installed JRE Types, select Standard VM, then click Next.
Next to the JRE home box, click the Directory button to browse for the location of the JRockit
JRE.

In the Browse For Folder dialog, expand the Middleware home directory, then the jrockit 160 _
29 directory, then click the JRE directory and click OK.

After the Add JRE dialog displays the JRE home directory, name, and system libraries, click the
dialog's Finish button.

58} Add JRE ==

JRE Definition i)
Specify attributes for a JRE %‘

JRE home: CA\Oracle\Middleware'jrockit_160_29 Directory...

JRE name: jrockit 160_29

Default VM Arguments: Variables...

JRE system libraries:

L-li? Ch\Oracle\Middlewarejrockit_160_29\jre\lib\resources.jar Add External JARs...

A\Oracle\Middleware\jrockit_160_20\jre\lib\rt jar
AOracle\Middleware\jrockit_160_2%jre\lib'jsse.jar i
AOracle\Middleware\jrockit_160_29jre\libYjce jar
\Oracle\Middleware\jrockit_160_29\jre\lib\charsets.jar
M\Oracle\Middleware\jrockit_160_20\jre\lib\ext\dnsns,jar
ma ChAOracle\Middleware\jrockit_160_29\jre\lib\ext\localedata, |
[ C\Oracle\Middleware\jrockit 160_29\jre\lib\ext\sunjce_pro’

ByEqE
sl EIEIGE

] M Restore Default

':?:I < Back Mext > I Finish I I I Cancel

In the Preference dialog, select the check box for the JRE you just added, then click OK.
In the New Server Runtime Environment dialog, from the JRE dropdown, select the JRE you
just added.

7. Click Finish.

7. In the New Oracle Event Processing Application Project dialog, with the Oracle
Event Processing v11.1 target runtime selected, click Next.

8. Under Oracle Event Processing Application Content, confirm the properties for
the project you're created.
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@ Mew Oracle Event Processing Application Project l E &]

Oracle Event Processing Application Content

Enter the data required to create application. \y

Bundle Properties

Bundle ID:

Bundle Version:  1.00

Bundle Mame: TradeReport

Bundle Provider:

@ <Back || Nea» || EinishM[ Cancel

9. Click Finish.

After you've created your project, the IDE will display the Project Explorer, with a
hierarchical list of the artifacts in your project, along with an empty editor for the
event processing network you're about to build.

An event processing network (EPN) is a central design concept in an Oracle Event
Processing application. An EPN represents the components, known as stages, that
make up the application, as well as the path taken by events from stage to stage. As
you develop your application, the EPN editor will display the stages you add and the
connections between them. Conceptually, event data enters your application from the
left, moving toward the right from stage to stage.

The design that the EPN editor shows is actually a graphical representation of the
EPN's underlying configuration. When you add a stage or connection through the
EPN editor, the IDE writes configuration XML to an underlying assembly file (just as
editing the XML file directly will result in an updated graphical design in the EPN
editor). An EPN assembly file includes the default configuration for each of an EPN's
stages. This is a default configuration that cannot be changed on the server at runtime
without redeploying the application. For configuration that can be edited at runtime,
you can use another kind of configuration file, as described later.

Note: The EPN assembly file's XML schema is an extension of the
Spring framework configuration file. For more on Spring, see the
Spring web site.

Take a look at the Project Explorer. You should have a project hierarchy that's
something like what's shown in the following illustration.
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L5 Project Explorer i = <===g'>| ¥ =08
= TradeReport

8 src
=i JRE Systern Library [Ja.
o resources.jar - C

aSE-1.6]
cle\Middleware\jrockit_.

e rtjar - C warelj t 1
[ jssejar -
o jeejar - CAO
[ charsets,jar -
(e dnsnsjar - C

(e localedata.jar dleware\jrockit_1

[mg sunjce_providerjar - C\Oracle\Middleware\jrockit_
=i OEP Classpath

(me com.beawlevsspi 11117 Ojar - C

s com.beawlevs.edeapi_ 11.1.1.7 0 jar -
w|=~3 com.beawlevs.ede 11.11.7_0.jar - C\Orac

[mg com.bea.wlevs.management.spi_111.1.7 0.jar

[ com.beawlevs.spring.support 11.1.1.7_0 jar
T com.beawlevs.spring_11.1.1.7_0.jar
(5 com.beawlevs.util 11117 _0jar - C:\0

acle_cep_ps
[mg com.bea.core.zpache.commons.logging.api_1
[ org.springframewerk.spring-beans_2.5.6.jar

[ org.springframework.spring-core_2.5.6.jar -
[ org.springframework.spring-osgi-core_1.2.0.jar - C

[mg org.springframework.spring-osgi-annotation_1.2.0.,
(= build
(= META-INF
= spring
¥ TradeReport.contextxml
= wlevs
x| configaxml
4+ MANIFEST.MF
|m$ build.properties
bundle.properties

4 1 3

If you're experienced with IDEs, much of this should be familiar. In addition to the
usual places for Java source code, the JRE system library, and build output, you'll also
find the following:

= JAR files that make up the Oracle Event Processing classpath. These provide the
functionality needed for the Oracle Event Processing server, including for stages of
an event processing network, Spring-configured components, and logging.

= A spring directory for configuration files that conform to the Spring framework
(for more on Spring, see the Spring web site). The file you start off with is the EPN
assembly XML file that describes the contents and structure of the event
processing network you're building. As you build your EPN, adding and
connecting stages, the IDE captures your work in this file. You can also edit the file
manually. At this point, the file merely declares namespaces for the XML that will
be added to it.

= A wlevs directory for files that describe components whose configuration should
be editable at runtime. Most components have a default configuration that you can
override within a component configuration file in the wlevs directory. The only
component whose configuration you must put in one of these files is a processor. A
processor's Oracle CQL code is editable at runtime by using the Oracle Event
Processing Visualizer.

If you're configuring multiple components, you can use one or multiple
component configuration files. For example, in the case of a team of developers,
where each is responsible for a different component, you might want to have a
configuration file per component to avoid source control conflicts.

Now that you've got a project created, in Section 8.3, "Create an Event Type to Carry
Event Data", you'll start assembling an event processing network. You'll begin by
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creating an event type that will represent incoming event data to the application's
logic.

8.3 Create an Event Type to Carry Event Data

Oracle Event Processing applications are about receiving, processing, and sending
events. Events start as event data that can be in almost any structured form. The event
data arrives at the application in its raw form, then is bound to an event type that you
define. Using your own event type makes handling the data predictable for the rest of
your code in the application, including Oracle CQL queries, Java code, and so on. (The
conversion is done by an adapter. More about those later.)

So an early task in defining any event processing network is clarifying the structure of
the data coming from the source, then defining the form to which you'll convert that
data for use inside the EPN. In this section, you'll work from the structure of example
stock trade data to define an event type to which the data will be bound.

In the case of the application you're building here, the sample incoming event data is
arriving as rows of comma-separated values. Each row contains data about a
particular thing that happened -- here, a stock trade. The structure of the values is
consistent from row to row. Here are a few example rows:

IBM,15.5,3.333333333,3000,15
SUN,10.8,-1.818181818,5000,11
ORCL,14.1,0.714285714,6000,14
GOO0G, 30,-6.25,4000,32
YHO0O,7.8,-2.5,1000,8

Though they aren't labeled in the CSV file, the values could be labeled as follows:

stock symbol, price, percentage change, volume of shares purchased, last
price

That's the structure of the incoming trade event data. In order to handle that data in
your application -- query it, filter it, perform calculations, and so on -- you will need to
assign that data to a new structure that supports doing those things. In particular, the
new structure should have the ability to specify properties of particular types. Having
types matched to the anticipated values makes it easier to handle the values in code.

Looking at the example data and labels, you can imagine each of the values for each
row bound to properties of the following Java types:

String, Double, Double, Integer, Double

Oracle Event Processing supports several forms on which you can base your new
event type. These include JavaBean classes, tuples, and java.util.Map instances. A
JavaBean class is the best practice type for new event types, so that's what you will use
here for trade events.

If you haven't worked with them before, you should know that JavaBeans are Java
classes that follow specific standard rules designed to make them predictable. In
general, the idea is for the class to provide variables to hold data inside it (such as the
trade event stock symbol) and methods through which the data can be retrieved or set
by code outside the class. Naming the methods with predictable names, such as
"setSymbol" and "getSymbol", gives code outside the class a predictable way to use the
data inside the class. For example, when Oracle Event Processing needs to bind
incoming event data to your event type, it will create a new instance of the event type
JavaBean and use the bean's "set" methods to set the data in the proper places inside
the class. Code later in the application, such as Java code or Oracle CQL code you will

1on

write, will be able to call the bean's "get" methods to get the data out again.

Walkthrough: Assembling a Simple Application 8-7



Create an Event Type to Carry Event Data

In the following sections, you will create the JavaBean as code behind your event type,
then configure the event type to use the JavaBean.

Create the TradeEvent JavaBean

In this section, you will create a TradeEvent JavaBean class that will be used as an
event type for incoming trade event data.

1. In the IDE, right-click the src directory, then click New > Class.

2. In the New Java Class dialog, in the package box, enter
com.oracle.oep.example.tradereport

3. In the Name box, enter TradeEvent.

E MNew Java Class [ El i:hl

Java Class —

Create a new Java class. @
Source folder: TradeReport/src
Package: com.oracle.oep.exampletradereport
[7] Enclosing type: Browse...
Mame: TradeEvent

Maodifiers: @ public ) default private protected

[ abstract []final static

Superclass: Jjava.lang.Object
Interfaces: Add...

Remove

Which method stubs would you like to create?
= public static void main(String[] args)
[] Constructors from superclass
Inherited abstract methods
Do you want to add comments? (Configure templates and default value here)
[] Generate comments

@] [ Einish[x ] [ Cancel

4. Click Finish.

The TradeEvent.java source code window will display with the declaration for the
TradeEvent class.

5. In the TradeEvent class, just beneath the TradeEvent class declaration, add private
variables for each of the properties you'll need as shown in the following example.

public class TradeEvent ({
// One variable for each field in the event data.
private String symbol;
private Double price;
private Double lastPrice;
private Double percChange;
private Integer volume;

6. Select the code for all of the variables, click the Source menu, then click Generate
Getters and Setters.
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7.

8.

File Edit [ Source| Refactor

Mavigate Search Project

C9 ~ [§
rﬁ_‘; Project:

hj‘J Tra
=)
=

1 E1EIEIEI G EEIE B EIED

=

a

W mWEIE G Mo

b Servers,

Toggle Comment
Add Block Comment
Remove Block Comment

Generate Element Comment

Shift Right

Shift Left

Correct Indentation
Format

Format Element

Add Import
Organize Imports
Sort Members...
Clean Up...

Override/Implement Methods...
Generate Getters and Setters...
Generate Delegate Methods...
Generate toString()...

Generate hashCode() and equals()...
Generate Constructor using Fields..,

Generate Constructors from Superclass...
Surround With

Externalize Strings...
Find Broken Externalized Strings

Run  Window Help
Ctrl+7 f@s', @ R e
Ctrl+Shift+/ — S
radeEvent.java
Ctrl+Shift+\, F K 2 1 SP— "
ackage com.oracle.oep.example.tradere
Alt+Shift+) packas P " pe
public class TradeEvent {
// One variable for each field in the
private String
private Double
Ctrl+1 private Double
Ctrl+Shift+F private Doubl
}
Ctrl+Shift+M
Ctrl+Shift+0
Alt+Shift+Z »
€l

In the Generate Getters and Setters dialog, select the check box for each variable
you selected (in other words, all of them).

In the Insertion Point dropdown, select Last member.

s

E Generate Getters and Setters

Select getters and setters to create:

A

lastPrice|

percChange
price
symbol
volume

Select All

Deselect All
|

3

[7] Allow setters for final fields (remove ‘final' modifier from fields if necessary)

Insertion point:

l Last member

4

Sort by:

lFields in getter/setter pairs

4

[ final

®@

@ public

Access modifier

() protected () default

[7] synchronized

[] Generate method comments

The format of the getters/setters may be configured on the Code Templates preference page.

I 10 of 10 selected.

() private

oK Q—H Cancel

Click OK.
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In the TradeEvent source code window, notice that you have created pairs of
methods that simply get or set the values of the variables you added.

10. Save the TradeEvent.java file and close the code window.

And that's all there is to creating a JavaBean (at least, in this case). The next step is to
tell your application that the JavaBean should be used as an event type.

Configure the TradeEvent Event Type

In this section, you'll tell the TradeReport application that the TradeEvent JavaBean
should be used as an event type.

1. In the IDE, confirm that the empty TradeReport EPN editor is open. Its tab at the
top of the window should read EPN: TradeReport.

2. At the bottom of the designer window, click the Event Types tab.

3. Under Event Type Definitions, select TradeReport.context.xml. This is the EPN
assembly file underlying your EPN design.

This is also the file you noticed in the META-INF/spring directory of the project
explorer. You are selecting it here to ensure that the event type you are about to
configure gets defined in that file.

4. Under Event Type Definitions, click the plus sign to add a new event definition.
5. Click the newEvent entry that was created.

6. Under Event Type Details, in the Type name box, change the event type's name to
TradeEvent. (It doesn't have to be the same as the JavaBean class, but it makes
things simpler to use the same name.)

7. Select the Properties defined in Java bean option. The other option is for defining
events as tuples.

8. In the Class box, enter the name of the JavaBean class you created:
com.oracle.oep.example.tradereport.TradeEvent.

5l EPM: TradeReport &0 =0
Event Type Definitions 4+ % Event Type Details
a4 B TradeReport.context.xml Type name:  TradeEvent

(% TradeEvent

") Properties defined declaratively

@ Properties defined in Java bean

Class: com.oracle.oep.exampletradereport.TradeEvent

9. Save the file to have the event type name updated in the event type definitions.

If you're curious about what was added to your EPN assembly file, open the file. It's in
the Project Explorer under TradeReport > META-INF > spring >
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TradeReport.context.xml. The part you added looks something like the following (you
might need to click the Source tab at the bottom of the editor window):

<wlevs:event-type-repository>
<wlevs:event-type type-name="TradeEvent">
<wlevs:class>com.oracle.oep.example.tradereport.TradeEvent</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

As the code suggests, Oracle Event Processing manages event types in an event type
repository. The TradeEvent event type you defined is mapped to the TradeEvent
JavaBean class you created.

Now that you have an event type defined and configured, you need to tell the
application how to watch for incoming event data. You also need to specify that the
data should be assigned to the TradeEvent type you created. You do those things with
an adapter, which you will add in Section 8.4, "Add an Input Adapter to Receive Event
Data".

8.4 Add an Input Adapter to Receive Event Data

Before you can try out the event processing network you're building, you will need to
create a way for event data to flow into it. In Oracle Event Processing applications,
adapters manage traffic between external components and the internals of the event
processing network. Event data arriving from external sources enter the application
through an adapter, while event data leaving the application on its way to external
components or applications exits through an adapter. By default, Oracle Event
Processing includes adapters for three different kinds of external components: Java
Message Service (JMS) destinations, HTTP publish-subscribe servers, and CSV files.

The adapter for CSV files, called csvgen, is great for trying things out with code in
development. It's a lightweight alternative to the task of defining an adapter for a
more substantial, "real" event data source. In your own apps, you might find it easier
to use the csvgen adapter until you have your EPN started and some of its logic
defined.

The csvgen adapter's logic knows how to translate event data read from a CSV file into
the event type you defined. You use the csvgen adapter in conjunction with the load
generator utility included with Oracle Event Processing (more about the load
generator later in this walkthrough). The csvgen adapter's implementation code is
included by default in Oracle Event Processing, so all you need to do is add
configuration code to declare the adapter as a stage in your EPN, as well as set a few of
its properties.

Add Code to Configure a CSV Adapter

In this section, you will add configuration code that creates a place for your CSV
adapter in the event processing network. The code will also set a few adapter
properties needed to configure the adapter's runtime behavior. You add the code to the
EPN assembly file so that the adapter will be included in the EPN and appear in the
EPN designer as a stage.

1. In the IDE, locate and open the EPN assembly file. In the Project Explorer, it
should be located at TradeReport > META-INF > spring >
TradeReport.context.xml.

2. Below the event-type-repository XML stanza, add the following XML to declare
the adapter:

<wlevs:adapter id="StockTradeCSVAdapter" provider="csvgen">
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<wlevs:instance-property name="port" value="9200" />
<wlevs:instance-property name="eventTypeName"
value="TradeEvent" />
<wlevs:instance-property name="eventPropertyNames"
value="symbol, price, percChange,volume, lastPrice" />
</wlevs:adapter>

This XML stanza declares an instance of the csvgen adapter and assigns to it three
properties that configure it for use in your EPN. The adapter uses the properties to
map from incoming raw event data to the properties of the event type you defined
in Section 8.3, "Create an Event Type to Carry Event Data". The following describes
the values you're adding:

= Adapter declaration. The id attribute value is a unique identifier for the
adapter. The provider attribute value must be "csvgen" in order to refer to the
csvgen implementation included with Oracle Event Processing.

s The port instance property tells the adapter instance what port to listen on for
incoming event data. The value here, 9200, corresponds to the port number to
which the load generator will send event data (more on that later).

»  The eventTypeName instance property tells the instance the name of the event
type to which incoming event data should be assigned. Here, you give the
name of the TradeEvent type you defined earlier.

s The eventPropertyNames instance property tells the instance the names of the
event type properties to which data should be assigned. Notice in this case
that the eventPropertyNames attribute value is a comma-separated list of the
same properties you defined in the JavaBean for the event type. In order for
the csvgen adapter to map from incoming values to event type properties, the
names here must be the same as your event type and must be in the same
order as corresponding values for each row of the CSV file.

3. Save and close the EPN assembly file with the adapter XML in it.
4, Ifitisn't open already, open the EPN editor to its Overview tab.

5. In the EPN editor, notice that it now displays an icon representing the csvgen
adapter instance you just added. The icon will be labeled with the adapter id value
you specified in configuration code.

=l EPM: TradeReport &0 =0
Filter. ¥| Bundle: TradeReport | b AT 100% bl S =

-

StockTradeCSVAdapter

Overview | Event Types
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In the next step, Section 8.5, "Add a Channel to Convey Events", you will add a way to
carry events from the adapter to logic you will add in a moment.

8.5 Add a Channel to Convey Events

In this step, you will add a way to connect the adapter you added in Section 8.4, "Add
an Input Adapter to Receive Event Data" to a bit of logic you will add in the next step.
Afterward, you will test the application.

In Oracle Event Processing applications, you connect EPN stages together by using a
channel. A channel is a conduit that transfers events from one part of the EPN to
another. Though conveying events is a channel's primary purpose, channel
configuration options give you opportunities to specify other properties through
which you can tune the application. These include:

»s  Whether the channel can process events asynchronously, and how big the buffer
for this can get.

=  How many threads may be used to process events in the channel (a larger number
can increase performance).

= Whether to partition events, based on their properties, in order to have the events
dispatched to separate downstream parts of the EPN.

Those kinds of channel configuration properties have default values, so you needn't
set them for the application you're building. In this application, you'll keep channel
configuration simple.

The purpose of the channel you are about to add is to carry newly generated events
from the adapter that's receiving event data to code you will add in the next step.

Add the AdapterOutputChannel

1. In the IDE, ensure that the EPN editor is open and that the EPN you're building is
visible.

2. Right-click the EPN editor, then click New > Channel.
A channel icon should appear in the EPN editor.

3. Double-click the channel icon that appears in the editor to display the channel's
configuration XML in the EPN assembly file.

4. In the assembly XML file, locate the channel XML stanza for the channel you
added. It should look something like the following:

<wlevs:channel id="channel">
</wlevs:channel>

You might notice a warning that "channels should declare an "event-type” value".
You are about to fix that.

5. Edit the default XML to match the following (or simply paste the following code
over the code you have).

<wlevs:channel id="AdapterOutputChannel" event-type="TradeEvent">
</wlevs:channel>

The following describes the values you're adding to configure the channel:

»  The channel element represents configuration for the channel, placing the
channel in the EPN.

Walkthrough: Assembling a Simple Application 8-13



Add a Channel to Convey Events

s The id attribute's value is a unique identifier for the channel in this EPN. (You
will be adding another channel.)

s The event-type attribute's value is the name of the event type that the channel
is configured to convey. In this case, you're setting it to TradeEvent, the name
of the event type you added earlier, whose implementation is the TradeEvent
JavaBean you created. Note that the value you are adding here is the same as
the type-name attribute value of the event-type element elsewhere in the
assembly file.

After you have finished editing the channel configuration XML, save the assembly
file.

6. Return to the EPN editor. You might need to click the EPN: TradeReport tab to
display the EPN editor.

7. In the EPN editor, create a connection from the input adapter to the channel you
added. To do this, click the StockTradeCSVAdapter icon and drag to the
AdapterOutputChannel icon. This will create a connecting line between the two

icons.
=l EPM: TradeReport &2 =0
Filter ¥ Bundle: TradeReport AP AL 100% ~|| & &

e
Adapteroxutchannel

Overview | Event Types

8. To make the EPN diagram tidy by having icons display sequentially from left to
right, click the Layout EPN icon at the top right corner of the EPN editor.

9. Double-click the StockTradeCSVAdapter icon to display the adapter's
configuration XML in the assembly file.

10. In the assembly file, notice that creating a connection between the adapter and the
channel has added a listener element to the adapter XML stanza. That element's
ref attribute value is set to the id attribute of channel element. This XML defines
the connection that is graphically displayed in the EPN editor.

The resulting EPN assembly XML should look something like the following
(aspects that connect components are shown in bold text):

<?xml version="1.0" encoding="UTF-8"?>

<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xmlns:jdbc="http://www.oracle.com/ns/ocep/jdbc"
xmlns:spatial="http://www.oracle.com/ns/ocep/spatial"
xsi:schemalocation="...">

<!-- Schema locations omitted for brevity. -->
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<wlevs:event-type-repository>
<wlevs:event-type type-name="TradeEvent">
<wlevs:class>com.oracle.cep.example.tradereport.TradeEvent</wlevs:c
lass>
</wlevs:event-type>
</wlevs:event-type-repository>

<wlevs:adapter id="StockTradeCSVAdapter" provider="csvgen">
<wlevs:listener ref="AdapterOutputChannel" />
<wlevs:instance-property name="port" value="9200" />
<wlevs:instance-property name="eventTypeName"
value="TradeEvent" />
<wlevs:instance-property name="eventPropertyNames"
value="gsymbol, price, percChange,volume, lastPrice" />
</wlevs:adapter>

<wlevs:channel id="AdapterOutputChannel" event-type="TradeEvent">
</wlevs:channel>

</beans>

11. Save TradeReport.context.xml and close the file.

In this step, you added a channel to convey events out of the input adapter. In the next
step, Section 8.6, "Create a Listener to Receive and Report Events", you will add a stage
for the events to go.

8.6 Create a Listener to Receive and Report Events

In this step, you will add a stage that will complete a simple event processing network
so that you can test the application with event data. The stage will be a "listener" Java
class that's designed to receive trade events passing through the EPN and report
information about the trades.

The listener you're adding is a particular kind of Java class known in Oracle Event
Processing as an event sink. An event sink is code that is able to receive events as they
pass through an EPN. By intercepting events with an event sink, you can use the
class's logic to find out what's inside the events and use that data while executing
other logic in the class. In addition to writing event sinks, you can also write event
sources, which are able to send events to stages downstream in the EPN.

So you can imagine, for example, a single Java class that intercepts events, executes
code that changes the events' contents (or creates new events from them), then sends
the resulting events along to the next stage. Such code could also initiate other
processes (potentially in other applications) based on what the events look like.

Both event sinks and event sources implement particular Oracle Event Processing Java
interfaces. For example, an event sink implements one of two interfaces, depending on
whether the events it's receiving are part of a stream or a relation:
com.bea.wlevs.ede.api.StreamSink or com.bea.wlevs.ede.api.RelationSink.

The difference between streams and relations isn't especially important in the
application you are building here (your code won't rely on the difference). Still, it's
worth a brief explanation because it's an important part of understanding how event
processing with Oracle Event Processing works.

A stream is a sequence of events that's sequential with respect to time, with events
with an earlier timestamp arriving before those with a later timestamp. In contrast, a
relation is a set of events in which events in the set were chosen because they met
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certain criteria. Code executing on a relation can result in delete, insert, and update
events.

As an illustration, consider a metaphor for a stock trade application that's more
involved than the one you're building here. Imagine that the trade events your
application receives are flowing through a pipe that you can't see into. The events
emerge from the pipe in the order they were received -- an order that you care about
because it matters which events occurred before which other events. To catch them,
you put a bucket under the end of the pipe that's designed to catch fifteen seconds'
worth of the trades at a time so that your code can see if a trade of one specific stock
occurred within 15 seconds before a trade of another specific stock.

The pipe is a stream, where the sequence and adjacent quality are key characteristics.
The bucket is a relation, where certain shared characteristics define what's in the
bucket.

In the following sections, you'll create a Java class that implements the interface
through which it listens for events, then configure that class as an event bean, making
it part of the EPN.

Create the Listener Event Sink Class
In this section, you'll create a Java class capable of receiving events from a stream.

1. In the IDE, in the Project Explorer, right-click the src directory, then click New >
Class.

2. In the New Java Class dialog, in the Package box, enter
com.oracle.oep.example.tradereport.

3. In the Name box, enter TradeListener.

4. Next to the Interfaces box, click the Add button to select the interface your listener
will need to implement to be an event sink.

5. In the Implemented Interfaces Selection dialog, in the Choose interfaces box,
enter com.bea.wlevs.ede.api.StreamSink.

6. With StreamSink selected in the Matching items box, click OK.

7. In the New Java Class dialog, under Which method stubs would you like to
create, ensure that the Inherited abstract methods check box is selected (the others
should be cleared).
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18] New Java Class l =l il’-]

Java Class —
Create a new Java class. @

Source folder: TradeReport/src
Package: com.oracle.cep.exampletradereport

[ Enclosing type: Browse...
Mame: TradeListener
Modifiers: @ public () default private protected

| abstract [ final static
Superclass: java.lang.Object
Interfaces: 1] com.bea.wlevs.ede.api.StreamSmld Add...

Remove

Which method stubs would you like to create?
|| public static void main(String[] args)
[] Constructers from superclass
Inherited abstract methods
Do you want to add comments? (Configure templates and default value here)

D Generate comments

@ Einish ] | [ Cancel

8. Click Finish.

The TradeListener.java source code window will open to display the declaration
for the TradeListener class. A declaration for the onInsertEvent method should
also be present in the java file. This method is required when implementing the
StreamSink interface.

9. In the TradeListener class, edit the onInsertEvent method to match the following
code:

@Override
public void onInsertEvent (Object event) throws EventRejectedException {

if (event instanceof TradeEvent) {
String symbolProp = ((TradeEvent) event).getSymbol();
Integer volumeProp = ((TradeEvent) event).getVolume();
System.out.println(symbolProp + ":" + volumeProp);

This is the method that Oracle Event Processing will use to pass an event into your
listener, where your code can do something with it. The changes you're making
implement the method to do the following;:

= Ensure that the incoming event is an instance of your TradeEvent JavaBean.
(Any others would be ignored.)

» If the event is a TradeEvent, the code will simply print out the stock symbol
and trade volume it contains.

10. Save and close the TradeListener.java file.
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Configure the Listener Class as an Event Bean
In the preceding section, you implemented an event sink to create a class to listen for

events of a particular type. In this section, you will add that listener to your EPN as an
event bean that you can connect to other parts of the EPN.

An event bean is a way to add Java code to an EPN. Another way is a Spring bean.
Though they offer differing management features, both bean models provide a means
to configure an EPN stage whose implementation is Java code that you write. An event
bean, which you're creating here, integrates more fully with Oracle Event Processing
server features. A Spring bean is a good choice when you need to integrate with an
existing Spring framework.

1. Inthe EPN editor, right-click an empty area, then click New > Event Bean.

2. Double-click the new eventBean icon to display its configuration code in the
assemble XML file.

3. In the TradeReport.context.xml source code, locate the event-bean element and
edit it so that it appears as follows:

<wlevs:event-bean id="ListenerBean"
class="com.oracle.oep.example.tradereport.TradeListener" />
With this code, you're configuring the event bean with the unique identifier,
"ListenerBean", and an implementation class that's the class you created earlier.

4. Save the assembly XML file.

5. Return to the EPN editor to see that the design reflects your changes to the
underlying XML, such as the new event bean name.

6. Inthe EPN editor, click the AdapterOutputChannel to select it.

7. Again click the AdapterOutputChannel and drag to the ListenerBean event bean
icon. This creates a connection so that events can pass from the channel to the
event bean.

8. Tidy the diagram by clicking the Layout EPN icon.

[k *EPN: TradeReport &3 A *TradeReport.context.xml =0

Filter ¥ Bundle: TradeReport ‘ AL AL [100% - | H=H =2

AdapterQutputChannel

StockTradeCSVAdapter ListenerBean

Overview | Event Types

9. Double-click the AdapterOutputChannel to display its underlying XML.

Note that the channel XML stanza now includes a listener element whose ref
attribute value is the same as the ID value for the event bean you added. (The
word "listener" in both places here is for convenience only.)

<wlevs:channel id="AdapterOutputChannel" event-type="TradeEvent">
<wlevs:listener ref="ListenerBean" />
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</wlevs:channel>

<wlevs:event-bean id="ListenerBean"
class="com.oracle.oep.example.tradereport.TradeListener" />

10. Save TradeReport.context.xml.

In this step, you added an event bean to listen for events traveling through the event
processing network. In the next step, Section 8.7, "Set Up the Load Generator and
Test", you will test the application you are building.

8.7 Set Up the Load Generator and Test

In this step, you will deploy your project on an instance of the Oracle Event Processing
server, then use the load generator utility included with Oracle Event Processing to
feed sample data to the application you are building.

The load generator utility installed with Oracle Event Processing provides a way for
you to easily begin testing your project. It's specifically designed to read a CSV file and
send rows in the file as event data to a port you specify in its configuration. In your
project, a CSV adapter listening on that port receives the rows and converts their data
into instances of the event type you defined for it. Through a properties file, you can
configure certain aspects of the load generator, including the CSV file and target port
to use, how long the load generator should run, how fast it sends event data, and so
on.

In the following sections, you'll create an instance of the Oracle Event Processing
server, configure it for deploying your project, then set up the load generator and test
the project.

Create a Server on Which to Run the Project

In this section, you'll add an Oracle Event Processing server instance to the
TradeReport project. Adding the server instance gives you a convenient way to use the
IDE to start and stop the server, as well as redeploy the project whenever you make
changes and want to test again.

The IDE is aware of the Oracle Event Processing server through the server runtime
environment included when you created the project. (You might have needed to add
the server runtime envirronment as a separate step.)

1. In the IDE, ensure that the Servers view is displayed. If it isn't visible, click
Window > Show View > Servers to display it.

2. In the Servers view, right-click to display the context menu, click New, then click
Server.

3. Inthe New Server dialog, under Select the server type, expand Oracle, then click
Oracle Event Processing v11.1.

4. Leave the host name, server name, and runtime environment as is, then click Next.

5. Under New Oracle Event Processing v11.1 Server, ensure that the Local Server
option is selected, then click Next.

6. In the next window, under New Oracle Event Processing v11.1 Server, leave the
Domain Directory as is, then click Next.

7. Under Add and Remove, in the Available box, select TradeReport, then click the
Add button between the Available and Configured boxes.
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Moving the TradeReport project name into the Configured list specifies that the
TradeReport project you're building should be configured to run on the server
you're adding. This simple step makes it easy to deploy (and redeploy) the project
to the server as you're debugging.

8] New Server l = il’-]

Add and Remove ‘ ‘

Meodify the resources that are configured on the server

Move resources to the right to configure them on the server

Available: Lonfigured:

Eé TradeReport

< Remove

<< Remowe All

.
® ot ) [y (e

8. Click Finish.

After you've added the server, it should be listed in the Servers view as Oracle Event
Processing v11.1 at locahost (Stopped). Expand its entry to confirm that the
TradeReport project is one of its configured projects.

Set Up the Test Data and Load Generator

You don't actually need to set up the test data and load generator -- they're set up
when you install Oracle Event Processing. But since you'll be using them to debug
your project, use the following steps to take a look at them.

1. In the text editor of your choice, open the StockData.csv file included with Oracle
Event Processing. By default, you'll find this file at the following path:

ORACLE_HOME/Middleware/ocep_11.1/utils /load-generator /StockData.csv

Notice that the contents of the file are essentially more of what you saw in the
example when you defined an event type for the data. Notice that, as with any
CSV file, the rows are uniform in terms of the order of values they contain.

2. In the text editor, open the StockData.prop file.

This is the properties file that configures the work of the load generator. Two of its
properties -- test.csvDataFile and test.port -- are required in order for the load
generator to work. The other properties are technically optional, but you'll need to
set one more in order to ensure that the load generator knows that your input is in
CSV form. To debug the TradeReport project, you should have the following
properties set:

= test.csvDataFile -- The name of the CSV file that the load generator will
read. The value here should be StockData.csv.
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= test.port -- The port number to which the load generator will send event
data. This should be the port value you specified when you configured the
CSV adapter instance, or 9200.

»  test.packetType -- The form that the load generator will be handling. This
value should be CsvV.

Debug the Project

Of course, you probably won't need to actually debug this project (you've been doing
everything exactly as described here, right?). But setting a breakpoint and running the
Oracle Event Processing server in debug mode will give you a chance to see how
things are working.

1.

In the IDE, open the TradeListener.java file you created in an earlier step. In the
Project Explorer, the file should be visible by expanding TradeReport > src >
com.oracle.cep.example.tradereport.

In TradeListener.java, set a breakpoint at the line with the following code:

System.out.println(symbolProp + ":" + volumeProp);

In the Servers view, select the server you added: Oracle Event Processing v11.1 at
localhost

With the server selected, click the Start the server in debug mode button in the
upper right corner of the Servers view.

You will likely need to wait for a few moments while the server starts, the IDE
compiles your project, and then deploys the TradeReport project as an application
to the running server. During this time, the Console view will display status
messages related to the server's startup progress. The server is running in debug
mode when the Console view's output ends with <Server STARTED> or <The
application context for "TradeReport" was started successfully>.

In the Servers view, confirm that the project does not need to be republished to the
server. If the TradeReport entry shows (Republish), then right-click the
TradeReport entry and click Force Publish. After it has been successfully
deployed, the entry will show (Synchronized).

If you see errors when you attempt to republish, you might need to clean and
rebuild the project before continuing.

Open a command prompt and change directory to the load-generator directory
installed with Oracle Event Processing. By default, this is at the following path:

ORACLE_HOME/Middleware/ocep_11.1/utils/load-generator

In the command prompt, type the following, then press Enter to start sending
event data to your deployed project:

s On Windows: runloadgen.cmd StockData.prop
s  On Linux: runloadgen.sh StockData.prop

Once the load generator begins sending event data, the IDE should switch to its
debugging perspective (if you have the IDE set that way) and pause execution at
the breakpoint you set in the Listener class.

When execution has paused at the breakpoint, look at the Variables view to
examine the contents of the event that was received by the listener. By clicking
each of the event's properties, you can view the values assigned to each from the
CSV file.
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10. Click the Resume button repeatedly to advance execution from event to event,
noticing the values in each.

11. In the Console window, notice that the listener code is printing stock symbols and
volumes from the events it receives.
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12. In the Servers view, select the Oracle Event Processing server, then click the Stop
the server button.

13. In the load generator command prompt window, press CIRL+C to stop the load
generator.

That's it! You've created and tested a simple Oracle Event Processing application. In
the last step, Section 8.8, "Add an Oracle CQL Processor to Filter Events", you'll make
the application a little more interesting by adding some Oracle CQL code.

8.8 Add an Oracle CQL Processor to Filter Events

In this step, you'll add a processor to filter events based on certain criteria. A processor
is a stage to which you add Oracle Continuous Query Language (Oracle CQL) code for
querying incoming events. Processors and Oracle CQL queries represent much of the
real power of event-oriented applications you build with Oracle Event Processing.
With Oracle CQL, you can focus the application's logic on just those events you care
about, executing sometimes complex logic as events arrive.
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If you have used Structured Query Language (SQL), Oracle CQL will appear very
familiar. In fact, Oracle CQL is essentially like SQL -- with the same keywords and
syntax rules -- but with features added to support the unique aspects of streaming
data. (If you aren't familiar with SQL, getting acquainted with it will go a long way
toward helping you get the most out of Oracle CQL.)

Remember that event data (and the Oracle Event Processing events that result from it)
is a stream of data that the EPN receives sequentially. To continue the comparison of
SQL and Oracle CQL, an event may be said in one sense to correspond to a row in a
database. However, an important difference is that with events, one event is always
before or after another, time-wise, and the stream is potentially infinite and
ever-changing. In a relational database, rows may be said to be a finite set where data
is relatively static. With a relational database, data is waiting for your query to go and
get it; with a stream of event data, data is always flowing into the EPN, where your
query examines it as it arrives.

To make the most of the sequential, time-oriented quality of streaming data, CQL
includes the ability to:

»  Specify a window of a particular time period, or range, from which events should
be queried. This could be each five seconds worth of events, for example.

s Specify a window of a particular number of events, called "rows," against which to
query. This might be each sequence of 10 events.

= Specify how often the query should execute against the stream by using the slide
keyword. The query could "slide" every five seconds to a later five-second window
of events.

»  Separate, or partition, an incoming stream into multiple streams based on
particular characteristics of the events. You could have the query create new
streams for each of specified stock symbols found in incoming trade events.

In addition, CQL supports common aspects of SQL you might be familiar with,
including views and joins. For example, you can write CQL code that performs a join
involving streaming event data and data in a relational database table or cache. CQL is
extensible through cartridges, with included cartridges providing support for queries
that incorporate functionality within Java classes, for calculations specific to spatial
data, and to query JDBC data sources.

To get acquainted with processors and CQL, you'll keep the code you're adding here
simple. You'll add a query that retrieves certain events fed from the
AdapterOutputChannel. The query will be designed to retrieve only those trades
whose volume is greater than 4000. Events in the query's results will be passed along
to the listener.

The following is what the CQL code will look like:

Example 8-1 GetHighVolume Query Element with CQL Code

<query id="GetHighVolume"><![CDATA [
select trade.symbol, trade.volume
from AdapterOutputChannel [now] as trade
where trade.volume > 4000
11>

</query>

This query can be paraphrased as "for every event coming from the
AdapterOutputChannel whose trade volume is more than 4000 shares, get the symbol
and volume values." The select, from, and where statements should look familiar if
you've used SQL. The now operator represents a window of time, where the window is
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essentially instantaneous -- it includes every event. Another window might have been
[range 5], meaning "select from all the events that arrive within each five second
period." (That might be useful if you care that certain trades have occurred within five
seconds of one another.)

The output of this query will be a relation -- or set, rather than sequence -- that
includes all of the events whose trade volume is greater than 4000. Because the
window is [now], the set will always have no more than one member. A relation from
a larger range might have multiple members in its set.

Add a GetHighVolume Processor and Query

1.

In the IDE, in the EPN editor, right-click an empty area of the diagram, then click
New > Processor.

In the New Processor dialog, in the Processor ID box, enter
GetHighVolumeProcessor.

Select the Use an existing configuration file option.

Remember that you can create a different configuration file for each processor.
That might be useful if you have a different person working on each one.

In the dropdown, leave config.xml selected, then click OK.
In the EPN editor, notice that a GetHighVolumeProcessor icon has been created.

Right-click the connector from the AdapterOutputChannel icon to the
ListenerBean icon, then click Delete.

Click then AdapterOutputChannel icon, then drag from it to the
GetHighVolumeProcessor icon.

Creating this connection makes the processor aware of the channel, After
connecting the channel to the processor, you can refer to the channel by its ID
value in CQL code.

Double-click the GetHighVolumeProcessor icon to open its configuration code in
the config.xml file.

In the config.xml file, replace the query element with the following query XML:

<query id="GetHighVolume"><![CDATA[
select trade.symbol, trade.volume
from AdapterOutputChannel [now] as trade
where trade.volume > 4000
11>
</query>

The code window should look something like the following:
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QQ*EPN: TradeReport % *configxml &2 =08

<?xml version="1.8" encoding="UTF-8"?> -
<wlevs:config umlns:wlevs="http://www.bea. com/ns/wlevs/config/application”
wmlns:jdbc="http:/www.oracle. com/ns/ocep/config/jdbc">

<processor>
<name>GetHighVolumeProcessor</name>
<rules>
<query id="GetHighVolume"><![CDATAL
select trade.symbol, trade.volume
from AdapterOutputChannel [ ] as trade
where trade.volume > 4688
1
| </query>
</rules>
</processors

</wlevs:config>

4 [}

Design | Source

10. In the EPN editor, right-click an empty area of the diagram, then click New >
Channel.

11. Right-click the icon for the new channel, then click Rename.
12. Type ProcessorOutputChannel and press Enter to rename the channel.

13. Click the GetHighVolumeProcessor icon, then drag to the new channel icon to
connect the processor and channel.

14. Click the ProcessorOutputChannel icon, then drag to the ListenerBean icon to
connect the channel to the listener.

15. Click the Layout EPN button to tidy the diagram so that the icons are in a row
from left to right in order of sequence.

16. Double-click the ProcessorOutputChannel icon to open the channel's
configuration in the assembly XML file.

17. In TradeReport.context.xml, replace the default channel configuration with the
following XML. In particular, note that you're specifying that TradeEvent is the
event type that passes through this channel.

<wlevs:channel id="ProcessorOutputChannel" event-type="TradeEvent">
<wlevs:listener ref="ListenerBean" />
</wlevs:channel>

18. Save all of the files in the project.
At this point, you should be ready to debug the application again.

Debug the Project

In this section, you'll debug once more to confirm that your CQL code is producing the
results you intend.

1. In the IDE, open the TradeListener.java file you created in an earlier step. In the
Project Explorer, the file should be visible by expanding TradeReport > src >
com.oracle.cep.example.tradereport.

2. In TradeListener.java, confirm that you have a breakpoint at the line with the
following code: System.out.println(symbolProp + ":" + volumeProp);

You might need to rebuild the project before you can successfully debug.
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3. Inthe Servers view, select the server you added: Oracle Event Processing v11.1 at
localhost

4. With the server selected, click the Start the server in debug mode button in the
upper right corner of the Servers view.

You will likely need to wait for a few moments while the server starts, the IDE
compiles your project, and then deploys the TradeReport project as an application
to the running server. During this time, the Console view will display status
messages related to the server's startup progress. When the Console view's output
ends with <Server STARTED>, the server is running in debug mode.

5. Inthe Servers view, confirm that the project does not need to be republished to the
server. If the TradeReport entry shows (Republish), then right-click the
TradeReport entry and click Force Publish. After it has been successfully
deployed, the entry will show (Synchronized).

6. If you don't have one already, open a command prompt and change directory to
the load-generator directory installed with Oracle Event Processing. By default,
this is at the following path:

ORACLE_HOME/Middleware/ocep_v11.1/utils/load-generator

7. In the command prompt, type the following, then press Enter to start sending
event data to your deployed project:

s On Windows: runloadgen.cmd StockData.prop
s On Linux: runloadgen.sh StockData.prop

Once the load generator begins sending event data, the IDE should switch to its
debugging perspective (if you have the IDE set that way) and pause execution at
the breakpoint you set in the listener class.

8. When execution has paused at the breakpoint, look at the Variables view to
examine the contents of the event that was received by the listener.

By clicking each of the event's properties, you can view the values assigned to each
from the CSV file. Notice that the event contains only two values -- symbol and
volume. That's because your query selects only those two values from events that
pass through the processor.

9. Click the Resume button repeatedly to advance execution from event to event,
noticing the values in each.

10. In the Console window, notice that the listener code is printing stock symbols and
volumes from the events it receives.

If you have coded your query correctly, all of the volume values should be higher
than 4000.

11. In the Servers view, select the Oracle Event Processing server, then click the Stop
the server button.

12. In the load generator command prompt window, press CTRL+C to stop the load
generator.

That's it -- you've finish this application. For a list of the things covered in this
walkthrough, along with links to more information, see Section 8.9, "Summary: Simple
Application Walkthrough".
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8.9 Summary: Simple Application Walkthrough

This section summarizes the simple application walkthrough, which begins with
Section 8.1, "Introduction to the Simple Application Walkthrough". In this
walkthrough, you built a simple Oracle Event Processing application. You assembled
an event processing network to receive events and report on those that met certain
criteria.

For other introductory content, see Chapter 1, "Overview of Creating Oracle Event
Processing Applications".

This walkthrough introduced the most basic aspects of developing Oracle Event
Processing applications. Those concepts include:

IDE features designed to make building Oracle Event Processing applications
easier.

To start learning more about the IDE, see Section 4.1, "Overview of Oracle Event
Processing IDE for Eclipse".

Building an application as an event processing network (EPN).

For another introduction to EPNSs, see Section 1.2, "How an Oracle Event
Processing Application Works".

Designing event types that model events.

For more information, see Section 9.1, "Overview of Oracle Event Processing Event
Types".

Using adapters to manage interactions with external components.

Oracle Event Processing includes adapters. You can also build your own. See the
following sections for more:

— Chapter 11, "Integrating the Java Message Service"
— Chapter 12, "Integrating an HTTP Publish-Subscribe Server"
— Chapter 15, "Integrating an External Component Using a Custom Adapter”

—  Chapter 21, "Testing Applications With the Load Generator and csvgen
Adapter"

Implementing a Java class that can receive or send events.

For more on writing event sinks and event sources, see Chapter 16.2, "Handling
Events with Sources and Sinks"

Event streams and relations as models for handling events as they pass through an
event processing network.

For an introduction to streams and relations, see Section 1.3, "Overview of Events,
Streams and Relations".

Using Oracle Continuous Query Language (Oracle CQL) to find and filter events.

For more on Oracle CQL, see Chapter 17, "Querying an Event Stream with Oracle
CQLH
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Defining and Using Event Types

This chapter describes how to define the Oracle Event Processing event types you will
need to carry event data through an event processing network, including how to
implement and configure event types and how to access the event type repository.

Through the event types you define, your code has access to event data. As described
in this chapter, you define event types that are based on one of several data types such
as JavaBean classes you write. You add your event types to your application by
configuring them as part of the event type repository. Although event types are
typically added to the repository through configuration XML, you can also write code
to access the repository programmatically.

This chapter includes the following sections:

= Section 9.1, "Overview of Oracle Event Processing Event Types"
= Section 9.2, "Designing Event Types"

= Section 9.3, "Creating Event Types"

»  Section 9.4, "Accessing the Event Type Repository"

»  Section 9.5, "Sharing Event Types Between Application Bundles"

9.1 Overview of Oracle Event Processing Event Types

An event type is how you represent event data in an Oracle Event Processing
application. An event is structured data related to something that occurred at a
particular time. For example, if your application is designed to react to changes in a
server room’s environment, event data could include snapshot information collected
by a device that monitors the environment. Or if your application pays attention to
trends and patterns related to stock market trades, event data could be values
corresponding to a trade, including what stock was traded, what the trade volume
was, what the share price was, and so on.

Event data entering your application can arrive in any of a wide variety of forms. By
creating an event type to represent the data inside the application, you create a
predictable way for your application’s logic to work with the data. Because event
types are the transport vehicles for event data, defining them is an essential part of
building an Oracle Event Processing application.

For a hands-on look at creating and using event types, take a look at Section 8.3,
"Create an Event Type to Carry Event Data".
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9.1.1 Where Event Type Instances are Used

Instances of event types you create carry event data through the event processing
network (EPN) of your application. Keep in mind how you're going to be using the
events in code to make better decisions about designing and implementing event

types.

Event type instances are used by either the Oracle Event Processing server or your
own application logic. Typically, the Oracle Event Processing server creates an instance
of the type and binds the data to it. However, for more control over how the event type
instance is created, you can create an event type builder. For more information, see
Section 9.3.1.5, "Controlling Event Type Instantiation with an Event Type Builder
Class".

The following lists the primary places where an event type instance is used:

= When incoming event data arrives from an external source, it is bound to an event
type instance.

= When an Oracle CQL processor executes a query and outputs a result, an instance
of the event type is created for carrying result event data to a stage that is
downstream in the EPN.

= Inyour application’s Java logic, such as Java code for handling events, you can
create new event type instances and send them to a stage that is downstream in
the EPN. Java code that creates events is known as an event source. For more
information about implementing event sources, see Section 16.2.2, "Implementing
an Event Source".

9.1.2 High-Level Process for Creating Event Types

At a high level, the process for creating an event type is a matter of identifying the
event data that the event type will need to carry, then implement the type as one of the
data types supported by Oracle Event Processing.

Here are high-level steps:

1. Design the event type. Essentially, this is a matter of identifying the set of event
data that’s relevant for your application, then choosing how that data should be
represented by an event type. For more information, see Section 9.2, "Designing
Event Types".

2. Create the event type. Once you know how data should be represented by the
type, you can create the type in one of three ways: by implementing it as a
JavaBean class, by configuring it as a tuple, or by configuring it as a
java.util.Map. You might also want to implement an event type builder for more
control over how the type is instantiated. For more information, see Section 9.3,
"Creating Event Types".

9.2 Designing Event Types

9-2

When you design an event type, you map raw event data to the implementation
options that Oracle Event Processing supports.

Designing an event includes the following tasks:

= Identify the structure of event data that the event type will represent. This could
be the structure of raw event data coming from an external source such as a
monitor in a server room. It could also be a data structure required by a
downstream stage or component to which your code will send instances of the
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type. For more information, see Section 9.2.1, "Identifying the Structure of Event
Data".

s Choose the data type that will be the basis of the event type you're creating. Your
event type will be based on one of three data types supported by Oracle Event
Processing: a JavaBean class, a tuple, or a java.util. Map instance. For more
information, see Section 9.2.2, "Choosing a Data Type for an Event Type".

s Keeping in mind the planned uses for the event type, and being aware of potential
constraints imposed by those uses. For more information, see Section 9.2.3,
"Constraints on Design of Event Types".

Finally, note that when configuring event types in the application’s EPN XML file, you
can mix type usage. For more information, see Section 9.2.4, "Mixing Use of Event
Type Data Types".

9.2.1 Identifying the Structure of Event Data

An early task (though typically a simple one) in defining an event processing network
is clarifying the structure of event data, then defining the form in which that data will
be handled inside the EPN. The event type you create will include a property for each
piece of event data your application cares about. Each of those properties will have its
own data type.

Before you can create an event type, use a sample of the event data to define the type’s
properties and their data types. For an example, consider a very simple set of event
data coming from a stock trade. Represented as a row of comma-separated values, the
trade event data might look as follows:

ORCL,14.1,6000

The following table illustrates how you could separate the event data into its distinct
values, defining an event type property for each.

Event Type
Sample Data Value Role Type of Data Property Name
ORCL stock symbol character symbol
14.1 share price number price
6000 volume of shares number volume

traded

Regardless of how you create your event type, you'll need to have a sense of its
properties and their data types. However, how you specify those property data types
will vary depending on the data type on which you base your event type. For
example, if you implement a JavaBean class as your event type, data types for the
three values specified in the table would likely be as follows:

Event Type

Property Name Java Data Type
symbol String

price Double

volume Integer
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The data types would be different if you were creating your event type as a tuple or
java.util. Map. For more information, see Section 9.2.2, "Choosing a Data Type for an

Event Type".

9.2.2 Choosing a Data Type for an Event Type

Event types you create are based on one of three data types supported by Oracle Event
Processing: a JavaBean class, a tuple, or a java.util.Map.

Each data type has its own benefits and limitations, but the best practice is to create
your event type as a JavaBean class, implementing event type properties as accessor
methods. With a JavaBean, you will have greater flexibility to deal with event types as
part of your application logic, as well as simplified integration with existing systems.
With an event type implemented as a JavaBean class, you can also (if you like) closely
control event type instantiation by implementing an event type builder class.

When you create your event type as a tuple or java.util.Map, you do so by defining
the event type in the EPN assembly file, specifying its properties declaratively. Unless
you explicitly declare that a java.util.Map should be used, Oracle Event Processing

will use the tuple type as the default.

For the benefits and limitations of each supported data type, see Table 9-1, " Data

Types for Event Types™:
Table 9—-1 Data Types for Event Types
Data Type Description Benefits and Limitations
JavaBean A Java class written to JavaBean conventions. In Benefits: This type is the best practice because it provides
addition to being used by logic you write, the type’s the greatest flexibility and ease of use for application
accessor ("get" and "set") methods will be used by logic that handles events. You access property values
the Oracle Event Processing server and CQL directly through accessor methods. A JavaBean class is
processor to retrieve and set event property values.  more likely to be useful when integrating your Oracle
For more information, see Section 9.3.1, "Creating an Event Processing apphcatlgn' with qther systems. For
: w  control over how the type is instantiated, you can
Oracle Event Processing Event Type as a JavaBean". | .
implement an event type builder class.
Limitations: Requires writing a JavaBean class, rather
than simply declaring the event type in a configuration
file. Oracle CQL does not support JavaBean properties in
GROUP BY, PARTITION BY, and ORDER BY, although
you can work around this by using an Oracle CQL view.
Tuple A structure that you create and register Benefits: Requires no Java programming to create the

java.util.Map

declaratively in the EPN assembly file.

For more information, see Section 9.3.2, "Creating an
Oracle Event Processing Event Type as a Tuple".

Based on an instance of java.util.Map. You don't
implement or extend the Map interface. Rather, you
specify that the interface should be used when
configuring the event type in the EPN assembly file.
If you write Java code to access the type instance,
you treat it as a Map instance.

For more information, see Section 9.3.3, "Creating an
Oracle Event Processing Event Type as a
java.util. Map".

event type. An event type is created by declaring it in the
EPN assembly file. Useful for quick prototyping.

Limitations: Using instances of this type in Java
application logic requires programmatically accessing the
event type repository to get the instance’s property
values. A tuple is also unlikely to be useful when
integrating the Oracle Event Processing with other
systems.

Benefits: Requires no Java programming to create the
type. An event type is created by declaring it in the EPN
assembly file. Useful for quick prototyping.

Limitations: Does not perform as well as other types.

For more detailed information on how Oracle CQL handles and supports various data

types, see:
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»  "Datatypes" in the Oracle Fusion Middleware CQL Language Reference for Oracle Event
Processing

9.2.3 Constraints on Design of Event Types

Depending on how you plan to use an event type, you might need to keep in mind
certain constraints. For example, you might need to limit the data types of its
properties or how you set values of certain attributes when configuring the event type.

The following sections describe areas of constraints on event type design:
= Section 9.2.3.1, "Constraints on Event Types for Use With the csvgen Adapter"
= Section 9.2.3.2, "Constraints on Event Types for Use With a Database Table Source"

9.2.3.1 Constraints on Event Types for Use With the csvgen Adapter

When you declaratively specify the properties of an event type for use with the csvgen
adapter, you may only use the data types that Table 9-2 describes.

Table 9-2 csvgen Adapter Types

Type Usage

char Single or multiple character values. Use for both char and java.lang.String values.

Optionally, you may use the length attribute to specify the maximum length of the
char value as Example 9-6 shows for the property with name id. The default length
is 256 characters. If you need more than 256 characters you should specify an
adequate length.

int Numeric values in the range that java.lang.Integer specifies.
float Numeric values in the range that java.lang.Float specifies.
long Numeric values in the range that java. lang.Long specifies.

double Numeric values in the range that java.lang.Double specifies.

For more information, see:

»  Chapter 21, "Testing Applications With the Load Generator and csvgen Adapter"

9.2.3.2 Constraints on Event Types for Use With a Database Table Source

You can use a relational database table as a source of event data, binding data from the
table to your event type instance at runtime. When your event data source is a
database table, you must follow the guidelines represented by the following tables.

When an event type will receive data from a database table, a property configured for
the type will each receive data from a particular column in the database. When
configuring the event type, note that its property child elements have attributes that
have particular meanings and value constraints, as described in Table 9-3, " EPN
Assembly File event-type Element Property Attributes".

Table 9-3 EPN Assembly File event-type Element Property Attributes

Attribute | Description

name The name of the table column you want to access as specified in the SQL create table
statement. You do not need to specify all columns.

type The Oracle Event Processing Java type from Table 94 that corresponds to the column’s SQL
data type.

length The column size as specified in the SQL create table statement.
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When you specify the properties of an event type for use with a relational database
table, you must observe the additional JDBC type restrictions listed in Table 9—4, " SQL
Column Types and Oracle Event Processing Type Equivalents".

Table 9-4 SQL Column Types and Oracle Event Processing Type Equivalents

Oracle Event Processing

SQL Type Java Type com.bea.wlevs.ede.api.Type | Description

ARRAY [Ljava.lang.Object Array, of depth 1, of java.lang.0Object.

BIGINT java.math.BigInteger bigint An instance of java.math.BigInteger.

BINARY bytel] Array, of depth 1, of byte.

BIT java.lang.Boolean boolean An instance of java.lang.Boolean.

BLOB bytel] Array, of depth 1, of byte.

BOOLEAN java.lang.Boolean boolean An instance of java.lang.Boolean.

CHAR java.lang.Character char An instance of java.lang.Character.

CLOB bytel] Array, of depth 1, of byte.

DATE java.sql.Date timestamp An instance of java.sql.Date.

DECIMAL java.math.BigDecimal An instance of java.math.BigDecimal.

BINARY DOUBLE! or | java.lang.Double double An instance of java.lang.Double

DOUBLE?

BINARY FLOAT! or java.lang.Double float An instance of java.lang.Double

FLOAT?

INTEGER java.lang.Integer int An instance of java.lang.Integer.

JAVA_OBJECT java.lang.Object object An instance of java.lang.Object.

LONGNVARCHAR char[] char Array, of depth 1, of char.

LONGVARBINARY bytel[] Array, of depth 1, of byte.

LONGVARCHAR char[] char Array, of depth 1, of char.

NCHAR char(] char Array, of depth 1, of char.

NCLOB bytel] Array, of depth 1, of byte.

NUMERIC java.math.BigDecimal An instance of java.math.BigDecimal.

NVARCHAR char[] char Array, of depth 1, of char.

OTHER java.lang.Object object An instance of java.lang.Object.

REAL java.lang.Float float An instance of java.lang.Float

SMALLINT java.lang.Integer int An instance of java.lang.Integer.

SQLXML xmltype xmltype For more information on processing XMLTYPE
data in Oracle CQL, see "SQL /XML (SQLX)"
in the Oracle Fusion Middleware CQL
Language Reference for Oracle Event
Processing.

TIME java.sql.Time An instance of java.sqgl.Time.

TIMESTAMP java.sql.Timestamp timestamp An instance of java.sql.Timestamp.

TINYINT java.lang.Integer int An instance of java.lang.Integer.

VARBINARY bytel] Array, of depth 1, of byte.

VARCHAR char(] char Array, of depth 1, of char.

1 Oracle SQL.
2 Non-Oracle SQL.

For more information, see:

= Section 17.3, "Configuring an Oracle CQL Processor Table Source"
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9.2.4 Mixing Use of Event Type Data Types

When defining an event type in the EPN assembly file, you can use a JavaBean-based
event type as another event type’s property data type.

Example 9-1 shows a tuple event type Student that defines its address property as
JavaBean event type Address.

Example 9-1 Event Type Repository
<event-type-repository>
<event-type name="Student">
<property name="name" type="char"/>
<property name="address" type="Address"/>
</event-type>

<event-type name="Address">
<class-name>test.Address</class-name>
</event-type>
<event-type-repository>

9.3 Creating Event Types

Event types define the event properties that provide access to event data within Oracle
Event Processing applications. You then use these event types in the adapter and Java
code, as well as in the Oracle CQL rules.

When you create an event type, you choose one of the three supported data types as a
base for the type you're creating. The best practice is that you can create the type as a
JavaBean class, writing a little Java code to handle event data in properties. You can
also create the type declaratively as a tuple or java.util. Map.

Before you create types, you might want to see Section 9.2, "Designing Event Types"
for design considerations.

This section describes:
= Section 9.3.1, "Creating an Oracle Event Processing Event Type as a JavaBean"
»  Section 9.3.2, "Creating an Oracle Event Processing Event Type as a Tuple"

= Section 9.3.3, "Creating an Oracle Event Processing Event Type as a java.util.Map"

9.3.1 Creating an Oracle Event Processing Event Type as a JavaBean

Creating an event type as a JavaBean gives you the greatest level of flexibility when
using instances of the type in your application logic. As a result, using a JavaBean class
is the best practice for creating an event type.

Note: Oracle CQL does not support expressions in GROUP BY,
PARTITION BY, and ORDER BY. As a result, these do not support Java
properties and will fail. When those features are needed, use Oracle
CQL views as a workaround.

Part of the flexibility in using a JavaBean event type comes from the two different
ways to have the type instantiated: by the server or by an event type builder class that
you provide. By providing an event type builder class as an instance factory, you can
create the instance yourself, controlling how they are created, including how event
data values are bound to JavaBean properties. For more information, see
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Section 9.3.1.5, "Controlling Event Type Instantiation with an Event Type Builder
Class".

When creating an event type as a JavaBean class, use the following guidelines to
ensure the best integration with the Oracle Event Processing system:

s Create an empty-argument public constructor with which the Oracle Event
Processing server can instantiate the class.

s For each event property, implement public accessors (get and set methods)
following JavaBean conventions. These will be used by the server to access event
property values. When you define an event type as a JavaBean, you may use any
Java type for its properties.

If you're unfamiliar with JavaBean conventions, see the JavaBeans Tutorial at
http://docs.oracle.com/javase/tutorial/javabeans/ for additional
details.

s Implement the hashCode and equals methods. This optimizes the class for use by
the Oracle Event Processing server, which sometimes uses a hash index whose
composite key is created from the event type instance hash codes.

If you're using the Eclipse IDE, you can easily implement hashCode and equals
methods through the Source context menu for a class after you have added its
accessors.

= Make the class serializable if you intend to cache events in Oracle Coherence.
This topic describes:

s Section 9.3.1.1, "How to Create an Oracle Event Processing Event Type as a
JavaBean Using the Event Type Repository Editor"

s Section 9.3.1.2, "How to Create an Oracle Event Processing Event Type as a
JavaBean Manually"

9.3.1.1 How to Create an Oracle Event Processing Event Type as a JavaBean Using
the Event Type Repository Editor

This procedure describes how to create and register an Oracle Event Processing event
type as a JavaBean using the Oracle Event Processing IDE for Eclipse event type
repository editor. For more information about the Oracle Event Processing IDE for
Eclipse, see Example 4, "Overview of the Oracle Event Processing IDE for Eclipse".

Alternatively, you can create and register your event type as a JavaBean manually (see
Section 9.3.1.2, "How to Create an Oracle Event Processing Event Type as a JavaBean
Manually").

To create an Oracle Event Processing event type as a Java Bean using the event
type repository editor:

1. Create a JavaBean class to represent your event type.

Be sure to follow the guidelines described in Section 9.3.1, "Creating an Oracle
Event Processing Event Type as a JavaBean".

Example 9-2 shows the MarketEvent which is implemented by the
com.bea.wlevs.example.algotrading.event .MarketEvent class.

Example 9-2 MarketEvent Class

package com.bea.wlevs.example.algotrading.event;

public final class MarketEvent {
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private final Long timestamp;
private final String symbol;

private final Double price;

private final Long volume;

private final Long latencyTimestamp;

public MarketEvent() {}

public Double getPrice() {
return this.price;

}

public void setPrice(Double price) {
this.price = price;

public String getSymbol () {
return this.symbol;

}

public void setSymbol (String symbol) {
this.symbol = symbol;

public Long getTimestamp() {
return this.timestamp;

}

public void setTimestamp (Long timestamp) {
this.timestamp = timestamp;

public Long getLatencyTimestamp () {
return this.latencyTimestamp;

}

public void setLatencyTimestamp (Long latencyTimestamp)
this.latencyTimestamp = latencyTimestamp;

public Long getVolume() {
return this.volume;

}

public void setVolume (Long volume) {
this.volume = volume;

// Implementation for hashCode and equals methods.

Compile the JavaBean that represents your event type.

In the IDE, open the EPN in the EPN editor.

For more information, see Section 7.1, "Opening the EPN Editor".

Click the Event Types tab.
Click Add Event Type (green plus sign).

A new event is added to the Event Type Definitions list with default name

newEvent as Figure 9-1 shows.

Defining and Using Event Types 9-9



Creating Event Types

Figure 9—-1 Event Type Repository Editor - JavaBean Event

i‘g HEPN: CEPFx 8 ¥| spreader,xml ¥| *com.oracle.cep.sample. Fx,context, xml 4] MarketEvent. java =

Event Type Definitions &= % Event Type Details
= BH rcom.oracle.cep.sample.fxcontest, xml Type name: | newEvent

(3 StackTick

:3; CrossRateEvent

'::X—" SpreaderOuputEvent

'::le' CrossrateSummaryEwvent | = LAEERLERREE

'::X—" newEvent

() Properties defined declaratively

Class:

Crverview | Event Types

6. In the Event Type Definitions list, select newEvent.

The properties of this event appear in the Event Type Details area as Figure 9-1
shows.

7. Enter a name for this event in the Type name field.
8. Click Properties defined in Java bean.
9. Enter the fully qualified class name of your JavaBean class in the Class field.
For example com.bea.wlevs.example.algotrading.event .MarketEvent.
10. Click the Save button in the tool bar (or type CTRL-S).
The event is now in the event type repository.
You can use the event type repository editor:

a. To view the corresponding event type definition in the EPN assembly file,
double-click the event type in the Event Type Definitions area.

b. To delete this event, select the event type in the Event Type Definitions area
and click Delete Event Type (red x).

9.3.1.2 How to Create an Oracle Event Processing Event Type as a JavaBean
Manually

This procedure describes how to create and register an Oracle Event Processing event
type as a JavaBean manually.

Alternatively, you can create and register your event type as a JavaBean using the
Oracle Event Processing IDE for Eclipse event type repository editor (see

Section 9.3.1.1, "How to Create an Oracle Event Processing Event Type as a JavaBean
Using the Event Type Repository Editor").

To create an Oracle Event Processing event type as a Java bean manually:
1. Create a JavaBean class to represent your event type.
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Follow standard JavaBean programming guidelines. See the JavaBeans Tutorial at
http://java.sun.com/docs/books/tutorial/javabeans/ for additional
details.

When you design your event, you must restrict your design to the even data types
that Section 9.2.4, "Mixing Use of Event Type Data Types" describes.

Example 9-3 shows the MarketEvent which is implemented by the
com.bea.wlevs.example.algotrading.event .MarketEvent class.

Example 9-3 MarketEvent Class

package com.bea.wlevs.example.algotrading.event;

public final class MarketEvent {
private final Long timestamp;
private final String symbol;
private final Double price;
private final Long volume;
private final Long latencyTimestamp;

public MarketEvent() {}

public Double getPrice() {
return this.price;

}

public void setPrice(Double price) {
this.price = price;

public String getSymbol() {
return this.symbol;

}

public void setSymbol (String symbol) {
this.symbol = symbol;

public Long getTimestamp() {
return this.timestamp;

}

public void setTimestamp(Long timestamp) {
this.timestamp = timestamp;

public Long getLatencyTimestamp () {
return this.latencyTimestamp;

}

public void setLatencyTimestamp (Long latencyTimestamp) {
this.latencyTimestamp = latencyTimestamp;

public Long getVolume() {
return this.volume;

}

public void setVolume (Long volume) {
this.volume = volume;

// Implementation for hashCode and equals methods.

2, Compile the JavaBean that represents your event type.

3. Register your JavaBean event type in the Oracle Event Processing event type
repository:
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a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child element as
Example 94 shows.

Example 9-4 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="MarketEvent">
<wlevs:class>
com.bea.wlevs.example.algotrading.event.MarketEvent
</wlevs:class>
</wlevs:event-type>
</wlevs:event-type-repository>

b. To register programmatically, use the EventTypeRepository class as
Example 9-5 shows.

Example 9-5 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
rep.registerEventType (
"MarketEvent",
com.bea.wlevs.example.algotrading.event .MarketEvent.getClass()
)
For more information, see Section 9.4, "Accessing the Event Type Repository".

9.3.1.3 Using JavaBean Event Type Instances in Java Code

Reference the event types as standard JavaBeans in the Java code of the adapters and
business logic in your application.

The following code implements the onEvent method from an event sink class. For
more information on event sinks, see Section 16.2.1, "Implementing an Event Sink".

public void onInsertEvent (Object event)
throws EventRejectedException {
if (event instanceof MarketEvent) {
MarketEvent marketEvent = (MarketEvent) event;
System.out.println("Price: " + marketEvent.getPrice());

9.3.1.4 Using JavaBean Event Type Instances in Oracle CQL Code

The following Oracle CQL rule shows how you can reference the MarketEvent in a
SELECT statement. It assumes an upstream channel called marketEventChannel whose
event type is MarketEvent.

<query id="helloworldRule">
<! [CDATA[ SELECT MarketEvent.price FROM marketEventChannel [NOW] ]]>
</query>

Also, with property data types implemented as JavaBeans, Oracle CQL code can get
values within those properties by using standard JavaBean-style property access.

For example, the following configuration snippet declares a StudentType event type
that is implemented as a JavaBean class. The school.Student class is a JavaBean with an
address property that is itself an Address JavaBean class. The following query suggests
how you might access values of the Address object underlying the address property.
This query selects student addresses whose postal code begins with "97".

<query id="studentAddresses">
SELECT
student.address
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FROM
StudentType as student
WHERE
student.address.postalCode LIKE ’'"97'
</query>

9.3.1.5 Controlling Event Type Instantiation with an Event Type Builder Class

You can create an event type builder to have more control over how event type
instances are created. For example, using an event type builder you can ensure that the
properties of a configured event are correctly bound to the properties of an event type
class, such as one you have implemented as a JavaBean. You would need an event type
builder in a case, for example, where event property names assumed in CQL code are
different from the names of properties declared in the class.

For example, assume the event type has a firstname property, but the CQL rule that
executes on the event type assumes the property is called fname. Assume also that you
cannot change either the event type class (because you are using a shared event class
from another bundle, for example) or the CQL rule to make them compatible with
each other. In this case you can use an event type builder factory to change the way the
event type instance is created so that the property is named fname rather than
firstname.

At runtime, an event type builder class receives property values from the Oracle Event
Processing server and uses those values to create an instance of the event type class
you created. Your event type builder then returns the instance to the server. In this
way, your builder class is in effect an intermediary, instantiating event types in cases
where the server is unable to determine how to map configured properties to event
type properties.

Creating and using an event type builder involves implementing the builder class and
configuring a JavaBean event type to use the builder, as described in the following
sections:

= Section 9.3.1.5.1, "Implementing an Event Type Builder Class"
= Section 9.3.1.5.2, "Configuring an Event Type that Uses an Event Type Builder"

9.3.1.5.1 Implementing an Event Type Builder Class When you program the event type
builder factory, you must implement the EventBuilder.Factory inner interface of the
com.bea.wlevs.ede.api.EventBuilder interface; see the Oracle Fusion Middleware Java
API Reference for Oracle Event Processing for details about the methods you must
implement, such as createBuilder and createEvent.

The following example of an event type builder factory class is taken from the FX
sample:

package com.bea.wlevs.example.fx;

import java.util.HashMap;

import java.util.Map;

import com.bea.wlevs.ede.api.EventBuilder;

import com.bea.wlevs.example.fx.OutputBean.ForeignExchangeEvent;

public class ForeignExchangeBuilderFactory implements EventBuilder.Factory {
// Called by the server to get an instance of this builder.
public EventBuilder createBuilder() {

return new ForeignExchangeBuilder () ;

}
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// Inner interface implementation that is the builder.
static class ForeignExchangeBuilder implements EventBuilder ({

// A Map instance to hold properties until the event type is instantiated.
private Map<String,Object> values = new HashMap<String,Object>(10);

// Called by the server to put an event type property. Values from the map

// will be used to instantiate the event type.

public void put (String property, Object value) throws IllegalStateException {
values.put (property, value);

}

// Called by the server to create the event type instance once property
// values have been received.
public Object createEvent() {
return new ForeignExchangeEvent (
(String) values.get("symbol"),
(Double) values.get("price"),
(String) values.get("fromRate"),
(String) values.get("toRate"));

9.3.1.5.2 Configuring an Event Type that Uses an Event Type Builder When you register the
event type in the EPN assembly file, use the <wlevs:property
name="builderFactory"> child element of the wlevs:event-type element to specify
the name of the event type builder class. The hard-coded builderFactory value of the
name attribute alerts Oracle Event Processing that it should use the specified factory
class, rather than its own default factory, when creating instances of this event. For
example, in the FX example, the builder factory is registered as shown in bold:

<wlevs:event-type-repository>
<wlevs:event-type type-name="ForeignExchangeEvent">
<wlevs:class>com.bea.wlevs.example. fx.OutputBean$ForeignExchangeEvent</wlevs:class>
<wlevs:property name="builderFactory">
<bean id="builderFactory"
class="com.bea.wlevs.example.fx.ForeignExchangeBuilderFactory"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

9.3.2 Creating an Oracle Event Processing Event Type as a Tuple

You can create an Oracle Event Processing event type as a tuple simply by adding the
type’s configuration XML to the EPN XML file. As a result, a tuple is the easiest way to
create an event type, and so can be useful for quick prototyping. However, both the
tuple and java.util. Map data types provide less flexibility than creating an event type
as a JavaBean class.

With a tuple-based event type, your Java code using instances of the type must always
set and get its property values using EventTypeRepository APIs.

When you design your event, you must restrict design of the type’s properties to the
data types described in Section 9.3.2.1, "Types for Properties in Tuple-Based Event
Types".

Before you get started, consider reading the event type design recommendations in
Section 9.2, "Designing Event Types".

This topic describes:
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s Section 9.3.2.2, "How to Create an Oracle Event Processing Event Type as a Tuple
Using the Event Type Repository Editor"

= Section 9.3.2.3, "How to Create an Oracle Event Processing Event Type as a Tuple
Manually"

9.3.2.1 Types for Properties in Tuple-Based Event Types

When you specify the properties of the event type declaratively in the EPN assembly
file as a tuple, you may use any of the types specified in
com.bea.wlevs.ede.api.Type.

For more information on supported property types, see Section C.23, "wlevs:property".

Example 9-6 shows the use of different types:

Example 9-6 Specifying com.bea.welvs.ede.api.Type Data Types for Tuple Event Type
Properties
<wlevs:event-type-repository>
<wlevs:event-type type-name="SimpleEvent">
<wlevs:properties>
<wlevs:property name="id" type="char" length="1000" />
<wlevs:property name="msg" type="char" />
<wlevs:property name="count" type="double" />
<wlevs:property name="time_stamp" type="timestamp" />
</wlevs:properties>
</wlevs:event-type>

</wlevs:event-type-repository>

For more information, see Section 9.3.2, "Creating an Oracle Event Processing Event
Type as a Tuple".

9.3.2.2 How to Create an Oracle Event Processing Event Type as a Tuple Using the
Event Type Repository Editor

This procedure describes how to create and register an Oracle Event Processing event
type as a tuple using the Oracle Event Processing IDE for Eclipse event type repository
editor. For more information about the Oracle Event Processing IDE for Eclipse, see
Chapter 4, "Overview of the Oracle Event Processing IDE for Eclipse".

You can instead create and register your event type as a tuple manually (see
Section 9.3.2.3, "How to Create an Oracle Event Processing Event Type as a Tuple
Manually").

To create an Oracle Event Processing event type as a tuple using the event type
repository editor:

1. Decide on the properties your event type requires.

When you design your event, you must restrict your design to the even data types
that Section 9.3.2.1, "Types for Properties in Tuple-Based Event Types" describes.

2. In the IDE, open the EPN in the EPN editor.

For more information, see Section 7.1, "Opening the EPN Editor".
3. Click the Event Type tab.
4. Click Add Event Type (green plus sign).
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A new event is added to the Event Type Definitions list with default name
newEvent as Figure 9-2 shows.

Figure 9-2 Event Type Repository Editor - Tuple Event
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5. Inthe Event Type Definitions list, select newEvent.

The properties of this event appear in the Event Type Details area as Figure 9-2
shows.

6. Enter a name for this event in the Type name field.
7. Click Properties defined declaratively.
8. Add one or more event properties:
s Click Add Event Property (green plus sign).
A new row is added to the Event Type Details table.
s Click in the Name column of this row and enter a property name.

s Click in the Type column of this row and select a data type from the pull
down menu.

When you design your event, you must restrict your design to the even data
types that Section 9.3.2.1, "Types for Properties in Tuple-Based Event Types"
describes.

s For char data type properties only, click in the “char” Length column of this
row and enter a value for the maximum length of this char property.

Optionally, you may used the length attribute to specify the maximum length
of the char value. The default length is 256 characters. The maximum length is
java.lang.Integer.MAX VALUE. If you need more than 256 characters you
should specify an adequate length.

9. Click the Save button in the tool bar (or type CTRL-S).
The event is now in the event type repository.

You can use the event type repository editor:
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a. To view the corresponding event type definition in the EPN assembly file,
double-click the event type in the Event Type Definitions area.

b. To delete this event, select the event type in the Event Type Definitions area
and click Delete Event Type (red x).

9.3.2.3 How to Create an Oracle Event Processing Event Type as a Tuple Manually

This procedure describes how to create and register an Oracle Event Processing event
type declaratively in the EPN assembly file as a tuple.

Note, however, that the best practice for creating event types is to create them as
JavaBean classes. For more information, see Section 9.3.1, "Creating an Oracle Event
Processing Event Type as a JavaBean".

For more information on valid data types, see Section 9.3.2.1, "Types for Properties in
Tuple-Based Event Types".

To create an Oracle Event Processing event type as a tuple:
1. Decide on the properties your event type requires.

When you design your event, you must restrict your design to the data types that
Section 9.3.2.1, "Types for Properties in Tuple-Based Event Types" describes.

2. Register your event type declaratively in the Oracle Event Processing event type
repository:

To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child element as
Example 9-7 shows.

Example 9-7 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="CrossRateEvent">
<wlevs:properties>
<wlevs:property name="price" type="double"/>
<wlevs:property name="fromRate" type="char"/>
<wlevs:property name="toRate" type="char"/>
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

At runtime, Oracle Event Processing generates a bean instance of CrossRateEvent
for you. The CrossRateEvent has three properties: price, fromRate, and toRate.

For more information on the valid values of the type attribute, see Section 9.3.2.1,
"Types for Properties in Tuple-Based Event Types".

For reference information on the configuration XML, see Section C.13,
"wlevs:event-type", Section C.22, "wlevs:properties”, and Section C.23,
"wlevs:property"

9.3.2.4 Using a Tuple Event Type Instance in Java Code

When using a tuple-based event type in Java code, you must use a
com.bea.wlevs.ede.api.EventTypeRepository instance to get the names of the type’s
properties before getting their values. (For information on getting an
EventTypeRepository instance, see Section 9.4, "Accessing the Event Type
Repository".)

The following example uses the repository in a class acting as an event sink.
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@Service
public void setEventTypeRepository (EventTypeRepository etr) {
etr_ = etr;

}

// Called by the server to pass in the event type instance.
public void onInsertEvent (Object event) throws EventRejectedException {

// Get the event type for the current event instance
EventType eventType = etr_.getEventType (event) ;

// Get the event type name
String eventTypeName = eventType.getTypeName () ;

// Get the event property names
String[] propNames = eventType.getPropertyNames () ;

// See if property you’re looking for is present
if (eventType.isProperty ("fromRate")) {
// Get property value
Object propvValue =
eventType.getProperty ("fromRate") .getValue (event) ;
}
// Throw com.bea.wlevs.ede.api.EventRejectedException to have an
// exception propagated up to senders. Other errors will be
// logged and dropped.

9.3.2.5 Using a Tuple Event Type Instance in Oracle CQL Code

The following Oracle CQL rule shows how you can reference the CrossRateEvent in a
SELECT statement:

<query id="FindCrossRatesRule"><![CDATA[
select ((a.price * b.price) + 0.05) as internalPrice,
a.fromRate as crossRatel,
b.toRate as crossRate2
from FxQuoteStream [range 1] as a, FxQuoteStream [range 1] as b
where
NOT (a.price IS NULL)
and
NOT (b.price IS NULL)
and
a.toRate = b.fromRate
11></query>

9.3.3 Creating an Oracle Event Processing Event Type as a java.util.Map

You can create and register an Oracle Event Processing event type as a java.util.Map.

You can create an Oracle Event Processing event type as a java.util.Map simply by
adding the type’s configuration XML to the EPN XML file. As a result, this is an easy
way to create an event type. However, both the tuple and java.util. Map data types
provide less flexibility than creating an event type as a JavaBean class.

Creating and using an event type as a Map is something of a hybrid of the processes
for the tuple type and a JavaBean class. As with a tuple-based event type, you create
the Map-based type declaratively, by configuring it in the EPN XML file. And as with a
JavaBean-based event type, you needn’t use
com.bea.wlevs.ede.api.EventTypeRepository APIs to access instance property
values.

This topic describes:
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s Section 9.3.3.2, "How to Create an Oracle Event Processing Event Type as a
java.util. Map"

9.3.3.1 Types for Properties in java.util.Map-Based Event Types

When you specify the event type properties declaratively in the EPN assembly file as a
java.util.Map, you may use any Java type for its properties. However, you specify
the "type" of the event properties as either:

s The fully qualified name of a Java class that must conform to the same rules as
Class.forName () and must be available in the application's class loader.

= A Java primitive (for example, int or float).
You may specify an array by appending the characters [] to the event type name.

Example 9-8 shows how to use these types:

Example 9-8 Specifying Java Data Types for java.util. Map Event Type Properties

<wlevs:event-type-repository>
<wlevs:event-type type-name="AnotherEvent">
<wlevs:properties type="map">
<wlevs:property>
<entry key="name" value="java.lang.String"/>
<entry key="employeeId" value="java.lang.Integer[]"/>
<entry key="salary" value="float"/>
<entry key="projectIds" value="short[]"/>
</wlevs:property>
<wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

For more information, see Section 9.3.3.2, "How to Create an Oracle Event Processing
Event Type as a java.util. Map".

9.3.3.2 How to Create an Oracle Event Processing Event Type as a java.util.Map

This procedure describes how to create and register an Oracle Event Processing event
type as a java.util.Map. Oracle recommends that you create an Oracle Event
Processing event type as a JavaBean (see Section 9.3.1.2, "How to Create an Oracle
Event Processing Event Type as a JavaBean Manually").

For more information on valid event type data types, see Section 9.3.3.1, "Types for
Properties in java.util. Map-Based Event Types".

To create an Oracle Event Processing event type as a java.util.Map:
1. Decide on the properties your event type requires.

2. Register your event type in the Oracle Event Processing event type repository:

a. To register declaratively, edit the EPN assembly file using the
wlevs:event-type-repository element wlevs:event-type child element as
Example 9-9 shows.

Example 9-9 EPN Assembly File event-type-repository

<wlevs:event-type-repository>
<wlevs:event-type type-name="AnotherEvent">
<wlevs:properties type="map">
<wlevs:property name="name" value="java.lang.String"/>
<wlevs:property name="age" value="java.lang.Integer"/>
<wlevs:property name="address" value="java.lang.String"/>
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</wlevs:properties >
</wlevs:event-type>
</wlevs:event-type-repository>

At runtime, Oracle Event Processing generates a bean instance of
AnotherEvent for you. The AnotherEvent has three properties: name, age, and
address.

b. To register programmatically, use the EventTypeRepository class as
Example 9-10 shows.

Example 9-10 Programmatically Registering an Event

EventTypeRepository rep = getEventTypeRepository();
java.util.Map map = new Map({name, java.lang.String},

{age, java.lang.Integer}, {address, java.lang.String});
rep.registerEventType ("AnotherEvent", map);

For more information, see Section 9.4, "Accessing the Event Type Repository".

9.3.3.3 Using a Map Event Type Instance in Java Code

When using a Map-based event type instance in Java code, you access its properties as
you would with any java.util. Map instance.

public void onInsertEvent (Object event)
throws EventRejectedException {

java.util.Map anEvent = (java.util.Map) event;
System.out.println("Age: " + anEvent.get("age"));

9.3.3.4 Using a Map Event Type Instance in Oracle CQL Code
Access the event types from Oracle CQL and EPL rules:

The following Oracle CQL rule shows how you can reference the MarketEvent in a
SELECT statement:

<query id="helloworldRule">
<! [CDATA[ select age from eventChannel [now] ]]>
</query>

9.4 Accessing the Event Type Repository

The Oracle Event Processing event type repository keeps track of the event types
defined for your application. When you create an event type, you make it available for
use in the application by configuring it in the event type repository. In some cases, you
might need to write code that explicitly accesses the repository.

For example, when your event type is created as a tuple, Java logic that accesses
instance of the type will need to first retrieve the type definition using the repository
API, then use the API to access the instance property values.

The EventTypeRepository is a singleton OSGi service. Because it is a singleton, you
only need to specify its interface name to identify it. You can get a service from OSGi
in any of the following ways:

= Section 9.4.1, "Using the EPN Assembly File"
= Section 9.4.2, "Using the Spring-DM @ServiceReference Annotation"

»  Section 9.4.3, "Using the Oracle Event Processing @Service Annotation"
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For more information, see Oracle Fusion Middleware Java API Reference for Oracle Event
Processing.

9.4.1 Using the EPN Assembly File

You can access the EventTypeRepository by specifying an osgi:reference in the EPN
assembly file as Example 9-11 shows.

Example 9—-11 EPN Assembly File With OSGi Reference to EventTypeRepository

<osgi:reference id="etr" interface="com.bea.wlevs.ede.api.EventTypeRepository" />
<bean id="outputBean" class="com.acme.MyBean" >

<property name="eventTypeRepository" ref="etr" />
</bean>

Then, in the MyBean class, you can access the EventTypeRepository using the
eventTypeRepository property initialized by Spring as Example 9-12 shows.

Example 9-12 Accessing the EventTypeRepository in the MyBean Implementation
package com.acme;

import com.bea.wlevs.ede.api.EventTypeRepository;
import com.bea.wlevs.ede.api.EventType;

public class MyBean {
private EventTypeRepository eventTypeRepository;

public void setEventTypeRepository (EventTypeRepository eventTypeRepository) {
this.eventTypeRepository = eventTypeRepository;

public void onInsertEvent (Object event) throws EventRejectedException {
// get the event type for the current event instance
EventType eventType = eventTypeRepository.getEventType (event) ;
// Throw com.bea.wlevs.ede.api.EventRejectedException to have an
// exception propagated up to senders. Other errors will be
// logged and dropped.

9.4.2 Using the Spring-DM @ServiceReference Annotation

You can access the EventTypeRepository by using the Spring-DM @ServiceReference
annotation to initialize a property in your Java source as Example 9-13 shows.

Example 9-13 Java Source File Using the @ServiceReference Annotation

import org.springframework.osgi.extensions.annotation.ServiceReference;
import com.bea.wlevs.ede.api.EventTypeRepository;

@ServiceReference
setEventTypeRepository (EventTypeRepository etr) {
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9.4.3 Using the Oracle Event Processing @Service Annotation

You can access the EventTypeRepository by using the Oracle Event Processing
@Service annotation to initialize a property in your Java source as Example 9-14
shows.

Example 9-14 Java Source File Using the @Service Annotation

import com.bea.wlevs.util.Service;
import com.bea.wlevs.ede.api.EventTypeRepository;

@Service
setEventTypeRepository (EventTypeRepository etr) {

}

For more information, see Section 1.5, "com.bea.wlevs.util.Service".

9.5 Sharing Event Types Between Application Bundles

Each Oracle Event Processing application gets its own Java classloader and loads
application classes using that classloader. This means that, by default, one application
cannot access the classes in another application. However, because the event type
repository is a singleton service, you can configure the repository in one bundle and
then explicitly export the event type classes so that applications in separate bundles
(deployed to the same Oracle Event Processing server) can use these shared event

types.

The event type names in this case are scoped to the entire Oracle Event Processing
server instance. This means that you will get an exception if you try to create an event
type that has the same name as an event type that has been shared from another
bundle, but the event type classes are different.

To share event type classes, add their package name to the Export-Package header of
the MANIFEST . MF file of the bundle that contains the event type repository you want to
share.

Be sure you deploy the bundle that contains the event type repository before all
bundles that contain applications that use the shared event types, or you will get a
deployment exception.

For more information, see:
= Section 9.2.4, "Mixing Use of Event Type Data Types"
»  Section 23.2.3, "Assembling Applications With Foreign Stages"

s "Oracle Java Data Cartridge" in the Oracle Fusion Middleware CQL Language
Reference for Oracle Event Processing
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Connecting EPN Stages Using Channels

This chapter describes how to configure Oracle Event Processing channels, event
conduits through an event processing network.

This chapter includes the following sections:
= Section 10.1, "Overview of Channel Configuration"
= Section 10.2, "Configuring a Channel"

= Section 10.3, "Example Channel Configuration Files"

10.1 Overview of Channel Configuration

An Oracle Event Processing application contains one or more channel components. A
channel represents the physical conduit through which events flow between other
types of components, such as between adapters and processors, and between
processors and event beans (business logic POJOs).

You may use a channel with both streams and relations. For more information, see
Section 10.1.2, "Channels Representing Streams and Relations".

When you create a channel in your Event Processing Network (EPN), it has a default
configuration. For complete details, see Section C.10, "wlevs:channel".

The default channel configuration is typically adequate for most applications.

However, if you want to change this configuration, you must create a channel element
in a component configuration file. In this channel element, you can specify channel
configuration that overrides the defaults.

The component configuration file channel element’s name element must match the
EPN assembly file channel element’s id attribute. For example, given the EPN
assembly file channel element shown in Example 10-1, the corresponding component
configuration file channel element is shown in Example 10-2.

Example 10-1 EPN Assembly File Channel Id: priceStream

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />
</wlevs:channel>

Example 10-2 Component Configuration File Channel Name: priceStream

<channel>
<name>priceStream</name>
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<max-size>10000</max-size>
<max-threads>4</max-threads>
</channel>

You can create a channel element in any of the following component configuration
files:

»  The default Oracle Event Processing application configuration file (by default,
META-INF/wlevs/config.xml).

= A separate configuration file.

If your application has more than one channel, you can create a channel element for
each of them in the default config.xml file, you can create separate XML files in
META-INF/wlevs for each, or create a single XML file in META-INF/wlevs that contains
the configuration for all channels, or even all components of your application
(adapters, processors, and channels). Choose the method that best suits your
development environment.

By default, Oracle Event Processing IDE for Eclipse creates one component
configuration file and one EPN assembly file.

Component configuration files are deployed as part of the Oracle Event Processing
application bundle. You can later update this configuration at runtime using Oracle
Event Processing Visualizer, the wlevs.Admin utility, or manipulating the appropriate
JMX Mbeans directly.

This section describes:

s Section 10.1.1, "When to Use a Channel"

= Section 10.1.2, "Channels Representing Streams and Relations"
= Section 10.1.3, "System-Timestamped Channels"

= Section 10.1.4, "Application-Timestamped Channels"

= Section 10.1.5, "Controlling Which Queries Output to a Downstream Channel:
selector”

= Section 10.1.6, "Batch Processing Channels"

»  Section 10.1.7, "EventPartitioner Channels"

For more information, see:

= Section 1.4.2, "Overview of Component Configuration Files"

= Section 5.3, "Creating EPN Assembly Files"

»  Oracle Fusion Middleware Visualizer User's Guide for Oracle Event Processing

s "wlevs.Admin Command-Line Reference" in the Oracle Fusion Middleware
Administrator’s Guide for Oracle Event Processing

s "Configuring JMX for Oracle Event Processing" in the Oracle Fusion Middleware
Administrator’s Guide for Oracle Event Processing

10.1.1 When to Use a Channel

When constructing your EPN, consider the following rules:

= A channel is mandatory when connecting an Oracle CQL processor to a
down-stream stage.
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= A channel is mandatory when connecting a push source stream or relation to a
processor.

A channel is mandatory for a push source because in that case, the Oracle CQL
processor does need to be aware of its shape (that is, DDL is required) and so does
need the channel to act as intermediary.

= A channel is optional when connecting an external relation, or pull source, such as
a cache or table source, to a processor.

A channel is not needed between a pull source, such as a cache or table, and a
processor because the pull source represent an external relation. For an external
relation, the only valid operation is a join between a stream and a Now window
operator and hence it is considered a pull source. In other words, the join actually
happens outside of the Oracle CQL processor. Because it is a pull, the Oracle CQL
processor does not need to be aware of its shape (that is, no DDL is required) and
so does not need the channel to act as intermediary.

In general, use a channel between components when:

= Buffering is needed between the emitting component and the receiver.
= Queuing or concurrency is needed for the receiving component.

= If a custom adapter is used and thread control is necessary.

It is a good design practice to include channels in your EPN to provide the flexibility
of performance tuning (using buffering, queuing, and concurrency options) later in the
design lifecycle. Setting the channel attribute max-threads to 0 puts a channel in
pass-through mode and incurs no performance penalty.

For more information, see:
s Section 10.1.7, "EventPartitioner Channels"

s Table C-9, " Attributes of the wlevs:channel Application Assembly Element"

10.1.2 Channels Representing Streams and Relations

A channel can represent either a stream or a relation.
For more information, see:

= Section 16.2.2.2, "Implementing RelationSource"

= Section 10.1, "Overview of Channel Configuration"

s Section 1.3, "Overview of Events, Streams and Relations"

10.1.2.1 Channels as Streams

A stream supports appends only. You specify a channel as a stream by setting EPN
assembly element wlevs:channel attribute is-relation to false (the default).

10.1.2.2 Channels as Relations
A relation supports inserts, deletes, and updates. You specify a channel as a relation by
setting EPN assembly element wlevs:channel attribute is-relation to true.

When a channel is a relation, you must specify one or more event properties that
define event identity using the wlevs:channel attribute primary-key as Example 10-3
shows.

Connecting EPN Stages Using Channels 10-3



Overview of Channel Configuration

Example 10-3 Channel as Relation: primary-key Attribute

<wlevs:channel id="priceStream" event-type="PriceEvent" primary-key="stock,broker">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

Example 10-4 PriceEvent

<wlevs:event-type-repository>
<wlevs:event-type type-name="PriceEvent">
<wlevs:property>
<entry key="stock" value="java.lang.String"/>
<entry key="broker" value="java.lang.String"/>
<entry key="high" value="float"/>
<entry key="low" value="float"/>
</wlevs:property>
</wlevs:event-type>
</wlevs:event-type-repository>

For more information, see primary-key in Table C-9, " Attributes of the wlevs:channel
Application Assembly Element".

10.1.3 System-Timestamped Channels

By default, channels are system-timestamped. In this case, Oracle Event Processing
will assign a new time from the CPU clock under two conditions: when a new event
arrives, and when the configurable heartbeat timeout expires.

For more information, see:

s Section 10.2.1, "How to Configure a System-Timestamped Channel Using Oracle
Event Processing IDE for Eclipse”

s Section D.52, "heartbeat"

10.1.4 Application-Timestamped Channels

Optionally, you can configure a channel to be application-timestamped. In this case,
the time-stamp of an event is determined by the configurable wlevs:expression
element. A common example of an expression is a reference to a property on the event.
If no expression is specified, then the time-stamp may be propagated from a prior
event. For example, this is the case when you have a system-timestamped channel
from one Oracle CQL processor feeding events into an application-timestamped
channel of another downstream Oracle CQL processor.

In addition, an application can use the StreamSender . sendHeartbeat method to send
an event of type heart-beat downstream to StreamSink listeners in the EPN.

For more information, see:

= Section 10.2.2, "How to Configure an Application-Timestamped Channel Using
Oracle Event Processing IDE for Eclipse”

= Section C.3, "wlevs:application-timestamped"

= Section C.15, "wlevs:expression"
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10.1.5 Controlling Which Queries Output to a Downstream Channel: selector

If you configure an Oracle CQL processor with more than one query, by default, all
queries output their results to the downstream channel.

You can control which queries may output their results to a downstream channel using
the channel selector child element. Note that you must use a selector when you have
multiple channels connected on the downstream side of a processor. This is because
the output of a query in the processor has a particular type; selecting for a specific
query ensures that the query output is accepted by the channel.

Figure 10-1 shows an EPN with channel filteredStream connected to up-stream
Oracle CQL processor filteredFanoutProcessor.

Figure 10-1 EPN With Oracle CQL Processor and Down-Stream Channel

B——=—0

pricestream filkeredStream
PriceAdapter filkerFanoutProcessor

Example 10-5 shows the queries configured for the Oracle CQL processor.

Example 10-5 filterFanoutProcessor Oracle CQL Queries

<processor>
<name>filterFanoutProcessor</name>
<rules>
<query id="Yr3Sector"><![CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="3_YEAR"
]11></query>
<query id="Yr2Sector"><! [CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="2_YEAR"
11></query>
<query id="YrlSector"><![CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="1_YEAR"
11></query>
</rules>
</processor>

If you specify more than one query for an Oracle CQL processor as Example 10-5
shows, then, by default, all query results are output to the processor’s out-bound
channel (filteredStream in Figure 10-1). Optionally, in the component configuration
source, you can use the channel element selector child element to specify a
space-delimited list of one or more Oracle CQL query names that may output their
results to the channel as Example 10-6 shows. In this example, query results for query
Yr3Sector and Yr2Sector are output to filteredStream but not query results for
query YrlSector.

Example 10-6 Using selector to Control Which Query Results are Output

<channel>
<name>filteredStream</name>
<selector>Yr3Sector Yr2Sector</selector>
</channel>

You may configure a channel element with a selector before creating the queries in
the upstream processor. In this case, you must specify query names that match the
names in the selector.
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Note: The selector child element is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 17, "Querying an Event Stream with Oracle CQL".

For more information, see Appendix D.87, "selector".

10.1.6 Batch Processing Channels

By default, a channel processes events as they arrive. Alternatively, you can configure
a channel to batch events together that have the same timestamp and were output
from the same query by setting the wlevs:channel attribute batching to true as
Example 10-7 shows.

Example 10-7 Batch Processing Channel

<wlevs:channel id="priceStream" event-type="PriceEvent" batching="true">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

For more information, see:
= Section 16.2.2.2, "Implementing RelationSource"

= batching in Table C-9, " Attributes of the wlevs:channel Application Assembly
Element"

10.1.7 EventPartitioner Channels

By default, a channel broadcasts each event to every listener.

When you configure a channel to use an EventPartitioner, each time an incoming
event arrives, the channel selects a listener and dispatches the event to that listener
instead of broadcasting each event to every listener.

You can use an EventPartitioner on a channel to improve scalability.

For more information, see Section 25.1.2.1, "EventPartitioner".

10.1.8 Handling Faults in Channels

You can write code to handle exceptions that occur in stages that are downstream of a
channel, then thrown to the channel. By default, the fault-handling behavior for a
channel is as follows:

»  If the channel’s max-threads setting is 0 (also known as a pass-through channel),
then the exception is re-thrown to the next upstream stage in the EPN.

»  If the channel’s max-threads setting is greater than 0, then the exception is logged
and dropped, along with any events associated with the fault.

You can write a fault handling class and associate the handler with channels whose
max-threads values are greater than 0. With a fault handler associated with the
channel, exceptions thrown to the channel are received by the handler, where your
code can handle the fault or re-throw it. Keep in mind that if your fault handling code
re-throws the exception, the exception is logged but events related to the exception are
lost. If you want to keep track of events involved in these exceptions, you must persist
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them with your code, such as by writing the event data to a data source connected to
your EPN.

For information on writing fault handlers, see Section 17.6, "Handling Faults".

10.2 Configuring a Channel

You can configure a channel manually or by using the Oracle Event Processing IDE for
Eclipse.

See Section B.2, "Component Configuration Schema wlevs_application_config.xsd" for
the complete XSD Schema that describes the channel component configuration file.

See Section 10.3, "Example Channel Configuration Files" for a complete example of a
channel configuration file.

This section describes the following topics:

= Section 10.2.1, "How to Configure a System-Timestamped Channel Using Oracle
Event Processing IDE for Eclipse”

= Section 10.2.2, "How to Configure an Application-Timestamped Channel Using
Oracle Event Processing IDE for Eclipse”

= Section 10.2.3, "How to Create a Channel Component Configuration File
Manually"

10.2.1 How to Configure a System-Timestamped Channel Using Oracle Event
Processing IDE for Eclipse

This section describes how to create a system-timestamped channel.

The most efficient and least error-prone way to create and edit a channel configuration
in the default component configuration file is to use the Oracle Event Processing IDE
for Eclipse. Optionally, you can create a channel configuration file manually (see
Section 10.2.3, "How to Create a Channel Component Configuration File Manually").

For more information, see:
= Section 10.1.3, "System-Timestamped Channels"

»  Chapter 7, "Oracle Event Processing IDE for Eclipse and the Event Processing
Network"

To configure a channel using Oracle Event Processing IDE for Eclipse:
1. Use Oracle Event Processing IDE for Eclipse to create a channel.

See Section 7.4.1.1, "How to Create a Basic Node".

2. Optionally, override the default channel assembly file configuration by adding
additional wlevs:channel attributes and child elements:

a. Right-click the channel node and select Go To Assembly Source.
b. Add the appropriate wlevs:channel attributes.

Required attributes include:

- id

— event-type

In particular, specify whether this channel is a stream or relation by
configuring attribute is-relation:
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— To specify this channel as stream, set is-relation to false (default).
- To specity this channel as a relation, set is-relation to true.

If you specify this channel as a relation, you must also configure the chan-
nel attribute primary-key.

See Table C-9, " Attributes of the wlevs:channel Application Assembly
Element".

c. Add the appropriate wlevs:channel child elements.
- Appendix C.18, "wlevs:instance-property"
- Appendix C.19, "wlevs:listener"
- Appendix C.24, "wlevs:property"
- Appendix C.25, "wlevs:source"
3. In the Project Explorer, expand your META-INF/wlevs directory.
4. Choose the component configuration file you want to use:

a. To use the default component configuration file, right-click the
META-INF/wlevs/config.xml file and select Open With > XML Editor.

The file opens in an XML Editor.
b. To create a new component configuration file:
- Right-click the wlevs directory and select New > File.
The New File dialog appears.
- Enter a file name.

You can name the file anything you want but the name of the file must
end in .xml.

—  Click Finish.

Oracle Event Processing IDE for Eclipse adds the component configura-
tion file to the wlevs directory.

5. Right-click the component configuration file you chose to use and select Open
With > XML Editor.

The file opens in an XML Editor.

6. If you created a new component configuration file, add the header and config
element shown in Example 10-8. Otherwise, proceed to step 7.

Example 10-8 Component Configuration File Header and config Element

<?xml version="1.0" encoding="UTF-8"?>

<nl:config xsi:schemalLocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

</config>

7. Add a channel element for the channel as Example 10-9 shows.

Example 10-9 Component Configuration File Channel Element

<?xml version="1.0" encoding="UTF-8"?>
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<nl:config xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<processor>

</processor>

<channel>

</channel>
</config>

8. Add a name child element to the channel element.

The name element value must match the corresponding EPN assembly file channel
element’s id attribute.

For example, given the EPN assembly file channel element shown in
Example 10-10, the corresponding configuration file channel element is shown in
Example 10-11.

Example 10-10 EPN Assembly File Channel Id: priceStream

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

Example 10-11 Component Configuration File Channel Name: priceStream

<channel>
<name>priceStream</name>
</channel>

Caution: Identifiers and names in XML files are case sensitive. Be
sure to specify the same case when referencing the component's
identifier in the EPN assembly file.

9. Optionally, override the default channel configuration by adding additional
channel child elements:

»  Add amax-threads child element to specify the maximum number of threads
that Oracle Event Processing server uses to process events for this channel.

Setting this value has no effect when max-size is 0. The default value is 0.

<channel>
<name>priceStream</name>
<max-threads>2</size>
</channel>

When set to 0, the channel acts as a pass-through. When max-threads > 0, the
channel acts as classic blocking queue, where upstream components are
producers of events and the downstream components are the consumers of
events. The queue size is defined by the configuration max-size. There will be
up to max-threads number of threads consuming events from the queue.

With multiple threads enabled,
com.bea.wlevs.ede.api.EventRejectedException instances thrown from
downstream components in the EPN won’t be propagated up to an adapter
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from which the channel is receiving events unless the channel has an
associated fault handler. For more information, see Section 10.1.8, "Handling
Faults in Channels".

Add a max-size child element to specify the maximum size of the channel.
Zero-size channels synchronously pass-through events.

Non-zero size channels process events asynchronously, buffering events by the
requested size. The default value is 0.

<channel>
<name>priceStream</name>
<max-size>10000</size>
</channel>

Note that when a queued channel becomes full, the default behavior is to
discard events that could not be inserted into the queue because the queue is
full. You can configure the channel so that it will instead raise an
EventProcessingException to its upstream stage. The exception contains the
events that could not be inserted into the queue. To support this behavior, set
the fail-when-rejected setting to true. You can also specify a timeout value
after which events are dropped or an exception is raised. For configuration
reference information, see D.50 , "fail-when-rejected" and D.68 ,
"offer-timeout".

Add a heartbeat child element to specify the number of nanoseconds a
channel can be idle before Oracle Event Processing generates a heartbeat event
to advance time. The default is 100,000,000 nanoseconds.

The heartbeat child element applies to system-timestamped relations or
streams only when no events arrive in the event channels that are feeding the
processors and the processor has been configured with a statement that
includes some temporal operator, such as a time-based window or a pattern
matching with duration.

<channel>
<name>MatchOutputChannel</name>
<heartbeat>10000</heartbeat>
</channel>

Add a selector child element to specify which up-stream Oracle CQL
processor queries are permitted to output their results to the channel.

You may configure a channel element with a selector before creating the
queries in the upstream processor. In this case, you must specify query names
that match the names in the selector.

For more information, Section 10.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector”.

Note: The selector attribute is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 17, "Querying an Event Stream with Oracle CQL".

10. Select File > Save.

The EPN Editor adds a configuration badge to the channel as Figure 10-2 shows.
For more information, see Section 7.2.7, "Configuration Badging".
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Figure 10-2 Channel With Configuration Badge

priceSktream =
PriceAdapter filterFanoutProcessaor

10.2.2 How to Configure an Application-Timestamped Channel Using Oracle Event
Processing IDE for Eclipse

This section describes how to create an application-timestamped channel.

The most efficient and least error-prone way to create and edit a channel configuration
in the default component configuration file is to use the Oracle Event Processing IDE
for Eclipse. Optionally, you can create a channel configuration file manually (see
Section 10.2.3, "How to Create a Channel Component Configuration File Manually").

For more information, see:
= Section 10.1.4, "Application-Timestamped Channels"

s Chapter 7, "Oracle Event Processing IDE for Eclipse and the Event Processing
Network"

To configure a channel using Oracle Event Processing IDE for Eclipse:
1. Use Oracle Event Processing IDE for Eclipse to create a channel.

See Section 7.4.1.1, "How to Create a Basic Node".

2. Optionally, override the default channel assembly file configuration by adding
additional wlevs:channel attributes and child elements:

a. Right-click the channel node and select Go To Assembly Source.
b. Add the appropriate wlevs:channel attributes.

In particular, specify whether this channel is a stream or relation by
configuring attribute is-relation:

- To specify this channel as stream, set is-relation to false (default).
- To specify this channel as a relation, set is-relation to true.

See Table C-9, " Attributes of the wlevs:channel Application Assembly
Element".

c. Addawlevs:application-timestamped child element.

Use this element to specify a wlevs:expression child element that Oracle
Event Processing uses to generate timestamp values.

Optionally, configure the wlevs:application-timestamped attributes:

- 1is-total-order: specifies if the application time published is always
strictly greater than the last value used.

Valid values are true or false. Default: false.
For more information, see Appendix C.3, "wlevs:application-timestamped".
d. Add other appropriate wlevs:channel child elements.
- Appendix C.18, "wlevs:instance-property"
- Appendix C.19, "wlevs:listener"
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- Appendix C.24, "wlevs:property"

- Appendix C.25, "wlevs:source"
3. In the Project Explorer, expand your META-INF/wlevs directory.
4. Choose the component configuration file you want to use:

a. To use the default component configuration file, right-click the
META-INF/wlevs/config.xml file and select Open With > XML Editor.

The file opens in an XML Editor.
b. To create a new component configuration file:
- Right-click the wlevs directory and select New > File.
The New File dialog appears.
- Enter a file name.

You can name the file anything you want but the name of the file must
end in .xml.

—  Click Finish.

Oracle Event Processing IDE for Eclipse adds the component configura-
tion file to the wlevs directory.

5. Right-click the component configuration file you chose to use and select Open
With > XML Editor.

The file opens in an XML Editor.

6. If you created a new component configuration file, add the header and config
element shown in Example 10-8. Otherwise, proceed to step 7.

Example 10-12 Component Configuration File Header and config Element

<?xml version="1.0" encoding="UTF-8"?>

<nl:config xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

</config>

7. Add a channel element for the channel as Example 10-9 shows.

Example 10-13 Component Configuration File Channel Element

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xsi:schemalocation="http://www.bea.com/ns/wlevs/config/application
wlevs_application_config.xsd"
xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<processor>

</processor>
<channel>
</channel>

</config>

8. Add a name child element to the channel element.
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The name element value must match the corresponding EPN assembly file channel
element’s id attribute.

For example, given the EPN assembly file channel element shown in
Example 10-10, the corresponding configuration file channel element is shown in
Example 10-11.

Example 10-14 EPN Assembly File Channel Id: priceStream

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

Example 10-15 Component Configuration File Channel Name: priceStream

<channel>
<name>priceStream</name>
</channel>

Caution: Identifiers and names in XML files are case sensitive. Be
sure to specify the same case when referencing the component's
identifier in the EPN assembly file.

9. Optionally, override the default channel configuration by adding additional
channel child elements:

Add a max-threads child element to specify the maximum number of threads
that Oracle Event Processing server uses to process events for this channel.

Setting this value has no effect when max-size is 0. The default value is 0.

<channel>
<name>priceStream</name>
<max-threads>2</size>
</channel>

When set to 0, the channel acts as a pass-through. When max-threads > 0, the
channel acts as classic blocking queue, where upstream components are
producers of events and the downstream components are the consumers of
events. The queue size is defined by the configuration max-size. There will be
up to max-threads number of threads consuming events from the queue.

Note that with multiple threads enabled,
com.bea.wlevs.ede.api.EventRejectedException instances thrown from
downstream components in the EPN won’t be propagated up to an adapter
from which the channel is receiving events.

Add a max-size child element to specify the maximum size of the channel.
Zero-size channels synchronously pass-through events.

Non-zero size channels process events asynchronously, buffering events by the
requested size. The default value is 0.

<channel>
<name>priceStream</name>
<max-size>10000</size>
</channel>
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Note that when a queued channel becomes full, the default behavior is to
discard events that could not be inserted into the queue because the queue is
full. You can configure the channel so that it will instead raise an
EventProcessingException to its upstream stage. The exception contains the
events that could not be inserted into the queue. To support this behavior, set
the fail-when-rejected setting to true. You can also specify a timeout value
after which events are dropped or an exception is raised. For configuration
reference information, see D.50 , "fail-when-rejected" and D.68 ,
"offer-timeout".

Add a selector child element to specify which up-stream Oracle CQL
processor queries are permitted to output their results to the channel.

You may configure a channel element with a selector before creating the
queries in the upstream processor. In this case, you must specify query names
that match the names in the selector.

For more information, Section 10.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector".

Note: The selector attribute is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 17, "Querying an Event Stream with Oracle CQL".

For more information, Section D.87, "selector".

10. Select File > Save.

The EPN Editor adds a configuration badge to the channel as Figure 10-3 shows.
For more information, see Section 7.2.7, "Configuration Badging".

Figure 10-3 Channel With Configuration Badge

PriceAdapter

pricestream 2
filterFanoutProcessor

10.2.3 How to Create a Channel Component Configuration File Manually

Although the Oracle Event Processing IDE for Eclipse is the most efficient and least
error-prone way to create and a channel configuration file (see Section 10.2.1, "How to
Configure a System-Timestamped Channel Using Oracle Event Processing IDE for
Eclipse"), alternatively, you can also create and maintain a channel configuration file
manually.

For simplicity, the following procedure assumes that you are going to configure all
components of an application in a single XML file.

To create a channel component configuration file manually:

1.

Create an EPN assembly file and add a wlevs:channel element for each channel in
your application.

Uniquely identify each wlevs:channel with the 1d attribute.

See Section 5.3, "Creating EPN Assembly Files" for details.
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Optionally, override the default channel assembly file configuration by adding
additional wlevs:channel attributes and child elements:

a. Add the appropriate wlevs:channel attributes.

See Table C-9, " Attributes of the wlevs:channel Application Assembly
Element".

b. Add the appropriate wlevs:channel child elements.
- Appendix C.3, "wlevs:application-timestamped"
- Appendix C.18, "wlevs:instance-property"
- Appendix C.19, "wlevs:listener"
- Appendix C.24, "wlevs:property"
- Appendix C.25, "wlevs:source"

Create an XML file using your favorite XML editor.

You can name this XML file anything you want, provided it ends with the .xml
extension.

The root element of the configuration file is config, with namespace definitions
shown in the next step.

For each channel in your application, add a channel child element of config.

Uniquely identify each channel with the name child element. This name must be
the same as the value of the i1d attribute in the channel element of the EPN
assembly file that defines the event processing network of your application. This is
how Oracle Event Processing knows to which particular channel component in the
EPN assembly file this channel configuration applies. See Section 5.3, "Creating
EPN Assembly Files" for details.

For example, if your application has two streams, the configuration file might
initially look like:

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<helloworld:config
xmlns:helloworld="http://www.bea.com/xml/ns/wlevs/example/helloworld">
<processor>

</processor>

<channel>
<name>firstStream</name>

</channel>

<channel>
<name>secondStream</name>

</channel>
</helloworld:config>

In the example, the configuration file includes two channels called firstStream
and secondStream. This means that the EPN assembly file must include at least
two channel registrations with the same identifiers:

<wlevs:channel id="firstStream" ...>

</wlevs:channel>
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<wlevs:channel id="secondStream" ...>

</wlevs:channel>

Caution: Identifiers and names in XML files are case sensitive, so be
sure you specify the same case when referencing the component's
identifier in the EPN assembly file.

Optionally, override the default channel configuration by adding additional
channel child elements:

Add a max-threads child element to specify the maximum number of threads
that Oracle Event Processing server uses to process events for this channel.

Setting this value has no effect when max-size is 0. The default value is 0.

<channel>
<name>priceStream</name>
<max-threads>2</size>
</channel>

When set to 0, the channel acts as a pass-through. When max-threads > 0, the
channel acts as classic blocking queue, where upstream components are
producers of events and the downstream components are the consumers of
events. The queue size is defined by the configuration max-size. There will be
up to max-threads number of threads consuming events from the queue.

Note that with multiple threads enabled,
com.bea.wlevs.ede.api.EventRejectedException instances thrown from
downstream components in the EPN won’t be propagated up to an adapter
from which the channel is receiving events.

Add a max-size child element to specify the maximum size of the channel.
Zero-size channels synchronously pass-through events.

Non-zero size channels process events asynchronously, buffering events by the
requested size. The default value is 0.

<channel>
<name>priceStream</name>
<max-size>10000</size>
</channel>

Note that when a queued channel becomes full, the default behavior is to
discard events that could not be inserted into the queue because the queue is
full. You can configure the channel so that it will instead raise an
EventProcessingException to its upstream stage. The exception contains the
events that could not be inserted into the queue. To support this behavior, set
the fail-when-rejected setting to true. You can also specify a timeout value
after which events are dropped or an exception is raised. For configuration
reference information, see D.50 , "fail-when-rejected" and D.68 ,
"offer-timeout".

Add a heartbeat child element to specify a new number of nanoseconds a
channel can be idle before Oracle Event Processing generates a heartbeat event
to advance time. The default is 100,000,000 nanoseconds.
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The heartbeat child element applies to system-timestamped relations or
streams only when no events arrive in the event channels that are feeding the
processors and the processor has been configured with a statement that
includes some temporal operator, such as a time-based window or a pattern
matching with duration.

<channel>
<name>MatchOutputChannel</name>
<heartbeat>10000</heartbeat>
</channel>

s Add a selector child element to specify which up-stream Oracle CQL
processor queries are permitted to output their results to the channel.

You may configure a channel element with a selector before creating the
queries in the upstream processor. In this case, you must specify query names
that match the names in the selector.

For more information, Section 10.1.5, "Controlling Which Queries Output to a
Downstream Channel: selector".

Note: The selector attribute is only applicable if the up-stream
node is an Oracle CQL processor. For more information, see
Chapter 17, "Querying an Event Stream with Oracle CQL".

For more information, Section D.87, "selector".

6. Save and close the configuration file.

10.3 Example Channel Configuration Files

Figure 104 shows part of an EPN that contains two channels: priceStream and
filteredStream. The priceStream channel is an in-bound channel that connects the
PriceAdapter event source and its PriceEvent events to an Oracle CQL processor
filterFanoutProcessor. The filteredStream channel is an out-bound channel that
connects the Oracle CQL processor’s query results (FilteredPriceEvent events) to
down-stream components (not shown in Figure 10-4).

Figure 10-4 EPN with Two Channels

priceStream = filkeredstrearn
PriceAdapter filkerFanoutProcessor

This section provides example channel configuration files, including:
= Section 10.3.1, "Channel Component Configuration File"

»  Section 10.3.2, "Channel EPN Assembly File"

10.3.1 Channel Component Configuration File

Example 10-16 shows a sample component configuration file that configures the two
channels shown in Figure 104.
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Example 10-16 Sample Channel Component Configuration File

<?xml version="1.0" encoding="UTF-8"?>
<nl:config xmlns:nl="http://www.bea.com/ns/wlevs/config/application"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">
<processor>
<name>filterFanoutProcessor</name>
<rules>
<query id="Yr3Sector"><![CDATA[
select cusip, bid, srcId, bidQty, ask, askQty, seq
from priceStream where sector="3_YEAR"
11></query>
</rules>
</processor>
<channel>
<name>priceStream</name>
<max-size>10000</max-size>
<max-threads>4</max-threads>
</channel>
<channel>
<name>filteredStream</name>
<max-size>5000</max-size>
<max-threads>2</max-threads>
</channel>
</nl:config>

10.3.2 Channel EPN Assembly File

Example 10-17 shows a EPN assembly file that configures the two channels shown in
Figure 10-4.

Example 10-17 Channel EPN Assembly File

<?xml version="1.0" encoding="UTF-8"?>
<beans xmlns="http://www.springframework.org/schema/beans"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmlns:osgi="http://www.springframework.org/schema/osgi"
xmlns:wlevs="http://www.bea.com/ns/wlevs/spring"
xmlns:cglx="http://www.oracle.com/schema/cglx"
xsi:schemaLocation="
http://www.springframework.org/schema/beans
http://www.springframework.org/schema/beans/spring-beans.xsd
http://www.springframework.org/schema/osgi
http://www.springframework.org/schema/osgi/spring-osgi.xsd
http://www.bea.com/ns/wlevs/spring
http://www.bea.com/ns/wlevs/spring/spring-wlevs-vll_1_1_6.xsd">

<wlevs:event-type-repository>
<wlevs:event-type type-name="PriceEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="srcId" type="java.lang.String" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="seq" type="java.lang.Long" />
<wlevs:property name="sector" type="java.lang.String" />
</wlevs:properties>
</wlevs:event-type>
<wlevs:event-type type-name="FilteredPriceEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
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<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="srcId" type="java.lang.String" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="seq" type="java.lang.Long" />
</wlevs:properties>
</wlevs:event-type>
<wlevs:event-type type-name="BidAskEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bidseqg" type="java.lang.Long" />
<wlevs:property name="bidSrcId" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="askseqg" type="java.lang.Long" />
<wlevs:property name="askSrcId" type="java.lang.String" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="intermediateStrategy" type="java.lang.String" />
<wlevs:property name="correlationId" type="java.lang.Long" />
<wlevs:property name="priority" type="java.lang.Integer" />
</wlevs:properties>
</wlevs:event-type>
<wlevs:event-type type-name="FinalOrderEvent">
<wlevs:properties>
<wlevs:property name="cusip" type="java.lang.String" />
<wlevs:property name="bidseq" type="java.lang.Long" />
<wlevs:property name="bidSrcId" type="java.lang.String" />
<wlevs:property name="bid" type="java.lang.Double" />
<wlevs:property name="bidQty" type="java.lang.Integer" />
<wlevs:property name="bidSourceStrategy" type="java.lang.String" />
<wlevs:property name="askseqg" type="java.lang.Long" />
<wlevs:property name="askSrcId" type="java.lang.String" />
<wlevs:property name="ask" type="java.lang.Double" />
<wlevs:property name="askQty" type="java.lang.Integer" />
<wlevs:property name="askSourceStrategy" type="java.lang.String" />
<wlevs:property name="correlationId" type="java.lang.Long" />
</wlevs:properties>
</wlevs:event-type>
</wlevs:event-type-repository>

<!-- Assemble EPN (event processing network) -->
<wlevs:adapter advertise="true" id="PriceAdapter"
provider="csvgen">
<wlevs:instance-property name="port" value="9008" />
<wlevs:instance-property name="eventTypeName"
value="PriceEvent" />
<wlevs:instance-property name="eventPropertyNames"
value="srcId, sector,cusip,bid, ask,bidQty, askQty, seq" />
</wlevs:adapter>

<wlevs:channel id="priceStream" event-type="PriceEvent">
<wlevs:listener ref="filterFanoutProcessor" />
<wlevs:source ref="PriceAdapter" />

</wlevs:channel>

<!-- By default, CQL is used for OCEP 11.0 -->
<wlevs:processor id="filterFanoutProcessor" >
</wlevs:processor>

<wlevs:channel id="filteredStream"
event-type="FilteredPriceEvent">
<wlevs:listener ref="bbaProcessor" />
<wlevs:listener ref="analyticsProcessor" />
<wlevs:source ref="filterFanoutProcessor" />
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</wlevs:channel>

<!-- Explicitly specify provider CQL -->
<wlevs:processor id="bbaProcessor" provider="cqgl">

<wlevs:listener ref="bidAskBBAStream" />
</wlevs:processor>

<wlevs:processor id="analyticsProcessor">
<wlevs:listener ref="bidAskAnalyticsStream" />
</wlevs:processor>

<wlevs:channel id="bidAskBBAStream" event-type="BidAskEvent">
<wlevs:listener ref="selectorProcessor" />
</wlevs:channel>

<wlevs:channel id="bidAskAnalyticsStream" event-type="BidAskEvent">
<wlevs:listener ref="selectorProcessor" />
</wlevs:channel>

<wlevs:processor id="selectorProcessor">
<wlevs:listener ref="citipocOut" />
</wlevs:processor>

<wlevs:channel id="citipocOut" event-type="FinalOrderEvent" advertise="true">
<wlevs:listener>
<!-- Create business object -->
<bean id="outputBean"
class="com.bea.wlevs.POC.citi.OutputBean"
autowire="byName" />
</wlevs:listener>
</wlevs:channel>
</beans>
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Integrating the Java Message Service

This chapter describes how to use JMS adapters to connect the Java Message Service
with an Oracle Event Processing event processing network to receive and send JMS
messages.

This chapter includes the following sections:
= Section 11.1, "Overview of J]MS Adapter Configuration"
= Section 11.2, "Configuring a JMS Adapter for a JMS Service Provider"

= Section 11.3, "Creating a Custom Converter Between JMS Messages and Event
Types"

= Section 11.4, "Encrypting Passwords in the JMS Adapter Component
Configuration File"

= Section 11.5, "Configuring the JMS Adapter EPN Assembly File"
= Section 11.6, "Configuring the JMS Adapter Component Configuration File"

11.1 Overview of JMS Adapter Configuration

The Oracle Event Processing JMS adapters support any Java EE compliant JMS service
provider that provides a Java client. For more information, see Section 11.1.1, "JMS
Service Providers".

Oracle Event Processing provides the following Java Message Service (JMS) adapters
that you can use in your event applications to send and receive messages to and from a
JMS destination, respectively, without writing any Java code:

= Section 11.1.2, "Inbound JMS Adapter"
s Section 11.1.3, "Outbound JMS Adapter"

For general information about JMS, see Java Message Service on the Sun Developer
Network athttp://java.sun.com/products/jms/.

11.1.1 JMS Service Providers

The Oracle Event Processing JMS adapters support any Java EE compliant JMS service
provider that provides a Java client.

This chapter describes how to configure the Oracle Event Processing JMS inbound and
outbound adapters for use with the following JMS service providers:

= Section 11.2.3, "How to Configure a J]MS Adapter for Oracle WebLogic Server JMS
Manually"
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= Section 11.2.4, "How to Configure a J]MS Adapter for Tibco EMS JMS Manually"

If your JMS service provider is not in this list, you can still configure Oracle Event
Processing JMS adapters for use with your JMS service provider. Review the
procedure in Section 11.2.4, "How to Configure a J]MS Adapter for Tibco EMS JMS
Manually" as a configuration model, consult your JMS service provider
documentation, and adapt this procedure to suit your JMS service provider.

For more information, see Section 11.2, "Configuring a JMS Adapter for a JMS Service
Provider".

11.1.2 Inbound JMS Adapter

The inbound JMS adapter receives messages from a JMS destination and converts
them into events.

You specify an inbound JMS adapter in the EPN assembly file as follows:

<wlevs:adapter id="myJdmsInbound" provider="jms-inbound">

</wlevs:adapter>

You configure an inbound JMS adapter in its component configuration file as follows:

<jms-adapter>
<name>myJms Inbound</name>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Queuel</destination-jndi-name>
<user>weblogic</user>
<password>weblogic</password>
<work-manager>JettyWorkManager</work-manager>
<concurrent-consumers>1</concurrent-consumers>
<session-transacted>false</session-transacted>
</jms-adapter>

This section describes:

= Section 11.1.2.1, "Conversion Between JMS Messages and Event Types"

= Section 11.1.2.2, "Single and Multi-threaded Inbound JMS Adapters"

= Section 11.1.2.3, "Configuring a JMS Adapter for Durable Subscriptions"
For more information, see:

= Section 11.5.1, "JMS Inbound Adapter EPN Assembly File Configuration"
= Section 11.6.1, "JMS Inbound Adapter Component Configuration"

11.1.2.1 Conversion Between JMS Messages and Event Types

By default, the inbound JMS adapter automatically converts JMS messages into events
by matching property names with a specified event type if the following is true:

= You must specify an event type using the jms-adapter element event-type
child element in the JMS adapter component configuration file.

The JMS adapter converts incoming JMS messages into the Oracle Event
Processing event type this element specifies.

= JMS messages must be of type MapMessage.
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For each incoming message, an event of the specified event type is created. For
each map element in the incoming message, the adapter looks for a property on
the event type and if found, sets the corresponding value.

Optionally, you may customize JMS message to event type conversion by writing your
own Java class to specify exactly how you want the incoming JMS messages to be
converted into one or more event types. In this case, you do not specify an event type
using the jms-adapter element event-type child element in the JMS adapter
component configuration file.

For more information, see Section 11.3, "Creating a Custom Converter Between JMS
Messages and Event Types".

11.1.2.2 Single and Multi-threaded Inbound JMS Adapters
By default, an inbound JMS adapter is single-threaded. That is, the inbound JMS
adapter uses a single thread to read messages from the JMS destination.

When the inbound JMS adapter is single-threaded, event order is guaranteed.

To improve scalability, you can configure an inbound JMS adapter to use multiple
threads to read messages from the JMS destination. The simplest way to do this is to
configure the adapter with a work manager. You can specify a dedicated work
manager used only by the adapter or you can share a work manager amongst several
components such as other adapters and Jetty.

When the inbound JMS adapter is multi-threaded, event order is not guaranteed.
For more information, see:

s work-manager and concurrent-consumers in Table 11-1, " jms-adapter
Inbound Child Elements"

s Section 25.1.2.1, "EventPartitioner"

11.1.2.3 Configuring a JMS Adapter for Durable Subscriptions

You can configure an inbound JMS adapter to be a client in a durable subscription to a
JMS topic. A durable subscription ensures that the adapter receives published
messages even if the adapter becomes inactive. When the inbound adapter connects to
the JMS server it will register the durable subscription, and subsequent messages sent
to the topic will be retained during periods when the subscriber is disconnected
(unless they expire) and delivered when it reconnects.

A durable subscription assumes that the publisher that is publishing JMS messages to
the topic is using the persistent delivery mode. Note that publisher might be the
Oracle Event Processing outbound JMS adapter (in other words, its delivery-mode
value must be persistent, the default value).

To create a durable subscription in the adapter you do the following;:
= Ensure that the JMS message publisher is delivering messages in persistent mode.

= Specify a client ID for the connection factory. On Oracle WebLogic Server, the
client ID can be set on the connection factory administratively using the console.
Note that this implies that you should have a dedicated connection factory
configured for each adapter instance that is using durable subscribers.

»  Set three jms-adapter properties:
— destination-type mustbe set to TOPIC.

— durable-subscription mustbe set to true.
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- durable-subscription-name is set to a unique identifier for the
subscription.

For more information about these properties, see Section 11.6.1, "JMS Inbound Adapter
Component Configuration".

11.1.3 Outbound JMS Adapter

The outbound JMS adapter sends events to a JMS destination, automatically
converting the event into a JMS map message by matching property names with the
event type.

Typically, you also customize this conversion by writing your own Java class to specify
exactly how you want the event types to be converted into outgoing JMS messages.

If you do not provide your own converter class, and instead let Oracle Event
Processing take care of the conversion between messages and event types, the
following is true:

= You must specify an event type using the jms-adapter element event-type
child element in the JMS adapter component configuration file.

The JMS adapter converts incoming JMS messages into the Oracle Event
Processing event type this element specifies.

s By default, the outbound JMS adapter default converter creates JMS messages of
type MapMessage. For each property of the event, a corresponding element is
created in the output MapMessage.

You specify an outbound JMS adapter in the EPN assembly file as follows:

<wlevs:adapter id="myJdmsOutbound" provider="jms-outbound">

</wlevs:adapter>

You configure an outbound JMS adapter in its component configuration file as follows:

<jms-adapter>
<name>myJmsOutbound</name>
<event-type>JMSEvent</event-type>
<jndi-provider-url>t3://localhost:7001</jndi-provider-url>
<destination-jndi-name>Topicl</destination-jndi-name>
<delivery-mode>nonpersistent</delivery-mode>
</Jjms-adapter>

For more information, see:
= Section 11.5.2, "JMS Outbound Adapter EPN Assembly File Configuration"
= Section 11.6.2, "JMS Outbound Adapter Component Configuration"

= Section 11.3, "Creating a Custom Converter Between JMS Messages and Event
Types."

11.2 Configuring a JMS Adapter for a JMS Service Provider

This section describes how to configure the Oracle Event Processing JMS inbound and
outbound adapters:
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s Section 11.2.1, "How to Configure a JMS Adapter Using the Oracle Event
Processing IDE for Eclipse”

s Section 11.2.2, "How to Configure a J]MS Adapter Manually"
This section provides examples specific to the following JMS service providers:

= Section 11.2.3, "How to Configure a JMS Adapter for Oracle WebLogic Server JMS
Manually"

= Section 11.2.4, "How to Configure a J]MS Adapter for Tibco EMS JMS Manually"

If your JMS service provider is not in this list, and your JMS service provider offers a
Java client, then you can still configure Oracle Event Processing JMS adapters for use
with your JMS service provider. Review the procedure in Section 11.2.4, "How to
Configure a JMS Adapter for Tibco EMS JMS Manually" as a configuration model,
consult your JMS service provider documentation, and adapt this procedure to suit
your JMS service provider.

For more information, see Section 11.1.1, "JMS Service Providers".

11.2.1 How to Configure a JMS Adapter Using the Oracle Event Processing IDE for

Eclipse

The simplest way to create and configure a JMS adapter is using the Oracle Event
Processing IDE for Eclipse adapter wizard.

For more information, see Section 7.4.1.2, "How to Create an Adapter Node".

After using the adapter wizard to create and specify the basic JMS adapter
configuration, review Section 11.2.2, "How to Configure a JMS Adapter Manually" to
complete the configuration.

11.2.2 How to Configure a JMS Adapter Manually

This section describes how to create and configure a JMS adapter manually. It
describes the detailed steps that you may require depending on your JMS adapter
application and service provider.

The simplest way to create and configure a JMS adapter is using the Oracle Event
Processing IDE for Eclipse adapter wizard as Section 11.2.1, "How to Configure a JMS
Adapter Using the Oracle Event Processing IDE for Eclipse" describes. After using the
adapter wizard to create and specify the basic JMS adapter configuration, review this
procedure to complete the configuration.

To configure a JMS adapter manually:

1. In the EPN assembly file of the application, add a wlevs:adapter element for
each inbound and outbound JMS adapter you want to use in your application.

Example 11-1 shows the wlevs: adapter